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关于本指南
目的和范围
目的和范围

本使用指南的编写目的是帮助您成功地使用9102手持式频谱分析仪的各
项特性和功能。本使用指南将包含针对多项任务的使用说明，介绍怎样
安装、配置、使用和诊断 9102 手持式频谱分析仪。另外，本使用指南还
将介绍 Willtek 的质保、服务、许可和维修信息。

假定条件

本使用指南主要面向那些希望有效地使用9102手持式频谱分析仪的新用
户和中级用户。我们假定您熟悉电信领域的基本概念和术语。

相关信息

请将本使用指南与下列资料配合使用：

Willtek 9100 手持式频谱分析仪简易操作手册 :(getting started manual)

Willtek 9100 应用指南 :(application guide), M290/504

Willtek 还提供了一个关于 “频谱和网络分析”的术语表。订购编号为
SPEC/CT812/0105/EN。

技术支持

如果您在使用本产品方面需要任何帮助或者遇到任何问题，请致电
Willtek 的技术支持中心。您还可以通过电子邮件联系 Willtek，地址是：
customer.support@willtek.com

表 1 技术支持中心

地区 电话号码 传真号码

中国 +86 (0) 21 5835 8037 +86 (0) 21 5835 5238

欧洲、中东、亚洲
和非洲

+49 (0) 89 996 41 386
+49 (0) 89 996 41 227

+49 (0) 89 996 41 440

美洲 +1 973 386 9696
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关于本指南
规范
规范

下表列出了本指南所使用的命名规范和符号：

表 2 格式规范

说明 示例

用这种字体显示用户窗口上的操作。 在状态栏上，点击 Start （开始）。

用这种字体显示一个设备上的按钮或
者开关。

按下 ON 开关。

用这种字体显示代码和输出信息。 All results okay

用这种字体显示您必须准确地按原样
输入的文字。

在对话框中输入 a:\set.exe in the
dialog box.

用这种 < 字体 > 显示变量。 输入新的 < 主机名 >。

用这种字体显示参考书名。 请参阅 Newton's Telecom Dictionary
（牛顿电信字典）

竖线 | 表示 “或者”：在单个命令中
只能显示一个选项。

platform [a|b|e]

方括号 [] 表示一个可选的自变量 login [platform name]

斜括号 <> 表示必需的自变量 <password>

表 3 键盘和菜单规范

说明 示例

加号 + 表示同时按键。 按下 Ctrl+s

逗号表示连续按键。 按下 Alt+f,s

斜括号表示从菜单中选择一个子菜
单。

在菜单栏中，点击
Start> Program Files.
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关于本指南
规范
表 4 符号规范

表 5 安全定义

这个符号表示一般性注意事项。

这个符号代表触电危险。

注

这个符号表示一个表示相关信息或者提示的注释。

警告

表示可能存在危险的情况。如果没有设法避免，这种情况可能会导致
死亡或者严重伤害。

劝告

表示可能存在危险的情况。如果没有设法避免，这种情况可能会导致
轻微的或者中度的伤害。
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安全说明
本章将提供 9102 手持式频谱分析仪的安全说明。
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安全说明
安全警告
安全警告

本产品适合在室内使用。因为触水可能导致仪器损坏，所以在室外使用
本产品时必须避免受潮。

警告

本仪器是一款符合 EN 61326 的 A 类安全产品。它可能会产生影响家用
设备正常工作的射频干扰；用户可能必须采取防辐射措施。

警告

只能用一个 50 欧姆的 N 型接口连接 9102 的 RF IN 端口。使用其他任何
接口都可能会导致本仪器受损。

警告

不要遮挡通风口 （位于左下角和顶部）。遮挡通风口可能会导致严重
损坏和火灾。

警告

RF IN接口的最高输入功率为 30 dBm（1瓦）。更高的输入功率可能会导
致本仪器严重受损。

警告

必须在允许的温度范围之内 -- 从 0°C (32°F) 到 45°C (110°F)-- 使用本
仪器。在本温度范围之外使用本仪器将会导致无效的测量结果。

电池安全建议

不得挤压电池。不得加热或者焚化电池。不得将电池短路。不得拆除
电池。不得将电池浸入任何液体 -- 它可能会泄漏甚至破裂！不得在
0°C (32°F) 以下或者 45°C (110°F) 以上充电。

电池的使用

该电池只供 9102 使用。如果用户将该电池用于其他电动或者电子设
备， Willtek 不会对电池或者其他设备的损坏承担任何责任。
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Chapter 2 概述
1

本章将概括介绍 9102 手持式频谱分析仪。本章所要讨论的主题包括：

 

－ "9102 手持式频谱分析仪简介 " 第 2 页

－ "4.00 版本的新功能 " 第 3 页

－ " 特性和功能 " 第 5 页

－ " 选件 " 第 5 页

－ " 物理结构说明 " 第 10 页

－ " 维护您的仪器 " 第 10 页
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第一章 概述
9102 手持式频谱分析仪简介
9102 手持式频谱分析仪简介

9102 是一款轻便的、功能齐全的频谱分析仪，适用于多种应用：

－安装时的故障排除、维修和维护。

－天线和电缆安装正确与否的验收和故障排除。

－评估、验证电磁辐射和 EMI 性能。

－生产测试、调整射频模块输出。

－现场测量和验证基站发射情况。

－检测和定位手机部件和元器件的故障。

9102 手持式频谱分析仪所适用的典型测量任务包括测试收发器、校正调
制器和测量开关击穿电压。其他选件包括跟踪发生器选件、 9160 VSWR/
DTF 桥和 9130 VSWR/DTF 反射测量等，它们可以扩展 9102 的功能，使其
成为一款矢量网络分析仪。该分析仪可以通过前面板进行控制，也可以
通过 PC 从远程加以控制。

对于基站安装或者维护工程师而言，9102 可以提供 BTS 天线系统所具有
的所有常用测量功能：回波损耗（反射），塔上安装放大器（发射）和
故障点距离测量等。而且，这款轻便的设备可以提供 500 个数据点（最
小 0.05 米）的标准分辨率。

测量结果和仪器设置可以被方便地发送到 PC 中，用于演示或者后期处
理。这款牢固耐用的仪器适用于固定和移动测量环境，能够满足多种应
用的需要。
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4.00 版本的新功能
4.00 版本的新功能

新功能：

－新的电磁辐射 EMF(EMI) 测量选件 详情请参见第 11 章 "EMF (EMI) 操作 "

－ 9100 数据交换软件中的新特色 , 支持新的 EMF(EMI) 测量选件。详情请

参见第 14 章 "9100 数据交换软件 "。

－新的曲线追回功能 , 详情请参见第 19 页第一章中的 " 曲线追回 "
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4.00 版本的新功能
3.10 版本的新功能 新功能：

－新的VSWR/DTF反射测量选件 ,包括测量模式反射、故障点距离和线损。

－ 标记功能：所有测量模式都可以使用六个标记；标记可以设置在曲线
A 和曲线 B 上。

－ 参数窗口使用新的窗口外观

－ 直接打印

－ 新的打印机设置菜单

－ 带有 RMS 检波器的 RMS 选件

－ 发射模式下的绝对和相对显示

－ 发射模式下的精确曲线偏移

－ 曲线存储菜单：针对两条曲线的曲线保存和曲线调用功能

－ 通道功率模式：测量菜单被移入主菜单

－ 专门针对电池操作的特殊背光显示设置有助于节约能耗

改进：

－ 在模式窗口中完全支持外置设备

－ 经过改进的频率计数器

－ 经过改进的最小值降级功能

－ 经过改进的配色方案菜单：所有窗口组件都具有八个输入栏

3.01 版本的新功能 新功能：

曲线功能菜单中的新功能：添加 A+B->A

改进：

测量菜单得到改进。可以从频谱分析主菜单打开测量菜单。
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特性和功能
特性和功能

频率范围：从 100kHz 到 4GHz

数字 IF 可以提高测量精确度

为基本参数提供自动模式

六个标记，最多五个动态标记

大尺寸、高亮度的显示窗口

较小的占地面积和较大的前端尺寸

轻便的、高容量的电池

允许通过 RS-232 或者 LAN 进行远程控制

选件

9102 手持式频谱分析仪可以采用下列选件和附件：

表 6 可供 9102 手持式频谱分析仪使用的选件

产品编号 说明

M 897 261 9130 VSWR/DTF 反射测量选件

M 897 274 9131 EMF 测量文件

M 897 275 9132 RMS 检波器选件

M 248 966 9160 VSWR/DTF 桥

M 248 804 跟踪发生器升级
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选件
表 7 可供 9102 手持式频谱分析仪使用的附件

产品编号 说明

M 205 012 电池模块 （可供电， 7.2Ah）

M 241 015 9100 户外背包

M 241 013 9100 软质手提包

M 204 097 1500 电池充电器

M 248 328 9100 电源

M 860 389 9100 12V 汽车适配器

M 867 037 9100 安全锁

M 897 137 9100 数据交换软件

M 860 388 9100 串行通信电缆

M 248 640 1205 RF 探头 20dB ( 包含 N-BNC 适配器 )
频率范围 100kH-4GHz
RF 衰减 ( 额定阻抗 50 欧姆 ) 20dB
包括适配器 N ( 公 )， BNC ( 母 )

M 248 971 1207 感应探头

频率范围 4MHz 到 6GHz
30dB 放大器

M 860 368 9170 双锥形天线

M 248 809 9171 全向形天线

M 860 158 9172 定向天线， 80 到 1000MHz

M 860 159 9172 定向天线， 300 到 3000MHz

M 860 264 天线， 400MHz 频段 (TNC)

M 860 261 天线， 900MHz 频段 (TNC)

M 860 262 天线， 1800MHz 频段 (TNC)

M 860 260 天线， 1880MHz 频段 (TNC)

M 860 146 天线， 2400MHz 频段 (TNC)

M 886 098 适配器 N ( 公 ) 到 TNC ( 母 )

M 886 097 适配器 N ( 公 ) 到 BNC ( 母 )

M 886 205 匹配板， N 50 Ω 到 N 75 Ω

M 886 204 匹配板， N 50 Ω 到 F 75 Ω

M 874 061 衰减器 18GHz, 6dB

M 860 548 开路 / 短路 / 负载校准工具， DIN 7/16 英寸 ( 公 )

M 860 549 开路 / 短路 / 负载校准工具， N 型 ( 公 )

M 860 396 混合电缆 10 米 用于 9171

M 860 256 天线三脚架

M 860 395 天线三脚架包
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选件
9100 电池模块

1500 电池充电器

9100 软质手提包

9100 户外背包

9100 12V 汽车适配器

9100 安全锁
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选件
9100 串行通信电缆

1205 射频探头

1207 感应探头

9170 双锥形天线

9171 全向形天线

9172 和 9173 定向天线
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第一章 概述
选件
天线 900MHz 频段 (TNC)
天线 1800MHz 频段 (TNC)
天线 1880MHz 频段 (BNC)
天线 2400MHz 频段 (TNC)

适配器 N-BNC
适配器 N-TNC

阻抗变换器 ,N 50欧姆到N 75欧姆

阻抗变换器 ,N 50欧姆到F 75欧姆

阻抗变换器 18GHz, 6dB

开路 / 短路 / 负载校准工具，

DIN 7/16 英寸 （公）

开路 / 短路 / 负载校准工具，

N 型 （公）
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第一章 概述
物理结构说明
物理结构说明

9102手持式频谱分析仪附带了 9100数据交换软件。该软件也可以单独订
购。

9102 的可供用户接触的部件主要包括以下几部分：

前面板：包括大尺寸显示窗口、软键、数字、光标和功能键

接口：可以从 9102 的顶部和左侧操作

开关、电源接口和电池架

手柄：它可以旋转一定的角度，充当一个支架，以便让 9102 能够在使用
时保持一定的角度

维护您的仪器

Willtek 一直致力于不断改进它的产品。它在 www.willtek.cn 上提供了软件
更新。如需查看对升级应用软件的详细说明，第 13 章 " 升级仪器软件 "。

9102 手持式频谱分析仪是一款测量设备。与所有类似仪器一样，9102 应
当定期进行校准，以保持精确度。Willtek 建议用户每年对 9102 进行一次
校准。

另外，请阅读我们在互联网上提供的常问问题解答和电子新闻邮件。

如果您对 9102 手持式频谱分析仪存有其他疑问，请发信到

willtek.cn@willtek.com.
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Chapter 3 一般性操作
2

本章将介绍这款仪器的与所选模式无关的功能。本章所要讨论的主题包
括：

－ " 连接 9102 手持式频谱分析仪 " 第 12 页

－ " 仪器上电 " 第 14 页

－ " 开始测量 " 第 15 页

－ " 使用前面板 " 第 15 页

－ " 选择测量模式 " 第 26 页

－ " 使用标记 " 第 28 页

－ " 使用极限线 " 第 31 页

－ " 打印 " 第 35 页

－ " 从一台 PC 控制 9102" 第 35 页

－ " 从远程控制恢复到本地模式 " 第 35 页

－ " 检查一般性设置 " 第 35 页

－ " 使用过去保存的设置 " 第 46 页

－ " 将所有模式恢复到出厂设置 " 第 48 页
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第二章 一般性操作
连接 9102 手持式频谱分析仪
连接 9102 手持式频谱分析仪

DC in 接口 9102 可以使用内部电源或者外置直流电源，例如 9102 所附带的电源。另
外，在连接外置电源时电池将被充电。请参阅您的简易操作手册中列出
的产品规格，了解所需使用的直流电源的具体细节。您还可以从中了解
到安装、维护电池的详细信息。

请电源连接到 9102 顶部的 DC 输入接口。

RF in 接口 RF 输入是一个 50 欧姆的 N 型接口 （母）。

如果您将一条带有 N 型接口 ( 公 ) 的 50 欧姆屏蔽 RF 电缆连接到待测设
备，您只需要将该接口拧入 9102。

如果您拥有一条带有 BNC 接口 ( 公 ) 的 50 欧姆屏蔽 RF 电缆，您需要用
一个 N-BNC 适配器将该电缆连接到 9102。Willtek 为此提供了一款合适的
适配器；请参阅 " 选件 " 第 5 页。

图 1 9102 顶部的接口

DC in 

 

RF in 

多功能口 外部触发器 耳机插孔

RF out

警告

RF 输入接口的最高输入功率为 30 dBm (1 瓦 )。更高的输入功率可能会
导致本仪器受损！

劝告

只允许用一个 50 欧姆 N 型接口连接 9102 的 RF 输入端口。使用其他任
何接口都可能会导致本仪器受损。
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第二章 一般性操作
连接 9102 手持式频谱分析仪
如果您想测试一款输入阻抗为 75 欧姆的设备，请参阅 " 调节输入阻抗 "
第 51 页，了解怎样相应地调整 9102 的设置。

RF OUT 接口 RF 输出是一个 50 欧姆的 N 型接口 （母）。

待测设备和 9102 手持式频谱分析仪之间的连接可能会发生衰减，原因包
括连接可能是通过一个天线建立的，或者其中采用了一个功率分配器，
或者电缆过长等等。通过在 9102 中输入衰减值，可以补偿衰减对测量结
果的影响，详见 " 补偿增益和损耗 " 第 65 页。

外部触发器接口 主要用于频谱分析测量。利用这个接口，仪器可以获得一个外部触发信
号。它可以连接一个通过发送脉冲触发测量的外部设备。

多功能端口 为了使用外置适配器、放大器和附件，本仪器提供了一个多功能接口。
多功能端口让本仪器可以触发针对外部信号的测量任务。另外，它还可
以被用于读取外置设备中存储的数据 （例如校准数据）。

耳机插孔 除了内置的扬声器以外，本仪器还提供了一个标准的 3.5mm 耳机插孔。
当您将耳机连接到本仪器时，扬声器将会被自动禁用。

注意采用正确的终端

如果电缆和电源的输入阻抗不是 50 欧姆，将会导致不准确的测量结
果。

警告

外部触发器输入只适用于 TTL 输入电平。在这个端口上使用更高的电平
可能会导致仪器受损！
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第二章 一般性操作
仪器上电
串行 (RS-232) 接口 9102 手持式频谱分析仪左侧的这个 9 针 sub-D 接口可以被用于通过串行
接口 (RS-232) 远程控制本仪器。如需了解相关的指令集和响应，请参阅
"SCPI 命令参考 " 第 201 页。

请使用一条零调制解调器 (PC-PC) 电缆，将 9102 连接到一台控制 PC。

LAN 接口 9102 也可以利用 TCP/IP 连接，通过局域网 (LAN) 进行控制。LAN 接口位于
仪器左侧。 IP 地址可以在系统配置菜单中设置，也可以通过 RS-232 设
置。 9102 可以在速率为 100Mbps 的网络中工作，但是也能够以 10Mbps
的速度收发数据。

如需了解控制 9102 的指令集和 9102 的响应，请参阅 "SCPI 命令参考 " 第
201 页。

请用一条带有 RJ-45 接头的标准 LAN 电缆，将 9102 连接到 LAN。

仪器上电

9102 的开关状态由位于仪器顶部的电源开关控制。 9102 需要用大约 55
秒钟的时间载入和启动它的软件。

图 2 9102 左侧的接口

                      串行口

       LAN
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开始测量
开始测量

会在仪器上电之后自动开始测量和显示结果。它会自动进入最近一次使
用的测量模式。

使用前面板

概述 前面板包含多个部分，如下图所示：

电池状态 LED 该 LED 具有多个不同的状态：

－ LED 灯变绿，表示 9102 正在使用电池供电，没有外置电源为其供电。

－ LED 灯变黄，表示电池正被连接到一个外置电源进行充电。

－ LED 灯熄灭，表示充电结束，电池电量已满；或者 9100 的电池舱中没

有安放电池。

－当 LED 灯变黄，并且连续地、快速地闪烁时，表示电池或者充电器发

生故障。请向 Willtek 服务中心报告该故障。

图 3 前面板的构成要素

display 光标键 功能键

横向 ( 菜单 ) 软键
纵向功能软键

数字键 确认键
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使用前面板
显示窗口 6.5 英寸的显示窗口主要包括以下几个部分 ( 如图 4 所示 )：

－结果区域

－标记栏

－输入栏

－软键说明

结果区域 结果区域 （图形）

结果区域占据了屏幕的绝大部分空间，可以为您显示测量结果。一个由
十个垂直列和八个水平行组成的网格让用户可以更加方便地从坐标轴中
读取测量值。这个区域可能会显示一个或者两个图形，具体取决于用户
所选择的曲线个数。

注意

在电池电量不足时 （即电池电量低于额定电量的 10%），信号电平测
量结果可能会偏小。请参阅请参阅第 17 页中的表 8，了解判别电池电
量不足时的方法。如需了解安装电池和充电的详细信息，请参阅您的
简易操作手册。

图 4 显示窗口的构成

结果区域

标记栏 输入栏

软键说明
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横轴

横轴是频谱图中的频率轴。但是在零跨度下并非如此，因为这时横轴是
时间轴。坐标两端的频率值都在图中标出 （分别是起始频率和截止频
率）。

纵轴

纵轴反映的是 RF 功率。根据您所选择的电平单位， RF 功率可以用 dBm,
dBV, dBmV 或者 dB 礦表示。功率坐标的顶端被称为参考电平。

符号 ( 图标 )

除了结果图形本身以外，还可以用不同的图标来表示 9102 的状态，如下
表所示：

表 8 显示窗口上的图标

符号 含义

9102 正在从电池获取工作电流。彩色部分表示目前剩余的电
量。如果剩余电量不低于 30%，则这个部分的颜色为黄色；
如果介于 10% 到 30%，则颜色为红色；如果低于 10%，则颜
色为白色。当电量低于额定值的 30% 时，9102 将会发出一次
嘟嘟声。如果低于 10%， 9102 将会发出两次嘟嘟声。

9102 连接到一个外置直流电源。

9102 无法确定电池的剩余电量，但是电池仍然可以使用和充
电。在这种情况下，请联系 Willtek 的服务人员，将您的电池
送交检查。

9102 无法确定电池的剩余电量；通常发生在电池工作时间的
后三分之一阶段。请联系 Willtek 的服务人员，将您的电池送
交检查。

电池没有安装； 9102 从外置电源获取工作电流。

9102 连接到一个本地局域网 (LAN)。

在图示功率电平设置了一个视频触发器。该图标还会显示触
发器的斜率。

解调功能被启用 , 这样 9102 会在扬声器中播放经过解调的信
号。
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使用前面板
其他窗口构成要素

纵轴左侧的条栏显示了下面列出了部分或者全部要素：

表 9 左侧文字

文字 含义

Ref. Level 表示垂直 ( 功率 ) 轴的最高电平。可以利用 REF 功能键修改。

dBm
dBµV
dBmV
dBV
V
mV
µV
mW
µW
dBµV/m
dBmV/m
V/m
mW/m2

指明所显示功率的单位。可以在 Level>Units 菜单中修改。通
过按下 Units（单位）软键，可以在对数和线性单位之间切换。
对数单位包括 : dBm, dBµV, dBmV, dBV, dBµV/m, dBmV/m, dBV/
m。线性单位包括：V, mV, µV, mW µW, V/m, mW/m2。

HOLD 表示测量因为用户按下了 HOLD/RUN 功能键而处于暂停状态。

Count 接在后面的数字表示测量的进度，即已经进行了多少次基于
当前配置的测量任务。在启用曲线保持模式时，这个计数器将
会不断累加。一旦某个影响测量的参数 （例如频率、滤波器
或者衰减）发生变化，该计数器就将重置。

Ext. Dev. 表示启用外置设备补偿，这意味着任何耦合设备的衰减都将
被考虑在内。关于如何设置外置设备补偿，请参阅 " 补偿增益
和损耗 " 第 65 页。

UNCAL 在显示时表示当前的滤波器和扫描时间设置不允许进行正确
的测量。

Pos./Neg.
Pos. Peak
Neg. Peak
Sample
RMS

显示当前的检波器设置。如需了解检波器的改动方式，请参阅
" 选择曲线模式 " 第 60 页。如果安装并在您的 9102 上启用
了 9132 RMS 检波器选件，就可以使用 RMS 检波器。

A/B (ACT)
A/B (HLD)
A/B (MAX)
A/B (MIN)
A/B (AVG)

显示各条曲线的当前选择曲线模式。这段文字的背景颜色与
图形的颜色一致。如需了解更多关于曲线模式的信息，请参阅
" 选择检波方式 " 第 74 页。
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曲线追回

若曲线的 90%超出了显示屏范围 (或上移 ,或下移 ) 那么带有上箭头或下
箭头的曲线溢出指示图符 (处于显示屏将引导你曲线溢出的中间处置 )通
过修改相应的参考电平即可追回曲线。

标记栏

一旦您使用了任何一个标记，标记栏就会显示，标明标记所在位置的测
量值。其中最多可以显示四个标记的功率电平和频率值。如果您已经使
用了四个标记，那么当您再添加第五个标记时 （最多可以添加六个标
记），一个标记值将会被隐藏，新的标记值将取而代之。通过按下相关
的标记软键，您可以再次显示隐藏的标记值。标记可以从绝对值切换到
相对值。在这种情况下，所显示的标记值是它们的绝对值相对于标记 1
（例如 A1）的相对值。

输入栏

输入栏让您可以根据所选择的功能，输入一个数字或者一段文字。标题
行显示的是输入值的含义。有些输入栏还会对输入的步进值给出进一步
的说明。只有在利用上 / 下光标键 -- 而不是数字键 -- 改动输入值时，步
进值才会生效。

软键说明

软键说明指出了每个软键所具有的功能。它们与水平软键的下方和垂直
软键的右侧对齐。请参阅 " 软键 " 第 23 页，了解更多信息。
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键盘 前面板包含了很多按键。它们让您可以直接使用功能和菜单，以及输入
测量参数，例如中心频率。键盘主要分为以下几个部分：

功能键

功能键具有一些特殊的、固定的功能。因此，它们时常也被称为 “硬
键” -- 与功能会随着屏幕上的指示而改变的软键相对应。

功能键包括：

表 10 功能键

键 功能

模式 测量模式选择。这个功能键让您可以为特定的应用选择
不同的、预定义的测量类型。它还让您可以查看系统设
置。

测恢复缺省设
置

将所选模式的所有参数恢复到出厂缺省设置。它不会影
响其他模式的设置。

为了防止意外重置，只有在按键一段时间之后，恢复缺
省设置功能才会执行。将该功能键按住至少半秒钟，才
能恢复缺省设置。除了这个功能键以外，9102 手持式频
谱分析仪还为将所有模式恢复到缺省设置提供了出厂设
置功能。请参阅 " 将所有模式恢复到出厂设置 " 第 48
页，了解更多信息。

暂停 / 运行 暂停和开始扫描。

参数 这个功能键会调出参数页面，其中列出了当前使用的所
有设置参数。按下 Exit 键可以关闭该参数窗口。

请注意，不同测量模式的参数窗口是不同的。

指向某个 UNCAL 警告的参数都标有一个方块符号。

调用 / 存储 打开存储菜单。

清除曲线 该功能键会重置此前的测量结果 （包括平均值）、扫描
计数器和错误计数器，开始一次新的扫描。
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光标键

在一个输入栏中，上、下光标键可以被用于增加或者减少当前值。左、
右光标键分别可以将光标位置左移、右移一位。

如果标记栏激活，那么上、下光标键可以分别将标记上移或者下移半个
单位。左、右光标键则可以将标记左移、右移一个像素。

中心频率 直接打开频率菜单中的中心频率输入栏。

跨度 直接打开频率菜单中的频率跨度输入栏。

参考电平 直接打开参考电平输入栏。

标记 直接打开标记菜单。

表 10 功能键

键 功能

立即生效

利用光标键对输入参数进行的任何改动都会立即生效。利用屏幕上的
直接反馈，您可以用反复尝试的方式轻松地将参数调整到最佳值。
9102 手持式频谱分析仪 4.00 版本 21



第二章 一般性操作
使用前面板
数字键

数字键让您可以用一种类似于便携式计算器的方式输入一个数值。在某
些输入栏，您可以像使用移动电话一样输入一段文字。

±键提供了一项额外的功能。在将一台 PCL 打印机连接到 9102 之后，您
可以通过按下该键，直接打印显示窗口幕。如需了解配置打印机和打印
的详细信息，请参阅 " 设置一台打印机 " 第 44 页和 " 打印 " 第 35 页。

确认键 输入的数字或者字母数字信息必须通过一个确认键补齐，或者会受到这
些键的影响。下表列出了各个确认键的含义：

Escape 键 如果在打开某个输入栏时按下该键，Escape 键将会在不更
改原有值的情况下关闭该输入栏

无效输入

如果您输入了一个无效的数字或者字符串， 9102 将会发出嘟嘟声，自
动将输入值改为最接近的有效值。

表 11 确认键

键 功能

GHz/dBm 在频率输入栏，通过选择单位 GHz（吉赫兹）补齐输入。
在功率输入栏，为所输入的值选择单位 dBm。

MHz/dB/µs 在频率输入栏，通过选择单位 MHz （兆赫兹）补齐输
入。在功率输入栏，为所输入的值选择单位 dB。在时间
参数输入栏，为所输入的值选择单位 µ

kHz/dBµV/ms 在频率输入栏，通过选择单位 kHz（千赫兹）补齐输入。
在功率输入栏，为所输入的值选择单位 dB 礦。在时间参
数输入栏，为所输入的值选择单位 ms。

Enter 确认一个没有单位的输入，或者单位为赫兹和秒的输
入。
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退格键 删除最新输入的文字或者数字 （退格）。

在打开某个输入栏时，所以数字都会被选中。按下退格键
会清除整个输入条目。

软键 软键的功能会随着每个键旁边的屏幕说明的变化而变化。

水平 （菜单）软键

水平软键让您可以打开不同的菜单。激活菜单的名称将会高亮显示；菜
单的各项功能将会通过垂直软键提供。包含子菜单的条目将带有三个点
号 （“...”）；没有点号的菜单软键将带您进入上一级菜单。

垂直 （功能）软键

垂直软键让您可以更改 9102 的设置。

9102 的垂直软键具有下列功能：

－ 普通设置 -- 在按下软键时，一个输入栏会显示在屏幕上方，让您可

以输入数字或者字母数字数据。该数据将会在您按下一个确认键之后
生效。某些用于普通设置的软键还可以说明当前设置的值。
例如：通道功率模式中的通道软键

\

－ 混合输入和选择 -- 这种软键让您可以更改一个数值和一个相关的设

置，例如在自动和手动参数设置之间切换。第一次点击该软键将会打
开类似于普通设置软键的输入栏。多次点击该软键将使得 9102 在可

用选项之间来回切换。目前选择的选项将以蓝色显示，而未被选中的
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选项将以白色显示。
例如：RBW 软键

－执行 -- 通过按下该软键，可以执行该软键所代表的功能。执行软键都

带有一个惊叹号符号。
例如：标记菜单中的 Max Peak （最大峰值）软键。

－执行 -- 通过按下该软键，可以执行该软键所代表的功能。执行软键都

带有一个惊叹号符号。
例如：标记菜单中的 Max Peak （最大峰值）软键。

输入数字和文字 在打开输入栏之后，您需要在其中输入数字或者字符（字符中也可能包
含数字）。因为数字键将会在输入栏打开后切换到相应的输入功能，所
以您可以立即察觉需要输入的数据类型。

填写数字输入栏 在 9102 软件需要您输入数字数据时，按下一个数字键就会在输入栏中显
示一个相应的数字。9102 不一定允许您输入一个小数值或者一个带有正
负符号的值，所以用于输入小数点和改变数字符号的软键不一定可以使
用。在输入了所有的数字、符号和小数点之后，必须按下一个确认键。
数字通常都带有一个单位，确认键可以提供相应的单位。
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输入的声音提示

在输入一个新的参数值之后，您可能会听到两种声音提示中的一个：

－短嘟嘟声 ( 提醒 )：参数超过限值，或者输入影响到某个相关的参数；

相关参数已经被 9102 手持式频谱分析仪所纠正。

例 1：输入了一个无效的截止频率 5GHz，导致一个短嘟嘟声，仪器自

动将截止频率设置为最高值 --4GHz。
例 2：起始频率设置为 2GHz，截止频率设置为 4GHz ；而后用户输入

一个新的频率跨度：3GHz。这导致起始频率被自动改为 1GHz，并产

生一个短嘟嘟声。

－长嘟嘟声（错误）：一个参数被设置为无效值，9102 手持式频谱分析

仪自动恢复原有值，并发出错误嘟嘟声。
例如：在输入一个新的（无效的）衰减值 --60dB-- 之后， 9102 手持

式频谱分析仪发出一个长嘟嘟声，并自动将衰减值恢复到原有值。

填写文字输入栏 有些输入栏需要填写字母数字。数字键可以被用于输入字符。每个数字
键都被分配了多个字母或者数字。在这种情况下，按键的字符分配如下
表所示：

要输入一个字符，需要迅速地、反复地按某个软键，直到希望输入的字
符出现在字符栏中为止。

更改输入 在打开某个输入栏之后，您可以利用 Left/right （左 / 右）光标键移动光
标，将其置于数字或者文字之中。您可以输入其他的数字或者字符，或
者利用 BACKSPACE （退格）键删除光标前面的数字或者字符。

表 12 用于输入字母数字的按键

按键 所分配的字符

0 0

1 1

2 A, B, C, 2

3 D, E, F, 3

4 G, H, I, 4

5 J, K, L, 5

6 M, N, O, 6

7 P, Q, R, S, 7

8 T, U, V, 8

9 W, X, Y, Z, 9

. not assigned

± not assigned
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选择测量模式

9102 提供了多种不同的测量模式

－频谱分析模式的功能最丰富。它提供了所有其他模式中包含的大部分
选项。如需了解更多关于本模式的信息，请参阅第 49 页。

－通道功率模式让您可以测量某个特定频段内的辐射功率。如需了解更
多关于通道功率模式的信息，请参阅第 73 页。

－ 发射模式可以从模式菜单的 (VSWR)Tracking... 子菜单之中打开。它让

您可以确定有源和无源设备的频率特性。如需了解更多关于本模式的
信息，请参阅第 101 页。

－信号发生器模式也位于 (VSWR)Tracking... 子菜单之中。它可以为模拟一

个电路生成信号。如需了解更多关于本模式的信息，请参阅第 95页。

如果您在 9102 上安装并启用了 9130 VSWR/DTF 发射测量选件， (VSWR)
Tracking... 子菜单中将会多出三个额外的模式。如果没有安装该选件，这
个子菜单的名称将会是 Tracking... 而且没有额外的模式。如需了解 9130
VSWR/DTF 发射测量选件的详细信息，请参阅 "9130 VSWR/DTF 反射测量选
件 " 第 133 页。如需了解关于检查已经安装的选件和安装新选件的详细
信息，请参阅 "查看已装选件 "第 37页和 "安装一个新的选件 "第 38页。

所有三种模式都可以从模式菜单中的 (VSWR)Tracking... 子菜单中打开。

－反射模式可以通过对反射波进行矢量测量，提供高精度的天线系统反
射测量结果。如需了解更多关于本模式的信息，请参阅第 129 页。

－故障点距离模式可以提供对天线馈线的详细分析，以便找出故障原
因，例如接口松动、线缆绞缠等。如需了解更多关于本模式的信息，
请参阅第 147 页。

－线损模式让您可以确定平均线损。如需了解更多关于本模式的信息，
请参阅第 157 页。

如果 9131EMF 测量选件在您的 9102 频谱仪上已安装并激活 , 就可多一种
测量模式 :

EMF(EMI) 模式使您可以轻松高效地测量发射机的辐射 , 比如基站和广播
站。在这种模式下 , 9102 会通过用户定义的频率范围来测量电磁场 , 显示
场强或功率密度。请参阅第 165 页。

另外，您还可以通过模式菜单查看系统设置，例如 I/O 配置、版本信息
等。如需了解更多细节，请参阅 " 检查一般性设置 " 第 35 页。
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选择测量模式需要执行以下步骤：

1 按下 Mode （模式）功能键。
显示模式菜单 （如图 5 所示）。

2 通过按下相应的软键，选择新的模式或者返回到此前使用的模式。如
需选择信号发生器、发射、反射、故障点距离和线损等模式，请在按
下相关的模式软键之后，选择 (VSWR/)Tracking... 软键。

之后，屏幕上将显示所选模式的主菜单。如果您选择了一个新的模
式，所有参数都将设为该模式上一次启用时使用的值。但是，如果
您选择的是恢复上次启用的模式，测量参数将保持不变。

图 5 选择一种测量模式

注意

只有您在9102上安装并启用了9130 VSWR/DTF发射测量选件的情况下，
才可以使用反射、故障点距离和线损模式。如需了解关于如何检查已
经安装的选件和安装新选件的详细信息，请参阅 "查看已装选件 "第 37
页”和 " 安装一个新的选件 " 第 38 页。
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使用标记

9102 提供了强大的、方便的标记功能。最多可以使用六个标记；其中有
五个可以是动态标记 (Delta Marker)。标记非常容易放置，而且您只需要
按一次键，就可以改变中心频率和参考电平。如果您使用了两条曲线，
您还可以在曲线 A 和曲线 B 上分别使用标记。这些标记也会被分别命名
（例如 A1、 B1）。动态标记用 D 表示 （例如 DA1）。

必须指出的是，如果您将光标置于信号峰值处，再缩小频率跨度，那么
标记位置将会从峰值处略有偏移。这是因为在使用高跨度值时，显示频
率的分辨率有限。在缩小跨度之后，标记将会被重新定位到新的峰值
处。

启用和移动一个标记 1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mkr 功能
键。
如果您在没有启用任何标记的情况下从主菜单中选择 Marker，标记 1
的软键将会高亮显示。
要启用标记 1，需要切换软键状态，直到 “ON” 高亮显示。
屏幕将显示标记 1 的输入栏。
如果您在没有启用任何标记的情况下使用 Mkr 功能键，标记 （A1 或
者 B1）将会出现在最高峰值处。屏幕将显示标记 1 的输入栏。

2 如果您想要启用另一个标记，请按下相应的软键（A1 到 A4，或者 B1
到 B4）。如果您希望使用四个以上的标记，请按下 Mkr More 软键显
示标记 5 和标记 6 的标记软键，再执行与标记 1 到 4 相同的操作。
这样，标记将被启用，屏幕上将显示输入栏；所选的标记将会显示在
显示窗口顶部的标记栏中。

图 6 标记示例
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3 如有必要，可以利用光标键和 Max Peak（最大峰值）、Next Peak（次
高峰值）软键将标记移动到另外一个位置，或者利用数字键和相关的
确认键输入新位置的频率。

禁用一个标记 1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mrk 功能
键。
屏幕将显示标记菜单和标记 1 的输入栏。

2 按下您希望禁用的标记所对应的软键（A1 到 A6 或者 B1 到 B6 中的一
个）。如果您需要使用四个以上的标记，可以通过按下 Mkr More 软
键，显示标记 5 和标记 6 所对应的软键。切换软键状态，直到“OFF”
高亮显示。这时，该标记将会被禁用，相应的标记值将从屏幕顶部的
标记栏中消失。通过再次将软键状态切换到“ON”，标记将会被再次
启用。

启用一个动态标记 对于动态标记，标记栏将会显示它们相对于标记 1 的功率电平和频率。
标记 1 不能使用动态标记。如果在您将另外一个标记设为动态标记时，
标记 1 尚未启用，那么标记 1 将会被自动启用。

1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mrk 功能
键。

2 选择您希望改为动态标记的标记所对应的软键（A2 到 A6，或者 B2 到
B6）。如果您需要使用四个以上的标记，可以通过按下 Mkr More 软
键，显示标记 5 和标记 6 所对应的软键。
如果此前没有使用，那么该标记将会被启用。

3 按住该软键，直到 “REL”高亮显示。标记栏中的相应标记将会被标
为动态标记，例如 DA2，而不是 A2。

禁用一个动态标记 1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mrk 功能
键。
屏幕将显示标记菜单和标记 1 的输入栏。

2 选择您希望禁用的动态标记所对应的软键（例如 DA2）。如果您需要
使用四个以上的标记，可以通过按下 Mkr More 软键，显示标记 5 和
标记 6 所对应的软键。
如果此前没有使用，那么该标记将会被启用。

3 要完全禁用该标记，只需按住该软键，直到 “OFF”高亮显示。如果
需要将该动态标记改为一个显示绝对值的普通标记，则只需将该软键
再次切换到 “ON”状态。
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在某个相对于标记 1 的频
率设置一个标记

1 按照 " 启用一个动态标记 " 中的说明启用一个动态标记。
输入栏将会显示被选动态标记相对于标记 1 的频率。

2 输入一个相对于标记 1 的频率的（带符号）频率值。可以使用数字键
和相应的确认键，或者利用光标键将光标移动到该频率值所在的位
置。
输入栏显示该标记的频率偏移，以及该标记相对于标记 1 功率的功率
电平。

利用标记调节中心频率 本功能可以将中心频率调节为一个可选标记的频率。

1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mrk 功能
键。
屏幕将显示标记菜单和标记 1 的输入栏。

2 选择您希望使用除标记 1 以外的其他标记所在位置的频率，请按下相
应的软键 （A2 到 A6，或者 B2 到 B6）。如果您需要使用四个以上的
标记，可以通过按下 Mkr More 软键，显示标记 5 和标记 6 所对应的
软键。

3 按下 “Marker to Center”软键。
中心频率将变为所选标记所在位置的频率。只有在中心频率的改变而
导致无效的起始或者截止频率时，频率跨度才会发生变化。

利用标记调节参考电平 以下操作可以将参考电平调节到某个标记所在位置的功率水平：

1 从主菜单中，选择 Marker（标记）。或者按下任意菜单中的 Mrk 功能
键。

2 选择 Mkr Transfer 菜单。

3 选择您希望使用除标记 1 以外的其他标记所在位置的功率水平，请按
下相应的软键 （A2 到 A6，或者 B2 到 B6）。如果您需要使用四个以
上的标记，可以通过按下 Mkr More 软键，显示标记 5 和标记 6 所对
应的软键。

4 按下 Marker to Ref. Lvl 软键
参考电平将变为所选标记的功率水平。

将标记频率设为 FStep 在测量谐波或者互调产品时，按照用户定义的步进方便地调节频率的功
能可能非常有用。“Marker to FStep”（将标记频率设 FStep）功能可以将
当前标记 （或者动态标记）的频率设为 FStep，即选择中心频率和标记
频率的步进宽度。

假定条件：标记 A1 到 A6 或者 B1 到 B6 中的一个已经启用。

1 从主菜单中选择 Marker > Mkr Transfer，打开 Marker Transfer 菜单。
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2 按下 Marker to FStep.
FStep 参数使用手动模式。如果当前使用的标记是一个绝对标记，那
么标记所在位置的频率将成为新的 FStep 值。
或者，如果当前使用的标记是一个相对（动态）标记，那么当前标记
和标记 1 之间的差值将成为新的 FStep 值。
如果新的 FStep 值大于 1GHz，原先的 FStep 值将会保留，9102 将会发
出一次嘟嘟声。

使用极限线

概述 9102 的一项非常有用的功能是可以为曲线 A 的测量结果设置极限。这些
极限会显示在屏幕上，而且 9102 可以显示测量结果是否超越极限。

9102 提供了两种不同的极限模式。在第一种模式下，屏幕上会显示上、
下两条极限线。这种模式被称为“简单极限”；极限值可以通过 9102 的
极限菜单直接输入。

在第二种模式下，屏幕上会显示更加复杂的极限线，如图 7 所示。这些
极限值可以通过 PC 上的一个方便的工具输入，再通过 RS-232 或者 LAN
接口输入到 9102 之中。可以用一组极限线定义一个测量模板。9102 为这
些极限提供了多种工具，例如一个极限超出计数器，在测量值超出极限
时发出一次嘟嘟声，以及在发生超出情况之后暂停测量的功能。这些极
限可以在频率和时域中使用。

9102 最多可以存储 99 组极限值。

图 7 在频谱分析中使用极限线示例
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实际的极限值必须在一台 PC 上定义，再利用 9100 数据交换软件发送到
9102。9102 可以存储多个极限文件。当前使用的极限文件的名称将显示
在屏幕的左上方。

请注意，极限是在一个表格中定义的，与纵轴或者横轴使用的单位无
关。因此，您可以将极限应用于不同的频率范围和功率电平。但是，您
需要自行选择一个有用的频率范围、参考水准和电平刻度。

请注意，如果起始频率是 0Hz，而且将该频率设为上限，将会弹出一个
FAIL （超出）提示。

使用简单极限 简单极限包括固定的上限和下限。它们必须被事先启用，才能生效。一
旦启用，每条测量曲线都会伴有一个 Pass/Fail（不超出 / 超出）标示，指
明测量结果是否超出极限值。

启用和关闭简单极限 在启用极限线时，此前使用的任何极限模板都会被禁用。

1 按下 Level > Limits Memory。

2 按下 Simple Limits 软键，将新的选择 （启用或者关闭）高亮显示。
在启用极限时，红色的水平线将会显示标示上限和下限的水平线。每
显示一条新的测量曲线，屏幕左上角都会显示一个 Pass/Fail （不超出
/ 超出）标示。结论 (" 简单极限 ") 上的文本显示了结论适合简单极限。
在关闭极限时，极限线和标示将会消失。

定义上限和下限 只有在启用简单极限时，才可以修改极限。输入值的有效范围取决于屏
幕显示的功率刻度 （纵轴），如下表所示：

表 13 简单上限 / 下限的有效输入范围 （相对于参考电平）

刻度 有效范围

1 dB/ 分度 –8 … 0 dB

3 dB/ 分度 –24 … 0 dB

5 dB/ 分度 –40 … 0 dB

10 dB/ 分度 –80 … 0 dB

15 dB/ 分度 –120 … 0 dB

20 dB/ 分度 –160 … 0 dB
32 9102 手持式频谱分析仪 4.00 版本



第二章 一般性操作
使用极限线
请按照以下步骤，定义上限和下限：

1 按下 Level > Limits Memory。

2 按下 Upper 软键，输入一个新的上限值 （单位为 dB，相对于参考电
平），或者利用 UP/DOWN 光标键移动上限，再利用 MHz/dB/us或者
ENTER 确认。
上限线将移动到新的上限值。

3 按下 LOWER 软键，输入一个新的下限值（单位为 dB，相对于参考电
平），或者利用 UP/DOWN 光标键移动下限，再利用 MHz/dB/us或者
ENTER 确认。
下限线将移动到新的下限值。

使用极限模板 您可以方便地在一个基于 PC 的工具中定义极限值，再将其输入到 9102。
请参考 "9100 数据交换软件 " 第 201 页中的详细说明。下面将介绍怎样
调用、删除、启用和禁用极限模板。

在 9102 中选择极限线 1 从主菜单中选择 Level > Limits Memory。
屏幕将显示 Limits Memory 菜单。

2 按下 Recall Limit Template 软键。
屏幕将显示一个输入栏和一个文件选择对话框。

3 利用 UP/DOWN 光标键将光标移动到所要选择的文件的名称，或者在
输入栏中输入相应的文件名，再按下 ENTER 关闭输入栏。
所选择的极限文件将会被载入，上限 / 下限也将立即启用。

启用和禁用极限模板 1 选择一个极限文件 （参见 " 在 9102 中选择极限线 " 一节）

2 选择 Level > Limits Evaluation。
屏幕将显示 Limits Evaluation 菜单。

3 通过从选项 Off, Upper/Lower, Upper Limit,Lower Limit 中按下相应的软
键，选择极限选项。如果您选择 Off，将不会显示任何极限线。否则，
屏幕上将会显示您所选择的极限线（上限和 / 或下限）。每条测量曲
线在屏幕右上角都会显示一个 Pass/Fail （不超出 / 超出）标示。

删除 9102 中的极限文件 1 从主菜单中选择 Level > Limits Memory。

2 a. 要删除某一个文件，按下 Delete Limit Template，利用 UP/DOWN 光标
键选中一个极限文件，按下 ENTER 删除该文件（在文件被删除之前，
按下 ESC 可以撤销删除）。

b. 要删除 9102 中保存的所有极限文件，按下 Delete All Templates。如
果您的确希望删除所有极限文件，按下 ENTER 确认删除。
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记录超出极限次数 在启用极限检查时，可以使用一个极限超出计数器。超出极限的次数会
显示在超出 / 不超出标示的下方。该计数器可以用于统计评估。在这种
应用中，必须定义测量次数。下面的操作有助于获得与指定的测量曲线
个数相关联的极限超出次数：

1 选了有限的曲线个数（Freq > Sweep，请参阅 " 进行有限次数的测量 "
第 68 页）

2 从主菜单中选择 Level > Limits Evaluation > Fail Count，启用极限超出计
数器；如果已经启用，应当将其关闭再重新打开。 极限超出计数器将
被重置到 0。

3 按下 HOLD/RUN 软键，开始测量。 
测量计数器和极限超出计数器都将从 0 开始计数。在达到选定的曲线
个数时，测量将会中止，这时您可以读取极限超出计数值。

重置计数器 通过将极限超出计数器关闭再重新打开（在 Level > Limits Evaluation 菜单
中），可以重置用于极限检查的极限超出计数器。

在超出极限之后发出一次
嘟嘟声

1 从主菜单中选择 Level > Limits Evaluation。
屏幕将显示 Limits Evaluation 菜单。

2 按下 Fail Beep 软键，启用或者禁用计数器报警功能：如果启用，每次
当测量信号超过极限时， 9102 都会发出一次嘟嘟声。

查看超出极限的测量值 如果您希望中止测量，查看超出极限的测量信号，这项功能将会非常有
用。请注意，此时 9102 应当设为连续测量。

1 从主菜单中选择 Level > Limits Evaluation。

2 按下一次或者两次 Fail Hold 软键，启用或者禁用超出暂停功能。
测量会在发生超出极限情况时暂停。超出极限的测量信号曲线将会在
屏幕上持续显示。

您还可以在 9102 中保存和调用测量信号，以便在以后进行分析和对比。
请参阅 " 保存和载入曲线 " 第 66 页。

利用 9100 数据交换软件，可以将测量曲线发送到 PC 上，在 PC 上进行保
存和查看。如需了解更多细节，请参阅 "9100 数据交换软件 " 第 201 页。
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打印

9102 提供了直接从仪器打印测量结果（例如曲线）的功能。要在联机打
印机上打印屏幕显示的测量结果，只需按下 9102 前面板上的数字键盘中
的±键。

如需了解关于 9102 所支持的打印机和如何配置一台打印机，请参阅 " 设
置一台打印机 " 第 44 页。

从一台 PC 控制 9102
您可以从一台 PC 对 9102 进行远程控制。 PC 和 9102 之间的接口可以使
用串行接口 (RS-232) 和 LAN(TCP/IP)。请参阅 "SCPI 命令参考 " 第 201 页，
了解关于远程控制的详细信息。

从远程控制恢复到本地模式

要在远程控制之后恢复对 9102 的手动控制，请按下 ESCAPE.

检查一般性设置

本节将介绍关于仪器参数，设置显示窗口亮度，时间和日期，以及配置
9102 远程控制接口的信息。

读取序列号 您可以通过以下操作获取您的 9102 的序列号：

1 按下 MODE 功能键。

2 选择 System。
屏幕将显示 System Information（如图 8 所示），包括序列号、已装软
件版本和已装选件。

注

如果在您按下±键时，屏幕上显示了一个输入栏，那么±输入将应通
过该输入栏完成。在这种情况下，打印功能将无法使用。要进行打印，
必须先通过取消选中相应软键，关闭输入栏。
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读取软件版本号 在安装一个新的软件版本或者报告问题之前，您可能需要查看目前安装
的软件版本。

1 按下 Mode 功能键，再按下 System 软键。
屏幕将显示 System Information 菜单。

2 读取和记录在 Application 栏中显示的软件版本号。

检查校准 与所有测试仪器一样，您应当检查 9102 的准确度是否符合它的技术规
格。这个过程被称为校准。如果 9102 的准确度超出了指定的容忍度，就
必须对该仪器进行校准。

Willtek建议每年对9102进行一次校准。9102保存了此前由一个经过Willtek
认证的实验室进行的校准的数据，以及下次进行校准的日期。另外，您
可以记录上次查看校准日期的时间。

要检查 9102 是否需要校准，请执行以下操作：

按下 Mode 功能键，再按下 Calibration Information 软键。

图 8 System Information 菜单
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1 菜单中显示了详细的仪器校准信息。
Calibration Number 部分显示了校准次数。
Calibration 部分的第一行表示最近一次校准 9102 的日期和机构。
第二行表示最近一次查看校准信息的时间和人员姓名。
第三行表示下一次校准的预定日期。这个日期通常是在最近一次校准
的一年之后。

2 按下 Date Last Check 软键，修改最近一次检查的日期。它将设为当前
日期 （由内置的实时时钟设定）。

3 按下 Name Last Check 软键，输入最近一次检查的人员的姓名。

查看已装选件 Willtek 为 9102 手持式频谱分析仪提供了多种应用软件和选件。您的仪器
可能选用了其中的部分产品。要查看您的 9102 上实际安装的选件，请执
行以下操作：

1 按下 Mode 功能键，再按下 System 软键。
屏幕将显示 System Information 菜单。

2 选择 Options。

屏幕将显示 Options 菜单，已装选件将以粗体显示，并且前面标有一
个记号；没有安装的选件将以灰色显示。

图 9 Calibration Information 菜单
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安装一个新的选件 您可以通过输入一个启用密码，安装软件选件。您可以从 Willtek 公司或
者它的销售代表购买启用密码。要安装一个新的选件，请执行以下操作：

1 按下 Mode 功能键，再按下 System 软键。
屏幕将显示 System Information 菜单。

2 选择 Options，按下 Activate Options。

3 输入启用密码，相应选件将以粗体显示，并且前面标有一个记号。这
表示该选件现在已经可以使用。

调节显示窗口亮度 1 按下 Mode 功能键。

2 选择 System > Settings。
屏幕将显示一般性设置菜单 （如图 10 所示）。当前显示窗口背光设
置以百分比表示。

3 按下 Display Extern 软键，调节在 9102 连接到某个外置电源时使用的
背光设置。
按下 Display Battery 软键，调节 9102 使用电池供电时的背光设置。这
里，您可以为电池供电状态设置一个较低的背光值，以便节约电能。

在这两种情况下，背光输入栏都将高亮显示。

4 在您想要修改的背光设置栏中输入一个新的值，按下 ENTER 确认。或
者利用 UP/DOWN 光标键更改当前值。

9102 显示窗口这时会启用新的亮度值。 

图 10 一般性设置菜单
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启用和禁用嘟嘟声 在 General Settings 菜单中 , 可以禁用和启用用于提示警告和错误的嘟嘟
声。

1 按下 Mode 功能键。

2 选择 System > Settings。
屏幕将显示一般性设置菜单，其中显示了嘟嘟声的当前设置（启用或
者禁用）。

3 多次按下 Beep 软键，直到需要的设置被高亮显示（启用或者禁用）。
嘟嘟声输入栏将显示当前设置。

为仪器设置一个设备名称 如果您拥有多台 9102 手持式频谱分析仪，就需要为每台 9102 设置一个
设备名称。如果您为它们使用了不同的名称，就可以方便地加以识别。
设备名称还会显示在通过 9100 数据交换软件发送到 PC 的曲线上。

要输入一个新的名称，请执行以下操作：

1 按下 Mode 功能键。

2 选择 System > Settings。
屏幕将显示一般性设置菜单，其中当前的设备名称。

3 按下 Device Name 软键。
设备名称输入栏将启用，以便修改当前名称。

4 输入一个新的名称 （最长 11 个字符；请参阅 " 填写文字输入栏 " 第
25 页，了解具体操作），再通过按下 Enter 关闭输入栏。
新的名称将显示在设备名称栏中。

注

调节亮度的显示窗口设置不会受到 Preset 功能键的影响，但是如果您
按下 Back To Defaults 软键，显示窗口设置将会恢复到缺省值。

注

这项参数不会受到 Preset 功能键的影响，但是如果您按下 Back To
Defaults 软键，设置将会恢复到缺省值。

注

这项参数不会受到 Preset 功能键的影响，但是如果您按下 Back To
Defaults 软键，设置将会恢复到缺省值。
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调节仪器的日期和时间 9102 手持式频谱分析仪配有一个实时时钟。它可以被用于显示实际的日
期和时间，或者比较预定的下一次校正日期。

要调节日期和时间，请执行以下操作：

1 按下 Mode 功能键。

2 选择 System > Settings>Time/Date。
屏幕将显示时间 / 日期菜单，指明当前的日期和时间。

3 按下 Time 软键。
时间输入栏将启用。您可以利用 Left/right光标键将光标移动到需要调
节的数字之后，按下 Backspace 键删除该数字，再输入一个新的数字。

4 按下 Date 软键。
日期输入栏将启用。您可以用一个新的日期改写原有日期，或者利用
Left/right 光标键将光标移动到需要调节的数字之后，按下 Backspace
键删除该数字，再输入一个新的数字。

5 按下 Enter 或者其他功能键确认输入信息。新的日期和时间将显示在
Time/Date 菜单中。

图 11 时间 / 日期菜单

注

这项参数不会受到 Preset 功能键的影响，但是如果您按下 Back To
Defaults 软键，设置将会恢复到缺省值。
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调节 RS-232 端口的波特
率

按下 Mode 功能键。选择 System > I/O Config > RS 232 Config。
屏幕将显示 RS 232 Config 菜单（如图 12 所示），指明当前使用的 RS-232
比特率 （即波特率）和接口设置。

1 要调节数据传输速率，按下 Baudrate 软键，利用 Up/down 光标键选择
一个新的速率。
改动将会立即生效。

注

这项参数不会受到 Preset 功能键的影响，但是如果您按下 Back To
Defaults 软键，设置将会恢复到缺省值。

图 12 RS 232 Configuration 菜单
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修改 9102 的 IP 地址 IP 地址应当根据您的系统环境所用的地址空间进行修改。网络上的每个
设备都应当具有一个独一无二的 IP 地址。

1 按下 Mode 功能键。

2 选择 System > I/O Config
屏幕将显示 TCP/IP Config 菜单，指明当前使用的 TCP/IP 设置。

3 要修改 9102 的 IP 地址，请按下 Target IP 软键。地址栏将会高亮显示。

4 改写整个 IP 地址，或者利用 Left/right 光标键选择一个输入栏，输入
一个新的 IP 地址，再按 Enter 确认。

5 要修改子网掩码，请按下 Subnet Mask 软键。Subnet Mask 栏将高亮显
示。

6 改写整个子网掩码，或者利用 Left/right 光标键选择一个输入栏，输入
一个新的子网掩码，再按 Enter 确认。

7 要修改网关地址，请按下 Gateway 软键。 Gateway 栏将高亮显示。

8 改写整个网关地址，或者利用 Left/right 光标键选择一个输入栏，输入
一个新的网关地址，再按 Enter 确认。

9 要使改动生效，您需要关闭 9102，再重新打开。

10 确保您的 PC 应用可以利用这个 IP 地址找到 9102，以便双方可以互相
通信。

图 13 TCP/IP Configuration 菜单
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修改 PC 的 IP 地址 为了从 PC 对 9102 手持式频谱分析仪进行远程控制，可以在仪器上输入
PC 的 IP 地址。

1 按下 Mode 功能键。

2 选择 System > I/O Config
屏幕将显示 TCP/IP Config 菜单（如图 13 所示），指明当前使用的 TCP/
IP 设置。

3 要修改 9102 的 IP 地址，请按下 Host IP 软键。地址栏将会高亮显示。

4 改写整个 IP 地址，或者利用 Left/right 光标键选择一个输入栏，输入
一个新的 IP 地址，再按 Enter 确认。

5 要让新的设置生效，需要重启 9102 （这意味着关闭 9102 再打开）

修改 9102 使用的 IP 端口 在需要从 PC 对 9102 手持式频谱分析仪进行远程控制时，PC 利用利用一
个端口号与 9102 中的远程控制应用通信。在缺省情况下，9102 使用的端
口号为 49200。您可以方便地修改端口号，具体操作如下所示：

1 按下 Mode 功能键。

2 选择 System > I/O Config
屏幕将显示 TCP/IP Config 菜单，指明当前使用的 TCP/IP 设置。

3 要修改 9102 的 IP 端口，请按下 Port 软键。地址栏将会高亮显示。

4 改写整个 IP 地址，或者利用 Left/right 光标键选择一个输入栏，输入
一个新的 IP 地址，再按 Enter 确认。

5 要让新的设置生效，需要重启 9102 （这意味着关闭 9102 再打开）。

Back to Default 软键可以将参数恢复到缺省值。
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检查一般性设置
设置一台打印机 您可以通过 9102 前面板上的±键，连接一台打印机进行直接打印。

1 按下 Mode 功能键。

2 选择 System > I/O Config > Printer Config
屏幕将显示打印机设置。

3 要设置一台联机PCL 5打印机进行直接打印，请按下Printer Type软键，
将其切换到 PCL。
方法是多次按该软键，直到这个选项高亮显示。

4 要设定打印机的波特率，请按下 Printer Baudrate 软键。Printer Rate 输
入栏将高亮显示。缺省波特率为 19200。 

图 14 打印机设置菜单

注

直接打印需要使用内置驱动程序的PCL 5打印机。不支持纯GDI打印机。
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检查一般性设置
选择用户窗口颜色 您可以在 Color Scheme 菜单中修改部分用户窗口元素的颜色。显示窗口
顶部的调色板中显示了可选的颜色，如表 14 所示：

要修改曲线、网格和极限线的颜色，请执行以下操作：

1 按下 Mode 功能键。

2 选择 System > Color Scheme
屏幕将显示 Color Scheme 菜单 （如图 13 所示），指明当前使用的颜
色设置。

3 要修改某个用户窗口元素的颜色，请按下相应的软键（曲线 A、曲线
B、网格、极限或者曲线偏移颜色）。
左侧的输入栏将启用。

表 14 9102 用户窗口的调色板

颜色编号 颜色

1 黑色

2 灰色

3 蓝色

4 绿色

5 紫色

6 黄色

7 红色

8 褐色

图 15 Color Scheme 菜单
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4 要选择一个新颜色，请输入一个与调色板中的颜色相对应的编号，按
下 Enter 确认。或者利用 Up/down 光标键修改颜色。
输入栏左侧的颜色栏会随着所选颜色的变化而变化。

5 按下 Last Mode 软键，回到测量窗口。
新的颜色方案将会立即生效。

使用过去保存的设置

9102 手持式频谱分析仪提供了存储某个特殊测量任务的所有参数的功
能，让您可以在需要在相同条件下重复该任务时随时调用这些参数，其
中也包括测量模式。大部分参数组合都可以保存为不同的名称，让您可
以迅速地、方便地加以识别；每个参数组合名称最长不能超过 11 个字
符。

除了在同一台 9102 上使用这些参数组合文件以外，您还可以将它们发送
到 PC 进行备份，利用一个标准的文本编辑器加以修改，或者在多台 9102
仪器上使用相同的参数。" 使用设置 " 第 225 页和 " 管理 PC 和 9102 上的
文件 " 第 226 页将会更加详细地介绍这些功能。

在 9102 上保存设置 要在 9102 上保存当前设置，请执行以下操作：

1 按下 RCL/STORE 功能键。
屏幕将显示 Trace Memory 菜单。

2 选择 Settings 软键。
屏幕将显示 Settings Memory 菜单。

3 按下 Store Settings。
显示一个输入栏 （如图 16 所示）。
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4 输入一个不超过 11 个字符的新文件名，按下 Enter 确认。这样，当前
参数设置就保存在该设置文件中，可以随时调用。

使用以前保存的设置 您可以通过调用设置文件，使用以前存储在 9102 内存中的设置。

1 按下 RCL/Store 功能键。
屏幕将显示 Trace Memory 菜单。

2 选择 Settings 软键。
屏幕将显示 Settings Memory 菜单。

3 按下 Recall Settings。
显示一个输入栏和文件选择对话框。

4 利用 Up/down 光标键选择需要的设置文件，或者输入一个已有文件
名，按下 Enter 确认。当前参数设置将被该设置文件中的设置所覆盖，
9102 将采用该文件中保存的测量模式和参数。

图 16 Recall Settings 菜单
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将所有模式恢复到出厂设置

除了可以将当前选择的模式恢复到出厂设置的 Preset 功能键 （请参阅 "
使用前面板 " 第 15 页）以外，9102 的 Mode 菜单还提供了 Factory Settings
功能。该功能可以将所有模式恢复到出厂设置，并让您返回到频谱分析
模式。要将所有模式恢复到出厂设置，请执行以下操作：

1 按下 Mode 功能键。
屏幕显示 Mode 菜单。

2 按下 Factory Settings 软键。显示 Factory Settings 菜单。

3 按下 Preset All 软键。屏幕将会显示一个提示信息，请您确认是否需要
重置所有模式。

4 按下 Enter 确认。这时，所有模式都将恢复到出厂设置。
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Chapter 4 频谱分析操作
3

本章将介绍频谱分析模式所特有的一些仪器功能。本章所要讨论的主题
包括：

－ " 选择测量模式 " 第 50 页

－ " 修改频率设置 " 第 50 页

－ " 选择 RBW、 VBW 和 SWT" 第 53 页

－ " 设置电平参数 " 第 53 页

－ " 调节输入阻抗 " 第 56 页

－ " 对信号执行特殊功能 " 第 57 页

－ " 设置曲线 " 第 60 页

－ " 保存和载入曲线 " 第 66 页

－ " 特殊测量功能 " 第 68 页

－ " 查看频谱分析模式参数 " 第 72 页
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选择测量模式
选择测量模式

要选择频谱分析模式，请执行以下操作：

1 按下 Mode 功能键。
屏幕将显示 Mode 菜单。

2 选择 Spectrum Analysis。
屏幕将显示 Spectrum Analysiss 主菜单。

修改频率设置

您可以通过多种方式设置需要测量的频率范围；频率范围可以利用起始
频率和截止频率（例如显示窗口上的第一个和最后一个频率）表示，或
者利用中心频率和跨度（例如中心和频率范围）表示，或者利用中心频
率、跨度、起始频率和截止频率的其他组合表示。

所有四个参数都可以通过 Freq 菜单查看。但是在主菜单中，只会显示上
述组合中的一种，具体选择哪一种取决于最后输入的参数。

图 17 频率菜单

注

修改一个频率参数可能会影响到相关的参数。例如：如果您将频率跨
度修改为 4GHz，那么起始频率和截止频率将会分别变为 0 和 4GHz。
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设置起始频率和截止频率 1 按下 Cent 功能键 （或者主菜单上的 Freq 软键）。
垂直软键包括 Start 和 Stop 软键。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

4 按下一个单位 (GHz 或者 MHz) 键确认，完成输入。如果输入的起始频
率低于截止频率，那么横轴将显示起始频率到截止频率的范围。如果
新的起始频率高于或者等于截止频率，开始频率将被用作零跨度的中
心频率，例如所选频率的信号将在时域显示。

5 按下 Stop 软键，输入显示窗口右端的频率。

您也可以通过修改频率模式，将用于设置起始频率和截止频率的软键放
在主菜单中，详见第 51 页。

设置中心频率和跨度 1 按下 CENT 功能键 （或者主菜单上的 Freq 软键）。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 Up/down 光标键的步进宽度。

2 利用数字键、光标键和 Backspace 键输入一个新的频率。

3 按下一个单位 (GHz 或者 MHz) 键确认，完成输入。

4 按下 Span 软键，输入从显示窗口左端到右端的频率范围。

您也可以通过修改频率模式，将用于设置中心频率和跨度的软键放在主
菜单中，详见下面的 " 修改主菜单中显示的频率参数 "。

修改主菜单中显示的频率
参数

主菜单会显示两个用以定义显示窗口的频率范围的软键。如前所述，可
以通过不同的方式定义频率范围；您可以将这两个软键设为两个可选组
合中的一种，方法为：

1 从主菜单中，选择 Freq > Freq Mode。

2 选择您希望在主菜单中看到的软键组合 (Start/Stop 或者 Center/Span)。

3 按下 Main... 软键，回到主菜单。

4 屏幕将显示主菜单，以及所选的软键组合。

请注意，频率横轴的说明会随着所选参数组合的改变而改变。
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修改频率设置
查看完整的频段 要将频率范围改为 9102 支持的全部带宽，请执行以下操作：

1 从主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Full Span 软键。

最左端的频率将变为 0，最右端的频率将变为 4GHz。

在时域进行测量 某个选定中心频率上的测量结果也可以在时域显示。

1 从主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Center 软键，输入需要的中心频率；通过选择确认键中的适当单
位，关闭输入栏。

3 按下 Zero Span 软键。

横轴将变为时间轴。刻度宽度与扫描时间一致。请参阅第 58 页图 18 所
提供的例子。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键 (UP/DOWN) 增大或者减小当前设置。光标键的按键
步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 从主菜单中，选择 Freq。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。

3 输入一个新的频率值，按下 ENTER 关闭输入栏。
自动 / 手动选择切换到手动方式，所选的频率步进宽度将显示在软键
上。

将频率步进宽度选择方式设为自动

1 从主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 "auto" 选项高亮显示。
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选择 RBW、 VBW 和 SWT

分辨率带宽 (RBW) 指的是 IF 滤波器用于选择待测信号的 3dB 带宽。分辨
率带宽可以表明频谱分析仪区分具有类似幅值的相邻信号的能力。只有
间隔频率超过 RBW 的信号才能彼此区分。

通过设置， 9102 可以根据频率跨度自动选择分辨率带宽。

帯视频 宽 (VBW) 指的是低通带宽，自此之上的频率点的多个测量结果将
会被平滑处理。视频带宽越低，信号曲线越平滑，变化越少。

通过设置， 9102 可以自动根据分辨率带宽选择视频带宽。

扫描时间 (SWT) 可以确定在所测量的频率范围 （即跨度）上进行一次完
整扫描所用的时间。

通过设置， 9102 可以自动根据 RBW 和 VBW 选择扫描时间。如果选择手
动设置，那么扫描时间应当长到足以让滤波后的信号达到稳定状态。如
果扫描时间过短 , 9102 将会输出一个 "UNCALibrated" 警告。

要设置分辨率带宽、视频带宽或者扫描时间，请执行以下操作：

1 在主菜单中选择相应的软键 (RBW、 VBW 或者 SWT)。

2 输入数值，利用相关单位所对应的确认键完成输入。利用 Up/down 光
标键输入一个新的值，或者切换到 auto 模式，由 9102 自动进行设置。

在自动和手动模式之间切换

多次按下相应的软键 (RBW、 VBW 或者 SWT)，直到所要选择的模式（自
动或者手动）高亮显示。

设置电平参数

测量信号与背景噪声之间的准确度和动态范围取决于正确的电平设置。
这包括参考电平和衰减值的设置。

参考电平将决定显示窗口顶部的电平。纵轴分为八条竖线；您可以根据
需要调节刻度 （缺省值为每条线 10dB）。

衰减值设置可以在参考电平设置之后自动进行。对于不超过 -20dBm 的
参考电平，衰减值被设为 10dB ；最大衰减值为 50dB。
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因为外部耦合而产生的衰减或者增益可以通过随频率变化的耦合系数加
以补偿，以便让屏幕显示的测量值真实地反映被测设备的功率电平。

设置参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 Ref 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏 ; 或
者利用 Up/down 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

设置硬件衰减值 1 在主菜单中，按下 Attenuation 软键。
屏幕将显示 Attenuation 输入栏。

2 输入一个介于 0 到 50dB 之间（步进值为 10dB）的新衰减值，通过一
个确认键关闭输入栏；或者利用 Up/down 光标键选择一个介于 10 到
50dB 之间的衰减值。

觤如果衰减值被修改，衰减选项将变为 anual"。

修改纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 Enter
或者 MHz/dB/µs 键确认，或者用 Up/down 光标键选择。

警告

RF in 接口的最高输入功率为 30dBm (1 瓦 )。更高的输入功率可能会导
致本仪器严重受损。

注

0dB 衰减值只能通过数字键设置，以避免意外禁用。应当慎用 0dB 设
置，因为过高的输入功率可能会导致仪器受损。

注

在需要精确测量时，输入功率减去衰减值的差值应当不超过 -23dBm。
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为输入和输出选择电平单
位

1 在主菜单中选择 Level>Units。

2 您可以使用对数或者线性单位。要在对数和线性单位之间切换，请按
下屏幕右下角的 Unit 软件，选择 log 或者 lin。

3 您现在可以通过屏幕右下角的 Unit 软键，选择下列单位：

对数单位：dBm, dBµV, dBmV 和 dBV

线性单位：V, mV, µV, mW 和 µW

补偿增益和损耗 如果被测设备通过一个放大器或者会导致信号衰减的设备（例如天线或
者长线）连接到 9102 手持式频谱分析仪，那么测量结果会受到增益或者
损耗因数的影响。这个因数可能是固定值，也可能会随频率变化而变
化。

为了获得正确的测量结果，可以补偿增益或者损耗。9102 甚至还可以补
偿一个随频率变化的因数；您可以利用9100数据交换软件在一台外部PC
上输入一个纠正曲线或者表，再将其发送到 9102。 " 定义和载入外部耦
合参数 " 第 217 页部分将详细介绍这项功能。

启用外部设备补偿 一旦在 9102 中保存了纠正值，就可以通过以下操作选择和启用它们：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 按下 Recall Ext. Dev. Comp。
屏幕显示一个下拉菜单，列出 9102 上现有的补偿表的名称。

3 利用 Up/down 光标键选择一个补偿表，再通过按下 Enter 确认您的选
择。
这时补偿尚未启用，但是 9102 会自动显示 Level 菜单。

4 按下 Ext. Dev. Comp. 软键，直到 "on” 高亮显示。
文字 ”Ext.Dev.” 和所载入的文件名将显示在测量结果的左上角。

关闭外部设备补偿 1 从主菜单中选择 Level。

2 按下 Ext. Dev. Comp. 软键，直到 off 高亮显示。
测量结果左侧的文字 ”Ext.Dev.” 将会消失。

注

如果某个文件过去曾经被选用过，那么第一步到第三步可以略过。这
时，可以选择 Level，直接进入第四步。
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删除用于外部设备补偿的文件 要删除包含补偿参数的文件，请执行以下操作：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 a. 要从 9102 内存中删除某个补偿文件，请按下 Delete Ext. Dev. Comp。
选择一个文件名，再按 Enter 确认。
补偿文件将从列表中删除。请注意，删除时将不会弹出警报；如果您
选中一个文件并要求将其删除，该文件将会被立即删除。

b. 要删除 9102 中的所有补偿文件，按下 Delete All，再按 Enter 确认。
所有补偿文件都将被删除。

调节输入阻抗

大部分RF应用都配有一个 50欧姆的阻抗；其他应用（例如有线电视）则
使用 75 欧姆阻抗。9102 的输入阻抗为 50 欧姆，但是它可以利用软件阻
抗开关测试一个配有 75 欧姆阻抗的设备。 50 欧姆输入的测量结果会被
重新计算，以匹配不同的阻抗。

在 9102 上，您只需选择正确的阻抗值，9102 就可以自动地将内部测量值
转换为耦合器之前的功率。

1 将被测设备连接到 9102 手持式频谱分析仪。

2 从主菜单中选择 Level。

3 在垂直菜单中，选择设备阻抗，即选择 Impedance:50Ω或者 Impedance:
75Ω。
新的测量结果已经考虑到了新的阻抗值。另外，如果阻抗改为 75 欧
姆，而功率的显示单位为 dBm，那么新的测量值将以 dBµV 为单位显
示。如果阻抗改为 50 欧姆，而功率的显示单位为 dBµV，那么新的测
量值将以 dBm 为单位显示。

注

50 欧姆和 75 欧姆设备之间的连线上的信号反射会影响 9102 手持式频
谱分析仪的测量精度。为了获得更加准确的测量结果， Willtek 建议使
用一个阻抗转换器；例如一个可以对测量结果产生衰减作用的转换
器。9102 可以对这种衰减进行补偿，详见 " 补偿增益和损耗 " 第 55 页
部分。
56 9102 手持式频谱分析仪 4.00 版本



第三章  频谱分析操作
对信号执行特殊功能
对信号执行特殊功能

本节将介绍怎样触发测量，怎样限制测量次数，以及怎样收听解调信号
的声音。

使用触发器 9102 可以在某个随机的时刻开始信号分析，或者在信号超过某个指定的
门限值时开始测量。根据实际信号电平启动测量的功能只限于零跨度模
式。

选择无需触发的信号分析：

1 从主菜单中按下 Freq > Trigger。
屏幕显示 Trigger 菜单。

2 按下 Free Run 软键。
该软键将高亮显示， 9102 准备好在随机时刻开始测量。

选择一个 RF 信号的触发器门限值

1 从主菜单中按下 Freq > Trigger。
屏幕显示 Trigger 菜单。

2 按下 Video 软键。
Video 软键将高亮显示，弹出一个用以输入触发器电平的输入栏。

3 输入触发器电平 （单位为 dBm），通过按下 GHz/dBm 或者 Enter 键完
成输入。
触发器门限值显示在功率轴上；该符号还会表示方向（即信号超越门
限值启动测量的方向）。

4 如有必要，可以通过按下 Slope 软键，在正、反方向之间切换。
方向激活符号将显示在功率轴上（另见图 18） : 

注

Video 触发器只适用于零跨度模式。在其他模式下，该软键的说明将以
灰色显示。
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.

使用外部触发器

要使用外部设备生成的触发信号，请执行以下操作：

1 将外部设备连接到位于仪器顶部的 Ext. Trig. 接口。

2 在主菜单中，通过按下 Freq>Trigger 进入 Sweep 菜单。
屏幕将显示 Trigger 菜单。

3 按下 Extern 软键。
该软键将高亮显示。
在启用外部触发器之后， 9102 将会等待接收一个脉冲。一旦 9102 在
外部触发器入口检测到一个脉冲，就会进行一次扫描。此后 9102 将
急需等待下一次触发事件。

进行有限次数的测量 9102 可以连续进行测量，也可以限定测量次数。限制测量次数可能有助
于统计分析。

1 从主菜单中选择 Freq>Sweep。
屏幕将显示 Sweep 菜单。

2 选择触发器模式：如需连续测量，按下 Cont. ；如需进行有限次数的
测量，按下 Single。
所选触发器模式将高亮显示。

3 要输入测量次数，请按下 Single Count 软键，输入一个介于 1 到 1000
之间的数值，按下 Enter。
如果触发器模式设为 Single, 9102将会执行指定次数的测量，而后进入
Hold （保持）模式。

图 18 触发测量（时域）
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－要重启 Single 模式测量，请按下 Hold/run 功能键或者 Single 软键。

－要中止连续测量，请按下 Hold/run 功能键。再按一次可以恢复测量。

解调一个 AM 或者 FM 信
号

9102 可以解调一个 AM( 调幅 ) 或者 FM( 调频 ) 信号，通过内置扬声器输
出信号。信号的强度应当不少于 -50dBm ；解调带宽约为 10kHz。

通过设置，9102 可以用同不变频率解调一个信号，或者在不同频率之间
切换。在设为用不变频率解调一个信号时，9102 会在中心位置解调该信
号。

当 9102 被设为在不同频率间切换时，它可以使用标记频率 （如果此前
没有被激活，标记 M1 将被启用）。在进行并显示了一次新的测量之后，
9102 会在一段较短的时间内解调和输出所受到的信号。这段时间的长度
可以在 100 毫秒到 10 秒之间选择。9102 可以在标记位置解调载波；解调
后的信号会在选定的时段内输出。如果启用了一个以上的标记，解调将
会在下一个标记频率恢复，直到所有激活标记处的信号都被解调。这个
过程会在进行一次新测量任务时重新开始。

扬声器音量可以设为扬声器最大音量的一定比例。

1 在需要解调的信号的中心频率设置一个标记（参见 " 设置曲线 " 第 60
页部分）。

2 从主菜单中选择 Freq>Demod。
屏幕显示解调菜单。

3 选择解调模式 (AM,FM 或者 Off)。
所选模式将高亮显示。

4 通过按下相应的Demod软键，在多个标记选择用相同频率解调和间歇
性解调。

5 如果选择在某个标记频率进行解调，您可以修改输出解调信号的持续
时间：
按下 Duration 软键。
屏幕将显示 Demod Duration 输入栏。
利用数字键输入新的持续时间。通过按下一个与相应单位关联的确认
键完成输入：如果单位为毫秒，按下 kHz/dBµV/ms ；如果单位为秒，
按下 Enter。

6 要调节扬声器音量，请按下 Volume 软键。输入一个介于 0 到 100% 之
间的新音量比例，再按下 Enter 确认。
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设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据 （请参阅 " 保存和载入曲线 " 第 66 页）。

9102 会为每个频率点测量多个采样值。利用检波器功能，您可以定义用
以选择所显示的采样值的方法。

选择曲线模式 9102 提供了五种曲线显示模式：

－ 在实际值模式下，9102 在每条曲线中显示一个全新的测量结果。后续

曲线彼此无关。

－ 在保持模式下，最近一次的测量结果将显示在屏幕上；测量仍然在继
续，但是不会在屏幕上显示。

－ 在最大值保持模式下，9102 会进行新的测量。对于每个频率点，9102
会将新的测量结果与以前的结果进行比较。如果新的测量值大于以前
的测量结果，新的测量值将会称为新的测量结果；否则原有的测量结
果将保持不变。这样，从启用 Max Hold （最大值保持）模式 （或者

修改某个参数）以来的最大测量结果将会被保存并显示。

图 19 两条曲线示例
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－ 与之类似，在最小值保持模式下，9102 会进行新的测量，并将新的测

量结果与以前的结果进行比较。如果新的测量值小于以前的测量结
果，新的测量值将会称为新的测量结果；否则原有的测量结果将保持
不变。这样，从启用 Min Hold （最小值保持）模式 （或者修改某个

参数）以来的最小测量结果将会被保存并显示。

－ 在均值模式下，每个频率点将显示新的测量值和以前的测量值的平均
值。 9102 为平均计算使用了一种递归算法。

如果您想要查看实际测量值，中止并保持最近一次的测量结果，查看每
个频率的最小、最大数据或者平均值，请执行以下操作：

1 在主菜单中选择 Trace。

2 利用水平软键选择您想要修改的曲线 (Trace A 或者 Trace B)。

3 利用垂直软键选择曲线模式 (Actual, Hold, Max hold, Min hold, Average)。
曲线模式将显示在纵轴的左侧，例如 A (ACT)。

注

为了以最快的速度获得有效的结果， Willtek 建议您在选择其他任何模
式之前，先暂时启用实际值模式。

注

在曲线处于保持状态时，测量任务将继续进行，超出极限计数器也将
继续计数。如果启用了第二条曲线，那么第二条曲线也会继续更新。
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启用和关闭第二条曲线 您可以定义两个不同的曲线视图，例如一个显示实际值，另外一个显示
最大值。第一个视图 ( 曲线 A) 必须始终激活，但第二个视图可以关闭。
要启用或关闭曲线 B，以及选择曲线模式，请执行以下操作：

1 在主菜单中选择 Trace>Trace B。

2 要启用曲线 B，请选择曲线模式 (Actual, Hold, Max hold, Min hold 或者
Average)。要关闭曲线 B，请选择 Off。
在启用之后，曲线模式将显示在纵轴的左侧，例如 B(MAX)。

曲线 A 减去曲线 B 如前所述，如果您使用了两个不同的曲线视图，您可以通过用曲线 A 减
去曲线 B，显示曲线 A 和曲线 B 之间的差异。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Subtract A -B →
A。

2 选择 on，用曲线 A 减去曲线 B。在测量结果左侧将会显示 ”Subtract”，
表示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

注

如果曲线 A 处于保持状态，本功能将无法使用。Subtract A -B → A 软键
将会以灰色显示。
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曲线 B 加到曲线 A 如果您使用了两个不同的曲线视图，您还可以通过累加曲线 A和曲线 B，
显示这条曲线的总和。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Add A +B → A。

2 选择 on，用曲线 B 加到曲线 A。在测量结果左侧将会显示 ”Add”，表
示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

曲线偏移 一旦您使用了两个数学功能中的一个 --Subtract A -B → A 或者 Add A -B
→ A，曲线偏移功能将会启用。如果数学计算导致曲线移动到显示区域
之外，您可以利用该功能调节曲线的显示。为了将曲线重新移入显示区
域，可以利用 Trace Offset 软键调节偏移值，直到曲线回到显示区域。

图 20 启用 Subtract A-B → A
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定义用于计算均值的测量
次数

在曲线模式被设为计算均值时，可能需要 9102 用以计算均值的测量计
数。在曲线菜单中定义的平均次数值同样适用于两条曲线。

9102 采用了一种递归算法，即新的测量结果将通过一个加权因数加入原
有的平均值；下面将介绍怎样修改这个加权因数：

1 进入 Tace 菜单 （从主菜单选择 Trace > Trace A 或者 Trace B）。

2 按下 Average Count 软键。
屏幕显示 Average 输入栏。

3 输入用以计算均值的测量次数 （介于 2 到 128 之间）。

4 按下 Enter 确认。

选择检波方式 对于每个新的测量任务，9102 都要从每个频率值的多个测量值中选择一
个或者两个值。检波方式可由用户定义； 9102 提供了下列方式 （参见
图 21）：

－正 / 负峰值：最大值和最小值将被提取，并显示为一个竖条。

－正峰值：只显示最大值。

－负峰值：只显示最小值。

－采样：一个采样测量值将被提取。

－如果您在 9102 上安装并启用了 9132 RMS 检波器选件，您还可以使用

显示测量信号的 RMS 有效电平的均方根检波器。如果没有在您的仪

器上安装 9132 RMS 检波器选件， RMS 检波器将以灰色显示。

图 21 曲线检波方式
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检波方式适用于两条曲线。要选择检波方式，请执行以下操作：

1 从主菜单中，选择 Trace>Detect。

2 从垂直软键的 Detector 部分选择曲线检波方式。所选的曲线检波方式
将显示在屏幕左侧。

在 9102 中复制曲线 您可以将曲线 A 的实际测量值复制到曲线 B，反之亦然。这样，您可以
一边在屏幕上显示最新的测量结果，一边继续测量或者调节 9102 手持式
频谱分析仪的设置。目标曲线过去的测量结果将会被删除；目标曲线将
处于保持模式。

要将测量值从一条曲线复制到另外一条曲线，请执行以下操作：

从主菜单中，选择 Trace>Trace Function。

要将曲线 A 的测量值复制到曲线 B，按下 Copy A → B。
要将曲线 B 的测量值复制到曲线 A，按下 Copy B → A。

图 22 Trace Function 菜单

注

如果您先按下 Copy A → B，再按下 Copy B → A （或者相反顺序），两
条曲线将显示相同的测量结果，并且都将处于保持模式。
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保存和载入曲线

9102 提供了最多保存 99 条曲线，并随机载入这些曲线的功能。存储的
曲线可以在屏幕上显示，也与最近的测量结果进行比较。另外，存储的
曲线可以通过 9102 附带的 9100 数据交换软件发送到一台 PC 上。如需了
解该软件的详细信息，请参阅第 14 章 "9100 数据交换软件 "。

保存一条曲线 您可以保存曲线 A 或者曲线 B。任何曲线可以用一个不超过 11 个字符的
名称保存。关于在字母数字输入栏中输入文字的步骤，请参阅 " 输入数
字和文字 " 第 24 页。请注意，除了曲线以外，频率范围、电平范围和标
记等仪器设置也将被保存下来。

1 从主菜单中，选择 Trace > Trace Memory。

2 按下 Store Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入曲线名称。要使用某个修改的曲线名称，您可以利用 Up/down 光
标键将光标移动到相应的曲线名称。选中的曲线名称也将显示在输入
栏中；利用 Left/right光标键将光标移动到曲线名称中的相应位置，输
入额外字符或者删除已有字符。

4 按下 Enter 确认。
输入栏将关闭，曲线将以所选名称保存。

图 23 Trace A 菜单
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重复使用一个曲线名称 您不能用相同的曲线名称覆盖一个已有的曲线。如果您希望重复使用一
个曲线名称，您必须先删除原有曲线。

载入一条曲线 1 从主菜单中选择 Trace > Trace Memory。

2 按下 Recall Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入需要载入的曲线的名称，或者利用 Up/down 光标键选择一个名
称。

4 按下 Enter 确认。
输入栏将关闭，所选曲线将显示在屏幕上。

删除一条曲线 您可以删除过去保存的曲线。请注意，在您删除曲线时 9102 将不会发出
警报；如果您选中一个文件并要求将其删除，该文件将会被立即删除。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete Trace。
屏幕将会显示一个输入栏，请您输入需要删除的曲线的名称；以及一
个曲线选择对话框。

3 利用 Up/down 光标键选择需要删除的曲线。或者，利用数字键输入曲
线名称。

4 按下 Enter 确认。
所选文件将从曲线列表中删除。

5 选择另外一条需要删除的曲线。或者按下 Escapce，关闭输入栏和曲
线选择对话框。

删除所有曲线 除了单独删除各条曲线之外，您也可以一次性删除所有曲线。这个步骤
将要求您加以确认。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete All。
屏幕将显示一个提示，请您确认您的选择。

3 按下 Enter，删除所有曲线。
提示将消失。所有曲线均被删除。

注

除了曲线以外， 9102 还会载入曲线保存时使用的设置。它们将覆盖现
有设置，例如频率范围、参考电平和标记。
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保存和载入仪器设置 要保存或者载入仪器设置，包括频率范围、电平设置和标记等，请执行
" 保存一条曲线 " 和 " 载入一条曲线 " 部分所介绍的操作。

特殊测量功能

频谱分析模式支持三种不同的频率选择型功率测量方式：

－信道功率

－相邻信道功率比 (ACPR)

－占用带宽 (OBW)

它们类似于信道功率模式中的测量类型 ( 参见 " 信道功率 " 第 68 页），
但是没有信道功率模式对于预定义参数 (例如跨度和分辨带宽）的限制。

信道功率 这种测量功能可以测量所选信道的功率。一个信道由中心频率和信道宽
度 （并非跨度）所界定；请参阅 " 调节信道宽度 " 第 71 页。

9102 会在屏幕左上角显示信道功率测量的结果。测量带宽将会以图形方
式显示，其中宽带边界用红色标出。
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相邻信道功率比 (ACPR) ACPR 指的是一个相邻的（上方和 / 或下方）信道的发射功率和所使用的
通信信道的发射功率之间的关系。这项测量功能可以被用于评估调制器
和发射器的质量。测量值越高，发射器的质量越低，因为其他信道的发
射功率可能会干扰通信的正常进行。

9102 通过信道宽度和信道间隔输入参数确定相邻信道（请参阅 " 调节信
道间隔 " 第 71 页和 " 调节信道宽度 " 第 71 页）。它会在屏幕左上角显示
左侧（较低）和右侧（较高）信道的相邻信道功率比测量值。测量频段
将会以图形方式显示，其中宽带边界用红色标出。

占用带宽 (OBW) 占用带宽表示指定比例的信号功率所在的频率范围。频率范围并不一定
对称于中心频率，但是会围绕中心频率对称选取，以便最大限度地减小
保持某个特定的用户定义的 OBW 比例所需要的带宽。请参阅 " 调节占用
带宽比例 " 第 71 页。

OBW 将在屏幕左上角显示为一个绝对值，并且还会显示 OBW 比例；标
记 A1 和动态标记 DA2 分别位于下方和上方的频率，以显示频率范围。功
率测量范围为三倍的标准信道宽度。红色边界会标出 Channel System 菜
单中选择的标准信道带宽。
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选择测量类型 要选择频谱分析模式下的测量类型，请执行以下操作：

1 从 Spectrum Analysis 主菜单中选择 Measure。

2 利用 Measure 窗口中垂直排列的软键，选择一种测量类型。
所选测量类型的测量结果将显示在屏幕的左上角。

关闭特殊测量功能 要返回到没有特殊测量功能的标准频谱分析测量窗口，您只需要再次按
下所选测量类型所对应的软键。这项操作将会关闭特殊测量功能。

注

如果所选分辨带宽较高，而占用带宽很低，那么可能会出现一种罕见
的情况：占用带宽的所有频率都集中于频谱显示的某一点。在这种情
况下，9102 将不会显示带宽，而是显示 "N/A”（不可用）。通常用于显
示带宽边界的标记也将消失。

通过提高占用带宽或者降低分辨带宽，可以恢复带宽显示。
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调节信道宽度 信道宽度指的是发射信号所占用的带宽。要为信道功率和 ACPR 测量调
节信道宽度，请执行以下操作：

1 从 Spectrum Analysis 主菜单中，选择 Measure。

2 按下 Channel Width，输入一个新值，按下与相应单位联系的确认键。
用于信道功率和 ACPR 测量的新测量带宽将会在按下该软键时显示。

调节信道间隔 信道间隔指的是两个相邻信道之间的频率间距。要为 ACPR 测量设置信
道间隔，请执行以下操作：

1 从 Spectrum Analysis 主菜单中，选择 Measure。

2 按下 Channel Spacing, 输入一个新值，按下与相应单位联系的确认键。
用于 ACPR 测量的新信道间隔将会在按下该软键时显示。

读取信道功率 除了第 15页所介绍的显示元素以外，信道功率模式还包括了一个较大的
信道功率、信道、分辨带宽和扫描时间显示窗口。请参阅第 68 页，了解
测量方法。

调节占用带宽比例 OBW 测量功能旨在发现指定比例的发射功率所在的频率范围。要调节比
例值，请执行以下操作：

1 从 Spectrum Analysis 主菜单中，选择 Measure。

2 按下 % OBW，输入一个介于 5 到 99 之间的新比例值。

3 按下 ENTER，关闭输入栏。
如果选择了 OBW 测量类型，新的 OBW 比例值将显示在屏幕左上角。
9102 会根据新的比例值重新计算频率范围。
9102 手持式频谱分析仪 4.00 版本 71



第三章  频谱分析操作
查看频谱分析模式参数
修改分析仪的一般性参数 在使用频谱分析模式下的信道功率、 ACPR 和 OBW 测量功能时，也可以
照常修改一般性设字呼，例如中心频率、跨度、分辨带宽。下面将介绍
通过一个按钮，调节跨度、分辨带宽、视频段宽、检波器和曲线模式的
方法。

1 从 Spectrum Analysis 主菜单中，选择 Measure。

2 按下 Adjust Settings。
分辨带宽和视频段宽将被自动设置为最优值（自动模式）。曲线检波
器将被设置为采样模式，曲线模式被设置为实际值模式。
如果选择了信道功率测量功能，那么跨度将被设置为所选信道宽度的
120%。对于 ACPR 测量功能，跨度将被设置为 1.2 倍信道宽度 +2 倍信
道间隔。 OBW 宽度是信道宽度的三倍。

查看频谱分析模式参数

您可以在 Parameter Window ( 参数窗口 ) 中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 24 频谱分析模式参数
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Chapter 5 信道功率操作
4

本章将介绍 9102 在信道功率测量模式下的功能。本章所要讨论的主题包
括：

－ " 信道功率模式介绍 " 第 74 页

－ " 选择测量模式 " 第 77 页

－ " 信道功率模式操作方法 " 第 78 页

－ " 读取信道功率 " 第 79 页

－ " 调节占用带宽比例 " 第 79 页

－ " 使用通信系统和频率设置 " 第 79 页

－ " 设置电平参数 " 第 82 页

－ " 调节输入阻抗 " 第 85 页

－ " 设置曲线 " 第 86 页

－ " 保存和载入曲线 " 第 91 页

－ " 查看信道功率模式参数 " 第 93 页
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信道功率模式介绍

9102 提供了多种不同的测量模式，例如频谱分析和信道功率测量。信道
功率模式让您只需按下一个按钮，就可以测量指定频段内的辐射功率。
该模式避免了对指定通信系统进行设置的复杂操作。9102 中预置了多个
通信系统，或者也可以利用 9100数据交换软件从一台 PC下载通信系统。
请参阅 " 管理用于信号功率测量的通信系统 " 第 219 页，了解更多细节。

信道功率模式支持三种不同的频率选择型功率测量方式：

－ 信道功率

－ 相邻信道功率比率 (ACPR)

－ 占用带宽 (OBW)

信道功率和频率分析模式都支持这三种模式；但是在信道功率模式中，
利用预先定义的信道间隔和带宽，可以更加方便地使用不同频率对通信
系统进行测量。

为了清楚地说明系统 , 需要在 9102 上设置以下参数 :

－ 起始信道

－ 结束信道

－ 信道宽度

－ 信道步进

－ 起始频率
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您可以定义系统设置 , 并将它们存储在 9102 上。然而 , 您也可以使用仪
器上预置的系统。了解仪器上预置的完整的通讯系统列表 , 请参见 "9102
上预装的系统 " 第 317 页。

信道功率 这项测量功能可以测量所选信道的功率。信道可以在主菜单中选择，但
是参数 -- 例如信道宽度 （即测量带宽）和信道间隔 -- 可以从 Channel
System 菜单查看和修改。

9102 会在屏幕左上角显示信道功率测量的结果。测量带宽将会以图形方
式显示，其中宽带边界用红色标出。
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相邻信道功率比 (ACPR) ACPR 指的是一个相邻的（上邻和 / 或下邻）信道的发射功率和所使用的
通信信道的发射功率之间的关系。这项测量功能可以被用于评估调制器
和发射器的质量。测量值越高，发射器的质量越低，因为其他信道的发
射功率可能会干扰通信的正常进行。

9102 会在屏幕左上角显示左侧 （较低）和右侧 （较高）信道的相邻信
道功率比测量值。测量频段将会以图形方式显示，其中宽带边界用红色
标出。

ACPR 测量模式的选择和使用详情 , 请 " 选择测量模式 " 第 77 页。

占用带宽 (OBW) 占用带宽表示指定比例的信号功率所在的频率范围。频率范围并不一定
对称于中心频率，但是会围绕中心频率对称选取，以便最大限度地减小
保持某个特定的用户定义的 OBW 比例所需要的带宽。请参阅 " 调节占用
带宽比例 " 第 79 页。

OBW 将在屏幕左上角显示为一个绝对值，并且还会显示 OBW 比例；标
记 A1 和动态标记 DA2 分别位于下方和上方的频率，以显示频率范围。功
率测量范围为三倍的标准信道宽度。红色边界会标出 Channel System 菜
单中选择的标准信道带宽。
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选择测量模式

要选择信道功率模式，请执行以下操作：

1 按下 MODE 功能键。

2 选择 Channel Power 软键。

屏幕将显示信道功率模式的主菜单。如果您选择了一个新的模式，所有
参数将被设置为该模式长期启用时使用的值。但是，如果您选择恢复上
次启用的模式，测量将继续进行，测量参数都将保持不变。

要选择信道功率模式下的测量类型，请执行以下操作：

1 按下 Measure 软键。

2 利用垂直排列的功能软键，选择一种测量类型（信道功率、 ACPR 或
者 OBW）。

注

如果所选分辨带宽较高，而占用带宽很低，那么可能会出现一种罕见
的情况：占用带宽的所有频率都集中于频谱显示的某一点。在这种情
况下，9102 将不会显示带宽，而是显示 ”N/A”（不可用）。通常用于显
示带宽边界的标记也将消失。

通过提高占用带宽或者降低分辨带宽，可以恢复带宽显。
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信道功率模式操作方法

这种模式可以测量指定带宽之内的总功率。关于如何选择该测量模式，
请参阅第 77 页。

在信道功率模式下，频率参数、滤波器和扫描时间均不可以单独选择。
但是，可以选择或者定义一个通信系统。9102 将在通信系统中测量信道
功率。频率参数将被保存在通信系统设置中。

9102 预置了多个通信系统，例如 GSM。9100 数据交换软件预置了更多的
系统设置，它们可以被下载到 9102 中。另外，用户也可以自行定义一个
通信系统的设置，将其保存在 9102 中，并在测量信道功率时调出。

注

相邻信道功率比 (ACPR) 测量是适用于信道带宽不超过信道间隔的通信
系统；否则，相邻信道的测量范围将会与所选信道的测量范围重叠。
在这种情况下，可以在频谱分析模式下使用ACPR测量功能（参见第 76
页）。

图 25 信道功率测量示例
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读取信道功率

除了第 16页所介绍的显示元素以外，信道功率模式还包括了一个较大的
信道功率、信道、分辨带宽和扫描时间显示窗口。在第 78 页图 25 所显
示的例子中，9102 设定了位于红色竖线之间的频率范围，并再次范围内
测量信道功率。

调节占用带宽比例

OBW 测量功能旨在发现指定比例的发射功率所在的频率范围。要调节比
例值，请执行以下操作：

1 从 Channel Power 主菜单中，选择 Channel System。

2 按下 % OBW，输入一个介于 5 到 99 之间的新比例值。

3 按下 ENTER，关闭输入栏。

如果选择了 OBW测量类型，新的 OBW比例值将显示在屏幕左上角。9102
会根据新的比例值重新计算频率范围。

使用通信系统和频率设置

选择 9102 上的一个通信
系统

要启用 9102 存储的通信系统设置，请执行以下操作：

1 在信道功率模式的主菜单中，选择 Ch. System > System Memory。
屏幕将显示 System Memory 菜单。

2 按下 Recall System。
屏幕将显示一个滚动框，列出现有的通信系统。输入 9102 中保存的
系统名称，或者利用UP/DOWN光标键将光标移动到需要测量的系统。

3 按下 ENTER 确认。
输入栏和滚动框将关闭，所选频段的频谱将被测出。第一个通道的信
道功率将显示在屏幕左上角。

注

也可以通过 Measure 菜单调节占用带宽。
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9102 配有预置的通讯系统。查阅 9102 预置的信道系统列表 , "9102 上预
装的系统 " 第 317 页

设置一个新的通信系统 通过设置频率范围、信道宽度和间隔，以及信道编号，可以定义一个新
的通信系统；这样，可以通过信道编号方便地找到信道，而不需要借助
于载波或者中心频率。要设置一个新的通信系统，请执行以下操作：

1 在主菜单中，选择 Ch. System。
屏幕将显示 Channel System 菜单。

2 按下 First Channel，输入系统目前使用的第一个信道的编号，再按下
ENTER 关闭输入栏。

3 按下 Last Channel，输入系统目前使用的最后一个信道的编号，再按下
ENTER 关闭输入栏。

4 按下 Channel Width，修改测量宽度；确认选择了正确的单位 （例如
kHz）。

5 选择 Channel Spancing 软键，输入相邻信道之间的间隔，按下与相应
频率单位关联的确认键关闭输入栏。

6 按下 1st Ch. Center 软键，输入目前使用的第一个通道的载波频率（信
道编号通过第一个软键定义）。按下与相应单位（例如 MHz）关联的
确认键关闭输入栏。

7 在测量占用带宽 (OBW) 时，选择 %OBW，输入比例值。按下 ENTER，
确认该值。

8 选择 System Memory > Store System，为系统输入一个新的名称，按下
ENTER 确认。

注

除了信道宽带以外，预装配置系统的参数均不能修改。

注

不能覆盖已有系统；您必须先删除已有系统。

如果您删除了一个 9102 预装的系统，您可以按照 " 恢复缺省通信系统
" 第 81 页中介绍的操作，恢复该系统。
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删除一个通信系统 要删除一个保存在 9102 中的通信系统设置，请执行以下操作：

1 从主菜单中选择 Ch. System > System Memory。
屏幕将显示 System Memory 菜单。

2 按下 Delete System 软键。
屏幕将显示一个滚动框，列出已有的通信系统。

3 通过用 UP/DOWN 光标键将光标移动到需要删除的系统设置名称，选
择需要删除的系统设置，再按下 ENTER 确认。
该系统设置将从列表中删除。

4 按下 ESCAPE，关闭输入栏和滚动框。

删除所有通信系统 您可以方便地清空过去保存的所有通信系统，包括 9102 预装的通信系
统。

1 从主菜单中选择 Ch. System > System Memory。
屏幕将显示 System Memory 菜单。

2 按下 Delete All 软键。
屏幕将显示一个对话框，请您确认您是否希望删除所有通信系统设
置。

3 按下 ENTER，确认删除；或者按下 ESCAPE，防止 9102 删除所有通信
系统。
一旦确认，所有通信系统都将被删除，这意味着通信系统列表将被清
空。

恢复缺省通信系统 如果您删除了 9102 预装的通信系统，您可以恢复这些系统设置。

1 从主菜单中选择 Ch. System > System Memory。
屏幕将显示 System Memory 菜单。

2 按下 Restore Default Systems 软键。
9102 将创建 9102 预装的所有通信系统。

利用 9100 数据交换软件
配置通信系统

利用 9100 数据交换软件，用户可以定义更多的系统系统，并将其载入到
9102 中选择使用。请参阅 " 管理用于信号功率测量的通信系统 " 第 219
页，了解更多细节。并且 , 利用 9100 数据交换软件 , 更多的预置通讯系
统可以转入您的 9102。了解可用的通讯系统列表 , 请参阅 "9100 数据交
换软件中的预定义系统 " 第 318 页。
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定义频率跨度 9102 可以显示系统使用的全部频谱，或者只显示所测量的信道。要选择
频率跨度，请执行以下操作：

在主菜单中，选择 Full System 或者 Single Channel。

如果您选择 Full System，那么将显示通信系统所定义的全部频段。如
果您选择 Single Channel，将只显示当前选中信道的频率范围。

更改信道 1 在输入菜单中，按下 Channel 软键。
屏幕将显示 Channel 输入栏。

2 手动输入所要选择的信道在通信系统中的编号，或者利用 UP/DOWN
光标键选择信道编号。

3 按下 ENTER 确认。
所选信道的信道功率将显示在左上角。

调节扫描时间

扫描时间 (SWT) 可以确定在所测量的频率范围 （即跨度）上进行一次完
整扫描所用的时间。

在缺省情况下，9102 可以根据其他测量参数（例如跨度）自动选择扫描
时间。在某些情况下，需要手动选择一个不同的扫描时间。例如对于脉
冲信号，较长的扫描时间有助于提高测量准确度。如果选择手动设置，
那么扫描时间应当长到足以让滤波后的信号达到稳定状态。如果扫描时
间过短， 9102 将会输出一个 "UNCALibrated" 警告。

要在信道功率模式下调节扫描时间，请执行以下操作：

1 从主菜单中选择 Measure。

2 按下 SWT 软键。

3 输入新的扫描时间，再利用与相应单位联系的确认键完成输入。

设置电平参数

测量信号与背景噪声之间的准确度和动态范围取决于正确的电平设置。
这包括参考电平和衰减值的设置。

参考电平将决定显示窗口顶部的电平。纵轴分为八条竖线；您可以根据
需要调节刻度 （缺省值为每条线 10dB）。
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衰减值设置可以在参考电平设置之后自动进行。对于不超过 -20dBm 的
参考电平，衰减值被设为 10dB ；最大衰减值为 50dB。

因为外部耦合而产生的衰减或者增益可以通过随频率变化的耦合系数加
以补偿，以便让屏幕显示的测量值真实地反映被测设备的功率电平。

设置参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏；或
者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

设置硬件衰减 1 在主菜单中，按下 Attenuation 软键。
屏幕将显示 Attenuation 输入栏。

2 输入一个介于 0 到 50dB 之间（步进值为 10dB）的新衰减值，通过一
个确认键关闭输入栏；或者利用 UP/DOWN 光标键选择一个介于 10 到
50dB 之间的衰减值。
如果衰减值被修改，衰减选项将变为 "auto"。

.

警告

RF IN 接口的最高输入功率为 30 dBm(1 瓦 )。更高的输入功率可能会导
致本仪器严重受损。

注

0 dB 衰减值只能通过数字键设置，以避免意外禁用。应当慎用 0 dB 设
置，因为过高的输入功率可能会导致仪器受损。

注

在需要精确测量时，输入功率与衰减值的差值应当不超过 -23dBm。
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修改纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

为输入和输出选择电平单
位

1 在主菜单中选择 Level>Units。

2 您可以使用对数或者线性单位。要在对数和线性单位之间切换，请按
下屏幕右下角的 Unit 软件，选择 log 或者 lin。

3 您现在可以通过屏幕右下角的 Unit 软键，选择下列单位：
对数单位：dBm, dBµV, dBmV 和 dBV
线性单位：V, mV, µV, mW 和 µW

补偿增益和损耗 如果被测设备通过一个放大器或者会导致信号衰减的设备 ( 例如天线或
者长线 ) 连接到 9102 手持式频谱分析仪，那么测量结果会受到增益或者
损耗因数的影响。这个因数可能是固定值，也可能会随频率变化而变
化。

为了获得正确的测量结果，可以补偿增益或者损耗。9102 甚至还可以补
偿一个随频率变化的因数；您可以利用9100数据交换软件在一台外部PC
上输入一个纠正曲线或者表，再将其发送到 9102。 " 定义和载入外部耦
合参数 " 第 217 页部分将详细介绍这项功能。

启用外部设备补偿 一旦在 9102 中保存了纠正值，就可以通过以下操作选择和启用它们：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 按下 Recall Ext. Dev. Comp。
屏幕显示一个下拉菜单，列出 9102 上现有的补偿表的名称。

3 利用 UP/DOWN 光标键选择一个补偿表，再通过按下 ENTER 确认您的
选择。
这时补偿尚未启用，但是 9102 会自动显示 Level 菜单。

4 按下 Ext. Dev. Comp. 软键，直到 "on" 高亮显示。
文字 "Ext.Dev." 和所载入的文件名将显示在测量结果的左上角。
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关闭外部设备补偿 1 从主菜单中选择 Level。

2 按下 Ext. Dev. Comp. 软键，直到 "off" 高亮显示。
测量结果左侧的文字 "Ext.Dev." 将会消失。

删除用于外部设备补偿的文件 要删除包含补偿参数的文件，请执行以下操作：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 a. 要从 9102 内存中删除某个补偿文件，请按下 Delete Ext. Dev. Comp。
选择一个文件名，再按 ENTER 确认。
补偿文件将从列表中删除。请注意，删除时将不会弹出警报；如果您
选中一个文件并要求将其删除，该文件将会被立即删除。
b. 要删除 9102 中的所有补偿文件，按下 Delete All，再按 ENTER 确认。
所有补偿文件都将被删除。

调节输入阻抗

大部分RF应用都配有一个 50欧姆的阻抗；其他应用（例如有线电视）则
使用 75 欧姆阻抗。9102 的输入阻抗为 50 欧姆，但是它可以利用软件阻
抗开关测试一个配有 75 欧姆阻抗的设备。 50 欧姆输入的测量结果会被
重新计算，以匹配不同的阻抗。

在 9102 上，您只需选择正确的阻抗值，9102 就可以自动地将内部测量值
转换为耦合器之前的功率。

1 要连接一个75欧姆设备，将被测设备连接到9102手持式频谱分析仪。

2 从主菜单中选择 Level。

3 在垂直菜单中，选择设备阻抗，即选择Impedance: 50Ω或者Impedance:
75 Ω。

新的测量结果已经考虑到了新的阻抗值。另外，如果阻抗改为 75 欧
姆，而功率的显示单位为 dBm，那么新的测量值将以 dBµV 为单位显
示。如果阻抗改为 50 欧姆，而功率的显示单位为 dBµV，那么新的
测量值将以 dBm 为单位显示。

注

50 欧姆和 75 欧姆设备之间的连线上的信号反射会影响 9102 手持式频
谱分析仪的测量精度。为了获得更加准确的测量结果， Willtek 建议使
用一个阻抗转换器；例如一个可以对测量结果产生衰减作用的转换
器。9102 可以对这种衰减进行补偿，详见 " 补偿增益和损耗 " 第 84 页
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设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据 （请参阅 " 保存和载入曲线 " 第 91 页）。

9102 会为每个频率点测量多个采样值。利用检波器功能，您可以定义用
以选择所显示的采样值的方法。

选择曲线模式 9102 提供了五种曲线显示模式：

－ 在实际值模式下，9102 在每条曲线中显示一个全新的测量结果。后续

曲线彼此无关。

－ 在保持模式下，最近一次的测量结果将显示在屏幕上；测量仍然在继
续，但是不会在屏幕上显示。

－ 在最大值保持模式下，9102 会进行新的测量。对于每个频率点，9102
会将新的测量结果与以前的结果进行比较。如果新的测量值大于以前
的测量结果，新的测量值将会称为新的测量结果；否则原有的测量结
果将保持不变。这样，从启用 Max Hold （最大值保持）模式 （或者

修改某个参数）以来的最大测量结果将会被保存并显示。

图 26 信道功率模式下的两条曲线示例
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－与之类似，在最小值保持模式下，9102 会进行新的测量，并将新的测

量结果与以前的结果进行比较。如果新的测量值小于以前的测量结
果，新的测量值将会称为新的测量结果；否则原有的测量结果将保持
不变。这样，从启用 Min Hold （最小值保持）模式 （或者修改某个

参数）以来的最小测量结果将会被保存并显示。

－ 在均值模式下，每个频率点将显示新的测量值和以前的测量值的平均
值。 9102 为平均计算使用了一种递归算法。

如果您想要查看实际测量值，中止并保持最近一次的测量结果，查看每
个频率的最小、最大数据或者平均值，请执行以下操作：

1 在主菜单中选择 Trace。

2 利用水平软键选择您想要修改的曲线 (Trace A 或者 Trace B)。

3 利用垂直软键选择曲线模式 (Actual, Hold, Max hold, Min hold, Average)。
曲线模式将显示在纵轴的左侧，例如 A(ACT)。

注

为了以最快的速度获得有效的结果， Willtek 建议您在选择其他任何模
式之前，先暂时启用实际值模式。

注

在曲线处于保持状态时，测量任务将继续进行，超出极限计数器也将
继续计数。如果启用了第二条曲线，那么第二条曲线也会继续更新。
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启用和关闭第二条曲线 您可以定义两个不同的曲线视图，例如一个显示实际值，另外一个显示
最大值。第一个视图（曲线 A）必须始终激活，但第二个视图可以关闭。
要启用或关闭曲线 B，以及选择曲线模式，请执行以下操作：

1 在主菜单中选择 Trace>Trace B。

2 要启用曲线 B，请选择曲线模式 (Actual, Hold, Max hold, Min hold 或者
Average)。要关闭曲线 B，请选择 Off。在启用之后，曲线模式将显示
在纵轴的左侧，例如 B(MAX)。

曲线 A 减去曲线 B 如前所述，如果您使用了两个不同的曲线视图，您可以通过用曲线 A 减
去曲线 B，显示曲线 A 和曲线 B 之间的差异。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Subtract A -B →
A。

2 选择 on，用曲线 A 减去曲线 B。在测量结果左侧将会显示 "Subtract"，
表示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

注

如果曲线 A 处于保持状态，本功能将无法使用。Subtract A -B → A 软键
将会以灰色显示。
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曲线 B 加到曲线 A 如果您使用了两个不同的曲线视图，您还可以通过累加曲线 A和曲线 B，
显示这条曲线的总和。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Add A +B → A。

2 选择 on，用曲线 B 加到曲线 A。在测量结果左侧将会显示 "Add"，表
示目前正在进行一项数学运算。计算结果显示在曲线 A。

曲线偏移 一旦您使用了两个数学功能中的一个 --Subtract A+B → A 或者 Add A+B →
A，曲线偏移功能将会启用。如果数学计算导致曲线移动到显示区域之
外，您可以利用该功能调节曲线的显示。为了将曲线重新移入显示区
域，可以利用 Trace Offset 软键调节偏移值，直到曲线回到显示区域。

定义用于计算均值的测量
次数

在曲线模式被设为计算均值时，可能需要 9102 用以计算均值的测量计
数。在曲线菜单中定义的平均次数值同样适用于两条曲线。

9102 采用了一种递归算法，即新的测量结果将通过一个加权因数加入原
有的平均值；下面将介绍怎样修改这个加权因数：

1 进入 Trace 菜单 （从主菜单选择 Trace > Trace A 或者 Trace B）。

2 按下 Average Count 软键。
屏幕显示 Average 输入栏。

3 输入用以计算均值的测量次数 （介于 2 到 128 之间）。

4 按下 ENTER 确认。

选择检波方式 在信道功率模式下，缺省的检波器为采样模式。如果您在 9102 上安装并
启用了 9132 RMS 检波器选件，您还可以使用显示测量信号的 RMS 有效
电平的均方根检波器。要将检波器设为 RMS 模式，请执行以下操作：

1 从主菜单中，选择 Trace>Detect。

2 从垂直软键的 Detector 部分选择 RMS 模式。所选的检波器将显示在屏
幕左侧。

注

如果没有在您的仪器上安装 9132 RMS 检波器选件，RMS 检波器将以灰
色显示。
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设置曲线
在 9102 中复制曲线 您可以将曲线 A 的实际测量值复制到曲线 B，反之亦然。这样，您可以
一边在屏幕上显示最新的测量结果，一边继续测量或者调节 9102 手持式
频谱分析仪的设置。目标曲线过去的测量结果将会被删除；目标曲线将
处于保持模式。

要将测量值从一条曲线复制到另外一条曲线，请执行以下操作：

1 从主菜单中，选择 Trace>Trace Function。

2 要将曲线 A 的测量值复制到曲线 B，按下 Copy A → B。
要将曲线 B 的测量值复制到曲线 A，按下 Copy B → A。

图 27 带有已经启用的 9132 RMS 检波器选件的 Detect 菜单

注

如果您先按下 Copy A → B，再按下 Copy B → A （或者相反顺序），两
条曲线将显示相同的测量结果，并且都将处于保持模式。
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保存和载入曲线

9102 提供了最多保存 99 条曲线，并随机载入这些曲线的功能。存储的
曲线可以在屏幕上显示，也与最近的测量结果进行比较。另外，存储的
曲线可以通过 9102 附带的 9100 数据交换软件发送到一台 PC 上。如需了
解该软件的详细信息，请参阅第 14 章 "9100 数据交换软件 "。

保存一条曲线 您可以保存曲线 A 或者曲线 B。任何曲线可以用一个不超过 11 个字符的
名称保存。关于在字母数字输入栏中输入文字的步骤，请参阅 " 输入数
字和文字 " 第 24 页 "。请注意，除了曲线以外，频率范围、电平范围和
标记等仪器设置也将被保存下来。

1 从主菜单中，选择 Trace > Trace Memory。

2 按下 Store Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入曲线名称。要使用某个修改的曲线名称，您可以利用 UP/DOWN
光标键将光标移动到相应的曲线名称。选中的曲线名称也将显示在输
入栏中；利用 LEFT/RIGHT 光标键将光标移动到曲线名称中的相应位
置，输入额外字符或者删除已有字符。

4 按下 ENTER 确认。
输入栏将关闭，曲线将以所选名称保存。

图 28 Trace A 菜单
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重复使用一个曲线名称 您不能用相同的曲线名称覆盖一个已有的曲线。如果您希望重复使用一
个曲线名称，您必须先删除原有曲线。

载入一条曲线 1 从主菜单中选择 Trace > Trace Memory。

2 按下 Recall Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入需要载入的曲线的名称，或者利用 UP/DOWN 光标键选择一个名
称。

4 按下 ENTER 确认。
输入栏将关闭，所选曲线将显示在屏幕上。

删除一条曲线 您可以删除过去保存的曲线。请注意，在您删除曲线时 9102 将不会发出
警报；如果您选中一个文件并要求将其删除，该文件将会被立即删除。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete Trace。
屏幕将会显示一个输入栏，请您输入需要删除的曲线的名称；以及一
个曲线选择对话框。

3 利用 UP/DOWN 光标键选择需要删除的曲线。或者，利用数字键输入
曲线名称。

4 按下 ENTER 确认。
所选文件将从曲线列表中删除。

5 选择另外一条需要删除的曲线。或者按下 ESCAPCE，关闭输入栏和曲
线选择对话框。

删除所有曲线 除了单独删除各条曲线之外，您也可以一次性删除所有曲线。这个步骤
将要求您加以确认。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete All。
屏幕将显示一个提示，请您确认您的选择。

3 按下 ENTER，删除所有曲线。
提示将消失。所有曲线均被删除。

注

除了曲线以外， 9102 还会载入曲线保存时使用的设置。它们将覆盖现
有设置，例如频率范围、参考电平和标记。
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保存和载入仪器设置 要保存或者载入仪器设置， 包括频率范围、电平设置和标记等，请执行
" 保存一条曲线 " 和 " 载入一条曲线 " 第 92 页部分所介绍的操作。

查看信道功率模式参数

您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 29 信道功率模式参数
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Chapter 6 信号发生器操作
5

本章将介绍 9102 在信号发生器模式下的功能。本章所要讨论的主题包
括：

－ " 信号发生器模式介绍 " 第 96 页

－ " 启用和关闭信号发生器 " 第 96 页

－ " 更改频率 " 第 96 页

－ " 设置电平 " 第 99 页

－ " 对信号执行特殊功能 " 第 99 页
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信号发生器模式介绍
信号发生器模式介绍

在这种模式下，9102 可以被用于生成一个具有指定频率和功率电平的信
号来激励一个电路。因为这种模式只用于发出信号，而不需要在 9102 上
进行任何实际的测量，所以不显示任何测试曲线。信号的用途决定了这
个流程的结果，例如启动一个处理器。

选择测量模式

要选择信号发生器模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕将显示 Mode 菜单。

2 选择 (VSWR/)Tracking ... > Signal Generator。
屏幕将显示 Signal Generator 主菜单 （参见图 30 和图 31）

启用和关闭信号发生器

当您按照以上操作选择信号发生器模式时，信号发生器将会自动启用。
要关闭信号发生器，请按下 Output 软键，直到 “off”高亮显示。如果
您关闭信号发生器，选择另外一种模式，那么当您返回到信号发生器模
式时，它将会再次自动启动。

更改频率

主菜单显示了用于定义屏幕的频率范围的软键。用于设置频率参数的软
键取决于您所选择的频率模式。您可以选择两种频率模式：CW （连续
波）和 SWP （扫描）。

选择频率模式 要配置用于设置频率的软键，您可以在两种频率模式 --CW 和 SWP-- 之
间选择。在缺省情况下，CW 模式将被启用。要在 CW 和 SWP 之间切换，
请按下 Mode 软键，直到所需选项高亮显示。主菜单的显示内容也会发
生相应的变化。
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更改频率
设置中心频率

1 在主菜单中，要选择 CW 模式，只需按下 Mode 软键，直到 CW 高亮
显示。屏幕将会显示 CW 主菜单 （如上图所示）。

2 按下 CENT 功能键（或者主菜单中的 Frequency 软键）。屏幕上将显示
一个输入栏，指明目前设置的中心频率和 UP/DOWN 光标键的步进宽
度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

按下一个与相应单位（如果单位为吉赫兹，按下 GHz/dBm ；如果单位为
兆赫兹，按下 MHZ/dB/µS）关联的确认键，完成输入。

图 30 CW 模式下的 Signal Generator 主菜单
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更改频率
设置起始频率和截止频率

1 在主菜单中，要选择 SWP 模式，只需按下 Mode 软键，直到 SWP 高
亮显示。屏幕将会显示 SWP 主菜单 （如上图所示）。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

4 按下 Stop 软键，输入频率。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键（UP, DOWN）增大或者减小当前设置。光标键的按
键步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 按照 " 选择频率模式 " 第 96 页中介绍的操作，在 Signal Generator 主菜
单中选择您希望设置频率步进宽度的频率模式 （CW 或者 SWP）。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。

3 输入一个新的频率值，按下 ENTER 关闭输入栏。自动 / 手动选择切换
到手动方式，所选的频率步进宽度将显示在软键上。

图 31 SWP 模式下的 Signal Generator 主菜单
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设置电平
将频率步进宽度选择方式设为自动

1 在 Signal Generator 主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 “auto”选项高亮显示。

设置电平

1 在主菜单中，按下 Level 软键。
屏幕将显示 Level 输入栏。

2 利用数字键输入新的电平，再利用相应的确认键关闭输入栏；或者利
用 UP/DOWN 光标键选择电平。可以输入的电平范围为 -10dBm 到 -
30dBm，步进为 1dB。

对信号执行特殊功能

本节将介绍怎样限制测量次数。

进行有限次数的测量 9102 可以连续进行测量，也可以限定测量次数。限制测量次数可能有助
于统计分析。

1 从主菜单中选择 Sweep。
屏幕将显示 Sweep 菜单。

2 选择扫描模式：如需连续生成信号，按下 Cont. ；如需进行单次扫描，
按下 Single。
所选扫描模式将高亮显示。
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对信号执行特殊功能
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Chapter 7 发射操作
6

本章将介绍 9102 在发射模式下的功能。本章所要讨论的主题包括：

－ " 发射模式介绍 " 第 102 页

－ " 选择测量模式 " 第 102 页

－ " 启用和关闭跟踪发生器 " 第 103 页

－ " 归一化曲线 " 第 103 页

－ " 设置跟踪输出功率 " 第 104 页

－ " 更改频率设置 " 第 105 页

－ " 选择 RBW、 VBW 和 SWT" 第 108 页

－ " 设置电平参数 " 第 108 页

－ " 对信号执行特殊功能 " 第 111 页

－ " 查看发射模式参数 " 第 121 页
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发射模式介绍
发射模式介绍

发射模式让您可以确定被测的无源 （例如带通滤波器）或者有源设备
（例如放大器）的频率特性。在这种模式下， 9102 手持式频谱分析仪会
使用跟踪发生器--一种与频谱分析仪的接收频率同步的信号发生器--测
量被测设备的反射和发射特性。跟踪发生器的输出频率介于 1MHz 到
4GHz 之间。它的功率电平可以在 -10 到 -30dBm 之间调节，以便根据被
测设备的需要调整输出信号。请参阅和仪器一起寄过来的 CD 中的文件
9100 应用手册 (Application Guide)，查看本模式的一个应用示例。

选择测量模式

要选择信号发生器模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕将显示 Mode 菜单。

2 选择 (VSWR/)Tracking ... > Transmission。
屏幕将显示 Transmission 主菜单。

图 32 发射测量示例
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启用和关闭跟踪发生器
启用和关闭跟踪发生器

当您按照 " 选择测量模式 " 中介绍的操作选择发射模式时，跟踪发生器
将会自动启用。要关闭跟踪发生器，请执行以下操作：

1. 在 Transmission 主菜单中，按下 Tracking Generator 软键。

2. 按下 Tracking 软键，直到 “off”高亮显示。

如果您关闭跟踪发生器，选择频谱分析或者信道功率模式，那么当您返
回到发射模式时，它将会再次自动启动。

归一化曲线

为了消除曲线显示中的微小波动，应当在进行测量之前使用 Normailize
（归一化）功能。屏幕上显示了两个用于归一化曲线 A 和曲线 B 的软键。
下图显示了没有进行归一化的曲线 A。

要获得一个归一化的曲线，请执行以下操作：

1 用一条线缆连接在 RF IN 和 RF OUT 接口。

2 在 Transmission 主菜单中，按下 Tracking Generator 软键。

3 按下 Normalize A 或者 B 软键，直到 “on”高亮显示。

图 33 Normalize A 关闭
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设置跟踪输出功率
测量结果左侧的文字“Normal.’d”表示所显示的结果已经进行了归一化。
如果您调节了测量参数，例如跟踪输出、频率设置或者衰减，您必须重
新执行归一化操作。在这种情况下，在测量结果显示区域左侧的一个红
色背景上将显示 “Normalize”提示。

下图显示了在进行了归一化操作之后的曲线 A。

设置跟踪输出功率

跟踪发生器的输出功率可以在 -10 到 -30dBm 之间设置。要调节输出功
率，请执行以下操作：

1 在 Transmission 主菜单中，按下 Tracking Generator 软键。

2 按下 Tracking Output Power 软键。屏幕将显示 Tracking Output Power 输
入栏。

3 利用 UP/DOWN 光标键输入一个新的输出功率值（步进为 1dBm），或
者利用数字键输入新的功率值。

4 按下 ENTER 确认。

注

如果没有使用曲线 B， Normalize B 软键将以灰色显示。

图 34 Normalize A 启用
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更改频率设置

您可以通过多种方式设置需要测量的频率范围；频率范围可以利用起始
频率和截止频率（例如显示窗口上的第一个和最后一个频率）表示，或
者利用中心频率和跨度（例如中心和频率范围）表示，或者利用中心频
率、跨度、起始频率和截止频率的其他组合表示。

所有四个参数都可以通过 Freq 菜单查看。但是在主菜单中，只会显示上
述组合中的一种，具体选择哪一种取决于最后输入的参数。

设置起始频率和截止频率 1 按下 CENT 功能键 （或者 Transmission 主菜单上的 Freq 软键）。
垂直软键包括 Start 和 Stop 软键。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

图 35 频率菜单

注

修改一个频率参数可能会影响到相关的参数。例如：如果您将频率跨
度修改为 4GHz，那么起始频率和截止频率将会分别变为 0 和 4GHz。
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4 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS）关联的确认键，完成输入。
如果输入的起始频率低于截止频率，那么横轴将显示起始频率到截止
频率的范围。如果新的起始频率高于或者等于截止频率，开始频率将
被用作零跨度的中心频率，例如所选频率的信号将在时域显示。

5 按下 Stop 软键，输入显示窗口右端的频率。

您也可以通过修改频率模式，将用于设置起始频率和截止频率的软键放
在主菜单中，详见 " 修改主菜单中显示的频率参数 "。

设置中心频率和跨度 1 按下 CENT 功能键 （或者 Transmission 主菜单上的 Freq 软键）。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 UP/DOWN 光标键的步进宽度。

2 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

3 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS ；如果单位为千赫兹，按下 KHZ/dBµV/
MS ；如果单位为赫兹，按下 ENTER）关联的确认键，完成输入。

4 按下 Span 软键，输入从显示窗口左端到右端的频率范围。

您也可以通过修改频率模式，将用于设置中心频率和跨度的软键放在主
菜单中，详见下面的 " 修改主菜单中显示的频率参数 "。

修改主菜单中显示的频率
参数

Transmission 主菜单会显示两个用以定义显示窗口的频率范围的软键。如
前所述，可以通过不同的方式定义频率范围；您可以将这两个软键设为
两个可选组合中的一种，方法为：

1 从 Transmission 主菜单中，选择 Freq > Freq Mode。

2 选择您希望在主菜单中看到的软键组合 (Start/Stop 或者 Center/Span)。

3 按下 Main... 软键，回到主菜单。

屏幕将显示主菜单，以及所选的软键组合。

请注意，频率横轴的说明会随着所选参数组合的改变而改变。
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查看完整的频段 要将频率范围改为 9102 支持的全部带宽，请执行以下操作：

1 从 Transmission 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Full Span 软键。
最左端的频率将变为 0，最右端的频率将变为 4GHz。

在时域进行测量 某个选定中心频率上的测量结果也可以在时域显示。

1 从 Transmission 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Center 软键，输入需要的中心频率；通过选择确认键中的适当单
位，关闭输入栏。

3 按下 Zero Span 软键。
横轴将变为时间轴。刻度宽度与扫描时间一致。请参阅第 112页图 36
所提供的例子。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键 (UP/DOWN) 增大或者减小当前设置。光标键的按键
步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 从 Transmission 主菜单中，选择 Freq。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。

3 输入一个新的频率值，按下 ENTER 关闭输入栏。自动 / 手动选择切换
到手动方式，所选的频率步进宽度将显示在软键上。

将频率步进宽度选择方式设为自动

1 从主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 “auto”选项高亮显示。
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选择 RBW、 VBW 和 SWT

分辨带宽 (RBW) 指的是 IF 滤波器用于选择待测信号的 3dB 带宽。分辨带
宽可以表明频谱分析仪区分具有类似幅值的相邻信号的能力。只有间隔
频率超过 RBW 的信号才能彼此区分。
通过设置， 9102 可以根据频率跨度自动选择分辨带宽。

视频带宽 (VBW) 指的是低通带宽，自此之上的频率点的多个测量结果将
会被平滑处理。视频带宽越低，信号曲线越平滑，变化越少。
通过设置，9102 可以自动根据分辨带宽选择视频带宽。视频带宽的典型
值应当等于射频带宽值，或者比射频带宽值小 10 倍。

扫描时间 (SWT) 可以确定在所测量的频率范围 （即跨度）上进行一次完
整扫描所用的时间。
通过设置， 9102 可以自动根据 RBW 和 VBW 选择扫描时间。如果选择手
动设置，那么扫描时间应当长到足以让滤波后的信号达到稳定状态。如
果扫描时间过短， 9102 将会输出一个 “UNCALibrated”警告。

要设置分辨带宽、视频带宽或者扫描时间，请执行以下操作：

1 在主菜单中选择相应的软键 （RBW、 VBW 或者 SWT）。

2 输入数值，利用相关单位所对应的确认键完成输入。利用 UP/DOWN
光标键输入一个新的值，或者切换到 auto 模式，由 9102 自动进行设
置。

在自动和手动模式之间切换

多次按下相应的软键 （RBW、 VBW 或者 SWT），直到所要选择的模式
（自动或者手动）高亮显示。

设置电平参数

测量信号与背景噪声之间的动态范围取决于正确的电平设置。这包括参
考电平和衰减值的设置。

参考电平将决定显示窗口顶部的电平。纵轴分为八条竖线；您可以根据
需要调节刻度 （缺省值为每条线 10dB）。

衰减值设置可以在参考电平设置之后自动进行。对于不超过 -20dBm 的
参考电平，衰减值被设为 10dB ；最大衰减值为 50dB。
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因为外部耦合而产生的衰减或者增益可以通过随频率变化的耦合系数加
以补偿，以便让屏幕显示的测量值真实地反映被测设备的功率电平。

切换显示 您可以选择在屏幕上显示绝对值或者相对值。请执行以下操作：

1 在主菜单中选择 Level。屏幕将显示 Level 菜单。

2 按下 Display 软键，切换绝对值或者相对值显示，直到所要选择的显
示选项高亮显示。如果您选择绝对值，结果窗口将显示参考电平和单
位 dBm。如果您选择相对值，结果窗口将显示参考值和单位 dB。

设置参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏；或
者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

设置硬件衰减 1 在主菜单中，按下 ATTN 软键。
屏幕将显示 Attenuation 输入栏。

2 输入一个介于 0 到 50dB 之间（步进值为 10dB）的新衰减值，通过一
个确认键关闭输入栏；或者利用 UP/DOWN 光标键选择一个介于 10 到
50dB 之间的衰减值。

警告

RF IN接口的最高输入功率为30 dBm (1瓦)。更高的输入功率可能会导致
本仪器严重受损。

注

0dB衰减值只能通过数字键设置，以避免意外禁用。应当慎用0dB设置，
因为过高的输入功率可能会导致仪器受损。

注

在需要精确测量时，输入功率与衰减值的差值应当不超过 -23dBm。
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修改纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

补偿增益和损耗 如果被测设备通过一个放大器或者会导致信号衰减的设备 ( 例如天线或
者长线 ) 连接到 9102 手持式频谱分析仪，那么测量结果会受到增益或者
损耗因数的影响。这个因数可能是固定值，也可能会随频率变化而变
化。

为了获得正确的测量结果，可以补偿增益或者损耗。9102 甚至还可以补
偿一个随频率变化的因数；您可以利用9100数据交换软件在一台外部PC
上输入一个纠正曲线或者表，再将其发送到 9102。" 定义外部耦合因数 "
第 218 页部分将详细介绍这项功能。

启用外部设备补偿 一旦在 9102 中保存了纠正值，就可以通过以下操作选择和启用它们：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 按下 Recall Ext. Dev. Comp。
屏幕显示一个下拉菜单，列出 9102 上现有的补偿表的名称。

3 利用 UP/DOWN 光标键选择一个补偿表，再通过按下 ENTER 确认您的
选择。
这时补偿尚未启用，但是 9102 会自动显示 Level 菜单。

4 按下 Ext. Dev. Comp. 软键，直到 “on”高亮显示。
文字 “Ext.Dev.”和所载入的文件名将显示在测量结果的左上角。

关闭外部设备补偿 1 从主菜单中选择 Level 菜单。

2 按下 Ext. Dev. Comp. 软键，直到 “off”高亮显示。
测量结果左侧的文字 “Ext.Dev.”将会消失。

注

如果某个文件过去曾经被选用过，那么第一步到第三步可以略过。这
时，可以选择 Level，直接进入第四步。
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删除用于外部设备补偿的文件 要删除包含补偿参数的文件，请执行以下操作：

1 从主菜单中选择 Level > Ext. Dev. Memory。

2 a. 要从 9102 内存中删除某个补偿文件，请按下 Delete Ext. Dev. Comp。
选择一个文件名，再按 ENTER 确认。
补偿文件将从列表中删除。请注意，删除时将不会弹出警报；如果您
选中一个文件并要求将其删除，该文件将会被立即删除。
b. 要删除 9102 中的所有补偿文件，按下 Delete All，再按 ENTER 确认。
所有补偿文件都将被删除。

对信号执行特殊功能

本节将介绍怎样触发测量和怎样限制测量次数。

使用触发器 9102 可以在某个随机的时刻开始信号分析，或者在信号超过某个指定的
门限值时开始测量。根据实际信号电平启动测量的功能只限于零跨度模
式。

选择无需触发的信号分析：

1 从主菜单中按下 Freq > Trigger。
屏幕显示 Trigger 菜单。

2 按下 Free Run 软键。
该软键将高亮显示， 9102 准备好在随机时刻开始测量。

选择一个 RF 信号的触发器门限值

1 从主菜单中按下 Freq > Trigger。
屏幕显示 Trigger 菜单。

2 按下 Video 软键。
Video 软键将高亮显示，弹出一个用以输入触发器电平的输入栏。

3 输入触发器电平 （单位为 dBm），通过按下 GHz/dBm 或者 ENTER 键
完成输入。
触发器门限值显示在功率轴上；该符号还会表示方向（即信号超越门
限值启动测量的方向）。

注

Video 触发器只适用于零跨度模式。在其他模式下，该软键的说明将以
灰色显示。
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4 如有必要，可以通过按下 Slope 软键，在正、反方向之间切换。
方向激活符号将显示在功率轴上 （另见图 36） : 

使用外部触发器

要使用外部设备生成的触发信号，请执行以下操作：

1 将外部设备连接到位于仪器顶部的 EXT. TRIG. 接口。

2 在主菜单中，通过按下 Freq>Trigger 进入 Sweep 菜单。
屏幕将显示 Trigger 菜单。

3 按下 Extern 软键。
该软键将高亮显示。
在启用外部触发器之后， 9102 将会等待接收一个脉冲。一旦 9102 在
外部触发器入口检测到一个脉冲，就会进行一次扫描。此后 9102 将
急需等待下一次触发事件。

图 36 触发测量（时域）
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进行有限次数的测量 9102 可以连续进行测量，也可以限定测量次数。限制测量次数可能有助
于统计分析。

1 从主菜单中选择 Freq>Sweep。
屏幕将显示 Sweep 菜单。

2 选择触发器模式：如需连续测量，按下 Cont. ；如需进行有限次数的
测量，按下 Single。
所选触发器模式将高亮显示。

3 要输入测量次数，请按下 Single Count 软键，输入一个介于 1 到 1000
之间的数值，按下 ENTER。如果触发器模式设为 Single, 9102将会执行
指定次数的测量，而后进入 Hold （保持）模式。

－要重启 Single 模式测量，请按下 HOLD/RUN 功能键或者 Single 软键。

－ 要中止连续测量，请按下HOLD/RUN功能键。再按一次可以恢复测量。

设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据 （请参阅 " 保存和载入曲线 " 第 118 页）。

9102 会为每个频率点测量多个采样值。利用检波器功能，您可以定义用
以选择所显示的采样值的方法。

图 37 两条曲线示例
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选择曲线模式 9102 提供了五种曲线显示模式：

－ 在实际值模式下， 9102 在每条曲线中显示一个全新的测量结果。后

续曲线彼此无关。

－ 在保持模式下，最近一次的测量结果将显示在屏幕上；测量仍然在继
续，但是不会在屏幕上显示。

－ 在最大值保持模式下，9102 会进行新的测量。对于每个频率点，9102
会将新的测量结果与以前的结果进行比较。如果新的测量值大于以前
的测量结果，新的测量值将会称为新的测量结果；否则原有的测量结
果将保持不变。这样，从启用 Max Hold （最大值保持）模式 （或者

修改某个参数）以来的最大测量结果将会被保存并显示。

－ 与之类似，在最小值保持模式下， 9102 会进行新的测量，并将新的

测量结果与以前的结果进行比较。如果新的测量值小于以前的测量结
果，新的测量值将会称为新的测量结果；否则原有的测量结果将保持
不变。这样，从启用 Min Hold （最小值保持）模式 （或者修改某个

参数）以来的最小测量结果将会被保存并显示。

－ 在均值模式下，每个频率点将显示新的测量值和以前的测量值的平均
值。 9102 为平均计算使用了一种递归算法。

如果您想要查看实际测量值，中止并保持最近一次的测量结果，查看每
个频率的最小、最大数据或者平均值，请执行以下操作：

1 在主菜单中选择 Trace。

2 利用水平软键选择您想要修改的曲线 （Trace A 或者 Trace B）。

3 利用垂直软键选择曲线模式 (Actual, Hold, Max hold, Min hold, Average)。
曲线模式将显示在纵轴的左侧，例如 A (ACT)。

注

为了以最快的速度获得有效的结果， Willtek 建议您在选择其他任何模
式之前，先暂时启用实际值模式。

注

在曲线处于保持状态时，测量任务将继续进行，超出极限计数器也将
继续计数。如果启用了第二条曲线，那么第二条曲线也会继续更新。
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启用和关闭第二条曲线 您可以定义两个不同的曲线视图，例如一个显示实际值，另外一个显示
最大值。第一个视图（曲线 A）必须始终激活，但第二个视图可以关闭。
要启用或关闭曲线 B，以及选择曲线模式，请执行以下操作：

1 在主菜单中选择 Trace>Trace B。

2 要启用曲线 B，请选择曲线模式 (Actual, Hold, Max hold, Min hold 或者
Average)。要关闭曲线 B，请选择 Off。
在启用之后，曲线模式将显示在纵轴的左侧，例如 B(MAX)。

曲线 A 减去曲线 B 如前所述，如果您使用了两个不同的曲线视图，您可以通过用曲线 A 减
去曲线 B，显示曲线 A 和曲线 B 之间的差异。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Subtract A -B →
A。

2 选择 on，用曲线A减去曲线 B。在测量结果左侧将会显示“Subtract”，
表示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

注

如果曲线 A 处于保持状态，本功能将无法使用。 Subtract A -B → A 软
键将会以灰色显示。
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曲线 B 加到曲线 A 如果您使用了两个不同的曲线视图，您还可以通过累加曲线 A和曲线 B，
显示这条曲线的总和。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Add A +B → A。

2 选择 on，用曲线 B 加到曲线 A。在测量结果左侧将会显示 “Add”，
表示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

曲线偏移 一旦您使用了两个数学功能中的一个 --Subtract A -B → A 或者 Add A -B
→ A，曲线偏移功能将会启用。如果数学计算导致曲线移动到显示区域
之外，您可以利用该功能调节曲线的显示。为了将曲线重新移入显示区
域，可以利用 Trace Offset 软键调节偏移值，直到曲线回到显示区域。

定义用于计算均值的测量
次数

在曲线模式被设为计算均值时，可能需要 9102 用以计算均值的测量计
数。在曲线菜单中定义的平均次数值同样适用于两条曲线。

9102 采用了一种递归算法，即新的测量结果将通过一个加权因数加入原
有的平均值；下面将介绍怎样修改这个加权因数：

1 选择 Trace 菜单 （从主菜单选择 Trace > Trace A 或者 Trace B）。

2 按下 Average Count 软键。
屏幕显示 Average 输入栏。

3 输入用以计算均值的测量次数 （介于 2 到 128 之间）。

4 按下 ENTER 确认。
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选择检波方式 对于每个新的测量任务，9102 都要从每个频率值的多个测量值中选择一
个或者两个值。检波方式可由用户定义； 9102 提供了下列方式 （参见
图 38）：

－正 / 负峰值：最大值和最小值将被提取，并显示为一个竖条。

－ 正峰值：只显示最大值。

－ 负峰值：只显示最小值。

－采样：一个采样测量值将被提取。

－ 如果您在 9102 上安装并启用了 9132 RMS 检波器选件，您还可以使用

显示测量信号的 RMS 有效电平的均方根检波器。如果没有在您的仪

器上安装 9132 RMS 检波器选件， RMS 检波器将以灰色显示。

检波方式适用于两条曲线。要选择检波方式，请执行以下操作：

1 从主菜单中，选择 Trace>Detect。

2 从垂直软键的 Detector 部分选择曲线检波方式。所选的曲线检波方式
将显示在屏幕左侧。

在 9102 中复制曲线 您可以将曲线 A 的实际测量值复制到曲线 B，反之亦然。这样，您可以
一边在屏幕上显示最新的测量结果，一边继续测量或者调节 9102 手持式
频谱分析仪的设置。目标曲线过去的测量结果将会被删除；目标曲线将
处于保持模式。

要将测量值从一条曲线复制到另外一条曲线，请执行以下操作：

1 从主菜单中，选择 Trace>Trace Function。

2 要将曲线 A 的测量值复制到曲线 B，按下 Copy A → B。
要将曲线 B 的测量值复制到曲线 A，按下 Copy B → A。

图 38 曲线检波方式
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图 39 Trace function 菜单

注

如果您先按下 Copy A → B，再按下 Copy B → A （或者相反顺序），两
条曲线将显示相同的测量结果，并且都将处于保持模式。

图 40 Trace A 菜单
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9102 提供了最多保存 99 条曲线，并随机载入这些曲线的功能。存储的
曲线可以在屏幕上显示，也与最近的测量结果进行比较。另外，存储的
曲线可以通过 9102 附带的 9100 数据交换软件发送到一台 PC 上。如需了
解该软件的详细信息，请参阅第 14 章 "9100 数据交换软件 "。

保存一条曲线 您可以保存曲线 A 或者曲线 B。任何曲线可以用一个不超过 11 个字符的
名称保存。关于在字母数字输入栏中输入文字的步骤，请参阅 " 输入数
字和文字 " 第 24 页。请注意，除了曲线以外，频率范围、电平范围和标
记等仪器设置也将被保存下来。

1 从主菜单中，选择 Trace > Trace Memory。

2 按下 Store Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入曲线名称。要使用某个修改的曲线名称，您可以利用 UP/DOWN
光标键将光标移动到相应的曲线名称。选中的曲线名称也将显示在输
入栏中；利用 LEFT/RIGHT 光标键将光标移动到曲线名称中的相应位
置，输入额外字符或者删除已有字符。

4 按下 ENTER 确认。
输入栏将关闭，曲线将以所选名称保存。

重复使用一个曲线名称 您不能用相同的曲线名称覆盖一个已有的曲线。如果您希望重复使用一
个曲线名称，您必须先删除原有曲线。

载入一条曲线 1 从主菜单中选择 Trace > Trace Memory。

2 按下 Recall Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入需要载入的曲线的名称，或者利用 UP/DOWN 光标键选择一个名
称。

4 按下 ENTER 确认。
输入栏将关闭，所选曲线将显示在屏幕上。

删除一条曲线 您可以删除过去保存的曲线。请注意，在您删除曲线时 9102 将不会发出
警报；如果您选中一个文件并要求将其删除，该文件将会被立即删除。

注

除了曲线以外， 9102 还会载入曲线保存时使用的设置。它们将覆盖现
有设置，例如频率范围、参考电平和标记。
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1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete Trace。
屏幕将会显示一个输入栏，请您输入需要删除的曲线的名称；以及一
个曲线选择对话框。

3 利用 UP/DOWN 光标键选择需要删除的曲线。或者，利用数字键输入
曲线名称。

4 按下 ENTER 确认。
所选文件将从曲线列表中删除。

5 选择另外一条需要删除的曲线。或者按下 ESCAPCE，关闭输入栏和曲
线选择对话框。

删除所有曲线 除了单独删除各条曲线之外，您也可以一次性删除所有曲线。这个步骤
将要求您加以确认。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete All。
屏幕将显示一个提示，请您确认您的选择。

3 按下 ENTER，删除所有曲线。
提示将消失。所有曲线均被删除。

保存和载入仪器设置 要保存或者载入仪器设置，包括频率范围、电平设置和标记等，请执行
" 保存一条曲线 " 和 " 载入一条曲线 " 部分所介绍的操作。
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您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 41 发射模式参数
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Chapter 8 9130 VSWR/DTF 反射测量选件
7

本章将概括介绍 9130 VSWR/DTF 反射测量选件。本章所要讨论的主题包
括：

－ "9130 VSWR/DTF 反射测量选件介绍 " 第 124 页

－ " 技术规格 " 第 124 页

－ " 测量模式 " 第 125 页

－ " 硬件要求 " 第 126 页

－ " 连接 9160 VSWR/DTF 桥 " 第 126 页

－ " 校准 " 第 127 页
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9130 VSWR/DTF 反射测量选件介绍

9130 VSWR/DTF 反射测量选件与 9160 VSWR/DTF 桥可以将 9102 转变为一
个功能齐全的反射测试设备。9130 VSWR/DTF反射测量选件的功能是专门
为满足验收和维护专业天线系统 （例如蜂窝基站）的测试需求而设计
的。该测量选件特别适用于现场应用。但是，它也提供了实验室和服务
应用，例如对无源 RF 设备（如衰减器、匹配板和滤波器）进行发射测量。

在进行反射测量时，9102 的跟踪发生器会充当一个测试信号发生器，同
时频谱分析仪会测量反射信号的功率电平。和仪器一起寄给您的 CD 中
有文件 9100 应用手册 (Applications Giude), 您可查阅到 9130 VSWR/DTF 反
射测量选件的详细应用实例。

技术规格

表 15 9130 VSWR/DTF 反射测量选件的技术规格

测量范围 ≥ 70 dB

测量单位 dB, VSWR, mRho

测量样本数 501

线缆参数编辑方式 自动或者手动

测量方法 矢量或者标量

表 16 9160 VSWR/DTF 桥的技术规格

频率范围 1 MHz 到 4 GHz

方向性 (10MHz 到 3GHz) 典型值 30 dB

插入损耗 ≤ 2 x 10 dB

阻抗 50 欧姆

DUT 端口回波损耗 ≥ 18 dB
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9130 VSWR/DTF 反射测量选件提供了三种额外的测量模式：反射、故障点
距离和线损。如果您在您的 9102 上安装并启用了 9130 VSWR/DTF 反射测
量选件，您将可以在 VSWR/Tracking... 子菜单中看到除信号发生器和发射
以外的这三个子菜单：

－反射
这种模式让您可以在一个视图中测试天线系统在指定频率上的性能
和匹配性。
如需了解怎样利用反射测试进行测量，请参阅 "反射操作 "第 129页。

－故障点距离
这种模式将针对线缆性能，提供对馈线的详细分析。您将可以方便地
发现和定位与线缆有关的问题。如需了解怎样利用故障点距离模式进
行测量，请参阅 " 故障点距离操作 " 第 147 页。

－ 线损
线损模式可以帮助您确定平均线损。如需了解怎样利用线损模式进行
测量，请参阅 " 线损操作 " 第 157 页。

如需了解怎样选择测量模式，请参阅 " 选择测量模式 " 第 26 页。

图 42 VSWR/Tracking 菜单
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下面列出了利用 9130 VSWR/DTF 反射测量选件进行测量的硬件要求和推
荐配置：

－ 9160 VWSR/DTF 桥

－ 9150 跟踪发生器

－用于 N 或者 7/16” 的校准工具

－用于 N 或者 7/16” 的测试端口延长线

如需详细了解 9102 的选件和附件，请参阅 " 选件 " 第 5 页。

连接 9160 VSWR/DTF 桥

发射测量需要使用一个测量桥。9160 VSWR/DTF桥可以被用于非常精确地
测量天线或者其他设备的负载阻抗。它可以涵盖 9102 的全部频率范围。

在设置 9102 进行 VSWR/DTF 反射测量时，只需要将 9160 VSWR/DTF 桥连
接到 RF in 和 RF out 接口，以及仪器顶部的 Multi Port 接口。

如需详细了解9102的接口，请参阅"连接9102手持式频谱分析仪"第12页。

注

强烈建议在反射测量中使用测试端口延长线。在这种测试中，直接连
接天线馈线的做法通常并不可行，因为这些线缆的弹性很低。测试端
口延长线会对测量结果产生微弱的影响。但是，测试结果并不会受到
决定性的影响，因此这种干扰可以忽略不计。
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在开始 VSWR/DTF 测量之前，需要对 9102 进行校准。在校准参考电平时，
必须连接一个带有开路 / 短路和负载参考接口的参考标准。 Willtek 提供
了带有 7/16” 型（公）和 N 型（公）接口的开路 / 短路 / 负载校准工具，
以及带有不同标准接口（N 和 7/16” DIN）的测试端口延长线。如需了解
订购信息，请参阅 " 选件 " 第 5 页。如需了解反射、故障点距离和线损
模式下的校准步骤，请参阅第 8 章、第 9 章和第 10 章。
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Chapter 9 反射操作
8

本章将介绍 9102 在反射模式下的功能。本章所要讨论的主题包括：

－ " 反射模式介绍 " 第 130 页

－ " 选择测量模式 " 第 131 页

－ " 准备步骤 " 第 131 页

－ " 更改频率设置 " 第 132 页

－ " 反射校准 " 第 135 页

－ " 修改测量指标设置 " 第 136 页

－ " 设置电平参数 " 第 137 页

－ " 进行有限次数的测量 " 第 139 页

－ " 设置曲线 " 第 139 页

－ " 保存和载入曲线 " 第 142 页

－ " 使用极限 " 第 144 页

－ " 查看反射模式参数 " 第 145 页
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反射模式介绍

用于专业应用的现代天线系统都具有很低的反射率和良好的匹配性。天
线系统的所有组件都应当匹配到 50 ―欧姆 专业无线设备的标准阻抗。如
果所有组件都匹配，那么系统的效率将可以达到最高水平。匹配性越
好，辐射能量与损耗 RF 能量的比值也就越高。

反射模式让您可以在一个视图中测试天线系统在指定频率上的性能和匹
配性，以及在验收和维护时检验系统性能。

在进行反射测量时，9102 的跟踪发生器会生成一个测试信号。9102 会测
量天线反射的信号的功率电平。如果要在 9102 的全部频率范围上非常准
确地测量天线的负载阻抗，必须使用 9160 VSWR DTF 桥。反射测量模式
可以提供标量和矢量的反射测量，并且可以显示所有常用的反射测量指
标，例如回波损耗、 rho、 VSWR 和反射功率比。

图 43 显示了一个回波损耗测量结果窗口。

在测量结果窗口上，标记通常被设置在上行和下行频段极限所在位置。
它们之间的范围是所显示频谱中最需要注意的部分。另外两个标记被设
置在这些频段的最大反射点，以指明被测天线系统的回波损耗是否处于
正常反射极限 (17 到 20dB) 之内。和仪器一起寄给您的 CD 中有应用手册
(Applications Guide), 您可查阅到反射模式的详细应用实例。

图 43 回波损耗测量示例
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要选择信号发生器模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕将显示 Mode 菜单。

2 选择 (VSWR/)Tracking ... > Reflection。
屏幕将显示 Reflection 主菜单。

准备步骤

在开始测量之前，必须执行下列准备步骤：

－ 连接 9160 VSWR/DTF 桥。

如需了解这个步骤的细节，请参阅"连接9160 VSWR/DTF桥"第126页。

－ 选择需要测量的频段

－ 校准

下一节将介绍怎样更改 9102 的频率设置，之后将介绍校准步骤的细节。

注

只有在您的仪器上安装并激活了 9130 VSWR/OTF 反射测量选件后 , 才可
以选用此模式。
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更改频率设置

您可以通过多种方式设置需要测量的频率范围；频率范围可以利用起始
频率和截止频率（例如显示窗口上的第一个和最后一个频率）表示，或
者利用中心频率和跨度（例如中心和频率范围）表示，或者利用中心频
率、跨度、起始频率和截止频率的其他组合表示。

所有四个参数都可以通过 Freq 菜单查看。但是在主菜单中，只会显示上
述组合中的一种，具体选择哪一种取决于最后输入的参数。

设置起始频率和截止频率 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Start 和 Stop 软键。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

图 44 频率菜单

注

修改一个频率参数可能会影响到相关的参数。例如：如果您将频率跨
度修改为 4GHz，那么起始频率和截止频率将会分别变为 0 和 4GHz。
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4 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS）关联的确认键，完成输入。
如果输入的起始频率低于截止频率，那么横轴将显示起始频率到截止
频率的范围。如果新的起始频率高于或者等于截止频率，开始频率将
被用作零跨度的中心频率，例如所选频率的信号将在时域显示。

5 按下 Stop 软键，输入显示窗口右端的频率。
您也可以通过修改频率模式，将用于设置起始频率和截止频率的软键
放在主菜单中，详见 " 修改主菜单中显示的频率参数 " 第 106 页。

设置中心频率和跨度 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 UP/DOWN 光标键的步进宽度。

2 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

3 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS ；如果单位为千赫兹，按下 KHZ/dBµV/
MS ；如果单位为赫兹，按下 ENTER）关联的确认键，完成输入。

4 按下 Span 软键，输入从显示窗口左端到右端的频率范围。
您也可以通过修改频率模式，将用于设置中心频率和跨度的软键放在
主菜单中，详见下面的 " 修改主菜单中显示的频率参数 "。

修改主菜单中显示的频率
参数

Reflection 主菜单会显示两个用以定义显示窗口的频率范围的软键。如前
所述，可以通过不同的方式定义频率范围；您可以将这两个软键设为两
个可选组合中的一种，方法为：

1 从 Reflection 主菜单中，选择 Freq > Freq Mode。

2 选择您希望在主菜单中看到的软键组合 (Start/Stop 或者 Center/Span)。

3 按下 Main... 软键，回到主菜单。
屏幕将显示主菜单，以及所选的软键组合。

请注意，频率横轴的说明会随着所选参数组合的改变而改变。
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查看完整的频段 要将频率范围改为 9102 支持的全部带宽，请执行以下操作：

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Full Span 软键。
最左端的频率将变为 0，最右端的频率将变为 4GHz。

在时域进行测量 某个选定中心频率上的测量结果也可以在时域显示。

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Center 软键，输入需要的中心频率；通过选择确认键中的适当单
位，关闭输入栏。

3 按下 Zero Span 软键。
横轴将变为时间轴。刻度宽度与扫描时间一致。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键 (UP, DOWN) 增大或者减小当前设置。光标键的按键
步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 从 Reflection 主菜单中，选择 Freq。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。

3 输入一个新的频率值，按下 ENTER 关闭输入栏。自动 / 手动选择切换
到手动方式，所选的频率步进宽度将显示在软键上。

将频率步进宽度选择方式设为自动

1 从主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 “auto”选项高亮显示。
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反射校准

在开始测量之前，需要用一个参考匹配电阻器对 9102 进行校正。如需了
解校正工具的细节信息，请参阅 " 选件 " 第 5 页和 " 校准 " 第 127 页。在
结果显示窗口左侧会显示一个红色图标，提醒您需要进行校正。您可以
为反射测量进行矢量或者标量校正。要为您的反射测量任务校正 9102，
请执行以下操作：

1 将测试端口延长线连接到 9160 VSWR/DTF 桥。

2 在Reflection主菜单中，按下Reflection Cal.软键。屏幕将显示Reflection
Calibration 菜单。

3 在该菜单中，您可以通过按下 Scalar 或者 Vector 软键，选择您的测量
任务需要使用的模式。标量测量可以测量反射信号的功率电平。矢量
测量更为精确，而且还可以测量反射信号的相位。它可以提高测量准
确度和回波损耗的测量范围。如图 45 所示，9102 将通过屏幕提示引
导您逐步完成校正任务。在出现图 45 所显示的提示时，请将校正工
具连接到测试端口延长线，再按下 Continue。您可以通过按下 Cancel!
软键取消校准任务。

4 在校正完成之后，屏幕将会再次显示 Reflection 主菜单。测量结果窗
口的左侧的图标将变为绿色，显示 ”Calib'd” （校正完毕）。

一旦校正工具被卸载，测量窗口将显示完全反射 （回波损耗为 0dB）。
9102 现在已经做好了进行反射测量的准备。

图 45 Reflection Calibration 菜单
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修改测量指标设置

反射模式支持所有常见的反射测量指标：

－回波损耗
最常见的反射测量指标。利用该指标，可以测量反射信号相对于测试
信号功率的衰减程度。因为回波损耗与信号功率相关联，所以这个测
量指标非常便于处理。例如，如果回波损耗值为 20dB，就意味着 1/
100 的发射功率被反射到发射端。通常，一个天线要能正常工作，回

波损耗值得应不低于 17dB。

－ VSWR
这个测量指标建立在 RF 信号电压的基础上。它代表了发射电压和接

收电压的比率。利用特殊的准线图，所有测量指标都可以方便地互相
比较。例如，回波损耗值 20dB 相当于 VSWR 值 1.22。

－ 反射因数
这个测量指标也建立在 RF 信号电压的基础上，以 mRho 为单位显示反

射情况。

－反射功率
这个测量指标以比例的形式显示发射功率比。

要为您的反射测量选择测量指标，请执行以下操作：

1 在 Reflection 主菜单中选择 Level > Units。屏幕右侧将显示 Unit 菜单。

2 按下相应软键，选择 Return Loss, VSWR, Refl.Factor 或者 Refl.Power, 再按
ENTER 确认。所选的测量指标将显示在测量结果窗口的左侧。

注

在进行多次测量时，如果温度等因素发生变化，必须重新校准 9102。
这是一种需要定期执行的任务。而且，如果您修改了频带，也必须重
新校正9102。只要9102需要进行校准，屏幕上就会显示红色“Calibrate”
图标。
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设置电平参数

在为您的反射测量选择了测量指标之后，您可以调节电平参数。根据您
通过 Unit 菜单选择的测量指标， Level 菜单的显示内容也会随之发生变
化，以便让您可以为每个测量指标设置电平参数。

设置回波损耗的参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏；或
者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

调节回波损耗的纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

设置 VSWR 的最大值 1 在主菜单中，按下 Max VSWR 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的 VSWR 最大值 , 再通过相应的确认键关闭输入栏
或者利用 UP/DOWN 光标键。
新的 VSWR 最大值将显示在纵轴顶部。

调节 VSWR 的刻度 纵轴 （功率）可以在每分度 （窗口网格中的竖线） 1 到 1000 的范围内
修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 VSWR Scale 软键。
屏幕将显示 VSWR Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。
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设置反射因数的最大值 1 在主菜单中，按下 Max Refl. Factor 软键，或者先选择 Level，再选择
Max Refl. Factor。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的反射因数最大值，再通过相应的确认键关闭输入
栏；或者利用 UP/DOWN 光标键。
新的反射因数最大值将显示在纵轴顶部。

调节反射因数的刻度 纵轴（功率）可以在每分度（窗口网格中的竖线） 1 到 2000mRho 的范
围内修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Refl. Factor Scale 软键。
屏幕将显示 Refl. Factor Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

设置反射功率的最大值 1 在主菜单中，按下 Max Refl. Power 软键，或者先选择 Level，再选择
Max Refl. Power。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的反射因数最大值，再通过相应的确认键关闭输入
栏；或者利用 UP/DOWN 光标键。
新的反射因数最大值将显示在纵轴顶部。

调节反射功率的刻度 纵轴（功率）可以在每分度（窗口网格中的竖线） 1 到 200% 的范围内
修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Refl. Power Scale 软键。
屏幕将显示 Refl. Power Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。
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进行有限次数的测量

9102 可以连续进行测量，也可以限定测量次数。限制测量次数可能有助
于统计分析。

1 从主菜单中选择 Freq>Sweep。
屏幕将显示 Sweep 菜单。

2 选择触发器模式：如需连续测量，按下 Cont. ；如需进行有限次数的
测量，按下 Single。
所选触发器模式将高亮显示。

3 要输入测量次数，请按下 Single Count 软键，输入一个介于 1 到 1000
之间的数值，按下 ENTER。如果触发器模式设为 Single, 9102将会执行
指定次数的测量，而后进入 Hold （保持）模式。

－要重启 Single 模式测量，请按下 HOLD/RUN 功能键或者 Single 软键。

－ 要中止连续测量，请按下HOLD/RUN功能键。再按一次可以恢复测量。

设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据 （请参阅 " 保存和载入曲线 " 第 142 页）。

选择曲线模式 9102 提供了五种曲线显示模式：

－ 在实际值模式下， 9102 在每条曲线中显示一个全新的测量结果。后

续曲线彼此无关。

－ 在保持模式下，最近一次的测量结果将显示在屏幕上；测量仍然在继
续，但是不会在屏幕上显示。

－在最大值保持模式下，9102 会进行新的测量。对于每个频率点，9102
会将新的测量结果与以前的结果进行比较。如果新的测量值大于以前
的测量结果，新的测量值将会称为新的测量结果；否则原有的测量结
果将保持不变。这样，从启用 Max Hold （最大值保持）模式 （或者

修改某个参数）以来的最大测量结果将会被保存并显示。

－ 与之类似，在最小值保持模式下， 9102 会进行新的测量，并将新的

测量结果与以前的结果进行比较。如果新的测量值小于以前的测量结
果，新的测量值将会称为新的测量结果；否则原有的测量结果将保持
不变。这样，从启用 Min Hold （最小值保持）模式 （或者修改某个

参数）以来的最小测量结果将会被保存并显示。
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－ 在均值模式下，每个频率点将显示新的测量值和以前的测量值的平均
值。 9102 为平均计算使用了一种递归算法。

如果您想要查看实际测量值，中止并保持最近一次的测量结果，查看每
个频率的最小、最大数据或者平均值，请执行以下操作：

1 在主菜单中选择 Trace。

2 利用水平软键选择您想要修改的曲线 （Trace A 或者 Trace B）。

3 利用垂直软键选择曲线模式 (Actual, Hold, Max hold, Min hold, Average)。
曲线模式将显示在纵轴的左侧，例如 A (ACT)。

启用和关闭第二条曲线 您可以定义两个不同的曲线视图，例如一个显示实际值，另外一个显示
最大值。第一个视图（曲线 A）必须始终激活，但第二个视图可以关闭。
要启用或关闭曲线 B，以及选择曲线模式，请执行以下操作：

1 在主菜单中选择 Trace>Trace B。

2 要启用曲线 B，请选择曲线模式 (Actual, Hold, Max hold, Min hold 或者
Average)。要关闭曲线 B，请选择 Off。在启用之后，曲线模式将显示在
纵轴的左侧，例如 B(MAX)。

注

为了以最快的速度获得有效的结果， Willtek 建议您在选择其他任何模
式之前，先暂时启用实际值模式。

注

在曲线处于保持状态时，测量任务将继续进行，超出极限计数器也将
继续计数。如果启用了第二条曲线，那么第二条曲线也会继续更新。
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曲线 A 减去曲线 B 如前所述，如果您使用了两个不同的曲线视图，您可以通过用曲线 A 减
去曲线 B，显示曲线 A 和曲线 B 之间的差异。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Subtract A -B →
A。

2 选择 on，用曲线A减去曲线 B。在测量结果左侧将会显示“Subtract”，
表示目前正在进行一项数学运算。

3 计算结果显示在曲线 A。

曲线 B 加到曲线 A 如果您使用了两个不同的曲线视图，您还可以通过累加曲线 A和曲线 B，
显示这条曲线的总和。请执行以下操作：

1 在 Trace 菜单中，选择软键 Trace Function，再选择软键 Add A +B → A。

2 选择 on，用曲线 B 加到曲线 A。在测量结果左侧将会显示 “Add”，
表示目前正在进行一项数学运算。计算结果显示在曲线 A。

曲线偏移 一旦您使用了两个数学功能中的一个 --Subtract A +B → A 或者 Add A +B
→ A，曲线偏移功能将会启用。如果数学计算导致曲线移动到显示区域
之外，您可以利用该功能调节曲线的显示。为了将曲线重新移入显示区
域，可以利用 Trace Offset 软键调节偏移值，直到曲线回到显示区域。

定义用于计算均值的测量
次数

在曲线模式被设为计算均值时，可能需要 9102 用以计算均值的测量计
数。在曲线菜单中定义的平均次数值同样适用于两条曲线。

9102 采用了一种递归算法，即新的测量结果将通过一个加权因数加入原
有的平均值；下面将介绍怎样修改这个加权因数：

1 进入 Trace 菜单 （从主菜单选择 Trace > Trace A 或者 Trace B）。

2 按下 Average Count 软键。
屏幕显示 Average 输入栏。

注

如果曲线 A 处于保持状态，本功能将无法使用。 Subtract A -B → A 软
键将会以灰色显示。
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3 输入用以计算均值的测量次数 （介于 2 到 128 之间）。

4 按下 ENTER 确认。

在 9102 中复制曲线 您可以将曲线 A 的实际测量值复制到曲线 B，反之亦然。这样，您可以
一边在屏幕上显示最新的测量结果，一边继续测量或者调节 9102 手持式
频谱分析仪的设置。目标曲线过去的测量结果将会被删除；目标曲线将
处于保持模式。

要将测量值从一条曲线复制到另外一条曲线，请执行以下操作：

1. 从主菜单中，选择 Trace>Trace Function。

2. 要将曲线 A 的测量值复制到曲线 B，按下 Copy A → B。

要将曲线 B 的测量值复制到曲线 A，按下 Copy B → A。

保存和载入曲线

9102 提供了最多保存 99 条曲线，并随机载入这些曲线的功能。存储的
曲线可以在屏幕上显示，也与最近的测量结果进行比较。另外，存储的
曲线可以通过 9102 附带的 9100 数据交换软件发送到一台 PC 上。如需了
解该软件的详细信息，请参阅 "9100 数据交换软件 " 第 201 页。

保存一条曲线 您可以保存曲线 A 或者曲线 B。任何曲线可以用一个不超过 11 个字符的
名称保存。关于在字母数字输入栏中输入文字的步骤，请参阅 " 输入数
字和文字 " 第 24 页。请注意，除了曲线以外，频率范围、电平范围和标
记等仪器设置也将被保存下来。

1 从主菜单中，选择 Trace > Trace Memory。

2 按下 Store Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入曲线名称。要使用某个修改的曲线名称，您可以利用 UP/DOWN
光标键将光标移动到相应的曲线名称。选中的曲线名称也将显示在输
入栏中；利用 LEFT/RIGHT 光标键将光标移动到曲线名称中的相应位
置，输入额外字符或者删除已有字符。

注

如果您先按下 Copy A → B，再按下 Copy B → A （或者相反顺序），两
条曲线将显示相同的测量结果，并且都将处于保持模式。
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保存和载入曲线
4 按下 ENTER 确认。
输入栏将关闭，曲线将以所选名称保存。

重复使用一个曲线名称 您不能用相同的曲线名称覆盖一个已有的曲线。如果您希望重复使用一
个曲线名称，您必须先删除原有曲线。

载入一条曲线 1 从主菜单中选择 Trace > Trace Memory。

2 按下 Recall Trace。
屏幕将显示一个输入栏，允许您输入曲线名称。在输入栏下方列出了
现有的曲线。

3 输入需要载入的曲线名称，或者利用UP/DOWN光标键选择一个名称。

4 按下 ENTER 确认。
输入栏将关闭，所选曲线将显示在屏幕上。

删除一条曲线 存储的曲线可以删除。请留意这个操作没有警告提示 ; 一旦您选择和要
求了删除一个文件 , 文件会被立即删除。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete Trace。
屏幕显示一个输入栏，请输入要删除曲线的名称。同时屏幕上列出了
曲线选择框。

3 用Up/Down光标键选中要删除的曲线。另外 ,用数字键输入曲线名称。

4 按下 ENTER 确认。
该曲线从曲线列表中删除。

5 选择另一条要删除的曲线 ,或按下 ESCAPE, 离开输入栏和曲线选择框。

删除所有曲线 除了单独删除各条曲线之外，您也可以一次性删除所有曲线。这个步骤
将要求您加以确认。

1 从主菜单中选择 Trace > Trace Memory。

2 按下 Delete All。
屏幕将显示一个提示，请您确认您的选择。

3 按下 ENTER，删除所有曲线。
提示将消失。所有曲线均被删除。

注

除了曲线以外， 9102 还会载入曲线保存时使用的设置。它们将覆盖现
有设置，例如频率范围、参考电平和标记。
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使用极限
保存和载入仪器设置 要保存或者载入仪器设置，包括频率范围、电平设置和标记等，请执行
" 保存一条曲线 " 和 " 载入一条曲线 " 部分所介绍的操作。

使用极限

在启用用于表示测量频段的极限线时，频段的两端和反射极限将会在同
一个窗口中显示：9102 提供了一个简便的 Pass/Fail （不超出 / 超出）标
示，并且会在屏幕上显示极限线。

如果发射高于门限值，测试结果将显示为“Fail”。如需了解关于定义和
使用极限线的详细信息，请参阅 " 使用极限线 " 第 31 页。

图 46 测量结果窗口示例
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查看反射模式参数
查看反射模式参数

您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 47 反射模式参数
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查看反射模式参数
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Chapter 10 故障点距离操作
9

本章将介绍 9102 在故障点距离模式下的功能。本章所要讨论的主题包
括：

－ " 故障点距离模式介绍 " 第 148 页

－ " 选择测量模式 " 第 149 页

－ " 准备步骤 " 第 149 页

－ " 选择测量指标 " 第 149 页

－ " 设置线缆长度 " 第 150 页

－ " 设置线缆参数 " 第 150 页

－ " 设置中心频率和跨度 " 第 151 页

－ " 故障点距离校正 " 第 152 页

－ " 设置电平参数 " 第 153 页

－ " 设置曲线 " 第 154 页

－ " 使用极限 " 第 154 页

－ " 查看故障点距离参数 " 第 155 页
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故障点距离模式介绍
故障点距离模式介绍

故障点距离测量对于安装天线非常重要。这项功能可以测量反射指标随
线缆的变化情况，以发现和定位接口松动、线缆绞缠、浸水和其他与线
缆有关的问题。这种测试也被称为结构回波损耗，它可以准确地显示指
定区域中某个特定的线缆位置的反射指标。这样，您就可以方便地找出
出现问题的位置。 9102 可以对最长可达 2000 米的天线馈线进行详细的
分析。较高的 501 点测量分辨率可以检测出幅度很小的反射指标，并在
屏幕上显示故障点距离，帮助您迅速地、有效地诊断故障。

图 48显示了一个故障点距离测量结果窗口。与其他测量模式一样，您可
以利用标记标注所有尖峰。在故障点距离模式下，标记将以直线方式显
示。和仪器一起寄给您的 CD 中有应用手册 (Applications Guide), 您可查阅
到故障点距离模式的详细应用实例。

图 48 故障点距离测量示例
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选择测量模式
选择测量模式

要选择信号发生器模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕将显示 Mode 菜单。

2 选择 (VSWR/)Tracking ... > Distance to Fault。
屏幕将显示 Distance to Fault 主菜单。

准备步骤

在开始测量之前，必须执行下列准备步骤：

－ 连接 9160 VSWR/DTF 桥。

如需了解这个步骤的细节，请参阅"连接9160 VSWR/DTF桥"第126页。

－ 选择反射测量指标

－ 设置线缆参数，例如线缆长度

－设置中心频率和跨度

－校准

下面几节将介绍怎样选择测量指标、设置线缆参数、选择频率和校正。

选择测量指标

在测量故障点距离时，首先要做的是选择测量指标。故障点距离模式提
供了两个测量指标：dB 和 mRho。DTF 测量适合使用线性刻度测量指标，
例如反射因数 Rho。因此， mRho 是缺省测量指标。

要为您的故障点距离测量选择测量指标，请执行以下步骤：

1 在 Distance to Fault 主菜单中，选择 Level > Units。屏幕右侧将显示 Unit
菜单。

2 通过按下相应软键，选择 dB 或者 mRho，再按下 ENTER 确认。所选测
量指标将显示在测量结果窗口的左侧：如果您选择 dB，则显示“Ref.”
和 “dB”；如果您选择 Rho，则显示 “Refl. Factor”和 “mRho”。

注

只有当您的仪器上安装并激活了 9130 VSWR/DTF 反射测量选件后 , 该模
式才可被选用。
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第九章 故障点距离操作
设置线缆长度
设置线缆长度

线缆长度是DTF测量最重要的参数之一。为了获得更加真实的显示结果，
建议将线缆长度设为比实际线缆长度高 10% 的值。线缆长度可以用米或
者英尺作为单位。

选择距离单位 要选择距离单位，请执行以下操作：

1 在 Distance to Fault 主菜单中，按下 Distance Unit 软键。

2 将软键切换到需要选择的单位 -- 米或者英尺，按 ENTER 确认。该单
位将显示在结果显示窗口的线缆长度栏和 Cable Length 输入栏中。

设置长度 要设置线缆长度，请执行以下操作：

1 在 Distance to Fault 主菜单中，按下 Cable Length 软键。屏幕将显示
Cable Length 输入栏。

2 按照设定的单位输入线缆长度，按 ENTER 确认。

设置线缆参数

Willtek 可以为在安装天线时最常使用的同轴电缆提供预定义的线缆参数
文件。这些文件可以被方便地上载到 9102。但是，罕见线缆的参数则可
以在 9102 上逐步设置。

使用预定义的参数文件 您可以通过 9100 数据交换软件上载包含预定义的线缆类型的文件。如需
了解上载步骤的详细信息，请参阅 "9100 数据交换软件 " 第 201 页。在
上载文件之后，这些线缆类型将保存在您的 9102 之中，可供选择。

要为 DTF 测量选择一个线缆类型，请执行以下步骤：

1 在 Distance to Fault 主菜单中，选择 Cable > Cable Memory。屏幕将显示
Cable Memory 菜单。

2 按下 Recall Cable Type软键。屏幕上将显示一个包含系统中保存的所有
线缆类型的下拉列表。

3 利用 UP/DOWN 光标键选择所要使用的线缆类型，按下 ENTER 确认。
所选线缆类型的设置这时会被自动用于 DTF 测量。
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第九章 故障点距离操作
设置中心频率和跨度
逐步设置参数 在测量类型罕见的线缆时，可以通过 Cable Setting 菜单设置参数。如需
了解应当输入的数值，请参考线缆制造商为被测线缆提供的信息。要手
动设置线缆参数，请执行以下步骤：

1 在 Distance to Fault 主菜单中，选择 Cable > Cable Setting。屏幕将显示
Cable Setting 菜单。

2 要设置被测线缆的绝缘率 （与速度因数相关），请按下 Cable Dielec.
软键。屏幕将显示 Cable Dielec. 输入栏。输入线缆绝缘率，按 ENTER
确认。

3 要设置被测线缆的传播速度 （与绝缘率相关） ，按下 Cable Velocity
Factor。屏幕将显示 Cable Velocity Factor 输入栏。输入速度因数，按
ENTER 确认。

4 要设置线缆的截止频率（单位为GHz），即线缆所能传输的最高频率，
按下 Cut Off Freq. 软键。屏幕将显示 Cut Off Frequency 输入栏。输入频
率，按 ENTER 确认。

5 要设置被测线缆的衰减率 （单位为每 100 米 dBm 数，或者每 100 英
尺 dBm 数），按下 Cable Attn. 软键。该软键可以在 dB/100m 和 dB/100ft
之间切换。在按下该软键之后，屏幕将显示 Cable Attenuation 输入栏。
输入衰减率，按 ENTER 确认。

设置中心频率和跨度

1 按下 CENT 功能键，或者 Distance to Fault 主菜单上的 Center 软键。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 UP/DOWN 光标键的步进宽度。

2 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

3 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS ；如果单位为千赫兹，按下 KHZ/dBµV/
MS ；如果单位为赫兹，按下 ENTER）关联的确认键，完成输入。

4 按下 Span 软键。如果您想要手动设置跨度，请输入从显示窗口左端
到右端的频率范围。如果您想要自动设置跨度，请将 Span 软键切换
到 auto 状态。
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故障点距离校正
故障点距离校正

在开始测量之前，需要用一个参考匹配电阻器对 9102 进行校正。如需了
解校正工具的细节信息，请参阅 " 选件 " 第 5 页和 " 校准 " 第 127 页。在
结果显示窗口左侧会显示一个红色图标，提醒您需要进行校正。要为您
的故障点距离测量任务校正 9102，请执行以下操作：

1 将测试端口延长线连接到 9160 VSWR/DTF 桥。

2 在 Distance to Fault 主菜单中，按下 DTF Cal. 软键。屏幕将显示 Distance
to Fault Calibration 菜单。

3 如图 49 所示，9102 将通过屏幕提示引导您逐步完成校正任务。在出
现图 49 所显示的提示时，请将校正工具连接到测试端口延长线，再
按下 Continue。您可以通过按下 Cancel! 软键取消校正任务。

4 在校正完成之后，屏幕将会再次显示 Distance to Fault 主菜单。测量结
果窗口的左侧的图标将变为绿色，显示 ”Calib’ d” （校准完毕）。

注

如果您设置的中心频率与线缆截止频率相等，您将无法进行有效的测
量，因为截止频率限制了线缆所传输信号的最高频率。在这种情况下，
测量结果将没有任何意义。如需了解设置线缆截止频率的详细信息，
请参阅 " 设置线缆参数 " 第 150 页。

图 49 Distance to Fault Calibration 菜单
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设置电平参数
设置电平参数

在为您的故障点距离测量设置了测量指标之后，您可以调节电平参数。
根据您通过 Unit 菜单选择的测量指标，Level 菜单的显示内容也会随之发
生变化，以便让您可以为每个测量指标设置电平参数。

设置 dB 的参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏；或
者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

调节 dB 的纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dBµS 键确认，或者用 UP/DOWN 光标键选择。

设置反射因数的最大值 1 在主菜单中，按下Max Refl Factor软键，或者先选择Level，再选择Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的反射因数最大值，再通过相应的确认键关闭输入
栏或者利用 UP/DOWN 光标键。
新的反射因数最大值将显示在纵轴顶部。

调节反射因数的刻度 纵轴（功率）可以在每分度（窗口网格中的竖线） 0 到 2000mRho 的范
围内修改，具体操作如下：

注

在进行多次测量时，如果温度等因素发生变化，必须重新校准 9102。
这是一种需要定期执行的任务。而且，如果您修改了频带，也必须重
新校准9102。只要9102需要进行校准，屏幕上就会显示红色“Calibrate”
图标。
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设置曲线
1 在主菜单中选择 Level。

2 按下 Refl. Factor Scale 软键。
屏幕将显示 Refl. Factor Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据。如需了解详细信息，请参阅 " 设置曲线 " 第 139 页和第 8 章 " 反射
操作 "。

使用极限

与反射模式一样，您还可以为故障点距离测量使用极限线。如需了解使
用极限的详细信息请参阅 "使用极限线 "第31页和第2章 "一般性操作 "。
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查看故障点距离参数
查看故障点距离参数

您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 50 故障点距离参数
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查看故障点距离参数
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Chapter 11 线损操作
10

本章将介绍 9102 在线损模式下的功能。本章所要讨论的主题包括：

－ " 线损模式介绍 " 第 158 页

－ " 选择测量模式 " 第 158 页

－ " 准备步骤 " 第 159 页

－ " 更改频率设置 " 第 159 页

－ " 线损校准 " 第 162 页

－ " 设置电平参数 " 第 163 页

－ " 进行有限次数的测量 " 第 163 页

－ " 使用极限 " 第 164 页

－ " 查看线损参数 " 第 164 页
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第十章  线损操作
线损模式介绍
线损模式介绍

线损模式是一种用于检测线缆的传输质量的测量模式。它能够以 dB为单
位，显示平均线损。在测量线损时，需要使用与其他 VSWR/DTF 测量模式
类似的参数、步骤和线缆校准方法。

选择测量模式

要选择信号发生器模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕将显示 Mode 菜单。

2 选择 VSWR/Tracking ... >Cable Loss。
屏幕将显示 Cable Loss 主菜单。

图 51 线损测量窗口

注

如果 9130 VSWR/DTF 反射测量选件在您的仪器上已安装并激活 , 方可使
用这种模式。
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准备步骤

在开始测量之前，必须执行下列准备步骤：

－ 连接 9160 VSWR/DTF 桥。

如需了解这个步骤的细节，请参阅"连接9160 VSWR/DTF桥"第126页。

－ 选择需要选择的频段

－ 校准

下一节将介绍怎样更改 9102 上的频率设置和校准方法。

更改频率设置

您可以通过多种方式设置需要测量的频率范围；频率范围可以利用起始
频率和截止频率（例如显示窗口上的第一个和最后一个频率）表示，或
者利用中心频率和跨度（例如中心和频率范围）表示，或者利用中心频
率、跨度、起始频率和截止频率的其他组合表示。

所有四个参数都可以通过 Freq 菜单查看。但是在主菜单中，只会显示上
述组合中的一种，具体选择哪一种取决于最后输入的参数。

图 52 频率菜单
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设置起始频率和截止频率 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Start 和 Stop 软键。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

4 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS）关联的确认键，完成输入。
如果输入的起始频率低于截止频率，那么横轴将显示起始频率到截止
频率的范围。如果新的起始频率高于或者等于截止频率，开始频率将
被用作零跨度的中心频率，例如所选频率的信号将在时域显示。

5 按下 Stop 软键，输入显示窗口右端的频率。

您也可以通过修改频率模式，将用于设置起始频率和截止频率的软键放
在主菜单中，详见 " 修改主菜单中显示的频率参数 "。

设置中心频率和跨度 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 UP/DOWN 光标键的步进宽度。

2 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

3 按下一个与相应单位 （如果单位为吉赫兹，按下 GHz/dBm ；如果单
位为兆赫兹，按下 MHZ/dB/µS ；如果单位为千赫兹，按下 KHZ/dBµV/
MS ；如果单位为赫兹，按下 ENTER）关联的确认键，完成输入。

4 按下 Span 软键，输入从显示窗口左端到右端的频率范围。

您也可以通过修改频率模式，将用于设置中心频率和跨度的软键放在主
菜单中，详见下面的 " 修改主菜单中显示的频率参数 "。

注

修改一个频率参数可能会影响到相关的参数。例如：如果您将频率跨
度修改为 4GHz，那么起始频率和截止频率将会分别变为 0 和 4GHz。
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修改主菜单中显示的频率
参数

Reflection 主菜单会显示两个用以定义显示窗口的频率范围的软键。如前
所述，可以通过不同的方式定义频率范围；您可以将这两个软键设为两
个可选组合中的一种，方法为：

1 从 Reflection 主菜单中，选择 Freq > Freq Mode。

2 选择您希望在主菜单中看到的软键组合 (Start/Stop 或者 Center/Span)。

3 按下 Main... 软键，回到主菜单。
屏幕将显示主菜单，以及所选的软键组合。

请注意，频率横轴的说明会随着所选参数组合的改变而改变。

查看完整的频段 要将频率范围改为 9102 支持的全部带宽，请执行以下操作：

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Full Span 软键。
最左端的频率将变为 0，最右端的频率将变为 4GHz。

在时域进行测量 某个选定中心频率上的测量结果也可以在时域显示。

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Center 软键，输入需要的中心频率；通过选择确认键中的适当单
位，关闭输入栏。

3 按下 Zero Span 软键。
横轴将变为时间轴。刻度宽度与扫描时间一致。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键 (UP/DOWN) 增大或者减小当前设置。光标键的按键
步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 从 Transmission 主菜单中，选择 Freq。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。
9102 手持式频谱分析仪 4.00 版本 161



第十章  线损操作
线损校准
3 输入一个新的频率值，按下 ENTER 关闭输入栏。自动 / 手动选择切换
到手动方式，所选的频率步进宽度将显示在软键上。

将频率步进宽度选择方式设为自动

1 从主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 “auto”选项高亮显示。

线损校准

在开始测量之前，需要用一个参考匹配电阻器对 9102 进行校准。如需了
解校准工具的细节信息，请参阅 " 选件 " 第 5 页和 " 校准 " 第 127 页。在
结果显示窗口左侧会显示一个红色图标，提醒您需要进行校准。要为您
的线损测量任务校准 9102，请执行以下操作：

1 将测试端口延长线连接到 9160 VSWR/DTF 桥。

2 在 Reflection 主菜单中，按下 Cable Loss Cal. 软键。屏幕将显示 Cable
Loss Calibration 菜单。

3 如图 53 所示，9102 将通过屏幕提示引导您逐步完成校准任务。在出
现图 49 所显示的提示时，请将校准工具连接到测试端口延长线，再
按下 Continue。您可以通过按下 Cancel! 软键取消校准任务。

4 在校准完成之后，屏幕将会再次显示 Reflection 主菜单。测量结果窗
口的左侧的图标将变为绿色，显示 ”Calib'd” （校准完毕）。

图 53 Cable Loss Calibration 菜单
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一旦校准工具被卸载，测量窗口将显示完全反射 （回波损耗为 0dB）。
9102 现在已经做好了进行反射测量的准备。

设置电平参数

设置参考电平 1 在主菜单中，按下 Ref. 软键，或者先选择 Level，再选择 Ref。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

2 利用数字键输入新的参考电平，再通过相应的确认键关闭输入栏；或
者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

调节纵轴刻度 纵轴（功率）可以在每分度（窗口网格中的竖线）1 到 20dB 的范围内，
以 1-3-5 的步进修改，具体操作如下：

1 在主菜单中选择 Level。

2 按下 Scale 软键。
屏幕将显示 Scale 输入栏。

3 通过用数字输入一个新的每分度值选择一个新的刻度，再按下 ENTER
或者 MHz/dB/µS 键确认，或者用 UP/DOWN 光标键选择。

进行有限次数的测量

9102 可以连续进行测量，也可以限定测量次数。限制测量次数可能有助
于统计分析。如需了解限制测量次数的详细信息，请参阅 " 进行有限次
数的测量 " 第 139 页和第 8 章 " 反射操作 "。

注

在进行多次测量时，如果温度等因素发生变化，必须重新校准 9102。
这是一种需要定期执行的任务。而且，如果您修改了频带，也必须重
新校准9102。只要9102需要进行校准，屏幕上就会显示红色“Calibrate”
图标。
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使用极限

与反射模式一样，您还可以为线损测量使用极限线。如需了解使用极限
的详细信息请参阅 " 使用极限线 " 第 31 页和第 2 章 " 一般性操作 "。

查看线损参数

您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 54 线损参数
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Chapter 12 EMF (EMI) 操作
11

本章将介绍 EMF （EMI）模式所特有的一些仪器功能。本章所要讨论的
主题包括：

－ "EMF 测量 " 第 167 页

－ " 测量方法 " 第 169 页

－ " 测量天线 " 第 171 页

－ " 用 9102 测量 EMF" 第 177 页

－ " 连接天线 " 第 178 页

－ " 选择测量模式 " 第 179 页

－ " 选择单位 " 第 179 页

－ " 选择频率范围 " 第 180 页

－ " 选择 RBW、 VBW 和 SWT" 第 183 页

－ " 设定屏幕显示的计算结果 " 第 184 页

－ " 设置电平参数 " 第 184 页

－ " 进行自动测量 " 第 185 页

－ " 进行手动测量 " 第 188 页

－ " 设置曲线 " 第 191 页

－ " 使用极限 " 第 191 页

－ " 使用标记 " 第 191 页

－ " 查看 EMF （EMI）模式参数 " 第 191 页
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EMF （EMI）模式简介
EMF （EMI）模式简介

人们正在创造和安装越来越多的电磁场源，其中大部分都是移动射频、
广播和其他射频服务的发射器。家庭、办公室通信设备和其他技术装置
也会在工作环境和家庭中产生电磁场。为了保护人体健康，监管机构提
出了相应的限制要求，其中很多已经成为正式的国家法律。网络运营
商，安装广播发射器的企业，以及监管机构都面临着一个艰巨的挑战：
如何验证发射源符合规定的电磁场限制。

配有 9131 EMF 测量选件的 9102 所提供的 EMF（EMI）测量模式让您可以
方便地、有效地测量辐射情况。为了有效地记录电磁场强度，您所要做
的就是安装配有 9131 EMF 测量选件的 9102，以及符合您的测量方法要求
的天线。Willtek 提供了多种针对不同用途的天线。如需了解关于不同类
型的测量天线的详细信息，请参阅 " 测量天线 " 第 171 页。下图显示了
一个典型的应用实例，即利用 9102 和一个安装在三脚架上的全向形天线
, Willtek 9171 全向形天线 , 测量 EMF。

EMF （EMI）测量模式让您只需按下一个按钮，就可以进行自动 EMF 测
量。在这种模式下， 9102 可以在一个由用户指定的频段内测量电磁场，
并显示场强 （单位为 V/m）或者功率密度 （单位为 W/m2）。它提供了
所有必要的功能，例如在某个指定的时段检测峰值，或者求宽频信号功
率在某个指定频率范围内的积分。您可以将所测得的数值与相关的阈值
进行比较。
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测量结果可以显示为对数或者线性格式。用户可以根据测得信号的情
况，迅速地、方便地调节显示范围。如下面这个例子所示，界面上将显
示以对数或者线性格式表示的测得信号图形和数值。

EMF 测量

为了分析特定源（例如广播站或者移动电话基站）所发射的辐射量，通
常需要在一个指定的频率范围内测量电磁场强度。因此，应当在预计会
发生辐射的频率进行测量，例如某个广播或者蜂窝射频频率。要准确地
测量电磁场强度，必须使用一个具有较高的灵敏度、较大的动态范围和
较高的场强测量精度的选频接收器。这是获得准确的、可重现的测量结
果的前提条件。

在 EMF 验证方面，基本上存在两种不同的测量类型：

－辐射发射
－辐射入射

根据测量类型的不同，需要选用不同的测量设备和方法。通过配有 9131
EMF测量选件和相关附件（例如天线）的 9102手持式频谱分析仪，Willtek
提供了一个涵盖不同类型，满足不同要求的测量解决方案。

下面两节将分别说明辐射发射和辐射入射的概念，并将介绍针对不同的
测量类型进行 EMF 测量所需要的设备。

图 55 EMF (EMI) 测量
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辐射发射 利用这种测量类型，蜂窝网络和广播站的运营商可以验证他们所安装的
某个特定发射器的辐射水平是否超出了相关法律、法规所规定的限制范
围。在全球很多国家，监管机构都规定运营商必须提供符合相关法规的
证据。辐射发射测量是一种定向测量方式，旨在确定发射器所发出的电
磁场强度。在测量配置中使用定向天线有助于测量发射的辐射强度。

发射测量的测量配置 要依照 ICNIRP （国际非电离辐射防护委员会）标准，利用 9102 进行发
射测量，您只需要使用以下两款设备：

－配有9131 EMF测量选件和9132 RMS检波器选件的9102手持频谱分析仪

－一个定向天线

Willtek 为进行辐射发射测量提供了两种不同的定向天线。如需查看对这
两种天线的详细说明，请参阅 " 定向天线 " 第 176 页。

这种由 9102 和定向天线所组成的测量配置为方便地、有效地进行辐射发
射测量提供了一个手持式解决方案。

辐射入射 对于工程办公室和监管机构而言，了解所有辐射源在某个特定地点产生
的辐射强度具有非常重要的意义。在进行入射测量时，需要在某个指定
区域的不同位置测量电磁场强度，以确定最小和 / 或最大辐射强度。这
种测量类型的典型应用包括：

－ 通过入射测量，找出靠近发射器所在地的安全区域

－ 通过入射测量，确定发射器附近具有代表性的和特别敏感的设施（例
如学校、幼儿园和医院等）的辐射强度

－ 通过长期测量，确定入射辐射强度的波动情况

入射测量的测量配置 与发射测量一样，要利用 9102 进行入射测量，您只需要使用两款设备：

－ 配有 9131 EMF 测量选件和 9132 RMS 检波器选件的 9102 手持式频谱

分析仪

－ 9170 双锥形天线 （相关说明请参阅 "9170 双锥形天线 " 第 172 页

或者

－ 9171 全向形天线 （相关说明请参阅 "9171 全向形天线 " 第 174 页）
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测量方法
具体使用什么类型的天线取决于您的测量要求。" 测量天线 " 第 171 页对
两种不同的天线类型进行了详细的说明。这些有用的信息可以帮助您为
EMF 测量选择合适的测量天线。

在这样的测量配置中，9102 可以捕捉所有方向的电磁波，并显示制定频
段的总场强。

测量方法

进行 EMF 测量的地点通常是预先指定的。进行 EMF 测量的一个主要目标
是确定人们在日常生活中承受的辐射强度，因此测量经常在人们会停留
一段时间的地点进行，例如他们的工作场所、家庭、餐厅或者人行道等。
在测量地点，必须搜寻最大场强，以确定因为各种因素（例如移动网络
基站）所导致的辐射强度。在进行长期的 EMF 测量时，首先需要确定最
大场强，然后再将天线放在辐射强度最大的地点。目前主要有两种确定
某个指定测量区域内的最大场强的方法：

－游走法
－多点法

在使用这两种方法时，用户都需要携带着天线在待测区域内移动。下图
显示的是一个用户正在利用一套测量配置（包含一个全向形天线）确定
最大场强。
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游走法 在使用游走法时，用户需要将测量仪器设为最大值保持模式，并在指定
的测量区域内移动天线。根据所使用的天线类型，用户必须毫无遗漏地
扫描整个指定测量区域，以便平等地捕捉不同的地点、入射方向和极化
方向。如果使用的是全向形天线，就可以忽略入射和极化方向，因而全
向形天线为使用游走法提供了一种更加方便的解决方案。如需进一步了
解不同天线的特性，请参阅第 171 页的 “测量天线”。在完成对指定扫
描区域的扫描之后，测量仪器就会提供最大场强值。

多点法 多点法需要用一个事先定义的多点矩阵，为用户提供指定的测量点。为
此，首先必须去定测量区域的尺寸和指定测量点。在每个测量点，都要
进行一次测量。因为在每点需要测量三个值（一个值对应一个方向：X、
Y 和 Z），所以在使用多点法时，建议用多向同性天线进行测量。如需进
一步了解不同天线的特性，请参阅第 171 页的 “测量天线”。用户需要
在每个测量点进行测量，记录各次的测量结果。

另外，还可以使用一种经过简化的多点法。这种方法与游走法类似，即
用户需要将测量仪器设为最大值保持模式，并在指定的测量区域内移动
天线，并利用一个全向形天线扫描所有事先指定的测量点

与游走法相比，多点法 -- 无论是基本的还是经过简化的 -- 可以为需要
进行测量的用户提供指导原则，便于构成一种更加系统的方法。 
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测量天线

天线是 EMF 测量中最重要的因素之一。目前有三种不同类型的天线可以
用于测量场强。您可以根据自己的测量需要加以选择。Willtek 提供了多
种可以满足不同测量需求的天线：

－ 频率范围为 60 到 2500MHz 的 9170 双锥形天线，适用于入射测量；

－ 频率范围为 50 到 3000MHz 的 9171 全向形天线，适用于入射测量；

－ 频率范围分别为 80 到 1000MHz 和 300 到 3000MHz 的 9172 和 9173 定

向天线，适用于发射测量。

如需了解 Willtek 天线和天线附件的订购信息，请参阅 " 选件 " 第 5 页。

在测量时，天线会将自由行波转化为一个线性波。为了校准天线，需要
一个包含 k 系数的校准表。这些系数是一些旨在校准天线频率响应的比
例系数，有助于将测得的功率或者电压转化为场强或者功率密度。利用
k ― ―系数表，测得的电平会被转化为相关的物理量 场强（单位为 V/m）
或者功率密度 （W/m2）。

Willtek 所提供的测量天线都附带了相应的校准系数表。利用 9100 数据交
换软件，您可以将 k 系数表发送到您的仪器之中。如果使用的是 9171 全
向形天线，则不需要执行这个步骤，因为系数保存在天线接口内部的一
个存储器中。您还可以利用 9100 数据交换软件，搜集其他供应商的天线
产品的校准数据，再将它们发送到您的 9102 之中。如需进一步了解如何
使用 9100 数据交换软件的信息，请参阅第 14 章 "9100 数据交换软件 "。
在将校准表发送到仪器之后，用户就可以在进行 EMF 测量时加以选用。

Willtek 还提供了多种天线附件，例如三脚架和经过校准的电缆。这样，
您将可以利用 9102 及其附件，轻松自如地处理测量现场出现的任何情
况。如果您需要为测量使用三脚架和电缆，那么可以通过在仪器上启用
相应的电缆系数，考虑电缆信号衰减所产生的影响。

下面几节提供了对不同类型的测量天线的一般性技术介绍，包括关于它
们的测量用途和技术细节等信息。如需进一步了解在利用不同类型的测
量天线进行 EMF 测量时需要采取的所有步骤，请参阅 " 进行自动测量 "
第 185 页和 " 进行手动测量 " 第 188 页。
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9170 双锥形天线

顾名思义，双锥形天线具有类似于偶极子的结构。两个接收瓣高度对
称，分别为双锥形天线提供了两个开度角为 120 度的主接收方向。

在测量期间，需要手动地将双锥形天线扭转到三个主平面（x、y、 z）。
在每个不同的方向上，测量所使用的天线组件都完全相同。这就产生了
极高的全向形，使得双锥形天线非常适用于高精度测量。通过将这种天
线安装在一个转向设备上，您就可以方便地将天线旋转到该设备所指示
的方向，对各个平面进行测量。这样可以为测量产生一个类似于全向形
天线的球形扫描范围，如下图所示。

9102 支持在三个轴上进行连续测量，并可以自动计算最终得到的场强。

对于那些使用配有 9131 EMF 测量选件的 9102 测量 EMF 入射的用户，
Willtek 为他们提供了 9170 双锥形天线。
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天线产品包中含有：

－ 天线

－ 带有一个 1/4 英寸螺纹的夹子，用于可选的三脚架；能够以 120 度为

步长旋转

－ 经过校准的 10 米长铁氧体磁环同轴电缆

－ 校准证书和 k 系数表

下表列出了 9170 双锥形天线的技术规格。

天线类型 双锥形 （线性无源设备 )

频率范围 60MHz 到 2.5GHz

灵敏 > 0.5 mV/m

所能检测的最大场强 > 300 V/m

偶极子平衡对称性
60 到 80 MHz
80 MHz 到 3 GHz

±0.6 dB
±0.2 dB

全向形误差
1.5 GHz 以下
1.5 到 2.2 GHz
2.2 到 3 GHz

< 0.5 dB
< 0.9 dB
< 1.2 dB

尺寸
宽度

长度

重量

200 mm
250 mm
2.4 kg

RF 接口 N 型

工作温度范 -30C 到 +55C

环境保护等级 IP44

符合 RoHS
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9171 全向形天线

最便利、最快捷的 EMF 入射测量解决方案是使用一个全向形天线。在一
― ―个全向形天线中，三个天线或者偶极子组件 每个对应一个方向（x、

y 和 z ― ―） 以正交方式排列，并通过互联结合到一起，如下图所示。

对于那些使用配有 9131 EMF 测量选件的 9102 测量 EMF 入射的用户，
Willtek 为他们提供了 9171 全向形天线。 9171 全向形天线由 9102 手持式
频谱分析仪控制，从而使得用户不需要在测量时手动旋转天线。这种天
线让您可以进行快速的自动测量。远程控制是通过天线中集成的一个电
路实现的。电路通过一条附加的、带有高精度接口的屏蔽电缆，连接到
9102 的多端口接口。通过这条连接， 9102 还可以自动地从电路中的
EPROM 读取校准数据，例如 k 系数校准信息。
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一旦您将电缆连接到 9102 的多端口接口，该仪器就会自动地检测到天
线，并从天线加载一组单独的校准值。在开始测量之后，该仪器会自动
地控制天线的接收方向，在每个方向进行测量，以及根据三个单独的测
量值计算总的全向形值。

天线产品包中含有：

－ 天线

－ 带有一个 1/4 英寸螺纹的夹子，用于可选的三脚架

－ 6 米长的远程控制电缆和经过校准的铁氧体磁环同轴电缆

－ 支持在仪器上直接安装天线的 N-N 适配器

－ 天线接口 （控制和校准数据）

－ 校准证书和 k 系数表

下表列出了 9171 全向形天线的技术规格。

注

9171 全向形天线装在一个木箱之中。请保留这个木箱，以便在您需要
把天线送到 Willtek 进行校准时包装天线。

天线类型 带有 3 个正交偶极子天线的全向形
传感器

频率范围 30 MHz 到 3 GHz

灵敏度 < 5 mV/m

所能检测的最大场强 < 300 V/m

偶极子平衡对称性
50 到 80 MHz
80 MHz 到 3 GHz

±0.6 dB
±0.2 dB

全向形误差 （垂直极化）
1.7 GHz 以下
1.7 到 2.1 GHz
2.1 到 3 GHz

±0.5 dB
±1.0 dB
±0.5 dB

全向形误差 （水平极化）
1.2 GHz 以下
1.2 到 1.7 GHz
1.7 到 2.1 GHz
2.1 到 3 GHz

±0.5 dB
±1.0 dB
±0.5 dB
±1.0 dB

尺寸

天线罩直径

长度

重量

200 mm
520 mm
0.5 kg

RF 接口 N 型
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定向天线

定向天线是对数周期宽频天线，适用于更多的应用。它们通常被用于测
量来自于某个特定天线地点的辐射。

Willtek 提供了两种不同的 1 米长定向天线，分别适用于不同的频率范围：

－ 9172 定向天线－ 80 到 100MHz

－ 9173 定向天线－ 300 到 3000MHz

由于这些定向天线具有很小的波束宽度和出色的频率响应，它们还可以
被用于 EMF 审核和搜寻干扰源。利用这两种天线类型和它们交迭的频率
范围，可以扫描整个商用射频服务的频率范围。

天线产品包中含有：

－ 天线

－ 带有一个 5/8 英寸螺纹的夹子，用于可选的三脚架

下表列出了 9172 和 9173 定向天线的技术规格 :

工作温度范围 -20C to +60C

环境保护等级 IP 54

符合 RoHS-compliant

频率范围 80 到 100 MHz and 
300 MHz 到 3000 MHz

最大发射功率 （CW） > 0.5 mV/m

所能检测的最大场强 > 300 V/m

额定阻抗 50 Ω

VSWR （典型） < 2.0

RF 接口 N 型 , female

极化 线性 （垂直 / 水平）
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用 9102 测量 EMF
如前所述，配有 9131 EMF 测量选件的 9102 和它的天线附件可以为您提
供一个测量解决方案，帮助您按照自己特定的需要进行 EMF 测量。

在 EMF （EMI）模式下， 9102 会测量电场强度 （E）和功率密度 （S），
以便让您可以将测得的 EMF 和监管机构所规定的严格限制进行对比。您
可以设定哪些结果应当显示。如需进一步了解如何在您的 EMF 测量中设
定屏幕显示的数值，请参阅 " 设定屏幕显示的计算结果 " 第 184 页。

电场强度的显示单位为 V/m。

电场强度的计算方法为 S × R0，其中 R0 为空气的波阻抗 （377Ω）。

9102 显示的总电场强度是通过累加所有三个方向（x、y 和 z）上的测量
值而得到的。

Eresult 的计算方法是求 Exresult
2+ Eyresult

2+ Ezresult
2 的平方根。

功率密度的显示单位为 W/m2。

它的计算方法为 S = Er
2 ÷ R0. R0 ，其中 R0 仍为空气的波阻抗 （377Ω）。

下面几节将介绍怎样利用 9102进行 EMF测量，其中包括用于自动测量的
自动、快速模式 （使用 9171 全向形天线）和用于手动测量的手动模式
（使用9170双锥形天线）。在开始实际测量之前必须执行一些准备步骤，
例如选择 EMF （EMI）测量模式，设置所需要的频率范围，选择测量单
位，以及设定需要显示的测量结果 （功率密度或者场强）。除了在将天
线连接到 9102 方面有所差异以外，两种模式的准备步骤都是一样的。具
体执行哪些步骤取决于所使用的天线类型。

校准 CISPR

杆夹 5/8“ 螺纹 , 37 mm 圆形法兰

尺寸 （长度×宽度） 1 m x 0.55 m

重量 2.4 kg

注

由于 EMF 测量的物理性质，必须考虑下列因素。

在宽频信号上进行测量时，所显示的电场强度或者功率密度可能与实
际值存在一定的偏差。在这种情况下， EMF 测量必须通过信道功率测
量进行。而且，如果跨度和 RBW 之间相差过大或者过小，都可能导致
错误或者无效的测量结果。
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连接天线

首先，您需要根据测量类型，为 EMF 测量构建起适当的硬件配置。如前
所述，您所使用的天线类型取决于测量类型和测量方法。如需进一步了
解如何选择天线的信息，请参阅 "EMF 测量 " 第 167 页和 " 测量天线 " 第
171 页。

连接 9170 双锥形天线 要连接 9102 和 9170 双锥形天线，您只需要通过一个 RF 电缆，将天线连
接到 9102 的 RF in 接口。

连接 9171 全向形天线 要连接 9102 和 9171 全向形天线，您可以将天线直接连接到 9102 的 RF in
接口，再将控制器电缆连接到 9102 的多端口接口。只要您将天线连接到
了这两个接口， 9102 就会自动检测到天线，并加载校准数据。

在检测到天线并加载了校准数据之后， 9102 就会切换到 Level 菜单，这
时 Antenna Factor 软键将高亮显示。为了启用天线系数，请按住 Antenna
Factor 软键，直到 on 高量显示。

连接定向天线 要连接 9102 和两个定向天线中的一个 （9172 或者 9173 定向天线），您
只需要通过一个 RF 电缆，将天线连接到 9102 的 RF in 接口。

使用三脚架 木制三脚架是 Willtek 提供的一个测量天线附件。如需了解订购信息，请
参阅 " 选件 " 第 5 页。您可以将这种三脚架用于多种用途，例如调整 9170
双锥形天线的方向。要在三脚架上安装合适的天线，首先需要在三脚架
上固定相应的适配器，再将天线固定到适配器上。这时，您就可以用适
当的延长线来将天线连接到 9102。如果使用的是 9171 全向形天线，您还
必须将控制器电缆连接到 9102 的多端口接口，详见 " 连接 9171 全向形
天线 " 第 178 页。

注

如果在 EMF （EMI）模式已经运行的情况下将天线控制器连接到仪器，
9102 大约需要 10 秒钟的时间才能检测到天线。为了避免干扰检测流
程，请勿在此期间按下仪器上的任何按钮。
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选择测量模式

要选择 EMF （EMI）模式，请执行以下操作：

1 按下 MODE 功能键。
屏幕显示 Mode 菜单。

2 选择 EMF （EMI）。
屏幕显示 EMF （EMI）主菜单。

选择单位

在选择了 EMF （EMI）测量模式之后，下一步要做的是选择单位。

1 在主菜单中选择 Level>Units。

2 您可以使用对数或者线性单位。要在对数和线性单位之间切换，请按
下屏幕右下角的 Unit 软键，选择 log 或者 lin。

3 您现在可以通过屏幕右下角的 Unit 软键，选择下列单位：
对数单位： dBµV/m, dBmV/m 和 dBV/m
线性单位：V/m, mW/m2

注

只有您的仪器上安装并启用了 9130 EMF 测量选件的情况下，这种模式
才可供选择。
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选择频率范围

您可以通过多种方式设置需要测量的频率范围；频率范围可以利用起始
频率和截止频率（例如显示窗口上的第一个和最后一个频率）表示，或
者利用中心频率和跨度（例如中心和频率范围）表示，或者利用中心频
率、跨度、起始频率和截止频率的其他组合表示。

所有四个参数都可以通过 Freq 菜单查看。但是在主菜单中，只会显示上
述组合中的一种，具体选择哪一种取决于最后输入的参数。

下一节将集中介绍设置频率的不同方法。这是 EMF 测量的准备步骤之
一。如需进一步了解 Frequency 菜单功能（例如 Trigger），请参阅第 3 章
" 频谱分析操作 "。

图 56 频率范围

注

修改一个频率参数可能会影响到相关的参数。例如：如果您将频率跨
度修改为 4GHz，那么起始频率和截止频率将会分别变为 0 和 4GHz。
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设置起始频率和截止频率 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Start 和 Stop 软键。

2 按下 Start 软键。
屏幕将显示一个输入栏，指明目前设置的起始频率和 UP/DOWN 光标
键的步进宽度。

3 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

4 按下一个单位（GHz/dBm 表示吉赫兹，MHz/dB/µs 表示兆赫兹）键确
认，完成输入。如果输入的起始频率低于截止频率，那么横轴将显示
起始频率到截止频率的范围。如果新的起始频率高于或者等于截止频
率，开始频率将被用作零跨度的中心频率，例如所选频率的信号将在
时域显示。

5 按下 Stop 软键，输入显示窗口右端的频率。

您也可以通过修改频率模式，将用于设置起始频率和截止频率的软键放
在主菜单中，详见修改主菜单中显示的频率参数。

设置中心频率和跨度 1 按下 CENT 功能键 （或者 Reflection 主菜单上的 Freq 软键）。
垂直软键包括 Center 和 Span 软键。屏幕将显示一个输入栏，指明目
前设置的中心频率和 UP/DOWN 光标键的步进宽度。

2 利用数字键、光标键和 BACKSPACE 键输入一个新的频率。

3 按下一个单位（GHz/dBm 表示吉赫兹，MHz/dB/ μ s 表示兆赫兹，KHz/d
B μ V/MS 表示千赫兹；或者直接输入 ENTER，这表示单位为赫兹）
键确认，完成输入。

4 按下 Span 软键，输入从显示窗口左端到右端的频率范围。

您也可以通过修改频率模式，将用于设置中心频率和跨度的软键放在主
菜单中，详见下面的修改主菜单中显示的频率参数。
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修改主菜单中显示的频率
参数

Reflection 主菜单会显示两个用以定义显示窗口的频率范围的软键。如前
所述，可以通过不同的方式定义频率范围；您可以将这两个软键设为两
个可选组合中的一种，方法为：

1. 从 Reflection 主菜单中，选择 Freq > Freq Mode。

2. 选择您希望在主菜单中看到的软键组合（Start/Stop或者Center/Span）。

3. 按下 Main…软键，回到主菜单。

屏幕将显示主菜单，以及所选的软键组合。

请注意，频率横轴的说明会随着所选参数组合的改变而改变。

查看完整的频段 要将频率范围改为 9102 支持的全部带宽，请执行以下操作：

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Full Span 软键。
最左端的频率将变为 0，最右端的频率将变为 4GHz。

在时域进行测量 某个选定中心频率上的测量结果也可以在时域显示。

1 从 Reflection 主菜单中按下 Freq 软键。
屏幕将显示 Frequency 菜单。

2 按下 Center 软键，输入需要的中心频率；通过选择确认键中的适当单
位，关闭输入栏。

3 按下 Zero Span 软键。
横轴将变为时间轴。刻度宽度与扫描时间一致。

为频率输入选择步进宽度 在设置中心频率、起始频率和截止频率时，可以利用数字键输入一个新
值，或者利用光标键（UP， DOWN）增大或者减小当前设置。光标键的
按键步进宽度可以由 9102 自动设置，也可以手动调节。

手动设置频率步进宽度

1 从 Reflection 主菜单中，选择 Freq。

2 按下 FStep 键。
屏幕将显示 Freq Step 输入栏。
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3 输入一个新的频率值，按下 ENTER 关闭输入栏。自动 / 手动选择切换
到手动方式，所选的频率步进宽度将显示在软键上。

将频率步进宽度选择方式设为自动

1 从 Reflection 主菜单中，选择 Freq。

2 多次按下 FStep 键，直到 “auto”选项高亮显示。

选择 RBW、 VBW 和 SWT

分辨带宽（RBW）指的是 IF 滤波器用于选择待测信号的 3dB 带宽。分辨
带宽可以表明频谱分析仪区分具有类似幅值的相邻信号的能力。只有间
隔频率超过 RBW 的信号才能彼此区分。

通过设置， 9102 可以根据频率跨度自动选择分辨带宽。 EMF （EMI）测
量模式为 EMC 审核测试提供了两个特殊的 RBW 滤波器：120kHz 和 9kHz，
带宽均为 6dB。

视频段宽（VBW）指的是低通带宽，自此之上的频率点的多个测量结果
将会被平滑处理。视频段宽越低，信号曲线越平滑，变化越少。

通过设置， 9102 可以自动根据分辨带宽选择视频段宽。

扫描时间（SWT）可以确定在所测量的频率范围（即跨度）上进行一次
完整扫描所用的时间。

通过设置， 9102 可以自动根据 RBW 和 VBW 选择扫描时间。如果选择手
动设置，那么扫描时间应当长到足以让滤波后的信号达到稳定状态。如
果扫描时间过短， 9102 将会输出一个 “UNCALibrated”警告。

要设置分辨带宽、视频段宽或者扫描时间，请执行以下操作：

1 在主菜单中选择相应的软键 （RBW、 VBW 或者 SWT）。

2 输入数值，利用相关单位所对应的确认键完成输入。利用 UP/DOWN
光标键输入一个新的值，或者切换到 auto 模式，由 9102 自动进行设
置。

在自动和手动模式之间切换

多次按下相应的软键 （RBW、 VBW 或者 SWT），直到所要选择的模式
（自动或者手动）高亮显示。
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设定屏幕显示的计算结果

9102 可以测量电场强度 （E）（单位为 V/m）和功率密度 （S）（单位为
W/m2）。如需进一步了解这两个数值和它们之间的关系，请参阅"用9102
测量 EMF" 第 177 页。您可以选择在屏幕上显示这两个结果数值中的哪一
个。

要在屏幕上切换电场强度和功率密度的显示，请执行以下操作：

1 在 EMF （EMI）主菜单中，选择 Measure>Display Calculation。

2 多次按下 Display 键，直到您所需要的选项（E 表示电场强度，S 表示
功率密度）高亮显示。在您进行测量时，所选数值将以相应的单位显
示在屏幕左上角：电场强度的单位为 V/m，功率密度为 W/m2。

设置电平参数

测量信号与背景噪声之间的准确度和动态范围取决于正确的电平设置。
这包括参考电平和衰减值的设置。

参考电平将决定显示窗口顶部的电平。纵轴分为八条竖线；您可以根据
需要调节刻度 （缺省值为每条线 10dB）。

因为外部耦合而产生的衰减或者增益可以通过随频率变化的耦合系数加
以补偿，以便让屏幕显示的测量值真实地反映被测设备的功率电平。

设置参考电平 1 在主菜单中，按下Ref. Level软键，或者先选择Level，再选择Ref. Level。
或者按下 REF 功能键。
屏幕将显示参考电平输入栏。

注

这是一个准备步骤，需要在您实际启用自动或者手动测量模式之前执
行。

注

根据您所使用的单位和指定的屏幕显示结果， Ref. Level 软键将会变为
Ref. Power 或者 Ref. Voltage。而且，输入栏的名称和屏幕左侧的显示也
会发生相应的变化。
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2 利用数字键输入新的参考功率或者电压，再通过相应的确认键关闭输
入栏；或者利用 UP/DOWN 光标键。
新的参考电平将显示在纵轴顶部。参考功率将使用实际设置的输出功
率。

设置硬件衰减值 1 在主菜单中，按下 Attenuation 软键。
屏幕将显示 Attenuation 输入栏。

2 输入一个介于 0 到 50dB 之间（步进值为 10dB）的新衰减值，通过一
个确认键关闭输入栏；或者利用 UP/DOWN 光标键选择一个介于 10 到
50dB 之间的衰减值。
如果衰减值被修改，衰减选项将变为 “manual”。

进行自动测量

在使用 9171 全向形天线时，您可以在自动模式下进行测量。进行自动测
量的一个前提条件是将 9171 的全向形天线的控制器电缆连接到 9102 的
多端口接口。通过这个连接，9102 可以从天线读取相关的校准数据和控
制测量。但是，如果您使用了一个三脚架测量配置和一条延长线，就必
须利用电缆校准数据消除电缆信号衰减所产生的影响。

在进行自动测量时，可以从 Measure 菜单中选择两个不同的选项：Auto
和 Quick。关于这两种不同模式的详细说明参见 " 自动测量 " 第 187 页和
" 快速测量 " 第 188 页。

启用天线系数设置 一旦您将天线直接连接到9102的RF in接口，并将控制器电缆连接到9102
的多端口接口， 9102 就会自动检测到天线，并加载校准数据。

注

如果没有将 9171 全向形天线的控制器电缆连接到 9102 的多端口接口，
EMF （EMI） Measure 菜单中的 Auto 和 Quick 软键将会以灰色显示。

注

如果在 EMF （EMI）模式已经运行的情况下将天线控制器连接到仪器，
9102 大约需要 10 秒钟的时间才能检测到天线。为了避免干扰检测流
程，请勿在此期间按下仪器上的任何按钮。
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在检测到天线和加载校准数据之后，9102 会切换到 Level 菜单，Antenna
Factor软键将会高量显示。要启动天线系数，请按住 Antenna Factor软键，
直到 on 高亮显示。

为延长线设定电缆系数 如果您需要用一条延长线来将 9171 全向形天线连接到您的 9102 （例如
为了将天线安装在三脚架上），您必须通过启用相应的电缆校准系数消
除电缆信号衰减产生的影响。您可以在 9100 数据交换软件中保存和编辑
电缆系数。您可以将它们发送到您的 9102，以便在 EMF 测量中使用。如
需了解更多信息，请参阅第 14 章 "9100 数据交换软件 "”中 " 为 EMF 测
量管理电缆系数 " 第 224 页。

要为您的测量使用电缆校准数据，请执行以下操作：

1 在 EMF（EMI）主菜单中，选择 Level>Ant. Factor Memory。屏幕将显示
系统存储的天线系数。

2 按下 Recall Cable Factor 软键。屏幕上将显示一个下拉菜单，其中列出
了系统中保存的所有电缆系数。

3 选择您想要使用的电缆系数，按下 ENTER。这时 Level 菜单将再次显
示，而 Cable Factor 软键将高亮显示。

4 要启用所选择的电缆系数，必须多次按下 Cable Factor 软键，直到 on
高亮显示。

图 57 Antenna Factor 菜单
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自动测量 Auto 测量可以让 9102 自行控制所有三个测量平面的测量流程，从而为您
提供极大的便利。一旦您开始启动 Auto 测量，9102 将自动执行所有测量
任务，并计算和显示从单独的 x、 y 和 z 测量结果得到的总结果。但是，
您可以设定测量时间。

要启动 Auto 测量，请执行以下操作：

1 在 EMF （EMI）主菜单中，选择 Measure。屏幕上将显示 EMF （EMI）
Measure 菜单。

2 在 Measure 菜单中，选择 Meas. Time。屏幕上将显示测量时间的输入
栏。

3 输入测量每个测量平面的时间间隔。缺省值为 360 秒，最大值为 600
秒。按下 ENTER，确认测量时间。

4 现在选择 Auto 软键，按下 Continue!，启动 Auto 测量。

5 在显示屏右侧，红色的 Measure 标识符表示正在进行测量： .
标识符上方会显示所测方向 （x 表示第一个） : .
You can abort the measurement by pressing the Cancel ! softkey.
您可以通过按下 Cancel! 软键，终止测量。

6 在完成对 x 测量平面的测量之后，Measure 标识符会消失，9102 接着
会自动切换到 y，而后是 z。

图 58 Measure 菜单
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7 在完成测量之后，屏幕上将显示测量结果，图形将自动显示，而经过
计算得出的总电场强度或者功率密度--取决于您通过Measure>Display
Calculation （参见 " 设定屏幕显示的计算结果 " 第 184 页）选择的计
算结果 -- 也将显示在屏幕上。您现在可以在仪器上保存您的结果曲
线。

要清除曲线和开始一个新的测量任务，请按下 HOLD/RUN 功能键，或者
Auto 软键。如果您想要使用其他的测量方式，您还可以按下 Quick 或者
Manual 软键。

快速测量 通过事先设定对每个测量平面 （x、 y、 z）进行一次扫描的持续时间，
Quick测量为迅速确定最大场强提供了一种方便的途径。除了事先设定测
量持续时间以外， Quick 测量的流程与 Auto 测量完全系统。

要启动一个快速测量流程，请执行以下操作：

1 在 EMF （EMI）主菜单中，选择 Measure。屏幕上将显示 EMF （EMI）
Measure 菜单。

2 选择 Quick 软键，按下 Continue!，开始快速测量。您可以按下 Cancel!
终止测量。此后的步骤则与 Auto 测量完全相同，不再赘述。

进行手动测量

手动测量模式为您用 9170 双锥形天线进行 EMF 测量提供了一种方便的
途径。在进行这种 EMF 测量时，9170 双锥形天线会被手动旋转到各个测
量平面（x、y 和 z）。它通常安装在一个转向设备之上。对于每个方向，
9102 都会测量电场强度或者功率密度 -- 具体取决于您通过 Measure >
Display Calculation（参见 " 设定屏幕显示的计算结果 " 第 184 页）选择的
计算结果。您可以在向天线旋转到某个方向之后，手动启动测量流程。
与自动测量一样，您也可以对每个方向设定测量时间。在完成所有测量
之后， 9102 将会计算总结果值。

因为在使用双锥形天线时， k 系数校准表不会被自动地加载和启用，所
有您必须手动地在您的仪器上启用相应的校准表。另外，因为双锥形天
线常常需要安装在三脚架上，通过一条延长线连接到 9102，所以必须手
动启用电缆系数。
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下面几节将介绍手动测量的特殊步骤。在开始实际测量之前必须执行一
些准备步骤，例如选择 EMF（EMI）测量模式，设置所需要的频率范围，
选择测量单位，以及设定需要显示的测量结果 （功率密度或者场强）。
手动和自动测量模式的准备步骤是相同的。

设定天线系数 9170 双锥形天线的产品包中含有相应的 k 系数校准表。这些数据保存在
9100 数据交换软件中。如需了解如何将数据下载到 9102 和管理 9100 数
据交换软件中的天线系数的信息，请参阅第 15 章 "9100 数据交换软件 "
中 " 为 EMF 测量管理天线系数 " 第 222 页。

要为您的测量启用适当的天线系数，请执行以下操作：

1 在 EMF（EMI）主菜单中，选择 Level>Ant. Factor Memory。屏幕将显示
系统存储的天线系数 （参见第 186 页图 57）。

2 按下 Recall Antenna Factor 软键。屏幕上将显示一个下拉菜单，其中列
出了系统中保存的所有天线系数。

3 选择您想要使用的天线系数，按下ENTER。这时Level菜单将再次显示。

要启用所选择的电缆系数，必须多次按下 Antenna Factor 软键，直到 on
高亮显示。

为延长线设定电缆系数 如果您需要用一条延长线来将 9171 全向形天线连接到您的 9102 （例如
为了将天线安装在三脚架上），您必须通过启用相应的电缆校准系数消
除电缆信号衰减产生的影响。您可以在 9100 数据交换软件中保存和编辑
电缆系数。您可以将它们发送到您的 9102，以便在 EMF 测量中使用。如
需了解更多信息，请参阅第 14 章 "9100 数据交换软件 " 中 " 为 EMF 测量
管理电缆系数 " 第 224 页。在手动测量中，设定电缆系数的步骤与自动
测量相同。如需了解更多信息，请参阅 " 进行手动测量 " 第 188 页。

进行测 要进行手动测量，请执行以下操作：

1 在 Measure 菜单中，选择 Meas. Time。屏幕上将显示测量时间的输入
栏。

2 输入测量每个测量平面的时间间隔。缺省值为 360 秒，最大值为 600
秒。按下 ENTER，确认测量时间。
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3 现在选择 Manual 软键。对应三个不同测量方向 （x、 y 和 z）的软件
将显示在屏幕右侧。作为第一个测量方向， x 将高亮显示。 X 方向标
识符将显示在屏幕左侧，如下图所示。

4 按下 Continue!，启动首次测量。在屏幕右侧，红色的 Measure 标识符
表示测量正在进行。 . 
您可以通过按下 Cancel! 软键终止测量。在测量完成后，Measure 标识
符将消失。

5 现在，按下 Y 软键，再按下 Continue!，对 y 方向进行测量。步骤与上
面介绍的 x 方向测量步骤相同。

6 在 y 方向测量完成之后，按下 Z 软键，再按下 Continue!。步骤与上面
介绍的 x 方向测量步骤相同。

7 在完成测量之后，屏幕上将显示测量结果，图形将自动显示，而经过
― ―计 算 得 出 的 总 电 场 强 度 或 者 功 率 密 度 取 决 于 您 通 过

Measure>Display Calculation （参见第 184 页的“设定屏幕显示的计算
结果”）选择的计算结果 -- 也将显示在屏幕上。您现在可以在仪器上
保存您的结果曲线。

要清除曲线和开始一个新的测量任务，请按下 HOLD/RUN 功能键，或者
Manual 软键。

图 59 手动测量的软键
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设置曲线

曲线功能可以提供不同的测量视图，例如实际测量数据或者上一组测量
数据的均值。您甚至可以选择两种不同的测量视图。另外，您还可以比
较实际测量数据和过去保存在 9102 中的、被载入到一个曲线视图的测量
数据。如需了解设置曲线的详细信息，请参阅第 3 章 " 频谱分析操作 " 中
" 设置曲线 " 第 60 页。

使用极限

与在反射模式中一样，您可以利用极限线测量故障点距离。如需了解关
于如何使用极限的详细信息，请参阅第 2 章 " 一般性操作 " 中 " 使用极限
线 " 第 31 页。

使用标记

9102 提供了强大的、方便的标记功能。为了进一步分析您的测量结果显
示图，您最多可以使用六个标记。如需了解关于如何使用标记的详细信
息，请参阅 " 使用标记 " 第 28 页。

查看 EMF （EMI）模式参数

您可以在 Parameter Window（参数窗口）中，查看当前模式的所有参数。
要查看这些参数，请按下 PARAM 功能键。要关闭 Parameter Window，回
到您此前使用的菜单，请按下 ESCAPE 功能键，Exit 软键，或者 PARAM 功
能键。要关闭参数页面和切换到相关的主菜单，请按下 Main 软键。

图 60 EMF (EMI) 参数
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查看 EMF （EMI）模式参数
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Chapter 13 故障诊断
12

本章将介绍怎样处理与 9102 手持式频谱分析仪有关的错误和故障。
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第十二章  故障诊断
处理系统错误
处理系统错误

如果一个错误或者故障导致您无法控制仪器，需要重新设置仪器软件，
9102 提供了 Setup Application Software 菜单。该菜单让您可以在不启动仪
器软件的情况下操作仪器和进行软件升级。

第 13 章 " 升级仪器软件 " 将详细介绍通过 Setup Application Software 菜单
升级仪器软件的方法。
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Chapter 14 升级仪器软件
13

本章将介绍怎样通过 9102 手持式频谱分析仪的 Setup Application Software
（应用软件设置）菜单升级仪器软件。本章所要讨论的主题包括：

－ " 应用软件设置菜单 " 第 196 页

－ " 设置一个密码 " 第 196 页

－ " 进行 LAN 升级 " 第 198 页

－ " 确定主机 IP 地址 " 第 199 页
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应用软件设置菜单
应用软件设置菜单

您可以在不自动载入仪器软件的情况下，进入 9102 手持式频谱分析仪的
应用软件设置菜单。因此，如果一个错误或者故障导致您无法控制仪
器，需要重新设置仪器软件，该菜单为您提供了操作仪器的途径。该菜
单为软件升级提供了两种方式：串行升级和 LAN 升级。您可以通过在启
动窗口上显示输入提示消息时按下数字键 0，进入该菜单。

设置一个密码

为了确保只有经过授权的用户才可以进行软件升级，您可以设置一个密
码，保护软件升级选项。如果您设置了一个密码，那么想要通过 Setup
Application Software 菜单升级软件的用户只有在正确输入密码之后，才能
载入数据。

要设置密码，请执行以下操作：

1 开启 9102。要进入 Setup Application Software 菜单，请在启动窗口上
显示输入提示消息时按下数字键 0。这时屏幕上将显示 Setup
Application Software 菜单。

2 按下数字键 3，打开密码输入栏。

3 输入一个 6 位数字作为您的密码。每输入一位数字，输入栏中就将显
示一个星号 (*)。

4 按下 ENTER，提交您输入的密码。这是系统将提示您再输一遍密码，
以供确认。

5 按下 ENTER，提交您再次输入的密码。如果您第二次输入的密码与首
次输入的密码不同，屏幕将会显示一个错误提示，您需要再次输入密
码。否则，您设置的新密码将被保存。

您还可以修改过去设置的密码。为此，请执行上述操作。如果此前已经
设置了一个密码，系统将会自动要求您在输入新密码之前先输入原先的
密码。

注

该密码只能影响 Setup Application Software 菜单中提供的软件升级选
项。它不会影响仪器的应用软件的使用。

注

如果您忘了您的密码，请联系Willtek的技术支持中心。如需了解Willtek
技术支持中心的联系信息，请参阅 " 技术支持 " 第 xvi 页。
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第十三章  升级仪器软件
进行串行升级
进行串行升级

要通过 Setup Application Software 菜单对仪器软件进行串行升级，请执行
以下操作：

1 将 9102 连接到一个外置电源。

2 将 9102 连接到一台 PC。如需了解更多细节，请参阅 " 连接 9102 手持
式频谱分析仪 " 第 12 页。

3 开启 9102。要进入 Setup Application Software 菜单，请在启动窗口上
显示输入提示消息时按下数字键 0。

这时屏幕上将显示 Setup Application Software 菜单。

4 按下数字键 1，打开 Serial Update 菜单。

Willtek 9100 Handheld Spectrum Analyzer
© Copyright 2005 Willtek Communications GmbH
All rights reserved.
U.S. patent pending

Press “0” to enter Setup…
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第十三章  升级仪器软件
进行 LAN 升级
5 要将应用文件从 PC 上载到仪器，请启动您的 PC 上的安装程序。这将
打开 Update 窗口，如下图所示：

6 在 Connection 栏中，选择 Serial。

7 要启动串行升级流程，请按下仪器上的数字键 1。

进行 LAN 升级

要通过 Setup Application Software 菜单对仪器软件进行 LAN 升级，请执行
以下操作：

1 将 9102 连接到一个外置电源。

2 将 9102 连接到一台 PC。如需了解更多细节，请参阅 " 连接 9102 手持
式频谱分析仪 " 第 12 页。

3 开启 9102。要进入 Setup Application Software 菜单，请在启动窗口上
显示输入提示消息时按下数字键 0。这时屏幕上将显示 Setup
Application Software 菜单。

4 按下数字键 2，打开 LAN Update 菜单。

注

您不需要点击您的 PC 上的 Update 窗口中的 Start。您不需要在 PC 上执
行任何操作，升级流程将会自动开始。
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确定主机 IP 地址
5 这时将显示仪器的 IP 地址（目标 IP）和 PC 的 IP 地址（主机 IP）。按
下数字键 1，修改或者输入主机 IP ；按下 2，修改目标 IP。如需了解
主机 PC 的 IP 地址的详细信息，请参阅 " 确定主机 IP 地址 " 第 199 页。

6 要将应用文件从 PC 上载到仪器，请启动您的 PC 上的安装程序。这将
打开 Update 窗口 （请参阅 " 进行串行升级 " 第 197 页） 。

7 在 Connection 栏中，选择 LAN。

8 要启动升级流程，请按下仪器上的数字键 3。

确定主机 IP 地址

要确定您的主机 PC 的 IP 地址，请执行以下操作：

1 在状态栏上，点击 Start，选择 Run，开启一个输入窗口。

2 在输入行键入 cmd，打开一个命令行提示窗口。

3 键入 IPconfig  -all，显示 PC 的网络设置。在这个列表中，您可以找到
PC 的 IP 地址。要关闭命令行提示窗口，请键入 exit。
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确定主机 IP 地址
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Chapter 15 9100 数据交换软件
14

本章将介绍怎样安装和使用 9100 数据交换软件。本章所要讨论的主题包
括：

－ "9100 数据交换软件介绍 " 第 202 页

－ " 安装要求 " 第 202 页

－ " 了解使用许可要求 " 第 202 页

－ " 安装软件 " 第 202 页

－ " 启动软件 " 第 203 页

－ " 连接 PC 和 9102" 第 204 页

－ " 载入 9102 的测量结果 " 第 205 页

－ " 在 PC 上保存、载入和打印结果 " 第 209 页

－ " 创建屏幕截图 " 第 211 页

－ " 使用测量结果 " 第 212 页

－ " 定义和载入极限模板 " 第 213 页

－ " 定义和载入外部耦合参数 " 第 217 页

－ " 管理用于信号功率测量的通信系统 " 第 219 页

－ " 管理用于故障点距离测量的线缆类型 " 第 220 页

－ " 为 EMF 测量管理天线系数 " 第 222 页

－ " 为 EMF 测量管理电缆系数 " 第 224 页

－ " 使用设置 " 第 225 页

－ " 管理 PC 和 9102 上的文件 " 第 226 页
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第十四章  9100 数据交换软件
9100 数据交换软件介绍
9100 数据交换软件介绍

9102 附带了一个名为 9100 数据交换软件的软件产品。该工具可以在 PC
上载入和显示 9102 的测量结果，以及在 9102 上安装升级软件。

安装要求

要安装 9100 数据交换软件，您需要：

－ 一台装有 Pentium （或者同等级的）处理器的 PC

－ Windows 98SE' Windows NT 或者更新版本

－ 至少 32MB RAM

－ 硬盘有 50MB 闲置空间

－ 一个闲置的串行接口或者 LAN 连接

了解使用许可要求

在安装 9100数据交换软件，请确认您已经理解了 "软件使用许可 "第 335
页中列出的许可条款。在任何时刻，该软件都只能安装在一台计算机
上！

安装软件

如果您通过 CD 获得该软件，您只需要将该 CD 插入您的 PC 的光驱。

运行 9100DataExchange.exe。

这将启动安装向导，将所需文件复制到您的 PC。

请遵循安装向导提供的安装提示。

在缺省情况下，安装向导将把程序文件保存在以下目录中（假定在英文
版 Windows 下安装）：

C:\Program files\Willtek\9100 Data Exchange
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第十四章  9100 数据交换软件
启动软件
启动软件

点击 Start > Programs > Willtek > 9100 Data Exchange，运行 9100 数据交换
软件。

屏幕将显示下面这个对话框：

要通过串行连接（PC 的 COM 端口上的 RS-232 接口）连接 9102，请选择
Serial Connection。

要通过基于 TCP/IP 的局域网（LAN）连接 9102，请选择 LAN Connection。

如果您不想要连接 9102，而是要打开一个过去保存在 PC 上的测量曲线
文件，请选择 Open existing Trace 或者 Cancel。
9102 手持式频谱分析仪 4.00 版本 203



第十四章  9100 数据交换软件
连接 PC 和 9102
连接 PC 和 9102
要连接 PC 和 9102，您需要先设置 9100 数据交换软件。

从菜单栏中，选择 Connection Settings > Serial / LAN...

这将打开 Connect 对话框，如下图所示：

使用事先定义的连接配置 如果您过去保存了成功连接 9102 的配置数据，请执行以下操作：

1 根据您想要使用的配置，利用一个串行连线或者 LAN连接 9102和 PC。

2 在 9100 数据交换软件的 Connect 对话框中（如上图所示），通过从下
拉列表框中或者 Connect 菜单左上角选择一个名称载入配置。点击
OK，载入这个配置。
PC 这时将试图通过配置文件中所定义的接口与 9102 互通消息。
Connect 对话框将关闭，如果成功建立了一个连接，PC 软件的状态栏
将显示 CONNECTED。

串行接口连接 1 选择 Serial 单选按钮。

2 选择与 9102 设置相同的波特率 （比特率）。

3 选择一个串行端口 （COM1 到 COM4）。

4 开启 9102，按照 " 连接 PC 和 9102" 第 204 页中的说明，利用一条交叉
调制解调器线将 9102 连接到 PC。
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第十四章  9100 数据交换软件
载入 9102 的测量结果
5 点击Check Connection，确认连接在所选的COM端口上是否可以使用。
PC 这时将试图通过所选串行端口连接的线缆与 9102 互通消息。
Connect 对话框将关闭，如果成功建立了一个连接，PC 软件的状态栏
将显示 CONNECTED。

LAN(TCP/IP）接口连接 1 选择 LAN 单选按钮。

2 输入 9102 的 IP 地址。9102 的 IP 地址可以利用 SCPI 命令通过一条 RS-
232 连接读取和修改；请参阅 " 修改 9102 的 IP 地址 " 第 42 页，了解
怎样修改 9102 的 IP 地址。

3 在 Port 输入栏中输入 IP 端口号。确认端口号处于有效范围 1024 到
65535 之间；缺省端口号为 49200。

4 开启 9102，利用一条标准网线将 9102 和 PC 连接到计算机网络，或者
利用一条交叉网线直接将它们连接到一起。

5 点击 Check Connection，确认连接在所选的 LAN 连接上是否可以使用。
PC 这时将试图通过网络与 9102 互通消息。Connect 对话框将关闭，如
果成功建立了一个连接， PC 软件的状态栏将显示 CONNECTED。

保存配置 您可以将配置保存在一个文件中供以后使用，这样您就不需要在每次使
用 9100 数据交换软件时重新输入配置。

1 在左上角的输入栏，输入一个配置名称，以识别您所进行的配置。多
个配置能够以不同的名称保存。

2 按下 Store，保存当前配置。

载入 9102 的测量结果

9100 数据交换软件可以用两种不同的方式载入和显示 9102 的测量结果
（曲线）。该软件可以载入 9102 目前显示的曲线，或者保存在 9102 内存
中的曲线。请注意，9100 数据交换软件可以打开多个窗口，并在每个窗
口中显示一条曲线。
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第十四章  9100 数据交换软件
载入 9102 的测量结果
在 PC 上查看实际曲线 1 按照第 204 页介绍的方法，连接 PC 和 9102。

2 在 9100 数据交换软件中，选择 Instrument > Display Trace，或者按下
Ctrl+T，或者点击图标 : 
曲线将显示在程序窗口中（如下图所示）。您可以在程序窗口中缩放
曲线或者将曲线显示最大化。

3 要将结果保存在本地 PC硬盘中 ,请选择 File > Save 或者 File > Save as，
再选择一个目录和文件名。
曲线文件将被保存在您的 PC 中。

切换显示模式 您可以曲线显示方式从横向显示改为纵向显示，或者相反。要切换显示
模式，请执行以下操作：

1 选择 View>View Mode。您还可以在屏幕上点击右键，打开一个右键菜
单，选择 View Mode。

2 选择显示模式 Landscape 或者 Portrait。显示模式将发生相应的变化。

显示和隐藏参数 您可以通过选择 View>Show All Parameters 或者 View>Hide All Parameters，
显示和隐藏曲线参数。

注

曲线还将显示任何已经启用的极限。在信道功率模式下，曲线将包含
通信系统的名称。

注

在信号发生器模式下，您不能通过 Display Trace 载入曲线，因为没有数
据可供显示。如果您在信号发生器模式下选择 Display Trace，屏幕将会
显示一个对话框，提醒您没有数据可供显示，请您选择另外一种模式。
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载入 9102 的测量结果
显示和隐藏标记 您可以通过选择或者取消选定 View>Markers Trace A 或者 View>Markers
Trace B，显示或隐藏标记。在选择显示标记时，Markers Trace A 或者 Marks
Trace B 边上将会显示一个记号。

连续加载实时曲线 您还可以在实时模式下，连续地从仪器加载实时曲线。这对于在您的 PC
上持续监控测量结果非常有用。为了连续地下载曲线，并在 9102 的显示
屏上加以显示，请执行以下操作：

1 选择 Instrument>Live Trace，按下 Ctrl+L，或者点击菜单栏中的相应图
标 : 。屏幕将显示实时曲线界面。您可以为实时曲线流程设置多
个参数。

2 如果您希望不断地刷新实时曲线，直到您手动终止该进程为止，那么
您可以在 Updates 栏中选择 Continuous mode。如果您希望设定一个固
定的刷新周期个数，而后进程将会自动终止，那么就选择第二个选
框，输入需要执行的刷新次数。在 Time between updates 字段中，输入
每个更新周期之间间隔的秒数。

3 如果您想要在一个新窗口中显示实时曲线，您可以在 View 栏中选择
Open new trace window。如果您希望覆盖当前曲线，请选择 Overwrite
active trace window。

4 如果您想要在实时曲线更新进程结束之后把实时曲线保存在一个文
件中，选择 Save 栏中的 Save as。在 Save 字段启用之后，您可以为把
曲线保存在您的 PC 上选择一个目录、文件名和文件类型。您可以将
曲线保存为 *.9tm 文件或者图片文件（例如 *.bmp、*.jpg 等）。如需了
解更多关于在您的 PC 上保存曲线的详细信息， " 在 PC 上保存、载入
和打印结果 " 第 209 页。
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将一条保存的曲线发送到
PC

要载入保存在 9102 中的曲线，请执行以下操作：

1 在 9102 上，将需要的测量结果保存在曲线文件中。

2 按照第 204 页页介绍的方法，连接 PC 和 9102。

3 在9100数据交换软件中，选择Instrument > Get Trace，或者按下Ctrl+G，
或者点击图标 : 
这将载入和显示 9102 上保存了的曲线文件列表 （如下图所示）。

4 选择需要的曲线文件，点击 View。
曲线将显示在程序窗口中。您可以在程序窗口中缩放曲线或者将曲线
显示最大化。

5 要将结果保存在本地PC硬盘中，请选择File > Save 或者 File > Save as，
再选择一个目录和文件名。缺省目录名为 Traces，位于您的 9100 数据
交换安装目录。
曲线文件将被保存在您的 PC 中，扩展名为 *.9tm，以区别 Get Trace 操
作所获得的、保存在 9102 中的原始曲线。这些曲线文件的扩展名为
*.9tr。

注

您还可以利用 Instrument > Data Transfer... 菜单中的 Traces 标签，双向传
输 *.9tr 曲线文件。
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在 PC 上保存、载入和打印结果

一旦一条测量曲线被发送到 PC，您可以将其保存在硬盘上，打印出来，
或者导出到一个图形或者文本文件。

在 PC 上保存结果 曲线 -- 以及 9102 的设置和标记 -- 都可以保存在一个文件中，并再次载
入到一个曲线文件中。这样，关于设置和测量结果值的信息将不会丢
失。

1 选择 File> Save 或者 File>Save As...。
屏幕将显示一个带有文件选择对话框的窗口。

2 选择一个目录和文件名，保存曲线数据，按下 ENTER 确认。
曲线数据将被保存在一个文件中。

在 PC 上载入一个曲线文
件

以前保存在 PC 上的结果可以重新显示在 9100 数据交换软件窗口中。

1 选了 File>Open。
屏幕将显示一个带有文件选择对话框的窗口。

2 选择包含曲线数据的目录和文件名，按下 ENTER 确认。
曲线数据将被载入到 9100 数据交换软件窗口中。

打印测量结果 1 选择 File>Print Setup，设置正确的打印机、打印方向和打印机相关参
数。按下 ENTER，确认改动。

2 您可以通过选择 File>Print Preview，在打印之前预览打印效果。

3 打开 File>Print 菜单，选择需要打印的页面，按下 ENTER 开始打印。如
果您希望一次打印多个文档，请选择 File>Print Open Documents。
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将测量结果保存为图形文
件

通过将测量结果保存为图形文件，您可以在其他应用 （例如 Word 处理
器）中载入它们，并以图形格式将它们插入到您的文档之中。支持的文
件格式包括：

－ Windows Bitmap (BMP)

－ JPEG (JPG/JPEG)

－ JPEG2000 (J2K/JP2)

－标签图像文件格式 (TIF/TIFF)

－ Zsoft Paintbrush (PCX)

－便携式网络图片 (PNG)

－ Sun Raster (RAS)

－ Truevision Targa (TGA)

－ Portable Bitmaps (PPM/PGM)

1 选择 File > Export > Image.
屏幕显示一个文件选择对话框 (Save image file)。

2 选择一个目录和文件名，保存测量曲线和文件格式，按下ENTER确认。
曲线数据将保存在选定位置的一个图形文件中。

将测量结果保存为文本文
件

您可以使用结果数据，将它们加入到其他用于后处理的应用中，例如
Microsoft Excel。

1 选择 File > Export > ASCII file.
屏幕显示一个文件选择对话框 (Save Trace as ASCII File...)。

2 选择一个目录和文件名，保存测量数据，按下 ENTER 确认。
曲线数据将保存在选定位置的一个文本 (.TXT) 文件中。

这个文本文件的每一行都包含一个设置参数，参数名称与它的值之间用
一个分号隔开。
210 9102 手持式频谱分析仪 4.00 版本



第十四章  9100 数据交换软件
创建屏幕截图
创建屏幕截图

9100数据交换软件还为直接生成9102所显示的软件窗口的屏幕截图提供
了一个工具。利用 Screen Dump 工具，您可以方便地创建屏幕截图，将
它们保存为图像文件和复制到剪贴板，以及直接打印它们。

要创建屏幕截图， 。 请执行以下操作：

1 选择 Instrument > Screen Dump, 或按下 Ctrl+N, 或选择菜单条中的图标
按钮 :  屏幕将显示 Screen Dump 窗口。

2 要在 Screen Dump 窗口中选择目前在 9102 中显示的屏幕窗口，点击
Read Screen。 9102 的显示窗口幕将显示在 Screen Dump 窗口中。 

3 要将屏幕截图保存为一个图形文件，请点击 Save as Image。
屏幕显示一个文件选择对话框 ("Save image file")。

4 选择一个目录和文件名，保存测量曲线和文件格式，按下ENTER确认。
曲线数据将保存在选定位置的一个图形文件中。

5 要将屏幕截图复制到其他应用中，请点击 Copy to Clipboard。

6 要直接从 Screen Dump 工具打印屏幕截图，请点击 Print。
注

为确保打印质量 , 建议使用直接连接的打印机 , 而不是用网络连接的打
印机。
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7 如果您想要创建另外一个屏幕截图，请点击 Clear Display ，重新执行
上述操作。

8 要关闭 Screen Dump 工具，点击 Exit。

使用测量结果

要从 PC 打开一个过去载入的测量曲线，请选择 File > Open。
这将打开一个文件选择对话框，请您选择一个目录和曲线文件。

添加标记 9102已经提供了多达六个标记；标记的位置将会随着曲线一同保存和发
送。您可以在曲线 A 和曲线 B 上使用标记。

除了这些静态标记以外，您还可以在 PC 上使用额外的动态标记，在屏幕
显示的任何频率上读取电平值。每条曲线最多可以使用 10 个标记。
要在 PC 上启用或者禁用标记，请执行以下操作：

－ 选择 View > Select Trace Markers。您还可以用右键点击屏幕，在右键

菜单中选择 Select Trace Markers。
屏幕将显示 Select Trace Marker 窗口。

－ 要启用一个标记，请通过选中 Marker 栏中的相应控制框，启用一个标

记 (A1 到 A10 或者 B1 到 B10)。要启用一个动态标记，请选中 Delta
Marker 栏中的相应控制框 (DA2 到 DA10 或者 DB2 到 DB10)。

－ 要将标记置于最高峰值上，请点击 Max Peak。

－ 要将标记置于次高峰值上，请点击 Next Peak。

－ 要将标记置于所有峰值上(最多支持10个标记)，请点击Label All Peaks。
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－ 要为 Label All Peaks 设置一个门限值，请点击 Set Threshold。按钮标签

这时将变为 Clear Threshold。请通过点击上下箭头，在下面的输入栏中

设定门限值。如果您想要移除极限，请点击 Clear Threshold。在设定门

限值之后，只有超过门限值的峰值才会被标注。

－ 要输入对标记的说明，请点击 Marker description。屏幕将显示一个

Marker Description 窗口。输入所设标记的说明，点击 OK。在纵向显示

格式下，这些说明将显示在标记之后。

－ 要将标记移动到另外一个频率，请用鼠标拖曳标记。或者，使用键盘
上的 LEFT/RIGHT ( 缓慢移动 ) 或者 UP/DOWN ( 较大步进值 )。

调节参考电平和刻度 要调节参考电平和刻度，请执行以下操作：

1 选择 View > Level，屏幕将显示 Level 窗口。

2 使用 Ref. 栏的上下箭头，设定参考电平。

3 在 Scale 栏中设定刻度。

4 在 Level Unit 栏中，您可以从下拉菜单中选择一个单位。

使用网格 您可以通过 View > Grid ，开启或者关闭由垂直、水平线组成的网格。您
还可以对屏幕点击右键，在右键菜单中选择 Grid。PC 网格与 9102 相同，
例如它也包含八条横线和十条直线。

输入文字 您可以为曲线添加文字说明，将其与测量结果一同保存。这样，您就可
以添加关于测量条件的重要信息。说明文字可以被打印出来和与图形一
同保存，但是不能导出到一个图形或者文本文件。

1 选择 View > Comment。
打开一个 “Comment”窗口，请您输入文字。

2 输入您的文字 ( 最多三行 ), 点击 Save, 让 9100 数据交换软件把文字与
测量结果保存到一起。

定义和载入极限模板

9102的一项重要功能之一就是它可以将测量结果与适先定义的极限相比
较。极限是以一种模板的形式定义的，决定实际测量结果未超出或者超
出了极限值。模板可以在 PC 上利用 9100 数据交换软件定义，再载入到
9102 上。 9102 最多可以保存 99 个模板。
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如果有一个典型测量结果曲线的例子，模板编辑将更为方便。9100 数据
交换软件的 Limits Editing 菜单不仅可以显示实际的极限曲线 ( 模板 )，还
可以显示 PC 上保存的一个例子。

极限模板可以被用于频率和时域的测量结果。用于时域的极限模板的一
个典型例子是用于 GSM 电话的功率 / 时间模板。

极限是以相对于 9102 显示窗口中的网格的位置表示而，而不是频率（或
时间）和功率的绝对值。这样，通过设置不同的刻度，您可以将同一个
模板用于不同的功率电平和频率。

定义极限 极限可以被定义为一种有上限和下限的极限曲线模板。每条曲线包括许
多点连成的直线。9100 数据交换软件的极限菜单可以让您输入和显示这
些线条。

极限是以相对于屏幕上的网格 （包含八条横线和十条竖线）的位置表
示。每个点的座标 （包括 X/Y 座标）与这些直线对应。

要定义一个新的模板，请执行以下操作：

1 在 9100 数据交换软件中，选择 Tools > Limits Editor... 或点击菜单条上
的图标 : 。
屏幕将显示 Limit Lines 窗口，并在左侧显示极限坐标表，在右侧显示
极限线。

2 要加入一条新的极限线，点击 Insert。
打开一个窗口，请您输入两点的 X/Y 座标。
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3 通过选择 Upper Level 和 Lower Level 单选按钮中的一个，选择您希望设
定上限还是下限。

4 输入极限线的第一个点的座标 (x1, y1)。

5 输入极限线的第二个点的座标 (x2,y2)。之后，您还可以通过用鼠标拖
曳极限线，移动极限线的位置。

6 选择 OK，确认您的选择，关闭窗口。
窗口将关闭。坐标值将被输入到屏幕左端的极限表中，而极限线将显
示在右侧的极限线图中。

7 根据您的需要，输入更多的极限线，完成整个模板的定义。

修改极限线 您可以通过修改或者删除单个极限线，修改模板：

1 在 Limit Lines 窗口的表格中，点击您想要修改或者删除的极限线。
表中的极限线将高亮显示，图形中相应的极限线将显示为红色。

2 要修改极限，点击 Edit 或者双击该行数据。将会弹出一个对话框，请
您修改极限。
要删除极限线，请点击 Delete。

或者，要修改现有极限线的起点和终点，请执行以下操作：

1 在 Limit Lines 窗口的图形中，点击您希望修改的极限线的起点。

2 将鼠标指向极限线的起点或终点。按住鼠标左键，将该点移动到新的
位置，再释放左键。

显示 Limits Editing 菜单
中的一个曲线示例

1 在 Limit Lines 窗口中，选择 Overlay Trace。
弹出一个文件选择对话框。

2 从缺省或者其他任何目录中选择一个曲线文件，点击 Open。
文件选择对话框关闭，曲线文件显示在 Limit Lines 窗口右侧的极限线
栏中显示的曲线数据。
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在 PC 上保存模板 可以在 PC 上保存一个模板，以便以后修改，或者随后将其下载到不同的
9102 分析仪。

1 在 Limit Lines 窗口中，选择 Save。
打开一个窗口 ("Save Limit Lines")。

2 选择一个目录，输入保存极限模板的文件名。

3 按下 ENTER ，确认您的选择。
极限模板保存在一个文件中。

从 PC 载入模板 要对已保存在 PC 上的模板进行修改或上载至 9102，请执行以下操作：

1 在 Limit Lines 窗口中，选择 Open。
显示一个文件选择窗口 ("Open Limits File...")。

2 选择包含此前通过9100数据交换软件保存的模板文件的目录和文件。

3 按下 ENTER ，确认您的选择。
极限将会被载入到极限表和图形中。您现在可以修改极限（参见上面
的 " 修改极限线 "）或者将极限下载到 9102°.

发送模板到 9102 1 按照上面介绍的步骤，定义一个模板或者从 PC 的硬盘载入。

2 确认 PC 通过 RS-232 或者 LAN 与 9102 相连。

3 选择 Data Transfer。
如果模板 (包含极限线 )尚未保存 ,一个对话框将询问您是否希望将其
保存在 PC 硬盘上。如果您选择不保存模板 , 您所做的改动将会丢失。
Data Transfer 窗口的 Limits 标签将显示。
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4 在 Data Transfer 窗口的 PC 端 （右侧）选择一个极限文件 （或者多个
文件），点击 < copy。
如果是首次打开该窗口， 9102 将询问是否连接到 9102。在这种情况
下，请遵循 " 连接 PC 和 9102" 第 204 页中的说明。

9102 上的文件名将只能使用 PC 上使用的文件名中的前 11 个字符。
如果选择发送 PC 上的一个极限文件，而 9102 上已经存在了一个具有
相同名称的极限文件，9100 数据交换软件将会弹出一个对话框，在标
题栏中显示这个极限文件的名称，并提供多个选项：

- 如果您想要覆盖 9102 上的同名文件，点击 Yes。

- 如果您想要取消发送该文件，点击 No。

- 如果您想要把所有文件发送到 9102 （无论文件名是否重复），请
点击 Yes to All。

- 要防止覆盖所有同名文件，点击 No to All。

- 点击 Rename，为下载到 9102 的文件输入一个新的文件名。

- 点击 Cancel，取消发送所有文件 , 无论 9102 中是否存在相同的文
件名。

当下载成功完成时， 9100 数据交换软件将显示提示。

5 在 9102 上，按下 ESCAPE，回到本地模式。您可以开始使用极限模板。

定义和载入外部耦合参数

9102手持式频谱分析仪可以补偿被测设备和9102之间的外部设备所产生
的增益或者衰减。耦合可以在 9100 数据交换软件中定义；您可以定义、
保存多个用于不同设备的文件，再将其下载到 9102。而且，在安装 9100
数据交换软件时，两个包含外部耦合参数的文件将会被自动保存到 PC上
的 9100 数据交换目录下的 ExtDev 目录。一旦下载完毕，您就可以随时
开启或者关闭对外部设备所产生的影响的补偿。9102 会在显示测量结果

之前，考虑耦合因数的影响。

在大多数情况下，增益和补偿都会随频率变化；因此，9100 数据交换软

件允许您输入插值点，涵盖在整个测量频率范围内的随频率变化的耦合
因数。
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定义外部耦合因数 1 打开External Device Compensation菜单:选择Tools > External Device Editor
...，或者按下 Alt-E，或点击图标 :

2 输入插值点，点击 Insert。
弹出一个对话框，请您输入频率和电平。

3 输入频率，选择单位 （从赫兹到兆赫兹） ，输入耦合因数 （单位为
dB）。正的耦合因数表示信号衰减，负的耦合因数表示信号增益。

4 按下 OK 关闭对话框。如果需要插入多个插值点，请反复执行后两步
操作。
在输入数值时，随频率变化的补偿曲线会显示在屏幕右侧。

5 如果您想要修改一个因数，请从左侧表格中选择一条曲线，点击Edit，
修改数值；或者用鼠标选中右侧图形中的某个插值点，将其拖曳到新
的位置。

6 要以 1dB 为步进单位上下移动整个插值曲线，请点击 Level Offset 箭头
按钮。

7 在完成之后，将设备补偿值保存在 PC 上的一个文件中：点击 Save，
输入一个文件名，再点击 Save 确认。

8 按下 Cancel，关闭 External Device Compensation 窗口。

将外部耦合损耗文件载入
到 9102

一个或者多个包含外部耦合损耗数据的文件可以被发送到 9102，保存在
9102 的内存之中。在启用它们之前，9102 不会在显示测量结果之前考虑

这些数据的影响 (请参阅 " 补偿增益和损耗 ")。

1 选择 Instrument > Data Transfer (Ctrl-D)，或者在 External Device
Compensation 菜单中 , 选择 Data Transfer。
打开 Data Transfer 菜单。
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2 在 Ext. Device 标签中，选择位于右侧的目录和文件，按下 < copy。
所选文件将会被发送到 9102。

管理用于信号功率测量的通信系统

要在信道模式下进行测量，需要定义一个带有预设信道编号和相关频率
的通信系统。9102预装了一些系统；您还可以将更多的系统从 9100数据
交换软件下载到 9102，例如无线 LAN、蓝牙和 TETRA。要了解 9100 数据
交换软件中可用的全部通信系统列表 ,请参阅 "预定义的信道功率通信系
统 " 第 316 页。您可以在 9102 上找到预装的通信系统列表。利用 9100 数
据交换软件，可以方便地在 PC 上输入其他系统的数据。每组系统数据都
保存在一个单独的文件中，您可以将一个或者多个文件下载到 9102。要
在 PC 和 9102 之间下载和复制系统文件，请参阅下面的 " 管理 PC 和 9102
上的文件 "。一旦数据被保存在 9102 之中，就可以按照 " 信道功率模式
操作方法 " 第 78 页中的说明使用这些数据。

在 PC 上编辑通信系统参
数

1 选择 Tools > Channel System Editor ( 或者 Alt-C ) 或点击菜单条上的图标
: 。
打开 Channel System 菜单。

2 如果您想要编辑已经保存在 PC 上的通信系统，请按下 Open，选择相
应的目录和文件，按下 ENTER 或者点击 Save。

3 输入系统的第一个和最后一个有效通道编号。

4 在 Channel Width 行中，输入测量带宽 （在不同的输入栏中分别输入
数值和单位）。

5 在 Channel Spacing 行中，输入连续信道编号之间的频率间隔（包括单
位）。

6 输入与 1st Ch. Center 行中的第一个信道编号对应的载波频率（包括单
位）。

7 点击 Save。
弹出一个对话框，让您输入保存通信系统的信道系统参数的文件名。
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8 输入一个文件名，按下 ENTER 或者点击 Save。
数据保存，对话框关闭。

9 要将数据发送到 9102，请按下 Data Transfer。要关闭 Channel System 窗
口，请按下 Cancel。

管理用于故障点距离测量的线缆类型

如果您在您的 9102 上安装并启用了 9130 VSWR/DTF 反射测量选件 ,
(VSWR/) Tracking... 菜单将可以为您提供额外的测量模式，包括反射、故

障点距离和线损。故障点距离测量针对天线系统中的线缆，可以测量反
射指标随线缆的变化情况，以发现和定位接口松动、线缆绞缠、浸水和
其他与线缆有关的问题。

对于这些测量，Willtek 可以为在安装天线时最常使用的同轴电缆提供预
定义的线缆参数文件。9100 数据交换软件附带的这些文件可以被方便地
上载到 9102。对于罕见的线缆类型，您可以手动设置线缆参数，再将它
们发送到 9102。 

如需了解关于故障点测量的详细信息， 请参阅 "故障点距离操作 "第 147
页。

将预定义的线缆类型上载
到仪器

要将您的 9100数据交换软件附带的预定义参数文件上载到 9102，请执行

以下操作：

1 选择 Instrument > Data Transfer，选择 Cable Type 标签。
您还可以选择 Tools > DTF Cable Type Editor...，点击 Data Transfer 按钮。
屏幕将显示线缆类型发送选择窗口。

注

下面几节所介绍的功能是专门针对 9130 VSWR/DTF反射测量选件的。如
果您没有在您的 9102 上安装和启用这个选件，这项功能将无法使用，
因为这种情况下线缆类型无法被发送到 9102。
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2 在右侧的 PC 栏将显示 PC 上保存的线缆类型。选择您想要上载到仪器
的线缆类型，点击 < copy。所选择的线缆类型将被发送到您的 9102。

定义线缆类型 要定义预装参数文件中没有提供的新线缆类型，请执行以下操作：

1 选择 Tools > DTF Cable Type Editor...或 Alt+C 或点击菜单栏图标 : . 屏
幕将显示 Cable Type 窗口。

2 输入线缆参数：线缆绝缘吕、线缆速度因数、线缆衰减值和线缆截止
频率。如需了解应当输入的数值，请参考制造商提供的信息。如需了
解线缆参数的一般性信息，请参阅 " 设置线缆参数 " 第 150 页。

3 点击 Save，将线缆类型保存到您的 PC 上。屏幕将显示一个文件选择
窗口。保存文件的扩展名将为 *.ct。

您现在可以按照 "将预定义的线缆类型上载到仪器 "第 220页中的说明，
将预定义线缆类型上载到您的 9102。

从 9102 发送线缆类型 您还可以将 9102 上定义的线缆类型发送到您的 PC。所用操作与 " 将预定
义的线缆类型上载到仪器 " 第 220 页中介绍的步骤几乎完全相同。保存
在 9102 中的线缆类型将显示在数据传输窗口左侧的仪器栏中。您只需要
选择需要的线缆类型，点击 copy >。

注

Willtek 建议您只将实际测量所需要的线缆类型发送到 9102。如果您在
9102 上保存了过多的线缆类型，您将需要用很长时间才能找到故障点
距离测量所需要的线缆类型。
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为 EMF 测量管理天线系数

天线是 EMF 测量中最重要的因素之一。为了校准天线，需要一个包含 k
系数的校准表。这些系数是一些旨在校准天线频率响应的比例系数，有
助于将测得的功率或者电压转化为场强或者功率密度。利用 k 系数表，
测得的电平会被转化为相关的物理量。

Willtek 所提供的测量天线都附带了相应的校准系数表。利用 9100 数据交
换软件，您可以将 k 系数表发送到您的仪器之中。您还可以利用 9100 数
据交换软件，搜集其他供应商的天线产品的校准数据，再将它们发送到
您的 9102 之中。

如需了解关于EMF测量和相关天线类型的详细信息，请参阅第11章 "EMF
(EMI) 操作 "。

注

下面几节中介绍的功能是专门针对 9131 EMF 测量选件的。如果您的
9102 上没有安装和启用该选件，这些功能就将无法发挥作用。
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定义一个天线系数 1 选择 Tools>EMF Antenna Factor Editor…，或者按下 Alt+A，或者点击菜
单栏上的相应按钮 : , 打开 EMF Antenna Factor 菜单。

2 要输入一个插值点，选择 Insert。
屏幕上显示一个对话框，让您可以输入频率和电平。

3 输入频率，选择一个单位（从赫兹到吉赫兹），再输入耦合系数（单
位：dB）。正系数表示信号衰减，负系数表示信号线路存在增益。

4 按下 OK，关闭对话框。再重复执行上两个步骤，输入其他的插值点。
当输入数值时，与频率有关的补偿曲线将显示在屏幕右侧。

5 如果您想要修改某个系数，您可以从屏幕左侧的表格中选择一行，点
击 Edit，修改数值；或者用鼠标点击屏幕右侧图片上的某个插值点，
将其拖入一个新的位置。

6 要想以 1dB 为单位，上移或者下移整个插值曲线，请点击 Level Offset
箭头按钮。

7 在完成之后，将天线系数值保存在 PC 上的一个文件之中：点击 Save，
输入一个文件名，再点击 Save 确认。

8 按下 Cancel，关闭 EMF 天线系数编辑器窗口。

将天线系数文件加载到
9102

用户可以将一个或者多个天线系数文件发送到 9102。它们将保存在 9102
的一个内部存储器之中。在启用它们之前，不需要加以考虑。

1 选择 Instrument>Data Transfer(Ctrl-D)，或者在 EMF 天线系数编辑器菜
单中，选择 Data Transfer。
打开 Data Transfer 菜单。

2 在 EMF Antenna Factors 标签中，在窗口右侧选择一个目录和文件，按
下 <copy。
所选文件将会被发送到 9102。
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为 EMF 测量管理电缆系数

如果您需要在您的 EMF 测量配置中使用一条延长线，（例如为了将天线
安装在三脚架和转向设备上），您必须通过在 9102 上启用相应的电缆校
准系数消除电缆信号衰减产生的影响。您可以在 9100 数据交换软件中保
存和编辑电缆系数。您可以将它们发送到您的 9102，以便在 EMF 测量中
使用。

如需了解更多关于在 EMF 测量中使用电缆系数的信息，请参阅第 11 章 
"EMF (EMI) 操作 "。

定义一个电缆系数 1 选择 Tools>EMF Cable Factor Editor…，或者按下 Alt+F，或者点击菜单
栏上的相应按钮 :: , 打开 EMF Cable Factor 菜单。

2 要输入一个插值点，选择 Insert。
屏幕上显示一个对话框，让您可以输入频率和电平。

3 输入频率，选择一个单位（从赫兹到吉赫兹），再输入耦合系数（单
位：dB）。正系数表示信号衰减，负系数表示信号线路存在增益。

4 按下 OK，关闭对话框。再重复执行上两个步骤，输入其他的插值点。
当输入数值时，与频率有关的补偿曲线将显示在屏幕右侧。

5 如果您想要修改某个系数，您可以从屏幕左侧的表格中选择一行，点
击 Edit，修改数值；或者用鼠标点击屏幕右侧图片上的某个插值点，
将其拖入一个新的位置。

注

下面介绍的功能是专门针对 9131 EMF 测量选件的。如果您的 9102 上没
有安装和启用该选件，这些功能就将无法发挥作用。
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6 要想以 1dB 为单位，上移或者下移整个插值曲线，请点击 Level Offset
箭头按钮。

7 在完成之后，将电缆系数值保存在 PC 上的一个文件之中：点击 Save，
输入一个文件名，再点击 Save 确认。

8 按下 Cancel，关闭 EMF 电缆系数编辑器窗口。

将电缆系数文件加载到
9102

用户可以将一个或者多个天线系数文件发送到 9102。它们将保存在 9102
的一个内部存储器之中。在启用它们之前，不需要加以考虑。

1 选择 Instrument>Data Transfer(Ctrl-D)，或者在 EMF 电缆系数编辑器菜
单中，选择 Data Transfer。
打开 Data Transfer 菜单。

2 在 EMF Cable Factors 标签中，在窗口右侧选择一个目录和文件，按下
<copy
所选文件将会被发送到 9102。

使用设置

9102 允许保存和调用设置（请参阅 " 使用过去保存的设置 " 第 46 页）。
在您需要在与过去完全相同的条件下进行测试时，这项功能可能会非常
有用。利用 9100 数据交换软件，您可以将设置从 9102 发送到 PC 进行备
份，或者将设置复制到另外一台 9102。另外一个有用的应用是在 PC 上
修改设置；这非常容易实现，因为设置文件都是可编辑的，而且格式包
含了 SCPI 命令。要修改或者添加一个设置，只需要在设置文件中修改或
者添加一行。

在 9102 和 PC 之间交换
设置文件

利用 9100 数据交换软件，可以将保存在 9102 上的设置复制到 PC。利用
Data Transfer 工具中的 Setting 标签，可以在 PC 和 9102 之间复制文件。请
参阅 " 管理 PC 和 9102 上的文件 " 第 226 页，了解详细信息。

在 PC 上修改 9102 设置 要修改和补充一个设置文件，以便在以后发送到 9102 和在 9102 上使用，
请执行以下步骤：

1 在 9100 数据交换软件中，选择 Tools > Settings, Editor 或按下 Alt+S。
打开 9100 Settings 对话框。

2 点击 Open，打开 PC 上已有的一个设置文件。
屏幕显示 Open Settings File... dialog box 对话框。

3 选择您希望修改的目录和设置文件，点击 Open。
打开另外一个包含 Microsoft Windows 文本编辑器 Notepad 的窗口。所
选文件将被显示在该窗口中。
9102 手持式频谱分析仪 4.00 版本 225



第十四章  9100 数据交换软件
管理 PC 和 9102 上的文件
4 利用 SCPI 命令为需要的设置修改或者添加内容。请参阅 "SCPI 命令参
考 " 第 229 页，了解正确的语法和参数的取值范围。

5 在 Notepad 中保存并关闭文件，回到 9100 数据交换软件，将文件发送
到 9102。

管理 PC 和 9102 上的文件

利用 9100 数据交换软件，可以从 PC 管理不同类型的设置。本节将介绍
怎样在 9102 和 PC 之间发送、保存和删除数据。

文件类型和目录结构 保存在PC上的每种针对不同参数组合的设置都具有一个首选文件扩展名
和目录。下标汇总了这些文件结构。

表 17 配置文件类型

配置文件类型
配置文件
类型

目录

曲线 *.9tr 9100 Data Exchange\Traces

保存在 PC 上上的、
经过修改的曲线。

*.9tm 9100 Data Exchange\Traces

设置 *.9st 9100 Data Exchange\Settings

极限 *.9lm 9100 Data Exchange\Limits

系统 *.9sy 9100 Data Exchange\Systems

外部设备 *.9ed 9100 Data Exchange\Extdev

DTF 线缆类型 *.9ct 9100 Data Exchange\Cable Types
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启动文件管理器 通过Data Transfer窗口,可以方便地选择、复制和删除PC和9102上的文件。

1 在 9100 数据交换软件中 , 选择 Instrument > Data Transfer( 或者 Ctrl-D)。
屏幕显示 Data Transfer 窗口。

2 用鼠标点击相应标签 (Traces, Settings, Limits, Systems, Ext. Device) 选中，
或者利用 << 和 >> 按钮选择标签。
窗口左侧显示 9102 现有的文件，右侧显示 PC 上现有的文件。PC 上的
文件带有一个扩展名，可以被存储在任何驱动器和任何目录中。9102
上则没有目录。

EMF 天线因素 *.9af 9100 Data Exchange\ Antenna Factor

EMF 电缆因素 *.9cf 9100 Data Exchange\Cable Factor

表 17 配置文件类型

配置文件类型
配置文件
类型

目录

注

9102 上的文件名只能包含 11 个字符。在将一个文件名超过 11 个字符
的文件从 PC 复制到 9102 时，文件名将会被自动截短。只有扩展名为
*.9tr 的曲线文件可以被发送到 9102。
9102 手持式频谱分析仪 4.00 版本 227



第十四章  9100 数据交换软件
管理 PC 和 9102 上的文件
将配置文件从 9102 复制
到 PC

文件可以双向复制。

1 选择需要保存文件的 PC 目录或者从中复制文件的 PC 目录。

2 在 PC 或者 9102 上选择一个或者多个需要复制的文件。

3 按下 < copy，将文件从 PC 发送到 9102。
或者
按下 copy > ，将文件发送到 PC。
如果在某一侧选择发送一个文件，而在另外一侧存在一个与之同名的
文件，那么 9100 数据交换软件将会弹出一个对话框，在标题栏中显
示这个极限文件的名称，并提供多个选项：
- 如果您想要覆盖同名文件，点击 Yes。
- 如果您想要取消发送该文件，点击 No。
-如果您想要发送所有文件 (无论文件名是否重复 )，请点击Yes to All。
- 要防止覆盖所有同名文件，点击 No to All。
- 点击 Rename，为所要发送的文件输入一个新的文件名。
- 点击 Cancel, 取消发送所有文件 -- 无论接收侧是否存在相同的文件
名。

删除文件 1 要在 9102 或者 PC 上删除一个文件，请先选择 ( 高亮显示 ) 该文件名。
您可以通过在选择单个文件时按下 Shift 或者 Ctrl 键，同时选择多个
文件。

2 点击在选中删除的文件上访的 Delete 按钮 ，将会弹出一个对话框：
覣 re you sure to delete the selected items?”( 您是否肯定要删除这些条目
?)。

3 点击 Yes，确认删除。
所选文件将被删除。
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Chapter 16 SCPI 命令参考
15

本章为 9102 手持式频谱分析仪的远程控制提供了一个参考命令列表。本
章所要讨论的主题包括：

－ " 概述 " 第 230 页

－ " 一般性命令 " 第 230 页

－ " 系统命令 " 第 235 页

－ " 测量命令 " 第 241 页

－ " 输入命令 " 第 262 页

－ "MMemory 命令 " 第 264 页

－ " 仪器命令 " 第 275 页

－ " 显示命令 " 第 277 页

－ " 计算命令 " 第 281 页

－ " 格式命令 " 第 289 页

－ " 服务命令 " 第 290 页

－ "SCPI 错误 " 第 293 页
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概述
概述

9102 手持式频谱分析仪的命令集符合 SCPI 标准，主要分为下列子系统：

－一般性命令

－系统命令

－测量命令

－输入命令

－存储命令

－显示命令

－计算命令

－格式命令

命令中的每个关键词都可以使用完整格式或者简化格式。大写字母表示
简化格式命令语法。但是在一个关键词中只能使用简化格式或者完整格
式，而不能混用。

语法可以被用于构成一个命令或者查询 （在命令格式后面带有一个问
号）。很多 SCPI 命令都具有命令格式或者查询格式，但是不能兼有这两
种格式。

请参阅 "SCPI 命令参考 " 第 309 页，查看按字母顺序排列的命令列表。

一般性命令

:REBoot

:HCOPY[:IMMediate]

语法 :REBoot

参数 没有参数

用途 重启 Willtek 9102。当前设置不会受到该命令的影响。

查询 该命令没有查询格式。

示例 :REBoot

语法 :HCOPy [:IMMediate]

参数 没有参数

用途

查询 没有命令格式。

示例 :HCOPy
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一般性命令
*CAL

*CLS

*IDN

*RST

语法 *CAL?

参数 没有参数

用途 没有命令格式。

查询 以 yyyy,mm,dd 的格式返回 Willtek 进行最后一次校正的日期。

示例 *CAL?
返回 2004,04,01.

语法 *CLS?

参数 没有参数

用途 重设整个状态报告系统 :
- 服务寄存器将被清空 （所有数据都重设为 0）。

- 事件状态寄存器将被清空 （所有数据都重设为 0）。

- 错误提示队列将被清空。

- 所有事件类型寄存器将被清空。

查询 该命令没有查询格式。

语法 *IDN? 

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回一个字符串，包含下列信息：

- 制造商名称

- 设备名称

- 序列号

- 软件版本号

所有参数通过逗号隔开。

注 : 考虑到公司并购的影响，最好检查设备名称，而不只是制造商名称，因为
后者可能会在软件升级时进行改动。这不仅包括 Willtek 对名称所做的任何改
动，也适用于一般性的仪器。

示例 *IDN?
返回 : "WILLTEK, 9102, 0104012, 1.00"

语法 *RST

参数 没有参数

用途 重置整个测试组合。所有参数、极限等都将被重置为内部预定义的缺省值。

查询 该命令没有查询格式。
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一般性命令
*OPC

影响事件状态寄存器的命
令

事件状态寄存器包含八个标志位。下表列出了这些标志位的含义。

下表还列出了与事件状态寄存器有关的命令。

*ESE

语法 *OPC?

参数 没有参数

用途 该命令只有查询格式。

查询 等待上个命令完成。另外，该查询会返回 Operation Complete 标志位。
如果上个命令成功完成，该标志位的值将为 1。

Tabelle 1: 

标志位 十进制 含义

7 128 上电 -- 该标志位总是会被设为 1。

6 64 用户请求 -- 如果该标志位的值为 1，则表示 9102 不
再由远程命令控制，而是由用户操作控制。

5 32 命令错误 -- 该标志位表示发生了一个 SCPI 命令错误
（SCPI 错误代码 100 到 199）。

4 16 执行错误 -- 在发生 SCPI 执行错误之后设置（SCPI 错
误代码 200 到 299）

3 8 与设备有关的错误 -- 该标志位表示发生了一个与设
备有关的错误 （SCPI 错误代码 300 到 399）

2 4 查询错误 -- 在发生 SCPI 查询错误之后设置（SCPI 错
误代码 400 到 499）

1 2 请求控制 -- 该标志位为未来用途预留。

0 1 操作完成标志位 -- 一旦一个命令执行完毕，该标志
位就会被设置为 1。

语法 *ESE <int1>

参数 int1是一个整数。

有效范围为从 0 到 255 （8 位）。

用途 设置事件状态寄存器的启用过滤器 （掩码）。

int1是二进制掩码的十进制值。

掩码和事件状态寄存器的当前内容将进行 “与”操作。如果结果为 0，那么
服务寄存器的第 5 位将被设为 1。

查询 查询格式会读取目前设置的启用过滤器 （掩码），再通过一个字符串返回它
的二进制值。

示例 *ESE 128
一经上电，第 7 位 （上电标志位）将被设为 1。通过和掩码 128 执行 “与”
操作，将得到一个二进制值 1，进而服务寄存器的第 5 位将被设为 1。
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一般性命令
*ESR

影响服务寄存器的命令 服务寄存器代表了 9102 的报告结构中的最高层次。

服务寄存器包含八个标志位。

如果标志位 0 到 5 或者 7 被设为 1，服务寄存器的汇总状态位（第 6 位）
也将被设为 1。

语法 *ESR? 

参数 没有参数

用途 该命令只有一种查询格式。

查询 通过一个字符串，返回事件状态寄存器当前内容的十进制值。

注 :  该寄存器具有自动恢复能力，即它的内容会在读取之后清空。

示例 在上电之后， *ESR? 查询将返回 ”128”。这意味着事件状态寄存器的第 7 位
被设为 1，所有其他位则均为 0。
该命令将清空事件状态寄存器，接下来的 *ESR? 查询将返回 “0”。

注

服务寄存器具有自动恢复能力，即它的内容会在读取之后清空。

标志
位

十进制 含义

7 128 OPERational状态汇总。在这一位被设为1时，表示
通用操作寄存器组中的某个事件（例如 9102 在等待
一个触发器）通过了所有过滤器。

6 64 汇总状态位。只有服务寄存器的其他任何一位被设
为 1，该位将会被立即设为 1。

5 32 事件状态汇总。在这一位被设为 1 时，表示事件状态
寄存器组中的某个事件 （例如发生了一个错误）通
过了所有过滤器。

4 16 消息可用。如果某个查询完成，并获得了测量结果，
该标志位将被立即设为 1。

3 8 QUESTionable状态汇总。在这一位被设为 1时，表
示一般性可疑状态寄存器组中的某个事件（例如“值
超出范围”）通过了所有过滤器。

2 4 错误队列状态。在这一位被设为 1 时，表示队列中包
含错误信息。错误队列中最多可以容纳 10 个错误提
示。错误队列可以利用:SYSTem:ERRor?查询读取。

1 2 远程命令完成。这个状态位将会在一个远程（SCPI）
命令执行完毕之后设为 1。
注：当 9102 收到一个 SCPI 命令时，它将会阻止任何
进一步的输入读取，直到该命令执行完毕。
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一般性命令
*SRE

*STB

语法 *SRE <int1>

参数 int1是一个整数。

有效范围是从 0 到 255 （八位）。

用途 设置服务寄存器的启用过滤器 （掩码）。

int1是该二进制掩码的十进制值。

掩码和服务寄存器的当前值将进行 “与”操作。

查询 查询格式可以读取当前设置的掩码，并通过一个字符串返回它的二进制值。

示例 *SRE 68
一旦发生错误，服务寄存器的第 2 位和第 6 位将被设为 1。通过与掩码（68）
进行 “与”操作，结果将是二进制值 1。

语法 *STB?

参数 没有参数

用途 该命令只有一种查询格式。

查询 通过一个字符串返回服务寄存器当前内容的二进制值。

注 : 该寄存器具有自动恢复能力，即它的内容会在读取之后清空。

示例 A *STB? 命令返回 "68"。
返回值 68 (= 64 + 4) 表示发生了错误 (4)。
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系统命令
系统命令

利用系统命令，可以更改 9102 手持式频谱分析仪的内部设置。

:SYSTem:DATE

:SYSTem:TIME

语法 :SYSTem:DATE <int1>,<int2>,<int3>

参数 intx 是三个整数。

int1的最小值为 1998，最大值为 2100，缺省值为 1998。
int2的最小值为 1，最大值为 12，缺省值为 1。
int3的最小值为 1，最大值为 31，缺省值为 1。

用途 设置系统日期。该命令使用以下格式： yyyy,mm,dd
其中

yyyy 表示年份的四位数字 (int1)，
mm 表示当前月份 (int2),
dd 表示当前日期 (int3).

查询 利用上面所介绍的格式，通过一个字符串读取和显示当前系统日期。

示例 SYST:DATE 2001,7,6
将系统日期设置为 2001 年 7 月 6 日。

语法 :SYSTem:TIME <int1>,<int2>,<int3>

参数 intx 是三个整数。

int1的最小值为 0，最大值为 23，缺省值为 0。
int2的最小值为 0，最大值为 59，缺省值为 0。
int3的最小值为 0，最大值为 59，缺省值为 0。

用途 设置系统时间。该命令使用以下格式： hh,mm,ss 
其中 hh 表示 24 小时格式的当前小时数 （int1），

mm 表示当前分钟数 (int2)，
ss 表示系统时间的秒数 (int3)。

查询 利用上面所介绍的格式，通过一个字符串读取和显示当前系统时间。

示例 :SYST:TIME?
这个例子所返回的字符串为 “14,56,05”，表示下午 2 点 56 分。
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系统命令
:SYSTem:COMMunicate:LOCal

:SYSTem:COMMunicate:ECHO

:SYSTem:COMMunicate:ETHernet?

语法 :SYSTem:COMMunicate:LOCal 

参数 没有参数

用途 设置 Willtek 9102，允许在 SCPI 操作期间在前面板进行手动操作。

注意：

- 该命令可以被用于在工作过程中允许交互校正步骤。

- 也可以通过按下前面板上的 Escape 功能键，将仪器设为本地模式。

查询 该命令没有查询格式。

示例  :SYSTem:COMM:LOC

语法 :SYSTem:COMMunicate:ECHo <PredefExpr>

参数 PredefExpr是下列预定义的表达式之一：ON|OFF。 
缺省值为 ON。

用途 该命令可以决定 Willtek 9102 在执行一个 SCPI 命令之后的操作。

如果回声设为 ON，那么 9102 就会发出一个响应。如果执行成功，则发回
”ok”,
如果发生错误，则发回“ERR”。回声启用模式适用于需要输入交互式命令的
情况。

如果回声设为 OFF，那么 9102 将不会对 SCPI 命令发出响应。在这种情况下，
可以通过用 *OPC? 查询判断 SCPI 命令是否执行完毕和 Willtek 9102 是否准备
好接收下一个命令。

查询 读取和返回当前回声设置。

示例 :SYST:COMM:ECH ON
Returns the following string: "ok"
All subsequent commands returns "ok" or "ERR".
:SYST:COMM:ECH?
Returns the following string: "ON"
:SYST:COMM:ECH OFF
Returns nothing, all subsequent commands return nothing.

语法 :SYSTem:COMMunicate:ETHernet?

参数 没有参数

用途 该命令只有一种查询格式。

查询 如果 Willtek 9100 通过 TCP/IP 连接到一个局域网（LAN），则返回 ON，否则返
回 OFF。

示例 :SYSTem:COMM:ETH?
在这个例子中返回的字符串为： "OFF"
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系统命令
:SYSTem:COMMunicate:ETHernet:IPADdress

:SYSTem:COMMunicate:ETHernet:TNAMe

:SYSTem:COMMunicate:ETHernet:PORT

:SYSTem:COMMunicate:ETHernet:TERMinator

语法 :SYSTem:COMMunicate:ETHernet:IPADdress
<int1>,<int2>,<int3>,<int4>

参数 intx 是四个整数。

所有整数的最小值为 0，最大值为 255，缺省值为 0。

用途 该命令可以将 Willtek 9102 的 IP 地址设为参数值。

查询 按照上面介绍的格式，读取和返回当前的 IP 地址设置。

示例  SYST:COMM:ETH:IPAD 192,16,16,114 将 IP 地址设为指定值。

语法 :SYSTem:COMMunicate:ETHernet:TNAMe <string>

参数 string是一个纯字符串，包含 Willtek 9102 的设备名称。

用途 该命令可以设置 Willtek 9102 的设备名称。如果网络支持 DHCP( 动态主机配置
协议 )
它可以被用于发布 9102 的设备代号 .

查询 按照上面介绍的格式，读取和返回设备名称的当前值。

示例 SYST:COMM:ETHernet:TNAMe "TARGET9104" 将设备名称设置为指定
值。

语法 :SYSTem:COMMunicate:ETHernet:PORT <int>

参数 int表示Willtek 9102的TCP/IP端口地址。地址必须介于1024到65535之间。缺省
值为 49200。

用途 该命令可以将 Willtek 9102 上的、用以通过 LAN 控制 9102 的端口地址设置为
一个新的值。

查询 按照上面介绍的格式，读取和返回 TCP/IP 所用端口的当前值。

示例  SYST:COMM:ETHernet:PORT 49200将 TCP/IP 端口地址设为缺省值。

语法 :SYSTem:COMMunicate:ETHernet:TERMinator <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : CRLF|LF|CR.
缺省值为 CRLF。

用途 设置终止符，它将附加在每个从Willtek 9102 LAN接口发出的SCPI响应的后面。

查询 读取和返回 LAN 接口的当前终止符设置。

示例 :SYST:COMM:ETH:TERM CR
:SYST:COMM:ETH:TERM?
返回以下字符串 : "CR"
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系统命令
:SYSTem:COMMunicate:SER:BAUDrate

:SYSTem:COMMunicate:SER:TERMinator

:SYSTem:ERRor[:NEXT]?

:SYSTem:ERRor:COUNt?

语法 :SYSTem:COMMunicate:SER:BAUDrate <int1>

参数 int1是一个整数。

int1的最小值为 300，最大值为 57600，缺省值为 57600。有效值包括：

300,1200,2400,4800,9600,19200,38400 和 57600。

用途 设置串行端口的数据传输速率。只改变数据传输速率；所有其他参数都保持
不变。个字符的位数被设为 8；终止位的个数被设为 1；奇偶校验设为 NO。

查询 读取和返回当前设置的串行接口数据传输速率。

示例 :SYST:COMM:SER:BAUD 9600
:SYST:COMM:SER:BAUD?
在这个例子中返回的字符串为："9600".

语法 :SYSTem:COMMunicate:SER:TERMinator <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : CRLF|LF|CR.缺省值为 CRLF。

用途 设置终止符，它将附加在每个从 Willtek 9102 串行接口发出的 SCPI 响应的后
面。

查询 读取和返回当前设置的串行接口终止符。

示例 :SYST:COMM:SER:TERM LF
:SYST:COMM:SER:TERM? 返回以下字符串 : "LF"

语法 :SYSTem:ERRor[:NEXT]?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回 Willtek 9102 的内部错误队列中存放时间最长的未读错误提示。返回的队
列条目将是一个字符串 （文字）。文字的最大长度为 255个字符。

注 : 可以在 "SCPI 错误 " 第 293 页查看错误提示列表。 

示例 *RESET:SYSTem:ERRor:NEXT?
在这个例子中返回的字符串为：-113,"Undefined header"

语法 :SYSTem:ERRor:COUNt?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回 Willtek 9102 的内部错误队列中存放的未读错误提示的个数。返回的字符
串将包含一个整数。内部最多能存储 10 个错误。

示例 :SYSTem:ERRor:COUNt?在这个例子中返回的字符串为："0"
这意味着错误队列中没有未读错误提示。
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系统命令
:SYSTem:ERRor:CODE[:NEXT]?

:SYSTem:ERRor:CODE:ALL?

:SYSTem:DNAMe

语法 :SYSTem:ERRor:CODE[:NEXT]?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回 Willtek 9102 的内部错误队列中存放时间最长的未读错误提示的代号。返
回的字符串将包含一个整数 （没有文字）。

注 : 可以在 "SCPI 错误 " 第 293 页查看错误提示列表。

示例 *RESET
:SYSTem:ERRor:CODE?
在这个例子中返回的字符串为： "-113"
这意味着收到了一个未定义的标题 （*RESET）。

语法 :SYSTem:ERRor:CODE:ALL?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回 Willtek 9102 的内部错误队列中存放的所有未读错误提示的错误代码。返
回的字符串最多包含 100 个用逗号分隔的整数。

注 : 可以在 "SCPI 错误 " 第 293 页查看错误提示列表。

示例 :SYSTem:ERRor:CODE:ALL?
在这个例子中返回的字符串为： "-113,-112,0,0,0,0,0,0,0,0"
这意味着错误队列中有两个未读错误提示。

语法 :SYSTem:DNAMe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 为 9102 设置一个可由用户定义的设备名称，以便在协议中使用这个唯一的名
称。

查询 读取和返回 9102 上设置的设备名称。

示例 :SYSTem:DNAMe "Develop5"
:SYST:DNAM?
在这个例子中返回的字符串为： "Develop5"
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系统命令
:SYSTem:SCReendump:COLor?

:SYSTem:SCReendump:LINe?

:SYSTem:SCReendump:REMote

:SYSTem:PRINter:TYPe

语法 :SYSTem:SCReendump:COLor? <int1>

参数 int1是一个整数，范围介于 0到 255之间。

用途 该命令只有查询格式。

查询 返回指定调色板条目的 RGB 颜色值 （用十六进制表示）。最多可以有 256 个
调色板条目。

示例 :SYST:SCR:COL? 5
在这个例子中返回的字符串为：
"a800a8"

语法 :SYSTem:SCReendump:LINe? <int1>

参数 int1是一个整数，范围介于 0到 479之间。

用途 该命令只有查询格式。

查询 以十六进制值对的形式，返回屏幕的一个像素行 （共 480 行）。

示例 :SYST:SCR:LIN? 345
在这个例子中返回的字符串为：
"0201420fff00f600010f0201080b1e0f1e0b"

语法 :SYSTem:SCReendump:REMote <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 ON。

用途 该命令在设为 OFF时可以关闭远程显示。这对于屏幕转储有用。

查询 读取和返回当前设置。

示例 :SYST:SCR:REM OFF:SYST:SCR:REM?
返回以下字符串 : "OFF"

语法 :SYSTem:PRINter:TYPe <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : OFF|PCL. 缺省值为 OFF。

用途 该命令可以设置用于打印屏幕窗口的打印机类型。目前，只支持 PCL 型打印
机，例如 HP Laserjet。打印机必须连接到串行端口（通常需要使用一个 RS232/
Centronics转换器），因此对打印机输出的远程控制只能通过TCP/IP进行。 串行
接口必须通过命令 SYSTem: COMMunicate: SER: BAUDrate，设置为打印
机

换器所支持的最高波特率。打印机输出可以通过命令 HCOPy[:IMMediate]
启动。

查询 读取和返回当前设置。

示例 :SYSTem:PRINter:TYPe PCL:SYSTem:PRINter:TYPe?
返回以下字符串 : "PCL"
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测量命令
:SYSTem:PRINter:BAUDrate

测量命令

这些命令可以影响频谱分析仪的设置，开始测量和返回测量结果。

:SENSe:BANDwidth:RESolution

:SENSe:BANDwidth:RESolution:AUTo

语法 :SYSTem:PRINter:BAUDrate <int1>

参数 int1是一个整数。

int1的最小值为 300，最大值为 57600，缺省值为 19200。
有效值包括 300,1200,2400,4800,9600,19200,38400 和 57600.

用途 设置串行端口的数据传输速率。打印输出可以通过命令 HCOPy启动。只改变
数据传输速率；所有其他参数都保持不变。每个字符的位数被设为 8 ；终止
位的个数被设为 1；奇偶校验设为 NO。

查询 读取和返回当前设置的串行端口数据传输速率。

示例 :SYST:PRINter:BAUD 9600
:SYST:PRINter:BAUD?
在这个例子中返回的字符串为：9600.

语法 :SENSe:BANDwidth:RESolution <real1>

参数 real1是一个浮点实数。

real1的最小值为 10000，最大值为 1000000。
real1可以被设为 1*10n or 3*10n。 real1的缺省值为 1000000。

用途 该命令可以设置 9102 的分辨带宽，单位为赫兹。

查询 读取和返回当前设置。

示例 :SENSe:BANDwidth:RESolution 300000
:SENSe:BANDwidth:RESolution?
这个例子的返回值为："300000"。

语法 :SENSe:BANDwidth:RESolution:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF.
缺省值为 ON。

用途 开关分辨带宽的自动选择功能。如果开启， 9102 会根据当前跨度、视频带宽
和扫描时间自动选择分辨带宽。

查询 读取和返回当前设置。

示例 :SENSe:BANDwidth:RESolution:AUTo ON
:SENSe:BANDwidth:RESolution:AUTo?
返回以下字符串 : "ON"
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测量命令
:SENSe:BANDwidth:VIDeo

:SENSe:BANDwidth:VIDeo:AUTo

:SENSe:FREQuency:CENTer

语法 :SENSe:BANDwidth:VIDeo <real1>

参数 real1是一个浮点实数。

real1的最小值为 10，最大值为 1000000。可选值包括：
10,100,300,1000,3000,10000,30000,100000,300000,1000000.
real1的缺省值为 1000000。

用途 该命令可以设置 9102 的视频带宽， real1单位为赫兹。

查询 读取和返回当前设置。

示例 :SENSe:BANDwidth:VIDeo 300000
:SENSe:BANDwidth:VIDeo?
这个例子的返回值为："300000".

语法 :SENSe:BANDwidth:VIDeo:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF|.
缺省值为 ON。

用途 开关视频带宽的自动选择功能。如果开启， 9102 会根据当前跨度、分辨带宽
和扫描时间自动选择视频带宽。

查询 读取和返回当前设置。

示例 :SENSe:BANDwidth:VIDeo:AUTo OFF
:SENSe:BANDwidth:VIDeo:AUTo?
返回以下字符串 : "OFF"

语法 :SENSe:FREQuency:CENTer <real1>

参数 real1是一个浮点实数。

real1的最小值为0，最大值为4000000000。real1可以设为1000的倍数。

real1的缺省值为 1800000000。

用途 设置 9102 的中心频率（单位为赫兹）。在选择了一个新的中心频率时，这将
会影响到起始和截止频率。只要新的起始和截止频率不超过 9102 的极限，跨
度就不会发生变化。

查询 返回当前设置。

示例 :SENSe:FREQuency:CENTer 1500000000
:SENSe:FREQuency:CENTer?
这个例子的返回值为："1500000000"。
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测量命令
:SENSe:FREQuency:SPAN

:SENSe:FREQuency:SPAN:FULL

:SENSe:FREQuency:STARt

:SENSe:FREQuency:STOP

语法 :SENSe:BANDwidth:VIDeo:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF|.
缺省值为 ON。

用途 开关视频带宽的自动选择功能。如果开启， 9102 会根据当前跨度、分辨带宽
和扫描时间自动选择视频带宽。

查询 读取和返回当前设置。

示例 :SENSe:BANDwidth:VIDeo:AUTo OFF
:SENSe:BANDwidth:VIDeo:AUTo?
返回以下字符串 : "OFF"

语法 :SENSe:FREQuency:SPAN:FULL

参数 没有参数

用途 将 9102 的频率跨度设为 9102 支持的最大值。该命令会影响到启动频率、截止
频率和相应的中心频率。

注：如果您将跨度设为 0， 9100 将在时域进行测量而不是频率。

查询 该命令没有查询格式。

示例 :SENS:FREQ:SPAN:FULL
将 9102 的起始频率设为 0，截止频率设为 4GHz。

语法 :SENSe:FREQuency:STARt <real1>

参数 real1是一个浮点实数。

real1的最小值为0，最大值为4000000000。real1的最小分辨率为1000。
real1的缺省值为 0。

用途 设置 9102 的起始频率，单位为赫兹。该频率不会影响跨度，但是会影响中心
频率和截止频率。

查询 读取和返回当前设置。

示例 :SENSe:FREQuency:STARt 1500000000
:SENSe:FREQuency:STARt?
这个例子的返回值为："1500000000".

语法 :SENSe:FREQuency:STOP <real1>

参数 real1是一个浮点实数。

real1的最小值为 100000，最大值为 4000000000。
real1的最小分辨率为 1000。
real1的缺省值为 3600000000。

用途 设置 9102 的截止频率，单位为赫兹。该频率不会影响跨度，但是会影响中心
频率和起始频率。

查询 读取和返回当前设置。
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测量命令
:SENSe:FREQuency:MODE

:SENSe:FREQuency:FSTep

:SENSe:FREQuency:FSTep:AUTo

示例 :SENSe:FREQuency:STOP 2500000000
:SENSe:FREQuency:STOP?
这个例子的返回值为："2500000000".

语法 :SENSe:FREQuency:MODE <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :CSPan|SSTop|SSPAN。
省值为 CSPan。

用途 定义启用哪种频率模式。有三种模式可供选择：中心－跨度、起始－截止、
起始－跨度。

查询 返回当前设置。

示例 :SENSe:FREQuency:MODe CSPan
:SENSe:FREQuency:MODe?
返回以下字符串 : "CSPan"

语法 :SENSe:FREQuency:FSTep <real1>

参数 real1是一个浮点实数。

real1的最小值为0，最大值为1000000000。real1的最小分辨率为1000。
real1的缺省值为 360000000。

用途 设置在手动模式下利用光标键选择中心频率时的步进宽度。

查询 读取和返回当前设置。

示例 :SENSe:FREQuency:FSTep 2.5E6
:SENSe:FREQuency:FST?
这个例子中的返回值为：2500000

语法 :SENSe:FREQuency:FSTep:AUTo <PredefExp>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。 
缺省值是 ON。

用途 启用或者禁用在手动模式下利用光标键选择中心频率时的步进宽度自动选择
功能。

查询 读取和返回当前设置。

示例 :SENSe:FREQuency:FSTep:AUTo ON
ENSe:FREQuency:FSTep:AUTo?
以下字符串 : "ON"
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测量命令
:SENSe:CPOWer:SPAN

:SENSe:CPOWer:CHANnel

:SENSe:CPOWer:OBW

:SENSe:CPOWer:MEASure

语法 :SENSe:CPOWer:SPAN <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : FULL|SINGle。
缺省值为 FULL。

用途 设置 9102 的信道功率显示模式。 FULL表示选择全部系统频谱。 SINGle只
显示所选信道的频谱。

查询 读取和返回当前设置。

示例 :CPOWer:SPAN SINGle
:ENSe:CPOWer:SPAN?
返回以下字符串 : "SINGle"

语法 :SENSe:CPOWer:CHANnel <int1>

参数 int1是一个整数。 int1的最小值为 0，最大值为 1000000，缺省值为 0。

用途 设置 SINGLe和 FULL模式下显示的实际信道个数。

查询 读取和返回当前设置。

示例 :SENSe:CPOWer:CHANnel 50
:SENSe:CPOWer:CHANnel?
这个例子的返回值为："50".

语法 :SENSe:CPOWer:OBW <int1>

参数 int1是一个整数。 int1的最小值为 5，最大值为 99, 缺省值为 90。

用途 设置 9102 确定占用带宽的比例值 （信道功率模式）。

查询 读取和返回当前设置。

示例 :SENSe:CPOWer:OBW 20
:SENSe:CPOWer:OBW?
这个例子的返回值为："20"

语法 :SENSe:CPOWer:MEASure <PredefExp>

参数 PredefExpr 是下列预定义的表达式之一 :CPOWer|ACPR|OBW。
缺省值为 CPOWer。

用途 开始按照 PredefExpr所定义的方式进行测量。

查询 读取和返回当前设置。

示例 :SENSe:CPOWer:MEASure ACPR
:SENSe:CPOWer:MEASure?
返回以下字符串 : "ACPR".
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测量命令
:SENSe:SWEep:TIME

:SENSe:SWEep:TIME:AUTO

:SENSe:SWEep:STATe

语法 :SENSe:SWEep:TIME <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.0，最大值为 20.0。real1的最小分辨率为 0.0001。
real1的缺省值为 0.0432。

用途 设置扫描时间，即扫描整个频率宽度所用的时间。 real1表示秒数。

查询 读取和返回当前设置。

示例 :SENSe:SWEep:TIME 0.3
:SENSe:SWEep:TIME?
这个例子的返回值为："0.3".

语法 :SENSe:SWEep:TIME:AUTO <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。
缺省值为 ON。

用途 启用或者关闭扫描时间的自动选择功能。如果启用， 9102 将会根据当前设置
的跨度、分辨带宽和视频带宽设置最佳的扫描时间。

查询 读取和返回当前设置。

示例 :SENSe:SWEep:TIME:AUTO ON
:SENSe:SWEep:TIME:AUTO?
返回以下字符串 : "ON".

语法 :SENSe:SWEep:STATe <PredefExpr>[,<int1>]

参数 PredefExpr 是下列预定义的表达式之一 :CONTinuous|SINGle|HOLD。
缺省值为 CONTinuous。
int1是一个可选整数。它只适用于 SINGLe扫描。int1的最小值为 1，最大
值为 999，缺省值为 1。

用途 设置 9102 的测量显示模式。

CONTinuous表示选择重复测量。

SINGle让 9102 可以进行和显示一次测量（或者有限次数的测量）。可选的秒
数参数表示两次扫描相隔的时间。

HOLD表示立即中止任何正在进行的测量。

查询 读取和返回当前设置。

示例 :SENSe:SWEep:STATe SINGle
:SENSe:SWEep:STATe?
返回以下字符串 : "SINGle".
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测量命令
:SENSe:TRIGger

:SENSe:TRIGger:LEVel

:SENSe:TRIGger:EDGE

:SENSe:DEMod[:MODulation]

语法 :SENSe:TRIGger <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : OFF|VIDeo。
缺省值为 OFF。

用途 设置 9100 的触发器模式。

OFF表示没有启用任何触发器。 VIDeo表示在所选电平启用触发器。 

查询 读取和返回当前设置。

示例 :SENSe:TRIGger VIDeo
:SENSe:TRIGger?
返回以下字符串 : "VIDeo".

语法 :SENSe:TRIGger:LEVel <real1>

参数 real1是一个浮点实数。

real1的最小值为 -100，最大值为 30.0。 real1的最小分辨率为 0.1。
real1的缺省值为 -40。

用途 设置所启用的触发器电平，如果 SENSe:TRIGger设为 VIDeo，那么 real1
就表示触发器电平，单位为 dBm。

查询 读取和返回当前设置。

示例 :SENSe:TRIGger:LEVel -10
:SENSe:TRIGger:LEVel?
这个例子的返回值为："-10"。

语法 :SENSe:TRIGger:EDGE <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :POSitive|NEGative。
缺省值为 POSitive。

用途 设置触发器的正或者负方向。

查询 读取和返回当前设置。

示例 :SENSe:TRIGger:EDGe NEGative
:SENSe:TRIGger?
返回以下字符串 : "NEGative".

语法 :SENSe:DEMod[:MODulation] <PredefExpr>

参数 PredefExpr is one of the following predefined expressions: OFF|AM|FM.
Default is OFF.

用途 Sets the demodulation mode, which can be off, AM (amplitude modulation) or FM 
(frequency modulation). FM demodulation is performed in a 30 kHz bandwidth.

查询 Reads and returns the current setting.
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测量命令
:SENSe:DEMod:DEMod

:SENSe:DEMod:VOLume

:SENSe:DEMod:DURation

示例 :SENSe:DEMod FM
:SENSe:DEMod:MODulation?
Returns the following string: "FM"

语法 :SENSe:DEMod:DEMod <PredefExpr>

参数 PredefExpr is one of the following predefined expressions: 
PERManent|ATMarker.
Default is PERManent.

用途 Sets the demodulation permanent to center frequency or at marker.

查询 Reads and returns the current setting.

示例 :SENSe:DEMod:DEMod PERManent
:SENSe:DEMod:DEMod?
Returns the following string: "PERManent"

语法 :SENSe:DEMod:VOLume <int1>

参数 int1是一个整数。 int1的最小值为 0，最大值为 100，缺省值为 50。

用途 设置解调信号的大小 （为百分数）。

查询 读取和返回当前设置。

示例 :SENSe:DEMod:VOLume 20
:SENSe:DEMod:VOLume?
这个例子的返回值为："20".

语法 :SENSe:DEMod:DURation <real1>

参数 real1是一个浮点实数。

real1的最小值为 0，最大值为 100。 real1的最小分辨率为 0.001。
real1的缺省值为 2。

用途 设置解调信号的持续时间 （单位为秒）。

查询 读取和返回当前设置。

示例 :SENSe:DEMod:DURation 10
:SENSe:DEMod:DURation?
这个例子的返回值为："10".
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测量命令
:SENSe:DETector:FUNCtion

:SENSe:TRACe:A[:STATe]

Syntax :SENSe:DETector:FUNCtion <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: 
POSNeg|SAMPle|POSitive|NEGative|.
Default is POSNeg.

Command Defines which measurement values shall be displayed.
The 9102 takes far more measurements than can be displayed on the screen, so sev-
eral results are summarized into one.
POSNeg indicates both the maximum and minimum values for each frequency point 
in the form of a straight vertical line between these values.
SAMPle lets the 9102 randomly select one of the measurement values for each fre-
quency point.
POSitive lets the 9102 pick the highest value.
NEGative lets the 9102 select the lowest value.

Query Reads and returns the current setting.

Example :SENSe:DETector:FUNCtion SAMPle
:SENSe:DETector:FUNCtion?
Returns the following string: "SAMPle".

语法 :SENSe:TRACe:A[:STATe] <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :
ACTual|MAXHold|MINHold|HOLD|AVG|OFF。缺省值为 ACTual。

用途 设置曲线 A 的显示模式。

ACTual 表示显示所有实际测量值。

MAXHold 表示为每个测量点显示所有测量值中的最大值。

MINHold表示为每个测量点显示所有测量值中的最小值。

HOLD 表示立即中止测量。

AVG 表示为每个测量点显示所有测量值的平均值。

OFF 表示关闭曲线。

查询 读取和返回当前设置。

示例 :SENSe:TRACe:A MAXHold
:SENSe:TRACe:A:STATe? 返回以下字符串 : "MAXHold".
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测量命令
:SENSe:TRACe:A:FETCh?

:SENSe:TRACe:B[:STATe]

语法 :SENSe:TRACe:A:FETCh? <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :
ALL|MINimum|MAXimum|FREQuency|FMINimum|FMAXimum.

用途 该命令只有一种查询格式。

查询 根据参数读取和返回曲线 A 的数据：

参数 ALL 返回：<min>,<max>,<freq>,<min>,<max>,<freq>, ... .
参数 MIN 返回：<min>,<min>, ... .
参数 MAX 返回：<max>,<max>, ... .
参数 FREQ 返回：<freq>,<freq>, ... .
参数 FMIN 返回：<min>,<freq>,<min>,<freq>, ... .
参数 FMAX 返回：<max>,<freq>,<max>,<freq>, ... .

示例 :SENSe:TRACe:A:FETCh? ALL
返回以下字符串 :
"1000000.0,-50.3,-45.5,1001000.0,-53.4,-48.2,...".

语法 :SENSe:TRACe:B[:STATe] <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :
ACTual|MAXHold|MINHold|HOLD|AVG|OFF°£
缺省值为 OFF。

用途 设置曲线 B 的显示模式。

ACTual 表示显示所有实际测量值。

MAXHold 表示为每个测量点显示所有测量值中的最大值。

MINHold表示为每个测量点显示所有测量值中的最小值。

HOLD 表示立即中止测量。

AVG 表示为每个测量点显示所有测量值的平均值。

OFF 表示关闭曲线。

查询 读取和返回当前设置。

示例 :SENSe:TRACe:B MAXHold
:SENSe:TRACe:B?
返回以下字符串 : "MAXHold".
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测量命令
:SENSe:TRACe:B:FETCh?

:SENSe:TRACe:AVGFactor

:SENSe:TRACe:CLEar

:SENSe:TRACe:COPY

语法 :SENSe:TRACe:B:FETCh? <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :
ALL|MINimum|MAXimum|FREQuency|FMINimum|FMAXimum.

用途 该命令只有一种查询格式。

查询 根据参数读取和返回曲线 B 的数据：

参数 ALL 返回：<min>,<max>,<freq>,<min>,<max>,<freq>, ...
参数 MIN 返回：<min>,<min>, ... .
参数 MAX 返回：<max>,<max>, ... .
参数 FREQ 返回：<freq>,<freq>, ... .
参数 FMIN 返回：<min>,<freq>,<min>,<freq>, ... .
参数 FMAX 返回：<max>,<freq>,<max>,<freq>, ... .

示例 :SENSe:TRACe:B:FETCh? ALL
返回以下字符串 :
"1000000.0,-50.3,-45.5,1001000.0,-53.4,-48.2,..."

语法 :SENSe:TRACe:AVGFactor <int1>

参数 int1是一个整数。 int1的最小值为 1，最大值为 125，缺省值为 5。

用途 设置曲线平均因数。

查询 读取和返回当前设置。

示例 :SENSe:TRACe:AVGFactor 10
:SENSe:TRACe:AVGFactor?
这个例子中的返回值为："10".

语法 :SENSe:TRACe:CLEar

参数 没有参数

用途 清除当前曲线。

查询 该命令没有查询格式。

示例 :SENSe:TRACe:CLEar

语法 :SENSe:TRACe:COPY <PredefExpr>[,<int>]

参数 PredefExpr 是下列预定义的表达式之一 : ATOB|BTOA.

用途 将曲线 A复制到曲线 B，或者相反。

查询 该命令没有查询格式。

示例 :SENSe:TRACe:COPY ATOB
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测量命令
:SENSe:TRACe:DATa?

:SENSe:TRACe:DATa:LIMit

:SENSe:TRACe:MATH

:SENSe:TRACe:MATH:[A|B]

语法 :SENSe:TRACe:DATa? <PredefExpr>[,<int>]

参数 PredefExpr是下列预定义的表达式之一 :A|B，命令将返回曲线 A或者曲线
B。

用途 该命令只有一种查询格式。

查询 首先返回字符串："ALL" 或者 "MINM"。如果最小值和最大值相等，则返回
“ALL”，例如 "Max hold" 或者 "Min hold"。这时会返回 501个值，其中
不存在冗余数据。如果最小值和最大值不相等，则返回 “MINM” ，例如
"ACTUAL" 或者 "Average"。这时会返回 1002个值，前 501 个值为最小值，
后 501 个值为最大值。然后返回字符串：曲线数据。每个电平值都通过三个
字节表示。下面的公式被用于计算以 dBm为单位的电平值：电平值 = 十六进
制值 / 10 - 200.

示例 :SENSe:TRACe:DATa? A
这个例子中返回的值为：
"ALL","38D36F37238B38D3A63A73BC4103A63E33A13CB..."

语法 :SENSe:TRACe:DATa:LIMit?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回最近通过 SENSe:TRACe:DATa? 收到的曲线的 Pass/Fail（不
超出 / 超出）标准。这将返回下列预定义的表达式之一 ：PASS|FAIL。

示例 :SENSe:TRACe:DATa:LIMit?
返回以下字符串 : "PASS"

语法 :SENSe:TRACe:MATH?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回当前曲线的归一化标准。这将返回下列预定义的表达式之一 ：
NA|UNNormalized|NORMalized。

示例 :SENSe:TRACe:MATH?
返回以下字符串 : "NORM"

语法 :SENSe:TRACe:MATH:[A|B] <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : OFF | SUBtract |
NORMalize。
缺省值为 OFF。

用途 将针对曲线 A 和 B 的数学功能关闭，或者将其改为减法，或者进行归一化。

查询 读取和返回当前设置。
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测量命令
:SENSe:TRACe:MATH:OFFSet

:SENSe:REFLevel

:SENSe:REFLevel:UNIT

示例 :SENSe:TRACe:MATH:A SUB
:SENSe:TRACe:MATH:A?
返回以下字符串 : "SUB"

语法 :SENSe:TRACe:MATH:OFFSet <real1>

参数 real1是一个浮点实数。

用途 该命令可以设置相减曲线的曲线偏移 (A-B->A 曲线 )。

查询 读取和返回当前设置。

示例 :SENSe:TRACe:MATH:OFFSet -20
:SENSe:TRACe:MATH:OFFSet?
这个例子的返回值为："-20".

语法 :SENSe:REFLevel <real1>

参数 real1是一个浮点实数。

real1的最大值和最小值取决于 SENS:REFLevel:UNIT 所设置的单位。

如果单位设置为 dBm，那么最小值为 -100，最大值为 30。
如果单位设置为 dBuV，那么最小值为 7，最大值为 137。
如果单位设置为 dBmV，那么最小值为 -53，最大值为 77。
如果单位设置为 dBV，那么最小值为 -113，最大值为 17。
real1的缺省值为 0 dBm.

用途 该命令可以利用 :SENS:REFLevel:UNIT 命令所设置的单位，设置 9102 的
参考电平 （即 0dB线所对应的电平）。

查询 读取和返回当前设置。

示例 :SENSe:REFLevel -50
:SENSe:REFLevel?
这个例子的返回值为："-50".

语法 :SENSe:REFLevel:UNIT <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :dBm|dBuV|dBmV|dBV|。缺省值
为dBm.

用途 定义参考电平的单位 (dBm, dBµV, dBmV 或者 dBV)。它还会影响屏幕显示
的测量结果 （纵轴）的单位。

查询 读取和返回当前设置。

示例 :SENSe:REFLevel:UNIT dBmV
:SENSe:REFLevel:UNIT?
返回以下字符串 : "dBmV".
9102 手持式频谱分析仪 4.00 版本 253



第十五章  SCPI 命令参考
测量命令
:SENSe:STATe

:SENSe:MEASure

:SENSe:MEASure:OBW

:SENSe:MEASure:CHANnel:WIDTh

语法 :SENSe:STATe?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回 the Uncal state.

示例 :SENSe:STATe?
返回以下字符串 : "ON".

语法 :SENSe:MEASure <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :NONe|CPOWer|ACPR|OBW。 
缺省值为 NONe。

用途 开始按照 PredefExp所定义的方式进行测量。

查询 读取和返回当前设置。

示例 :SENSe:MEASure ACPR
:SENSe:MEASure?
返回以下字符串 : "ACPR"

语法 :SENSe:MEASure:OBW <int1>

参数 int1是一个整数。 int1的最小值为 5，最大值为 99，缺省值为 90。

用途 设置 9102 用以确定占用带宽的比例值 ( 频谱分析仪模式 )。

查询 读取和返回当前设置。

示例 :SENSe:MEASure:OBW 20
:SENSe:MEASure:OBW?
这个例子的返回值为："20".

语法 :SENSe:MEASure:CHANnel:WIDTh <real1>

参数 real1是一个浮点实数。

real1的最小值为 100000，最大值为 2000000000。
real1可以设置为 1000的倍数。缺省值为 5000000。

用途 设置频谱分析仪模式下的实际信道宽度。

查询 读取和返回当前设置。

示例 :SENSe:MEASure:CHANnel:WIDTh 150000000
:SENSe:MEASure:CHANnel:WIDTh?
这个例子的返回值为："150000000".
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测量命令
:SENSe:MEASure:CHANnel:SPACing

:SENSe:MEASure:ADJSettings

:SENSe:DTF:CLENgth

:SENSe:DTF:CLENgth:UNIT

语法 :SENSe:MEASure:CHANnel:SPACing <real1>

参数 real1是一个浮点实数。

real1的最小值为 100000，最大值为 2000000000。
real1可以设置为 1000的倍数。缺省值为 10000000。

用途 设置频谱分析仪模式下的实际信道间隔。

查询 读取和返回当前设置。

示例 :SENSe:MEASure:CHANnel:SPACing 1500000000
:SENSe:MEASure:CHANnel:SPACing?
这个例子的返回值为："1500000000".

语法 :SENSe:MEASure:ADJSettings

参数 没有参数

用途 调节利用相应测量模式 CPOWer、 ACPR 或者 OBW下的 ...CHAN:WIDTh和
...SPACing命令设置的显示参数。

查询 读取和返回当前设置。

示例 :SENSe:MEASure:ADJSettings

语法 :SENSe:DTF:CLENgth <real1>

参数 real1是一个浮点实数。

real1 的最小值和最大值取决于 SENS:DTF:CLENgth:UNIT 所设置的单
位。在单位设为 m时，最小值为 1，最大值为 2000。
在单位设为 ft时，最小值为 3，最大值为 6660。 real1的缺省值为 1m。

用途 该命令可以利用 :SENS:DTF:CLEN:UNIT 所选择的单位，定义线缆长度。

查询 读取和返回当前设置。

示例 :SENSe:DTF:CLENgth 50
:SENSe:DTF:CLENgth? 这个例子的返回值为："50".

语法 :SENSe:DTF:CLENgth:UNIT <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : METer|FEET。
缺省值为 METer。

用途 定义线缆长度的单位 （米，英尺）。它还会影响线缆衰减的单位。

查询 读取和返回当前设置。

示例 :SENSe:DTF:CLENgth:UNIT FEET
:SENSe:DTF:CLENgth:UNIT? 返回以下字符串 : "FEET"
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测量命令
:SENSe:DTF:REFerence

:SENSe:DTF:REFerence:UNIT

:SENSe:DTF:REFerence:RFACtor

:SENSe:DTF:CALibration

语法 :SENSe:DTF:REFerence <real1>

参数 real1是一个浮点实数。

real1的最小值为 -100.0 dB,real1的最大值为 0.0 dB。
real1的缺省值为 0.0 dB。

用途 该命令可以设置9100在DTF模式下的参考电平（即0dB线所对应的电平值）。

查询 读取和返回当前设置。

示例 :SENSe:DTF:REFerence -50
:SENSe:DTF:REFerence? 这个例子的返回值为："-50".

语法 :SENSe:DTF:REFerence:UNIT <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : dB|MRHO|。缺省值为dB。

用途 定义显示测量结果（纵轴）的单位 (dB, mRho)。它不会影响 DTF参考电平
的单位。

查询 读取和返回当前设置。

示例 :SENSe:DTF:REFerence:UNIT dB
:SENSe:DTF:REFerence:UNIT? 返回以下字符串 : "dB"

语法 :SENSe:DTF:REFerence:RFACtor <real1>

参数 real1是一个浮点实数。

real1的最小值为 0 mRho。 real1的最大值为 2000mRho. 
real1的缺省值为 1000 mRho。

用途 在单位为 mRho时，该命令可以显示 DTF的最大因数值。

查询 读取和返回当前设置。

示例 :SENSe:DTF:REFerence:RFACtor 1000
:SENSe:DTF:REFerence:RFACtor?
这个例子的返回值为："1000.0".

语法 :SENSe:DTF:CALibration

参数 没有参数

用途 开始 DTF校正。在执行该命令之前，必须向测量端口连接一个 SHORT。

查询 读取和返回当前校正状态。它是下列预定义的表达式之一： NO|YES。

示例 :SENSe:DTF:CALibration
:SENSe:DTF:CALibration?
返回以下字符串 : "YES"
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测量命令
:SENSe:DTF:CALibration:ENABled

:SENSe:RFLection:REFerence

:SENSe:TRANsmission:REFerence:UNIT

语法 :SENSe:DTF:CALibration:ENABled <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 ON。

用途 启动或者关闭 DTF校正纠正。

查询 读取和返回当前设置。

示例 :SENSe:DTF:CALibration:ENABled OFF
:SENSe:DTF:CALibration:ENABled?
返回以下字符串 : "OFF"

语法 :SENSe:RFLection:REFerence[:RETurnloss] <real1>

参数 real1是一个浮点实数。

real1的最小值为 -60.0 dB ¨real1的最大值为 60.0 dB。
real1的缺省值为 0.0 dB。

用途 该命令可以在测量单位设为回波损耗时，设置 9102 在反射模式下的参考电平
（即 0dB线所对应的电平值）。

参考指的是跟踪发生器当前设置的输出功率电平。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:REFerence -10
:SENSe:RFLection:REFerence?
这个例子的返回值为："-10".

语法 :SENSe:RFLection:REFerence:UNIT <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :
RETurnloss|VSWR|RFACtor|RPOWer°£
缺省值为 RETurnloss。

用途 切换显示的测量单位，包括：回报损耗 (dB)、VSWR (-)、反射因数 (mRho)
或者反射功率 (%)。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:REFerence:UNIT dBm
:SENSe:RFLection:REFerence:UNIT?
返回以下字符串 : "dBm"
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测量命令
:SENSe:RFLection:REFerence[:RETurnloss]

:SENSe:RFLection:REFerence:UNIT

:SENSe:RFLection:REFerence:VSWR

:SENSe:RFLection:REFerence:RFACtor

语法 :SENSe:RFLection:REFerence[:RETurnloss] <real1>

参数 real1 is a floating point real number.
The minimum value for real1 is -60.0 dB. The maximum value for real1 is 
60.0 dB. The default value for real1 is 0.0 dB.

用途 This command sets the reference of the 9102 (0 dB line), in Reflection mode, when 
unit is set to Return Loss. The reference refers to the current set output power level of 
the tracking generator.

查询 Reads and returns the current setting.

示例 :SENSe:RFLection:REFerence -10
:SENSe:RFLection:REFerence?
The value returned in this example is: "-10".

语法 :SENSe:RFLection:REFerence:UNIT <PredefExpr>

参数 PredefExpr is one of the following predefined expressions: RETurn-
loss|VSWR|RFACtor|RPOWer.
Default is RETurnloss.

用途 Switches the display to following units: return loss (dB), VSWR (-), reflection factor 
(mRho) or reflected power (%).

查询 Reads and returns the current setting.

示例 :SENSe:RFLection:REFerence:UNIT dBm
:SENSe:RFLection:REFerence:UNIT?
Returns the following string: "dBm"

语法 :SENSe:RFLection:REFerence:VSWR <real1>

参数 real1是一个浮点实数。

real1的最小值为 1.0。
real1的最大值为 1000.0。
real1的缺省值为 10.0。

用途 该命令可以在测量单位设为 VSWR时，设置反射显示的最大 VSWR值。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:REFerence:VSWR 500
:SENSe:RFLection:REFerence:VSWR?
这个例子的返回值为："500.0".

语法 :SENSe:RFLection:REFerence:RFACtor <real1>

参数 real1是一个浮点实数。real1的最小值为 0 mRho，最大值为 2000mRho。
real1的缺省值为 2000 mRho。

用途 该命令可以在测量单位设为反射因数时，设置反射显示的最大因数值。
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测量命令
:SENSe:RFLection:REFerence:RPOWer

:SENSe:RFLection:FILTer

:SENSe:RFLection:FILTer:AUTo

查询 读取和返回当前设置。

示例 :SENSe:RFLection:REFerence:RFACtor 1000
:SENSe:RFLection:REFerence:RFACtor?
这个例子的返回值为："1000.0".

语法 :SENSe:RFLection:REFerence:RPOWer <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.0%，最大值为 200.0%。real1的缺省值为 200.0%.

用途 该命令可以在测量单位设为反射功率时，设置反射显示的最大功率值。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:REFerence:RPOWer 120
:SENSe:RFLection:REFerence:RPOWer?
这个例子的返回值为："120.0".

语法 :SENSe:RFLection:FILTer <real1>

参数 real1是一个浮点实数。

real1的最小值为 1000，最大值为 1000000。
real1可以设置为 1*10n或者 3*10n。
real1的缺省值为 1000000。

用途 该命令可以设置 9100 的分辨带宽过滤器，单位为赫兹。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:FILTer 300000
:SENSe:RFLection:FILTer? 这个例子的返回值为："300000".

语法 :SENSe:RFLection:FILTer:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。 缺省值为 ON。

用途 启用或者关闭对分辨带宽过滤器的自动选择功能。如果启用， 9102 就会根据
当前设置的跨度、视频带宽和扫描时间选择分辨带宽。

查询 读取和返回当前设置。

示例 :SENSe:RFLection:FILTer:AUTo ON
:SENSe:RFLection:FILTer:AUTo? 返回以下字符串 : "ON"
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测量命令
:SENSe:RFLection:CALibration

:SENSe:RFLection:CALibration:MODe

:SENSe:RFLection:CALibration:ENABled

语法 :SENSe:RFLection:CALibration <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :OPEN|SHORt|LOAD。

用途 开始反射测量。必须遵照下列顺序：

1 标量模式 :
连接一个 OPEN到测量端口，执行：
:SENSe:RFLection:CALibration OPEN.
连接一个 SHORT到测量端口，执行：
:SENSe:RFLection:CALibration SHORt.

2 矢量模式 :
连接一个 OPEN到测量端口，执行：
:SENSe:RFLection:CALibration OPEN.
连接一个 SHORT到测量端口，执行：
:SENSe:RFLection:CALibration SHORt.
连接一个 LORD到测量端口，执行：
:SENSe:RFLection:CALibration LOAD.
可以利用下面的命令，实现更改模式：
:SENSe:RFLection:CALibration:MODe SCALar|VECTor

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一 £½NO|YES。

示例 :SENSe:RFLection:CALibration?
返回以下字符串 : "YES"

语法 :SENSe:RFLection:CALibration:MODe <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : SCALar|VECTor。
缺省值为 SCALar。

用途 将反射校正模式设为标量或者矢量。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:RFLection:CALibration:MODe VECTor
:SENSe:RFLection:CALibration:MODe?
返回以下字符串 : "VECT"

语法 :SENSe:RFLection:CALibration:ENABled <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 OFF。

用途 启用或者关闭反射校正纠正。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:RFLection:CALibration:ENABled OFF
:SENSe:RFLection:CALibration:ENABled?
返回以下字符串 : "OFF"
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测量命令
:SENSe:CLOSs:REFerence

:SENSe:CLOSs:FILTer

:SENSe:CLOSs:FILTer:AUTo

:SENSe:CLOSs:CALibration

语法 :SENSe:CLOSs:REFerence <real1>

参数 real1是一个浮点实数。

real1的最小值为 -60.0 dB，最大值为 60.0 dB。
real1的缺省值为 0.0 dB。

用途 该命令将设置 9102 在线损模式下的参考电平（即 0dB线所对应的电平值）。
参考指的是跟踪发生器当前设置的输出功率电平。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:CLOSs:REFerence -10
:SENSe:CLOSs:REFerence?
这个例子的返回值为："-10".

语法 :SENSe:CLOSs:FILTer <real1>

参数 real1是一个浮点实数。

real1的最小值为 1000，最大值为 1000000。
real1可以设置为 1*10n 或者 3*10n。 
real1的缺省值为 1000000。

用途 该命令可以设置 9102 的分辨带宽过滤器，单位为赫兹。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:CLOSs:FILTer 300000
:SENSe:CLOSs:FILTer?
这个例子的返回值为："300000".

语法 :SENSe:CLOSs:FILTer:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 ON。

用途 启用或者关闭分辨带宽的自动选择功能。如果启用， 9102 将会根据当前设置
的跨度、视频带宽和扫描时间选择分辨带宽。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:CLOSs:FILTer:AUTo ON
:SENSe:CLOSs:FILTer:AUTo?
返回以下字符串 : "ON"

语法 :SENSe:CLOSs:CALibration <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : SHORt|OPEN.

用途 开始线损校正。必须遵照以下顺序：

连接一个 SHORT到测量端口，执行：
:SENSe:CLOSs:CALibration SHORt.
连接一个 OPEN 到测量端口，执行：
:SENSe:CLOSs:CALibration OPEN.
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输入命令
:SENSe:CLOSs:CALibration:ENABled

输入命令

利用这些命令，可以调节 9102 手持式频谱分析仪的输入。

:INPut:ATTenuation

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一 :NO|YES。

示例 :SENSe:CLOSs:CALibration?
返回以下字符串 : "YES"

语法 :SENSe:CLOSs:CALibration:ENABled <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 OFF。

用途 启用或者关闭线损校正纠正。

查询 读取和返回当前的校正状态。这是下列预定义的表达式之一：NO|YES。

示例 :SENSe:CLOSs:CALibration:ENABled OFF
:SENSe:CLOSs:CALibration:ENABled?
返回以下字符串 : "OFF"

警告

RF IN 接口的最高输入功率为 30 dBm （1 瓦）。更高的输入功率可能会
导致本仪器严重受损。

语法 :INPut:ATTenuation <real1>

参数 real1是一个浮点实数。

real1的最小值为 0，最大值为 50，可以用 10作为步进单位设置。

real1的缺省值为 30.

用途 该命令可以设置 Willtek 9102 的 RF 衰减。 real1的物理单位为 dB。

查询 读取和返回当前设置。

示例 :INP:ATT 20:
INPut:ATTenuation?
这个例子的返回值为： "20".
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输入命令
:INPut:ATTenuation:AUTo

:INPut:IMPedance

:INPut:EDEVice

:INPut:AFACtor

语法 :INPut:ATTenuation:AUTo <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 ON。

用途 允许 9102 根据参考电平自动选择衰减。

查询 读取和返回当前设置。

示例 :INP:ATT:AUTO ON:
INPut:ATTenuation:AUTO?
返回以下字符串 : "ON"

语法 :INPut:IMPedance <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : IMP50|IMP75。
缺省值为 IMP50。

用途 允许 9102 选择 50 欧姆或者 75欧姆阻抗。

查询 读取和返回当前设置。

示例 :INP:IMP IMP75:
INPut:IMPedance?
返回以下字符串 : "IMP75"

语法 :INPut:EDEVice <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 OFF。

用途 启动或者关闭外部设备补偿。必须事先利用 MMEMory:LOAD:EDEVice 命
令，载入一个相应的文件。

查询 读取和返回当前设置。

示例 :INP:EDEVice ON:
INPut:EDEVice?
返回以下字符串 : "ON"

语法 :INPut:AFACtor <PredefExpr>

参数 PredefExpr is one of the following predefined expressions: OFF|ON.
Default is OFF.

用途 Switches the antenna factor compensation on or off. A corresponding file has to be 
loaded first with command MMEMory:LOAD:AFACtor.

查询 Reads and returns the current setting.

示例 :INPut:AFACtor ON
:INPut:AFACtor?
Returns the following string: "ON"
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MMemory 命令
:INPut:CFACtor

MMemory 命令

利用 MMemory 命令，您可以充分利用 9102 在非易失性存储中保存和载
入测量结果方面的功能。

:MMEMory:STORe:STATe

:MMEMory:STORe:TRACe

语法 :INPut:CFACtor <PredefExpr>

参数 PredefExpr is one of the following predefined expressions: OFF|ON.
Default is OFF.

用途 Switches the cable factor compensation on or off. A corresponding file has to be 
loaded first with command MMEMory:LOAD:CFACtor.

查询 Reads and returns the current setting.

示例 :INPut:CFACtor ON
:INPut:CFACtor?
Returns the following string: "ON"

语法 :MMEMory:STORe:STATe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 将 9102 的实际设置保存在闪盘上的 SETTINGS 目录中的一个名为
<string1>的文件中。

查询 读取和返回上次利用该命令保存的文件名。

示例  :MMEMory:STORe:STATe "sett3"

语法 :MMEMory:STORe:TRACe <string1>[,<PredefExp>]

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

PredefExpr是一个可选参数，是下列预定义的表达式之一：A|B。缺省值为
A.

用途 将当前的曲线 A 或者 B 和参数设置保存在闪盘上的 SETTINGS 目录中的一个
名为 <string1>的文件中。

查询 读取和返回上次利用该命令保存的文件名。

示例  :MMEMory:STORe:TRACe "GSM900",A
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MMemory 命令
:MMEMory:STORe:LIMit

:MMEMory:STORe:CHANnel

语法 :MMEMory:STORe:LIMit 
<string1>{,<PredefExpr>,<x1>,<y1>,<x2>,<y2>...}
:MMEMory:STORe:LIMit? <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

PredefExpr 是下列预定义的表达式之一 ?：MINimium|MAXimum。
x1 y1 x2 y2是浮点实数。

所有这些实数的最小值为 0； x 的最大值为 10?， y 的最大值为 8? ；所有实
数的分辨率为 0.1，缺省值为 0。

用途 将定义为直线的极限保存在闪盘上的 SETTINGS 
目录中的一个名为 <string1> 的文件中。直线由一个参数组定义，包括
PredefExpr,x1,y1,x2,y2。字符串参数后面最多可以有 30 个参数。

查询 读取和返回作为参数提供的极限文件的参数组合。

示例 :MMEMory:STORe:LIMit
"lim2",UPP,2.3,4.5,6.9,7,2,LOW,2.3,1.5,6.9,3,2
:MMEMory:STORe:LIMit? "lim2"
返回的字符串为：UPP,2.3,4.5,6.9,7,2,LOW,2.3,1.5,6.9,3,2

语法 :MMEMory:STORe:CHANnel <string1>, <int1>, <int2>, 
<real1>, <real2>, <real3>, <real4>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11个字符。

int1是一个整数。int1的最小值为 1，最大值为 1000000，缺省值为 100。
int2是一个整数。 int2的最小值为 0，最大值为 1000000，缺省值为 0。
real1是一个浮点实数。 real1的最小值为 0，最大值为 4000000000。
最小分辨率为 1000。缺省值为 1000000。
real2是一个浮点实数。 real2的最小值为 0，最大值为 4000000000。
最小分辨率为 1000。缺省值为 1000000。
real2是一个浮点实数。 real2的最小值为 0，最大值为 4000000000。
最小分辨率为 1000。缺省值为 1000000。
real3是一个浮点实数。 real3的最小值为 0，最大值为 4000000000。
最小分辨率为 1000。缺省值为 1000000。
real4是一个浮点实数。 real4的最小值为 -100，最大值为 30。
最小分辨率为 1。缺省值为 0。

用途 该命令可以保存 9102 目前的通信系统设置 （用于信道功率模式）。

string1是保存参数的系统设置文件的名称。

int1设置信道个数。 int2设置起始信道的编号。

real1设置测量的信道带宽，单位为赫兹。

real2设置信道的频率间隔，单位为赫兹。

real3设置第一个信道的频率，单位为赫兹。

real4设置系统参考电平 （即 0dB线所对应的电平值）。

查询 从以参数形式提供的极限文件中读取和返回参数组合。

示例 :MMEMory:STORe:CHANnel 
"P-GSM9DO",125,0,400000,200000,935000000,0.0
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MMemory 命令
:MMEMory:STORe:EDEVice

:MMEMory:STORe:CTYPe

语法 :MMEMory:STORe:EDEVice <string1>, <real1freq>, 
<real1lev>, <real2freq>, <real2lev>, ... <real100freq>, 
<real100lev>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

real1freq 到real100freq均为浮点实数。最小值为0，最大值为4e9。最
小分辨率为 1。real1lev 到 real100lev均为浮点实数。最小值为 -100，
最大值为 30。最小分辨率为 0.01。

用途 该命令可以存储用于外部设备补偿的设置。string1是存储参数的外部设备
补偿文件的名称。 realxfreq 和 realxlev 是用以相应频率上设置衰减的
一对频率和电平值。 9102 会对频率点之间的电平进行线性插值。

查询 读取和返回以参数形式提供的外部设备补偿文件的参数组合。

示例 :MMEMory:STORe:EDEVice "EXT_DEV2",1000000, -5.1,
2000000,-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6
:MMEM:STOR:EDEV? "EXT_DEV2"
返回的字符串：1000000, -5.1,2000000,-3.2,
5000000,-4.1,10000000,-3.8,20000000,-2.6

语法 :MMEMory:STORe:CTYPe <string1>,<real1>,<real2>,
<PredefExpr>,<real3>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

real1是一个浮点实数，最小值为1.0，最大值为20.0。最小分辨率为0.1。
缺省值为 1.0。
real2 是一个浮点实数，最小值为 0.0，最大值为 2000.0。最小分辨率为
0.01。缺省值为 0.0。
PredefExpr是一个可选参数，是下列预定义的表达式之一：M100|FT100。
缺省值为 M100。
real3 是一个浮点实数，也是一个可选参数。最小值为 500000，最大值为
4000000000。最小分辨率为 0.1，缺省值为 4000000000。

用途 该命令可以保存线缆类型设置。 string1 是保存参数的线缆类型文件的名
称。 real1 是线缆的绝缘率。 real2 是线缆每米或者每英寸的衰减值。
PredefExpr将衰减值单位设为米或者英尺。 real3 是线缆截止频率。

查询 读取和返回以参数形式提供的线缆类型文件的参数组合。

示例 :MMEMory:STORe:CTYPe 
"EXT_DEV2",2.4,9.3,"MET",2000000000
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MMemory 命令
:MMEMory:STORe:AFACtor

:MMEMory:STORe:CFACtor

:MMEMory[:LOAD]:FILelist[:TRACe]?

语法 :MMEMory:STORe:AFACtor 
<string1>,<real1freq>,<real1lev>,<real2freq>,
<real2lev>,...,<real100freq>,<real100lev>

参数 string1 是一个字符串 （文字）参数。 string1 的最大长度为 11 个字符。

real1freq 到 real100freq 均为浮点实数。最小值为 0，最大值为 4e9。最小分辨
率为 1。
real1lev 到 real100lev 均为浮点实数。最小值为 -100，最大值为 30。最小分辨
率为 0.01。

用途 该命令可以保存线缆类型设置。 string1 是保存参数的线缆类型文件的名称。
real1 是线缆的绝缘率。 real2 是线缆每米或者每英寸的衰减值。 PredefExpr 将
衰减值单位设为米或者英尺。 real3 是线缆截止频率。 .

查询 读取和返回以参数形式提供的外部设备补偿文件的参数组合。

示例 :MMEMory:STORe:AFACtor "AFAC2",1000000,-5.1,2000000,
-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6

语法 :MMEMory:STORe:CFACtor 
<string1>,<real1freq>,<real1lev>,<real2freq>,
<real2lev>,...,<real100freq>,<real100lev>

参数 string1 is a string (text) parameter. The maximum length of string1 is 
11 characters.
real1freq to real100freq are floating point real numbers. The minimum 
value is 0, the maximum value 4e9. The minimum resolution is 1. real1lev to 
real100lev are floating point real numbers. The minimum value is -100, the 
maximum value 30. The minimum resolution is 0.01.

用途 This command stores settings for cable factor compensation. string1 is the name 
of cable factor compensation file in which the parameters are stored. realxfreq 
and realxlev are pairs of frequency and level values to set the attenuation on this 
frequency. Between frequency values there is a linear interpolation for the level.

查询 Reads and returns the parameter sets of the cable factor compensation file which is 
given as parameter.

示例 :MMEMory:STORe:CFACtor "CFAC7",1000000,-5.1,2000000,
-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6

Syntax :MMEMory:LOAD:FILelist[:TRACe]? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined expres-
sions: SHORt|EXTent. Default is SHORt.

Command There is only a query form of this command available.

Query Reads and returns the list of files stored in the TRACE directory. The file names are 
separated by commas.

Example :MMEMory:LOAD:FILelist:TRACe?
String returned in this example:
"TRACE1","TRACE2","TRACE3"
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MMemory 命令
:MMEMory[:LOAD]:FILelist:STATe?

:MMEMory[:LOAD]:FILelist:LIMit?

:MMEMory[:LOAD]:FILelist:CHANnel?

:MMEMory[:LOAD]:FILelist:EDEVice?

语法 :MMEMory[:LOAD]:FILelist:STATe? <PredefExpr>

参数 PredefExpr是一个可选参数，是下列预定义的表达式之一：

SHORt|EXTent。缺省值为 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回 TRACE目录中保存的文件列表。文件名之间用逗号隔开。

示例 :MMEMory:LOAD:FILelist:STATe?
在这个例子中返回的字符串为： "SETT1","SETT2","SETT3"

语法 :MMEMory[:LOAD]:FILelist:LIMit? <PredefExpr>

参数 PredefExpr 是一个可选参数，是下列预定义的表达式之一：
SHORt|EXTent。缺省值 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回一个用逗号隔开的文件名称列表。每个文件都包含9102中保
存的频谱极限值。

示例 :MMEMory:LOAD:FILelist:LIMit?
返回的字符串："LIM1","LIM2"

语法 :MMEMory[:LOAD]:FILelist:CHANnel? <PredefExpr>

参数 PredefExpr 是一个可选参数，是下列预定义的表达式之一：SHORt|EXTent。缺
省值为 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回一个用逗号隔开的文件名称列表。每个文件都包含 9102 中保存的
信道值。

示例 :MMEMory:LOAD:FILelist:CHANnel?
返回的字符串："GSM900","GSM1800"

语法 :MMEMory[:LOAD]:FILelist:EDEVice? <PredefExpr>

参数 PredefExpr是一个可选参数，是下列预定义的表达式之一：

SHORt|EXTent。缺省值为 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回一个用逗号隔开的文件名称列表。每个文件都包含 9102 中保存的
外部设备补偿值。

示例 :MMEMory:LOAD:FILelist:EDEVice?
在这个例子中返回的字符串为： "EXT_DEV2","EXT_DEV5"
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MMemory 命令
:MMEMory[:LOAD]:FILelist:CTYPe?

:MMEMory[:LOAD]:FILelist:AFACtor?

:MMEMory[:LOAD]:FILelist:CFACtor?

:MMEMory:LOAD:STATe

语法 :MMEMory[:LOAD]:FILelist:CTYPe? <PredefExpr>

参数 PredefExpr是一个可选参数，

是下列预定义的表达式之一 :SHORt|EXTent。缺省值为 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回一个用逗号隔开的文件名称列表。每个文件包含 9102 中保存的一
种线缆类型。

示例 :MMEMory:LOAD:FILelist:CTYPe?
在这个例子中返回的字符串为： "C_TYPE2","C_TYPE5"

语法 :MMEMory[:LOAD]:FILelist:AFACtor? <PredefExpr>

参数 PredefExpr是一个可选参数，是下列预定义的表达式之一：

SHORt|EXTent。缺省值为 SHORt。

用途 该命令只有一种查询格式。

查询 读取和返回一个用逗号隔开的文件名称列表。每个文件都包含 9102 中保存的
天线补偿因数。

示例 :MMEMory:LOAD:FILelist:AFACtor?
在这个例子中返回的字符串为："AFAC2","AFAC5"

语法 :MMEMory[:LOAD]:FILelist:CFACtor? <PredefExpr>

参数 PredefExpr is an optional parameter and one of the following predefined expres-
sions: SHORt|EXTent.
Default is SHORt.

用途 There is only a query form of this command available.

查询 Reads and returns a comma-separated list of file names. Each file contains cable fac-
tor compensation stored on the 9102.

示例 :MMEMory:LOAD:FILelist:CFACtor?
String returned in this example:
"CFAC7","CFAC8"

语法 :MMEMory:LOAD:STATe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的 SETTINGS目录中的文件 string1中载入 9102 参数设置。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:STATe "sett3"
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MMemory 命令
:MMEMory:LOAD:TRACe

:MMEMory:LOAD:LIMit

:MMEMory:LOAD:CHANnel

:MMEMory:LOAD:EDEVice

语法 :MMEMory:LOAD:TRACe <string1>,<PredefExpr>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

PredefExpr是一个可选参数，是下列预定义的表达式之一：A|B。
缺省值为 A。

用途 将从闪盘的TRACE目录中的文件<string1>中的9102曲线载入到曲线A或B。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:TRACe "TESTTRACE2"

语法 :MMEMory:LOAD:LIMit <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的 LIMIT目录中的文件 <string1>载入 9102 极限设置。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:LIMit "sett3"

语法 :MMEMory:LOAD:CHANnel <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的 CHANNEL目录中的文件 <string1>载入此前保存的信道数据。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:CHANnel "GSM900"

语法 :MMEMory:LOAD:EDEVice <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的外部设备目录中的文件 <string1>载入此前保存的信道数据。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:EDEVice "EXT_DEV2"
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MMemory 命令
:MMEMory:LOAD:CTYPe

:MMEMory:LOAD:AFACtor

:MMEMory:LOAD:CFACtor

:MMEMory:DELete:STATe

语法 :MMEMory:LOAD:CTYPe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的线缆类型目录中的文件 <string1>载入此前保存的线缆类型。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:CTYPe "RG58"

语法 :MMEMory:LOAD:AFACtor <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 从闪盘的天线参数目录中的文件 <string1>载入此前保存的天线参数。

查询 读取和返回最近一次利用本命令载入的文件名。

示例 :MMEMory:LOAD:CFACtor "CFAC7"

语法 :MMEMory:LOAD:CFACtor <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的 SETTING目录中的文件 <string1>。该目录中的文件通常包含
设备的参数设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:LOAD:AFACtor "AFAC2

语法 :MMEMory:DELete:STATe <string1>

参数 没有参数

用途 删除闪存的 SETTING 目录中的所有文件。该目录中的文件通常包含 9102 的
参数设置。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:STATe "sett3"
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MMemory 命令
:MMEMory:DELete:STATe:ALL

:MMEMory:DELete:TRACe

:MMEMory:DELete:TRACe:ALL

:MMEMory:DELete:LIMit

语法 :MMEMory:DELete:STATe:ALL

参数 没有参数

用途 删除闪存的 SETTING 目录中的所有文件。该目录中的文件通常包含 9102 的
参数设置。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:STATe:ALL 

语法 :MMEMory:DELete:TRACe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的 TRACE 目录中的文件 <string1>（保存有曲线数据和参数设
置）。

查询 Returns 最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:TRACe "GSM900"

语法 :MMEMory:DELete:TRACe:ALL

参数 没有参数

用途 删除闪存的 TRACE目录中的所有文件。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:TRACe:ALL

语法 :MMEMory:DELete:LIMit <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的 LIMIT 目录中的文件 <string1>。该目录中的文件通常包含设
备的极限设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:LIMit "lim3"
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MMemory 命令
:MMEMory:DELete:LIMit:ALL

:MMEMory:DELete:CHANnel

:MMEMory:DELete:CHANnel:ALL

:MMEMory:DELete:EDEVice

语法 :MMEMory:DELete:LIMit:ALL

参数 没有参数

用途 删除闪存的 LIMIT目录中的文件 <string1>。
该目录中的文件通常包含 9102 的频谱极限设置。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:LIMit:ALL

语法 :MMEMory:DELete:CHANnel <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的 CHANEL目录中的文件 <string1>。
该目录中的文件通常包含设备的信道设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:CHAN "P-GSM"

语法 :MMEMory:DELete:CHANnel:ALL

参数 没有参数

用途 删除闪存的 CHANEL目录中的所有文件。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:CHANnel:ALL

语法 :MMEMory:DELete:EDEVice <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的外部设备目录中的文件 <string1>。
该目录中的文件通常包含 9102 的外部设备补偿设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:EDEVice "EXT_DEV3
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MMemory 命令
:MMEMory:DELete:EDEVice:ALL

:MMEMory:DELete:CTYPe

:MMEMory:DELete:CTYPe:ALL

:MMEMory:DELete:AFACtor

语法 :MMEMory:DELete:EDEVice:ALL

参数 没有参数

用途 删除闪存的外部设备目录中的所有文件。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:EDEVice:ALL

语法 :MMEMory:DELete:CTYPe <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的线缆类型目录中的文件 <string1>。
该目录中的文件通常包含 9102 的线缆类型设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:CTYPe "cable3"

语法 :MMEMory:DELete:CTYPe:ALL

参数 没有参数

用途 删除闪存的线缆类型目录中的所有文件

查询 该命令没有查询格式。

示例 :MMEMory:DELete:CTYPe:ALL 

语法 :MMEMory:DELete:AFACtor <string1>

参数 string1是一个字符串（文字）参数。string1的最大长度为 11 个字符。

用途 删除闪存的天线参数目录中的文件 <string1>。
该目录中的文件通常包含 9102 的天线参数补偿设置。

查询 读取和返回最近一次利用本命令删除的文件名。

示例 :MMEMory:DELete:AFACtor "AFAC2"
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仪器命令
:MMEMory:DELete:AFACtor:ALL

:MMEMory:DELete:CFACtor

:MMEMory:DELete:CFACtor:ALL

仪器命令

:INSTrument:SELect

语法 :MMEMory:DELete:AFACtor:ALL

参数 没有参数

用途 删除闪存的天线参数目录中的所有文件。

查询 该命令没有查询格式。

示例 :MMEMory:DELete:AFACtor:ALL 

语法 :MMEMory:DELete:CFACtor <string1>

参数 string1 is a string (text) parameter. The maximum length of string1 is 
11 characters.

用途 Deletes file string1 in the cable factor directory on the flash disk. Files in this 
directory contain cable factor compensation settings on the 9102.

查询 Reads and returns the name of the file deleted last with this command.

示例 :MMEMory:DELete:CFACtor "CFAC7"

语法 :MMEMory:DELete:CFACtor:ALL

参数 There are no parameters.

用途 Deletes all the files in the cable factor directory on the flash disk.

查询 There is no query form of this command available.

示例 :MMEMory:DELete:AFACtor:ALL 

语法 :INSTrument:SELect <PredefExpr>

参数 PredefExpr是下列预定义的表达式之一：
SANalyzer|CPOWer|TRANsmission|SGENerator,
缺省值为 SANalyzer。

用途 选择测量模式。可选模式包括频谱分析、信道功率、发射和信号发生器。

查询 读取和返回当前设置。

示例 :INSTrument:SELect CPOWer
:INSTrument:SELect?
回以下字符串 : "CPOWer"
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仪器命令
:INSTrument:GENerator

:INSTrument:GENerator:LEVel

:INSTrument:GENerator:MODe

:INSTrument:GENerator:DISPlay

语法 :INSTrument:GENerator <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 OFF.

用途 开启或者关闭跟踪发生器。

查询 读取和返回当前设置。

示例 :INSTrument:GENerator ON
:INSTrument:GENerator?
回以下字符串 : "ON"

语法 :INSTrument:GENerator:LEVel <real1>

参数 real1是一个浮点实数。 real1是一个浮点实数。

real1的最大值和最小值取决于 SENS:REFL:UNIT 所设置的单位。

如果单位设置为 dBm，那么最小值为 -100，最大值为 30。
如果单位设置为 dBuV，那么最小值为 7，最大值为 137。
如果单位设置为 dBmV，那么最小值为 -53，最大值为 77。
如果单位设置为 dBV，那么最小值为 -113，最大值为 17。
real1的缺省值为 0 dBm.

用途 该命令可以按照 :SENS:REFL:UNIT 命令所选择的单位，

设置 9100 跟踪发生器的输出功率。

查询 读取和返回当前设置。

示例 :INSTrument:GENerator:LEVel -50
:INSTrument:GENerator:LEVel?
这个例子的返回值为 : "-50".

语法 :INSTrument:GENerator:MODe <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : CW|SWP。缺省值为 CW。

用途 切换发生器的工作状态：在某个特定频率扫描连续波形 (CW) ，或者从起始频
率扫描到截止频率。该命令只适用于 SIGNAL GENERATOR模式。

查询 读取和返回当前设置。

示例 :INSTrument:GENerator:MODe CW
:INSTrument:GENerator:MODe?
这个例子的返回值为 : "CW"

Syntax :INSTrument:GENerator:DISPlay <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ABSolute|RELative.
Default is ABSolute.

Command Switches the display absolute or relative to the tracking generator output power. This 
command is linked to SENSe:TRANsmission:REFerence:UNIT.
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显示命令
显示命令

显示命令子系统会影响仪器的屏幕显示。

:DISPlay:TRACe:Y[:SCALe][:LOGarithmic]

:DISPlay:TRACe:Y[:SCALe]:LINear:VOLT

:DISPlay:TRACe:Y[:SCALe]:LINear:WATT

Query Reads and returns the current setting.

Example :INSTrument:GENerator:DISPlay RELative
:INSTrument:GENerator:DISPlay?
Returns the following string: "REL"

语法 :DISPlay:TRACe:Y[:SCALe][:LOGarithmic] <int1>

参数 int1是一个整数。 <int1>的最小值为 1，最大值为 20。
有效值包括 1、 2、 5、 10和 20。缺省值为 10。

用途 保持功率电平的上限，根据 in1所设置的、在屏幕上显示的每刻度单位dB数，
调节分辨率 （和下限）。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe][:LOGarithmic] 20
:DISPlay:TRACe:Y[:SCALe][:LOGarithmic]?
这个例子的返回值为："20".

语法 :DISPlay:TRACe:Y[:SCALe]:LINear:VOLT <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.00001，最大值为 1.0。 real1的缺省值为 0.001。

用途 该命令只能在 9102 设置为电压单位时使用。它可以保持功率电平的上限，根
据 in1 所设置的、在屏幕上显示的每刻度单位电压数，调节电压刻度的分辨率
（和下限）。分辨率取决于 SENSe:REFLevel:UNIT 命令所设置的单位。如
果单位设为 V，本命令和查询的单位就是伏特。如果单位设为 MV，本命令和
查询的单位就是毫伏。如果单位设为 UV，本命令和查询的单位就是微伏。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe]:LINear:VOLT 0.0005
:DISPlay:TRACe:Y:[SCALe]:LINear:VOLT?
这个例子的返回值为："0.0005".

语法 :DISPlay:TRACe:Y[:SCALe]:LINear:WATT <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.00000000001，最大值为 0.1。
real1的缺省值为 0.000001.
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显示命令
:DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR

:DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor

:DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer

用途 该命令只能在 9102 设置为瓦特单位时使用。它可以保持刻度的上限，调节瓦
特刻度的分辨率（和下限）。real1定义了屏幕上显示的每个刻度单位的瓦
特数。分辨率取决于 SENSe:REFLevel:UNIT 命令所设置的单位。如果单
位设为 MV，本命令和查询的单位就是毫瓦。如果单位设为 UW，本命令和查
询的单位就是微瓦。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe]:LINear:WATT 0.0002
:DISPlay:TRACe:Y:[SCALe]:LINear:WATT?
这个例子的返回值为："0.0002".

语法 :DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR <real1>

参数 real1是一个浮点实数。

real1的最小值为 1.0，最大值为 1000.0。 real1的缺省值为 100.0.

用途 该命令只能在 9102 设置为反射模式，并且单位设置为 VSWR时使用。它可以
保持 VSWR刻度的上限，调节刻度的分辨率（和下限）。 real1定义了屏幕
上显示的每个刻度单位的 VWSR单位。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR 0.5
:DISPlay:TRACe:Y:[SCALe]:RFLection:VSWR?
这个例子的返回值为："0.5".

语法 :DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor <real1>

参数 real1是一个浮点实数。

real1的最小值为 1 mRho，最大值为 2000 mRho。
real1的缺省值为 200 mRho。

用途 该命令只能在 9102 设置为反射模式，并且单位设置为反射因数时使用。它可
以保持反射因数刻度的上限，调节刻度的分辨率（和下限）。 real1定义了
屏幕上显示的每个刻度单位的 mRho数。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor 100
:DISPlay:TRACe:Y:[SCALe]:RFLection:RFACtor?
这个例子的返回值为："100".

Syntax :DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer <real1>

Parameters real1 is a floating point real number.
The minimum value for real1 is 1.0 %. The maximum value for real1 is 
200.0 %. The default value for real1 is 20.0 %.

Command This command is only in effect when 9102 is set to reflection mode and unit is set to 
reflection power. It holds the upper limit of the reflection power scale but changes 
the resolution (and the lower limit) of the scale. real1 defines how many % per 
scale unit are shown on the display.
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显示命令
:DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor

:DISPlay:BACKlight[:BATTery]

:DISPlay:BACKlight:EXTern

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer 10
:DISPlay:TRACe:Y:[SCALe]:RFLection:RPOWer?
The value returned in this example is: "10".

语法 :DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor <real1>

参数 real1是一个浮点实数。

real1的最小值为 1 mRho，最大值为 1000 mRho。
real1的缺省值为 100 mRho。

用途 该命令只能在 9102 设置为反射模式，并且单位设置为反射因数时使用。它可
以保持反射因数刻度的上限，调节刻度的分辨率（和下限）。 real1定义了
屏幕上显示的每个刻度单位的 mRho数。

查询 返回当前设置。

示例 :DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor 100
:DISPlay:TRACe:Y:[SCALe]:DTF:RFACtor?
这个例子的返回值为："100".

语法 :DISPlay:BACKlight[:BATTery] <int1>

参数 int1是一个整数。 <int1>的最小值为 0，最大值为 100，缺省值为 50。

用途 设置电池供电模式下的屏幕亮度。如果设置值为 100，则表示亮度最高。

查询 返回当前设置。

示例 :DISPlay:BACKlight 30
:DISPlay:BACKlight?
这个例子的返回值为："30".

语法 :DISPlay:BACKlight:EXTern <int1>

参数 int1是一个整数。 <int1>的最小值为 0，最大值为 100，缺省值为 100。

用途 设置连接外部电源时的屏幕亮度。如果设置值为 100，则表示亮度最高。

查询 返回当前设置。

示例 :DISPlay:BACKlight:EXTern 50
:DISPlay:BACKlight:EXTern?
这个例子的返回值为："50".
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显示命令
:DISPlay:BEEP

:DISPlay:COLor:TRACe:[A|B]

:DISPlay:COLor:TRACe:OFFSet

:DISPlay:COLor:GRATicule

语法 :DISPlay:BEEP <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 : ON|OFF。缺省值为 ON。

用途 启用或者关闭嘟嘟声。

查询 读取和返回当前设置。

示例 :DISPlay:BEEP ON
:DISPlay:BEEP?返回以下字符串 : "ON"

语法 :DISPlay:COLor:TRACe:[A|B] <int1>

参数 int1是一个整数。 <int1>的最小值为 1，最大值为 8。
对于曲线 A，缺省值为 1；对于曲线 B，缺省值为 3。

用途 从调色板中设置曲线 A或者 B的颜色。

查询 读取和返回当前设置。

示例 :DISPlay:COLor:TRACe:A 5
:DISPlay:COLor:TRACe:A?
这个例子的返回值为："5".

语法 :DISPlay:COLor:TRACe:OFFSet <int1>

参数 int1是一个整数。 <int1>的最小值为 1，最大值为 8，缺省值为 7。

用途 从调色板中设置差值曲线 (A-B->曲线 A)的曲线偏移的颜色。

查询 读取和返回当前设置。

示例 :DISPlay:COLor:TRACe:OFFSet 5
:DISPlay:COLor:TRACe:OFFSet?
这个例子的返回值为："5".

语法 :DISPlay:COLor:GRATicule <int1>

参数 int1是一个整数。 <int1>的最小值为 1，最大值为 8，缺省值为 2。

用途 从调色板中设置网格的颜色。

查询 读取和返回当前设置。

示例 :DISPlay:COLor:GRATicule 5
:DISPlay:COLor:GRATicule?
这个例子的返回值为："5".
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计算命令
:DISPlay:COLor:LIMits

计算命令

利用计算命令，可以设置 9102 的标记。

:CALCulate:MARKer:AOFF

:CALCulate:MARKer:{A|B|C|D|E|F}[:STATe]

语法 :DISPlay:COLor:LIMits <int1>

参数 int1是一个整数。 <int1>的最小值为 1，最大值为 8，缺省值为 7。

用途 从调色板中设置极限线的颜色。

查询 读取和返回当前设置。

示例 :DISPlay:COLor:LIM 5
:DISP:COL:LIMits?
这个例子的返回值为："5"

语法 :CALCulate:MARKer:AOFF

参数 没有参数

用途 所有标记都被关闭。

查询 该命令没有查询格式。

示例 :CALC:MARK:A:STAT NORM
:CALC:MARK:B:STAT DELT
:CALC:MARK:C:STAT DELT
:CALC:MARK:AOFF

语法 :CALCulate:MARKer:{A|B|C|D|E|F}[:STATe] 
<PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 :OFF|NORMal|DELTa。
缺省值为 OFF。

用途 选择一个有效标记，将其设置为三种模式之一：OFF|NORMal|COUNter 或
者 OFF|NORMal|DELTa。OFF 用于关闭所选标记。NORMal用于启用所选标
记。 DELTa用于将标记 B、 C或者 D改为动态标记； REF标记总是标记 A。
标记 A不能被设为 DELTa。只有标记 A可以被设置为能够启用频率计数器的
COUNter。

查询 该命令的查询格式将返回当前设置。返回的字符串将包含上面所介绍的预定
义表达式的简短版本。

示例 :CALC:MARK:A:STAT NORM
:CALC:MARK:A:STAT?
这个例子中的返回值为："NORM".
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计算命令
:CALCulate:MARKer:{A|B|C|D|E|F}:DTF[:STATe]

:CALCulate:MARKer:{A|B|C|D|E|F}:Y?

:CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency]

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:DTF[:STATe] 
<PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 OFF|NORMal|DELTa。
缺省值为 OFF。

用途 选择一个有效标记，将其设置为三种模式之一：OFF|NORMal|COUNter 或
者 OFF|NORMal|DELTa。OFF用于关闭所选标记。NORMal用于启用所选
标记。 DELTa 用于将标记 B、 C 或者 D 改为动态标记； REF 标记总是标记
A。标记A不能被设为DELTa。只有标记A可以被设置为能够启用频率计数器的
COUNter。

查询 该命令的查询格式将返回当前设置。返回的字符串将包含上面所介绍的预定
义表达式的简短版本。

示例 :CALC:MARK:A:DTF NORM
:CALC:MARK:A:DTF? 这个例子中的返回值为："NORM".

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:Y? 

参数 没有参数

用途 该命令只有一种查询格式。

查询 本命令的查询格式将返回

CALCulate:MARKer:{A|B|C|D|E|F}:X 所设置的当前标记位置的电平
值。返回的字符串将包含一个浮点实数和被 (:SENSe:REFLevel:UNIT)选
为参考电平单位的物理单位。

示例 :CALCulate:MARKer:B:X 2200000000
:CALCulate:MARKer:B:Y?
返回值为："-22.4".

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency] <real1>

参数 real1是一个浮点实数。

real1的最小值为 0，最大值为 4000000000。
real1的最小分辨率为 1，缺省值为 1800000000。

用途 该命令可以在频谱分析模式下，设置 Willtek 9102 的六个标记中的一个标记的
频率。 real1的物理单位为赫兹。

查询 该命令的查询格式将返回 Willtek 9102 的相应标记 (A、B、C、D、E或者 F)
的当前标记频率设置。返回的字符串将包含一个实数。

示例 :CALCulate:MARKer:C:X 1500000000
:CALCulate:MARKer:C:X?
这个例子的返回值为："1500000000".
282 9102 手持式频谱分析仪 4.00 版本



第十五章  SCPI 命令参考
计算命令
:CALCulate:MARKer:{A|B|C|D|E|F}:X:TIMe

:CALCulate:MARKer:{A|B|C|D|E|F}:X:DISTance

:CALCulate:{A|B|C|D|E|F}:MARKer:FSTep

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:X:TIMe <real1>

参数 real1 是一个浮点实数。 real1 的最小值为 0.001，最大值为 100.0。
real1的最小分辨率为 1，缺省值为 0.0432。

用途 该命令将设置 Willtek 9102 的六个标记中的一个标记的零跨度测量时间。

real1的物理单位为秒。

查询 该命令的查询格式将返回 Willtek 9102 的相应标记 (A、B、C、D、E或者 F)
的当前标记时间设置。返回的字符串将包含一个实数。

示例 :CALCulate:MARKer:C:X:TIME 0.5
:CALCulate:MARKer:C:X:TIME?
这个例子的返回值为："0.5".

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:X:DISTance <real1>

参数 real1是一个浮点实数。 real1的最小值为 0.0，最小值为 2000.0。
real1的最小分辨率为 1，缺省值为 0.0432。

用途 该命令将设置 Willtek 9102 的六个标记中的一个标记的故障点距离测量时间。
real1的物理单位为米或者英尺。

查询 该命令的查询格式将返回 Willtek 9102 的相应标记 (A、B、C、D、E或者 F)
的当前 DTF标记长度设置。返回的字符串将包含一个实数。

示例 :CALCulate:MARKer:C:X:DISTance 10.5
:CALCulate:MARKer:C:X:DISTance?
这个例子的返回值为："10.5".

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:FSTep

参数 没有参数

用途 设置标记 A、 B、 C、 D、 E或者 F 为当前频率步进宽度 (FSTep)。

查询 该命令没有查询格式。

示例 :CALCulate:MARKer:A:FSTep
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计算命令
:CALCulate:MARKer:{A|B|C|D|E|F}:TSELect

:CALCulate:MARKer:MAXPeak

:CALCulate:MARKer:NPEak

:CALCulate:MARKer:MCENter

语法 :CALCulate:MARKer:{A|B|C|D|E|F}:TSELect <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 A|B。缺省值为 A。

用途 选择一个有效标记，将其设置到曲线 A 或者曲线 B。注：只有在曲线 B 启用
的情况下才能将其设置到曲线 B。

查询 该命令的查询格式将返回当前设置。返回的字符串将包含上面所介绍的预定
义表达式的简短版本。

示例 :CALC:MARK:A:TSELect B
:CALC:MARK:A:TSELect?
这个例子中的返回值为："B".

语法 :CALCulate:MARKer:MAXPeak

参数 没有参数

用途 将当前选中的标记设置为最大测量电平。可以通过

:CALCulate:MARKer:{A|B|C|D|E|F}[:STATe]命令“选择”一个标记。

查询 该命令没有查询格式。

示例 :CALCulate:MARKer:MAXPeak.

语法 :CALCulate:MARKer:NPEak

参数 没有参数

用途 将当前选中的标记设置为下一个最高电平值。

查询 该命令没有查询格式。

示例 :CALCulate:MARKer:NPEak.

语法 :CALCulate:MARKer:MCENter

参数 没有参数

用途 将中心频率改为当前标记频率。

查询 该命令没有查询格式。

示例 :CALCulate:MARKer:MCENter.
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计算命令
:CALCulate:MARKer:MREFlevel

:CALCulate:MARKer:FCOunt?

:CALCulate:MARKer:FCOunt:RESolution

:CALCulate:LIMit[:STATe]

语法 :CALCulate:MARKer:MREFlevel

参数 没有参数

用途 将参考电平改为标记所在位置的电平。

查询 该命令没有查询格式。

示例 :CALCulate:MARKer:MREFlevel.

语法 :CALCulate:MARKer:FCOunt?

参数 没有参数

用途 该命令只有一种查询格式。

语法 返回一个字符串，包含频率计数器的当前结果的浮点值，单位为赫兹。要获
得一个有效的结果，必须事先设置标记 M1 (CALC:MARK:A COUNter)。

示例 CALCulate:MARKer
:FCOunt?
这个例子的返回值为："2694365000.0".

语法 :CALCulate:MARKer:FCOunt:RESolution <real1>

参数 real1是一个整数。 <real1>的最小值为 1，最大值为 1000。
有效值包括 1、 10、 100和 1000。缺省值为 1000。

用途 设置频率计数器的计数分辨率，单位为赫兹。

查询 读取和返回当前设置。

示例 CALC:MARK:FCO:RES 10
:CALC:MARK:FCO:RES?
这个例子的返回值为："10".

语法 :CALCulate::LIMit[:STATe] <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 OFF|UPPer|LOWer|UPPLow。
缺省值为 OFF。

用途 将极限线选为四种不同模式之一：OFF|UPPer|LOWer|UPPLow.
OFF用于关闭极限线。

UPPer用于只启用上极限线。

LOWer用于只启用下极限线。

UPPLow用于启用上极限线和下极限线。

查询 该命令的查询格式将返回当前设置。返回的字符串将包含上面所介绍的预定
义表达式的简短版本。
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:CALCulate:LIMit:FCOunt

:CALCulate:LIMit:FCOunt:COUNt?

:CALCulate:LIMit:FBEep

:CALCulate:LIMit:FHOLd

示例 :CALC:LIM:STAT UPPLOW
:CALC:LIM?
这个例子中的返回值为："UPPL".

语法 :CALCulate:LIMit:FCOunt <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 ON|OFF。缺省值为 OFF。

用途 启用 （和重置）或者禁用超出极限计数器。在启用时，要求极限检查功能也
必须启用。（参见 CALC:LIM:STAT）。

查询 读取和返回当前设置。

示例 CALCulate:LIMit:FCOunt ON
:CALCulate:LIMit:FCOunt?
返回以下字符串 : "ON"

语法 :CALCulate:LIMit:FCOunt:COUNt?

参数 没有参数

用途 该命令只有一种查询格式。

语法 获得极限目前超出极限的次数。

示例 CALCulate:LIMit:FCOunt:COUNt?
这个例子的返回值为："5".

语法 :CALCulate:LIMit:FBEep <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 ON|OFF。缺省值为 OFF。

用途 启用或者禁用每次在测量值超出极限时发出的提示音。

查询 读取和返回当前设置。

示例 CALC:LIMit:FBEep ON
:CALCulate:LIMit:FBEep?
返回以下字符串 : "ON".

语法 :CALCulate:LIMit:FHOLd <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 ON|OFF。缺省值为 OFF。

用途 启用或者禁用保持状态 （如果测量值超出阈值）。

查询 读取和返回当前设置。

示例 :CALCulate:LIMit:FHOLd ON
:CALCulate:LIMit:FHOLd?
返回以下字符串 : "ON".
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计算命令
:CALCulate:LIMit:SIMPle

:CALCulate:LIMit:SIMPle:UPPer

:CALCulate:LIMit:SIMPle:LOWer

:CALCulate:MEASure:ACPR

语法 :CALCulate:LIMit:SIMPle <PredefExpr>

参数 PredefExpr 是下列预定义的表达式之一 ON|OFF。缺省值为 OFF。

用途 启用或者禁用简单极限线。

查询 读取和返回当前设置。

示例 CALCulate:LIMit:SIMPle ON
:CALCulate:LIMit:SIMPle?
返回以下字符串 : "ON".

语法 :CALCulate:LIMit:SIMPle:UPPer <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.0，最小值为 8.0，最小分辨率为 0.1，缺省值为 7.0。

用途 设置简单上限线。单位是一个网格。

0.0意味着显示区域的下边界， 8.0意味着上边界。

查询 读取和返回当前设置。

示例 CALCulate:LIMit:SIMPle:UPPer 6
:CALCulate:LIMit:SIMPle:UPPer?
这个例子的返回值为："6.0".

语法 :CALCulate:LIMit:SIMPle:LOWer <real1>

参数 real1是一个浮点实数。

real1的最小值为 0.0，最小值为 8.0，最小分辨率为 0.1，缺省值为 1.0。

用途 设置简单下限线。单位是一个网格。

0.0意味着显示区域的下边界， 8.0意味着上边界。

查询 读取和返回当前设置。

示例 CALCulate:LIMit:SIMPle:LOWer 2
:CALCulate:LIMit:SIMPle:LOWer?
这个例子的返回值为："2.0".

语法 :CALCulate:MEASure:ACPR?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回一个字符串，包含三个浮点值；它们分别代表了下方相邻信道的相对功
率（单位为 dB），信道功率（单位为 dBm），以及上方相邻信道的相对功率
（单位为 dB）。

示例 CALCulate:MEASure:ACPR?
这个例子的返回值为："-14.9,-31.5,-14.1".
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:CALCulate:MEASure:OBW

:CALCulate:MEASure:CPOWer

:CALCulate:MEASure:ACLoss

语法 :CALCulate:MEASure:OBW?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回一个字符串，包含针对占用带宽的浮点制，单位为赫兹。

示例 CALCulate:MEASure:OBW?
这个例子的返回值为："2694000.0".

语法 :CALCulate:MEASure:CPOWer?

参数 没有参数

用途 该命令只有一种查询格式。

查询 范围测量信道功率，单位为 dBm。

示例 CALCulate:MEASure:CPOW?
返回以下字符串 : "-32.2".

注 :
CALCulate:MEASure:CPOWer? 命令只有在进行了全面扫描之后才能返
回一个有效的测量结果。如果在扫描完成之前确定信道功率 , 将返回值 -
9999。如果定义的信道系统设置导致了无效的测量结果，也会返回这个值。
总之，如果返回值为 -9999，就表示出现了无效的测量结果。

语法 :CALCulate:MEASure:ACLoss?

参数 没有参数

用途 该命令只有一种查询格式。

查询 返回平均线损，单位为 dB。该查询只有在线损模式下才会返回有效结果。

示例 :CALCulate:MEASure:ACLoss?
这个例子的返回值为："-22.5".
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格式命令
:CALCulate:MEASure:EMF

格式命令

这些命令可以被用于设定 9102 手持式频谱分析仪的 SCPI 输出的格式。

:FORMat:ADELimiter

:FORMat:RESolution

Syntax :CALCulate:MEASure:EMF? 

Parameters There are no parameters.

Command There is solely a query form of this command available

Query Returns the EMF measurement value. The result depends on the setting of the  
:SENSe:EMF:MEASure:DISPlay command. If it is set to EFSTrength 
(electric field strength) the unit for the result is Volt/meter. If it is set to PDENsity 
(power density) the unit for the result is Watt/squaremeter. This query only returns 
valid results in EMF mode.

Example :CALCulate:MEASure:EMF?
The value returned in this example is: "0.103352".

语法 :FORMat:ADELimiter <PredefExp>

参数 PredefExp 是下列预定义的表达式之一 :COMMa|COLOn|SEMIcolon。
缺省值为 COMMa。

用途 选择在 SCPI 命令中分隔参数和在返回字符串中分隔各个测量结果值的分隔
符。

COMMa表示逗号 （缺省），

COLOn表示用冒号(:)作为分隔符，而SEMIcolon将使用一个分号(:)作为
分隔符。

查询 读取和返回当前设置。

示例 :FORM:ADEL
定义用逗号作为分隔符，分隔命令和测量结果。

语法 :FORMat:RESolution <int1>

参数 int1是一个整数。 <int1>的最小值为 0，最大值为 20，缺省值为 6。

用途 定义浮点实数在小数点后的位数。

查询 读取和返回当前设置。

示例 :FORM:RES 0
定义在小数点后没有位数。
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服务命令

这些命令可以被用于查询关于 9102 状态的信息。

:SERVice:BOOTversion?

:SERVice:BOOTversion:DATe?

:SERVice:BATTery

:SERVice:BATTery:SERialnumber?

语法 :SERVice:BOOTversion?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的引导软件的版本。该命令将返回一个字符串。

示例 :SERVice:BOOTversion?
在这个例子中返回的字符串为： "2.00".

语法 :SERVice:BOOTversion:DATe?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的引导软件的日期。该命令将返回一个字符串。

示例 :SERVice:BOOTversion:DATe?
在这个例子中返回的字符串为： "2004/10/22".

语法 :SERVice:BATTery?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回电池的当前电量 （用百分数表示）。该命令将返回一个整数。

示例 :SERVice:BATTery?
在这个例子中返回的字符串为： "40".

语法 :SERVice:BATTery:SERialnumber?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的电池的序列号。该命令将返回一个字符串。

示例 :SERVice:BATTery:SERialnumber?
在这个例子中返回的字符串为： "00300402".
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服务命令
:SERVice:POWerline?

:SERVice:CHECk:LAST

:SERVice:CHECk:NEXT

:SERVice:DEVice:TYPe?

语法 :SERVice:POWerline?

参数 没有参数

用途 该命令只有一种查询格式。

查询 如果 Willtek 9102 连接到 12V 电源线，返回 ON；否则返回 OFF。

示例 :SERV:POW?
在这个例子中返回的字符串为： "OFF".

语法 :SERVice:CHECk:LAST <int1>,<int2>,<int3>,<string>

参数 intx包括三个整数。

int1的最小值为 1998，最大值为 2100，缺省值为 1998。
int2的最小值为 1，最大值为 12，缺省值为 1。
int3的最小值为 1，最大值为 31，缺省值为 1。
string是一个字符串 （文字）参数。 string1的最大长度为 16个字符。

用途 设置上次对该设备进行检查的日期和人员姓名。

查询 读取和返回当前设置。该命令将返回三个整数和一个字符串。

示例 :SERVice:CHECk:LAST?
在这个例子中返回的字符串为： 2004,04,01,"John Williams".

语法 :SERVice:CHECk:NEXT?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回下次对这个设备进行检查的日期。该命令将返回三个整数。

示例 :SERVice:CHECk:NEXT?
在这个例子中返回的字符串为： 2005,04,01.

语法 :SERVice:DEVice:TYPe?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的类型。该命令将返回一个字符串。

示例 :SERVice:DEVice:TYPe?
在这个例子中返回的字符串为： "9102".
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:SERVice:DEVice:TEXT?

:SERVice:DEVice:CALibration:NUMBer?

:SERVice:EDEVice:SERialnumber?

:SERVice:EDEVice:TYPe?

语法 :SERVice:DEVice:TEXT?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的说明文字。该命令将返回一个字符串。

示例 :SERVice:DEVice:TEXT?
在这个例子中返回的字符串为：
"Willtek 9102 Handheld Spectrum Analyzer".

语法 :SERVice:DEVice:CALibration:NUMBer?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 的校正次数。该命令将返回一个字符串。

示例 :SERVice:DEVice:CALibration:NUMBer?
在这个例子中返回的字符串为： "1234".

语法 :SERVice:EDEVice:SERialnumber?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 所连接的外部设备的序列号。该命令将返回一个
字符串。

示例 :SERVice:EDEVice:SERialnumber?
在这个例子中返回的字符串为： "00100202".

语法 :SERVice:EDEVice:TYPe?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102所连接的外部设备的类型。该命令将返回一
个字符串。

示例 :SERVice:EDEVice:TYPe?
在这个例子中返回的字符串为： "1234".
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SCPI 错误
:SERVice:EDEVice:TEXT?

:SERVice:EDEVice:CALibration:DATe?

:SERVice:EDEVice:CALibration:NUMBer?

SCPI 错误

下表列出了 9102 在发生故障时返回的错误代码。

语法 :SERVice:EDEVice:TEXT? 

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 所连接的外部设备的说明文字。该命令将返回一
个字符串。

示例 :SERVice:EDEVice:TEXT?
在这个例子中返回的字符串为： "VSWR Bridge".

语法 :SERVice:EDEVice:CALibration:DATe?

参数 没有参数

用途 没有命令格式。

查询 以 yyyy,mm,dd的形式返回 Willtek 上次进行校正的日期。

示例 :SERVice:EDEVice:CALibration:DATe?
在这个例子中返回的字符串为： "2004/12/31".

语法 :SERVice:EDEVice:CALibration:NUMBer?

参数 没有参数

用途 该命令只有一种查询格式。

查询 读取和返回您的 Willtek 9102 所连接的外部设备的校正次数。该命令将返回一
个字符串。

示例 :SERVice:EDEVice:CALibration:NUMBer?
在这个例子中返回的字符串为： "1234".

错误代
码

错误说明

命令错误

-100 纯内部错误，用于调试目的 （命令错误） 

-101 命令字符串中存在无效字符 
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-102 SCPI 语法错误：命名不能作为查询使用，或者相反

-103 Invalid separator between parameters

-104 数据类型错误 （参数和允许数据格式不匹配） 

-108 参数超额 （参数过多） 

-109 遗漏参数 （参数过少） 

-111 标题分隔符错误 （可能在命令关键词之间缺少冒号） 

-112 程序名称过长 （即超过 12 个字符） 

-113 没有在命令列表中找到关键词 

-114 标题后缀超出范围 （命令行关键词中存在无效字符） 

-121 数字中存在无效字符 （不是数字，或者遗漏指数值） 

-123 指数超限 

-128 不允许使用数值数据 

-131 无效后缀 （没有找到附加单位） 

-134 后缀过长 （附加单位长于 12 个字符） 

-138 后缀不符 （参数类型不是实数） 

-141 无效字符数据 （参数表达式不在预定义列表中） 

-144 字符数据过长 （字符串数据超出允许范围） 

-158 这种参数类型不允许使用字符串数据 

-160 纯内部错误，用于调试目的 （数据块错误） 

-168 纯内部错误，用于调试目的 （不允许使用数据块）执行错误 

执行错误 

-201 纯内部错误，用于调试目的 （SCPI 执行功能没有定义） 

-202 纯内部错误，用于调试目的 （SCPI 查询功能没有定义） 

-210 纯内部错误，用于调试目的 （内存不足） 

-222 数据超限 

-230 纯内部错误，用于调试目的 （EXEC 收到无效标志） 

-231 纯内部错误，用于调试目的 （无效的参数索引） 

-232 纯内部错误，用于调试目的 （无效参数） 

-233 纯内部错误，用于调试目的 （参数类型错误） 

-234 纯内部错误，用于调试目的 （参数遗漏） 

-235 纯内部错误，用于调试目的 （索引错误） 

-236 参数超限 

-260 没有在预定义目录中找到文件名 

-261 无法在预定义目录创建文件 

-262 纯内部错误，用于调试目的 （标签未找到，配置文件） 

-264 在保存或者调用曲线文件时出错与设备有关的错误 
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器件独立错误 

-300 系统错误 

-310 纯内部错误，用于调试目的 （没有找到错误代码） 

-311 纯内部错误，用于调试目的 （功能尚未支持） 

-319 错误队列溢出 （超过 10 个条目） 

-320 密码错误 

-321 纯内部错误，用于调试目的 （序列号错误） 

-322 选件密钥错误 

-323 选件不可用 

-330 下载命令错误 

-331 上载命令错误查询错误 

 查询错误

-400 检查规则冲突，参数超限 

-401 纯内部错误，用于调试目的 （EPROM 写入错误） 

-402 纯内部错误，用于调试目的 （EPROM 读取错误） 

-410 无效结果
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SCPI 错误
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Chapter 17 编程示例
16

本章将通过示例，介绍怎样利用 SCPI 命令设置和控制 9102 手持式频谱
分析仪。

－ " 概述 " 第 298 页

－ " 命令示例 " 第 298 页

－ " 应用例程 " 第 306 页
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第十六章  编程示例
概述
概述

本章将介绍怎样通过串行或者 LAN 连接，从一台个人计算机控制 9102。
本章将说明 9102 手持式频谱分析仪的基本命令，介绍一些典型的应用和
SCPI 命令顺序。

本文不可能详细介绍每个命令。本文的假定条件是用户具有远程控制方
面的基础知识，而且在使用频谱分析仪方面拥有一定的经验。

命令示例

简介 整个命令集可以大致分为三类：设置、测量和其他。本章将分别用三节
介绍这三类命令。

<val> 表示数字值。

<enum> 表示字符串。

前期准备

通过串行接口 9102 必须上电。必须用一条串行线 （交叉调制解调器线）连接 9102 和
PC。接口参数应当设置为 57600 bps，每字符八位，无奇偶校验，1 个终
止位。

通过 LAN 接口 9102 必须上电。必须用一条交叉 LAN 线连接 9102 和 PC，或者用一条普
通 LAN 线将 9102 接入局域网。 9102 必须具有自己的 IP 地址。

设置 请注意， 9102 总是会试图执行您所发出的命令。但是，在某些情况下，
9102 必须调节或者更改其他设置。如果发生这种情况，请检查此前所做
的所有设置，设法消除这种冲突。

中心频率 SENSe:FREQuency:CENTer <val>设置中心频率，单位为赫兹。

示例：

标准格式：

SENSE:FREQUENCY:CENTER 96500000将中心频率设为 96.5 MHz

简短格式：

SENS:FREQ:CENT 96.5E06 将中心频率设为 96.5 MHz
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命令示例
跨度 SENSe:FREQuency:SPAN <val> 设置跨度 ( 单位为赫兹 )

示例：

标准格式：

SENSE:FREQUENCY:SPAN 20000000 将跨度设为 20 MHz

简短格式：

SENS:FREQ:SPAN 20E06 将跨度设为 20MHz

SENS:FREQ:SPAN:FULL 设置满跨度

SENS:FREQ:SPAN 0 启用零跨度

分辨带宽 SENSe:BANDwidth:RESolution <val> 设置分辨带宽(单位赫兹)

<val> 的有效值包括： 10 kHz, 30 kHz, 100 kHz, 300 kHz 或者 1 MHz.

示例：

标准格式：

SENSE:BANDWIDTH:RESOLUTION 30000 分辨带宽设为 30 kHz

简短格式：

SENS:BAND:RES 30E03 分辨带宽设为 30 kHz

SENS:BAND:RES:AUTO ON 启用自动选择

视频带宽 SENSe:BANDwidth:VIDeo <val> 设置视频带宽(单位赫兹)

<val> 的有效值包括： 10 kHz, 30 kHz, 100 kHz, 300 kHz 或者 1 MHz.

示例：

标准格式：

SENSE:BANDWIDTH:VIDEO 300000 将视频带宽设为 300 kHz

简短格式：

SENS:BAND:VID 10E03 将视频带宽设为 10 kHz 

SENS:BAND:VID:AUTO ON 启用自动选择

扫描时间 SENSe:SWEep:TIME <val> 设置扫描时间(单位毫秒)
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<val> 的有效值包括 :1, 2, 5, 10, 20, 50, 100, 200 或者 500 ms: 1, 2, 5, 10 或
者 20 s。

示例：

标准格式：

SENSE:SWEEP:TIME 200 将扫描时间设为 200ms

简短格式：

SENS:SWE:TIME 10 将扫描时间设为 10ms

SENS:SWE:TIME:AUTO ON 启用自动选择

参考电平 SENSe:RFLevel <val> 定义参考电平 (单位为 dBm)

示例：

标准格式：

SENSE:RFLEVEL -30.0 将参考电平设为 -30.0 dBm

简短格式：

SENS:RFL 10 将参考电平设为 +10 dBm

刻度 DISPlay:TRACe:Y <val> 定义每分度刻度(单位为dB)

示例：

标准格式：

DISPLAY:TRACE:Y 10 将刻度设为每分度 10dB

简短格式：

DISPL:TRAC:Y 20 将刻度设为每分度 20dB

输入衰减 INPut:ATTenuation <val> 设置输入衰减 ( 单位为 dB)

有效的输入衰减值包括 : 0, 10, 20, 30, 40 或者 50 dB。 

示例：

标准格式：

警告：

请慎用 0dB。如果实际功率过高，这可能会导致仪器受损。
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INPUT:ATTENUATION 10 将衰减值设为 10 dB

简短格式：

INP:ATT 20 将衰减值设为 20 dB

检波器 SENSe:DETector:FUNCtion <enum> 设置检波器行为。

<val> 的有效值包括：POSNeg, SAMPle, POSitive 或者 NEGative。

示例：

标准格式：

SENSE:DETECTOR:FUNCTION POSITIVE正采样

简短格式：

SENS:DET:FUNC NEG 负采样

曲线 SENSe:TRACe:<x> <enum> 设置曲线 A 或者 B 的行为

<x> 表示曲线 (A 或者 B)

<enum> 的有效值包括： ACTual, MAXHold, MINHold, HOLD, AVG 或者 OFF。

示例：

标准格式：

SENSE:TRACE:A ACTUAL 将 A 设为标准曲线。

简短格式：

SENS:TRAC:B AVG 将 B 设为平均值曲线。

标记 CALCulate:MARKer:<x>:X <val> 设置标记频率 (单位为赫兹 )

<x> 表示曲线 (A 到 D)

示例：

标准格式：

CALCULATE:MARKER:B:X 98500000 将标记 B 频率设为 98.5 MHz

简短格式：

CALC:MARK:A:X 1.2E09 将标记 A 频率设为 1.2 GHz

CALC:MARK:AOFF 禁用所有标记
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CALC:MARK:C:OFF 只禁用标记 C

CALC:MARK:MAXP 将选中标记设为 MaxPeak

CALC:MARK:NPE 将选中标记设为 NextPeak

测量

曲线 SENSe:TRACe:<x>:FETCh? <enum> 按照指定格式读取曲线数据

<x> 表示曲线 (A 或者 B)

<enum> 的有效值包括：ALL, MIN, MAX, FREQ, FMIN 或者 FMAX.

示例：

标准格式：

SENSE:TRACE:A:FETCH? ALL 获取全部测量数据

简短格式：

SENS:TRAC:B:FETC? MAX 获取曲线 B（只限最大值）

格式示例：

ALL:    <min level>, <max level>, <freq>, <min level>,...

MAX:  <max level>, <max level>,...

MIN:   <min level>, <min level>,...

FREQ: <freq>, <freq>,...

FMAX:   <max level>, <freq>, <max level>, <freq>, <max level>,...

FMIN:   <min level>, <freq>, <min level>, <freq>, <min level>,...

扫描 SENSe:SWEep:STATe <enum> 控制扫描

<enum> 的有效值包括：CONTinuous, SINGle 或者 HOLD

示例：

标准格式：

注：

一条曲线包含 500 个采样点
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命令示例
SENSE:SWEEP:STATE SINGLE 进行一次扫描

简短格式：

SENS:SWE:STAT CONT 启动重复扫描

最大峰值 CALCulate:MARKer:MAXPeak 将标记设置在最大峰值处

示例：

标准格式：

CALCULATE:MARKER:MAXPEAK 将标记设置在最大峰值处

简短格式：

CALC:MARK:MAXP 将标记设置在最大峰值处

次高峰值 CALCulate:MARKer:NPEak 将标记设置在次高峰值处

示例：

标准格式：

CALCULATE:MARKER:NPEAK 将标记设置在次高峰值处

简短格式：

CALC:MARK:NPE 将标记设置在次高峰值处

标记电平 CALCulate:MARKer:<x>:Y? 读取标记所在位置的实际电平。

<x> 选择曲线 (A 到 D)

示例：

标准格式：

CALCULATE:MARKER:B:Y? 获取标记 B 的电平

简短格式：

注：

必须先用下列命令启用一个标记：

CALC:MARKer:<x>[:STATE] {NORMal|DELTa|NOISe}.

注：

必须先用下列命令启用一个标记：

CALC:MARKer:<x>[:STATE] {NORMal|DELTa|NOISe}.
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CALC:MARK:A:Y? 获取标记 A 的电平

标记频率 CALCulate:MARKer:<x>:X? 读取标记的实际频率

<x> 选择曲线 (A 到 D)

示例：

标准格式：

CALCULATE:MARKER:B:X? 获取标记 B 的频率

简短格式：

CALC:MARK:A:X? 获取标记 A 的频率

其他

标识 *IDN? 读取仪器的序列号

返回格式 : "< 制造商 >, < 型号 >, < 序列号 >,< 软件版本 >"

制造商 : Willtek

型号 : 9102

序列号 : ( 七位数 )

软件版本 : 2.00 ( 例如 )

重置 *RST 重置仪器

示例：

*RST 将仪器置于闲置状态

错误队列 SYST:ERR? 查询错误队列

返回格式 : < 错误代码 >, "< 错误说明 >"

如果没有错误，发回 0,"No Error"。

注

错误队列最多可以容纳 10 个错误提示。请持续读取，直到返回 NO
ERROR。
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命令示例
回声 SYST:COMM:ECHO <enum> 启用 / 禁用回声功能

范围 : ON 或者 OFF.

示例：

SYST:COMM:ECHO ON 启用回声功能

这种功能的一个附带好处是可以创建一种握手机制。

本地模式 SYST:COMM:LOCAL 将仪器切换到本地模式

示例：

SYST:COMM:LOCAL 结束远程控制进程

注

我们建议始终启用回声功能。它会在命令成功执行后发回 “OK”，或
者在发生错误时发回 “ERR”
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应用例程

下面的应用例程将使用三个子程序，它们的作用分别是发送一个命令
(Output9100)，读取一个结果 (Input9100)，或者发送一个命令和读取确认
信息 (OutAck9100)。本文没有具体印出这些子程序，但是您可以从 Willtek
索取。这些例程是用 BASIC 编写的。

信号监控 任务：持续监控一个信号，检查它是否仍然存在。信号频率为 97.3 MHz，
信号强度大约为 -40 dBm。

OutAck9100 ("SENS:FREQ:CENT 97300000") ' 设置中心频率
OutAck9100 ("SENS:FREQ:SPAN 2E06") ' 将跨度设为 2 MHz

OutAck9100 ("SENS:REFL -30") ' 设置一个敏感的参考电平
OutAck9100 ("INP:ATT 10") ' 设置较低的衰减值
OutAck9100 ("SENS:TRAC:A ACT") ' 启用一个标准曲线
OutAck9100 ("SENS:DET:FUNC POS") ' 只使用正采样值

OutAck9100 ("CALC:MARK:AOFF") ' 关闭所有标记
OutAck9100 ("CALC:MARK:A NORM") ' 启用标记 A
SIG_FLAG = True

While SIG_FLAG = True
OutAck9100 ("SENS:SWE:STAT SING") ' 进行一次测量

OutAck9100 ("CALC:MARK:A:X 97.3E06") ' 将标记设置到该信号

Output9100 ("CALC:MARK:A:Y?") ' 读取信号电平
Lvl = Val(Input9100())

If Lvl < -45 Then SIG_FLAG = False ' 信号消失
Wend

Print "Signal disappeared!!!"
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信号搜索 任务 : 在一个频段内搜索发射机。如果存在一个信号 , 而且电平高于 -80
dBm, 就显示该频率。

OutAck9100 ("SENS: FREQ:SPAN 2000000") ' 将跨度设为 2 MHz
OutAck9100 ("SENS: FREQ:CENT 936000000") ' 从信道 0 开始

OutAck9100 ("SENS: REFL -40") ' 设置一个敏感的参考电平
OutAck9100 ("INP: ATT 0") ' 删除所有衰减值 !!
OutAck9100 ("SENS: TRAC: A MAXH") ' 启用一个最大值保持曲线
OutAck9100 ("SENS: DET: FUNC POS") ' 只使用正采样值

OutAck9100 ("CALC: MARK: AOFF") ' 关闭所有标记

channel = 1
For I = 9360 To 9594 Step 18 '以较小的步进值扫描GSM频段

Msg$ = "SENS:FREQ:CENT" & Str$(I) & "00000"
OutAck9100 (Msg$) ' 设置频率

For J = 0 To 4
OutAck9100 ("SENS:SWE:STAT SING") ' 进行五次测量

Next J

Output9100 ("SENS:TRAC:A:FETC? MAX")
MXdata$ = Input9100() ' 读取曲线数据

For J = 0 To 499 ' 将数据放入一个数组
P = InStr(MXdata$, ",") ' 搜索两个值之间的 COMMA

Yfeld(J) = Val(Mid$(MXdata$, 1, P))
MXdata$ = Right$(MXdata$, Len(MXdata$) - P)

' 删除实际值
Next J

For J = 45 To 445 Step 50
P = -120
For K = 0 To 8 ' 进行一次最大值搜索

If Yfeld(J + K) > P Then
P = Yfeld(J + K) ' 保存新的最大值

End If
Next K

If P > -80 And channel < 125 Then     ' 选出发现的通道
Print "Channel " & Str$(channel) & " = " & Str$(P) & " dBm."

End If
channel = channel + 1

Next J
Next I
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A

*CAL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
*CLS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
*ESE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232
*ESR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
*IDN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
*OPC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  232
*RST . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  231
*SRE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234
*STB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234
:CALCulate:{A|B|C|D|E|F}:MARKer:FSTep . . . . . . . . . . . . . . . . . . . . . .  283
:CALCulate:LIMit:FBEep . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
:CALCulate:LIMit:FCOunt . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
:CALCulate:LIMit:FCOunt:COUNt? . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
:CALCulate:LIMit:FHOLd . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  286
:CALCulate:LIMit:SIMPle  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287
:CALCulate:LIMit:SIMPle:LOWer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287
:CALCulate:LIMit:SIMPle:UPPer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287
:CALCulate:LIMit[:STATe] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285
:CALCulate:MARKer:{A|B|C|D|E|F}:DTF[:STATe] . . . . . . . . . . . . . . . . .  282
:CALCulate:MARKer:{A|B|C|D|E|F}:TSELect  . . . . . . . . . . . . . . . . . . . .  284
:CALCulate:MARKer:{A|B|C|D|E|F}:X:DISTance  . . . . . . . . . . . . . . . . .  283
:CALCulate:MARKer:{A|B|C|D|E|F}:X:TIMe . . . . . . . . . . . . . . . . . . . . .  283
:CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency]. . . . . . . . . . . . . . .  282
:CALCulate:MARKer:{A|B|C|D|E|F}:Y? . . . . . . . . . . . . . . . . . . . . . . . . .  282
:CALCulate:MARKer:{A|B|C|D|E|F}[:STATe]. . . . . . . . . . . . . . . . . . . . .  281
:CALCulate:MARKer:AOFF. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  281
:CALCulate:MARKer:FCOunt:RESolution . . . . . . . . . . . . . . . . . . . . . . . .  285
:CALCulate:MARKer:FCOunt? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285
:CALCulate:MARKer:MAXPeak . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284
:CALCulate:MARKer:MCENter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284
:CALCulate:MARKer:MREFlevel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285
:CALCulate:MARKer:NPEak. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284
:CALCulate:MEASure:ACLoss . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
:CALCulate:MEASure:ACPR  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287
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:CALCulate:MEASure:CPOWer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
:CALCulate:MEASure:EMF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  289
:CALCulate:MEASure:OBW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
:DISPlay:BACKlight:EXTern  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279
:DISPlay:BACKlight[:BATTery] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279
:CALCulate:MEASure:EMF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  289
:CALCulate:MEASure:EMF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  289
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:SYSTem:COMMunicate:SER:BAUDrate. . . . . . . . . . . . . . . . . . . . . . . . .  238
:SYSTem:COMMunicate:SER:TERMinator . . . . . . . . . . . . . . . . . . . . . . .  238
:SYSTem:ERRor[:NEXT]? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  238
:SYSTem:ERRor:COUNt? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  238
:SYSTem:ERRor:CODE[:NEXT]? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  239
:SYSTem:ERRor:CODE:ALL?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  239
:SYSTem:DNAMe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  239
:SYSTem:SCReendump:COLor? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
:SYSTem:SCReendump:LINe? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
:SYSTem:SCReendump:REMote . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
:SYSTem:PRINter:TYPe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
:SYSTem:PRINter:BAUDrate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241
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Chapter 19 预定义设置
B

本附录将概括介绍 9102 和 9100 数据交换软件中的一些预先定义的设置
和参数，供您参考。本附录所要讨论的主题包括：

－ " 预定义的测量设置 " 第 316 页

－ " 预定义的信道功率通信系统 " 第 316 页

－ " 预定义的电缆类型 " 第 320 页
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预定义的测量设置
预定义的测量设置

9102 提供了为某个特定的测量任务存储所有参数的功能，以便在相同条
件下重复测量时使用。在您的仪器所附带的 9100 数据交换软件中，也采
用了很多针对常见测量任务的预定义设置。如需了解使用这些设置的详
细信息，请参阅第 225 页的“使用设置”。

下表概括介绍了 9100 数据交换软件中提供的设置。预定义设置文件的名
称的前半部分表示进行各种测量时所使用的测量模式：

－ SP 表示频谱分析模式

－ CH 表示信道功率模式

－ SG 表示信号发生器模式

－ TR 表示传输模式

－ RFL 表示反射模式

－ DTF 表示故障点距离模式

－ CL 表示线损模式

－ EMF 表示 EMF （EMI）模式

预定义的信道功率通信系统

要在信道功率模式下进行测量，必须定义一个具有预定义信道编号和相
关频率的通信系统。9102 预装了部分系统。您还可以利用 9100 数据交换
软件，向 9102 下载更多的系统。下面两节将向您概括介绍 9102 上预装的
系统和 9100 数据交换软件可以提供的系统。

表 1 预定义测量设置

名称 含义 频率范围

SP-UKW 超短波 87.5 到 108 MHz

SP-DAB I 数字音频广播频段 I 223 到 230 MHz

SP-DAB II 数字音频广播频段 II 1452 到 1479.5 MHz

SP-VHF I 甚高频 TV 频段 I 47 到 68 MHz

SP-VHF III 甚高频 TV 频段 III 174 到 230 MHz

SP-UHF IV 超高频 TV 频段 IV 470 到 606 MHz

SP-UHF V 超高频 TV 频段 V 606 到 862 MHz

SP-LNB SAT-ZF 950 到 2050 MHz

RFL-GSM900 875 到 965 MHz

RFL-GSM1800 1700 到 1890 MHz

RFL-UMTS 1890 到 2200 MHz
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预定义的信道功率通信系统
9102 上预装的系统 下表列出了 9102 在缺省情况下预装的所有通信系统。如需了解关于使用
预装系统的详细信息，请参阅 " 使用通信系统和频率设置 " 第 79 页。

表 2 请参阅第 79 页的 “使用通信系统和频率设置”。 

系统名称 含义 频率范围
信道编号

(n) 中心频率 (fc)
信道宽度

到

DECT 1880 到 1900 MHz 0 到 9 fc = 1897.344 - n*1.728 1728 kHz

PGSM900-DL 主 GSM
下行链接

935 到 960 MHz 1 到 124 fc = 935 + 0.2*n 200 kHz

RGSM900-DL 铁路 GSM
下行链接

921 到 960 MHz 955 到 1023 fc = 935 + 0.2*(n-1024) 200 kHz

PCN1800-DL GSM 1800
下行链接

1805 到 1880 MHz 512 到 885 fc = 1805.2 + 0.2*(n-512) 200 kHz

PCS1900-DL GSM 1900
下行链接

1930 到 1990 MHz 512 到 810 fc = 1930.2 + 0.2*(n-512) 200 kHz

WCDMA-DL UTRA-FDD
下行链接

2110 到 2170 MHz 10562 到
10838

fc = n / 5 5 MHz

WCDMA-UL UTRA-FDD 
上行链接

1920 到 1980 MHz 9612 到
9888

fc = n / 5 5 MHz

WLAN IEEE 802.11b,g 2400 到 2484 MHz 1 到 13 fc = 2412 + (n-1)*5 22 MHz
9102 手持式频谱分析仪 4.00 版本 317



Appendix B  预定义设置
预定义的信道功率通信系统
9100 数据交换软件中的
预定义系统

下标列出了9100数据交换软件中包含的、可供下载到9102的所有通信系
统。如需了解如何使用这些系统的详细信息，请参阅第 219页的“管理用
于信道功率测量的通信系统”。 

表 3 9100 数据交换软件信道功率系统 

系统名称 含义 频率范围
信道编

(n) 中心频率 (fc) 信道宽度

GSM450-UL GSM 450 上
行链接

450.4 t 到到 o 
457.6 MHz

259 到 293 fc = 450.6 + 0.2*(n - 259) 200 kHz

GSM450-DL GSM 450 下
行链接

460.4 到 
467.6 MHz

259 到 293 fc = 460.6 + 0.2*(n - 259) 200 kHz

GSM480-UL GSM 480 上
行链接

478.8 到 468 MHz 306 到 340 fc = 479 + 0.2*(n - 306) 200 kHz

GSM480-DL GSM 480 下
行链接

488.8 到 496 MHz 306 到 340 fc = 489 + 0.2*(n - 306) 200 kHz

GSM850-UL GSM 850 上
行链接

824 到 849 MHz 128 到 251 fc = 824.2 + 0.2*(n - 128) 200 kHz

GSM850-DL GSM 850 下
行链接

869 到 894 MHz 128 到 251 fc = 869.2 + 0.2*(n - 128) 200 kHz

EGSM900-UL 扩展 GSM 上
行链接

880 到 915 MHz 975 到 1023 fc = 890 + 0.2*(n - 1024) 200 kHz

EGSM900-DL 扩展 GSM 下
行链接

925 到 960 MHz 975 到 1023 fc = 935 + 0.2*(n - 1024) 200 kHz

PGSM900-UL 铁路 GSM 上
行链接

890 到 915 MHz 1 到 124 fc = 890 + 0.2*n 200 kHz

RGSM900-UL 铁路 GSM 上
行链接

876 到 915 MHz 955 到 1023 fc = 890 + 0.2*(n - 1024) 200 kHz

PCN1800-UL GSM 1800 上
行链接

1710 到 1785 MHz 512 到 885 fc = 1710.2 + 0.2*
(n -512)

200 kHz

PCS1900-UL GSM 1900 上
行链接

1850 到 1910 MHz 512 到 810 fc = 1850.2 + 0.2*
(n - 512)

200 kHz

BLUE 到 OTH 美国 / 欧洲 2402 到 2480 MHz 0 到 78 fc = 2402 + n 1 MHz

USCELL-UL 美国蜂窝电
话网络上行
链接

824 到 849 MHz 1 到 799 fc = 825 + 0.03*n 1.25 MHz

USCELL-DL 美国蜂窝电
话网络 下行
链接

869 到 894 MHz 1 到 799 fc = 870 + 0.03*n 1.25 MHz

USPCS-UL 北美 PCS 上
行链接

1850 到 1910 MHz 0 到 1199 fc = 1850 + 0.05*n 1.25 MHz

USPCS-DL 北美 PCS 下
行链接

1930 到 1990 MHz 0 到 1199 fc = 1930 + 0.05*n 1.25 MHz

TACS-UL TACS 上行链
接

872 到 915 MHz 0 到 1000 fc  = 889.9875 + 0.025*n 1.25 MHz
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TACS-DL TACS 
下行链接

917 到 960 MHz 0 到 1000 fc = 934.9875 + 0.025*n 1.25 MHz

JTACS-UL JTACS 上行链
接

887 到 925 MHz 1 到 799 fc = 915 + 0.0125*n 1.25 MHz

JTAGS-DL JTACS 
下行链接

832 到 870 MHz 1 到  799 fc = 860 + 0.0125*n 1.25 MHz

KORPCS-UL 韩国 PCS 上
行链接

1850 到 1780 MHz 0 到 599 fc = 1750 + 0.05*n 1.25 MHz

KORPCS-DL 韩国 PCS 下
行链接

1840 到 1870 MHz 0 到 599 fc = 1840 + 0.05*n 1.25 MHz

NMT450-UL NMT-450 上
行链接

411 到 484 MHz 1 到 300 fc = 450 + 0.025*(n - 1) 1.25 MHz

NMT450-DL NMT-450 下
行链接

421 到 494 MHz 1 到 300 fc = 460 + 0.025*(n - 1) 1.25 MHz

IMT2000-UL IMT-2000 上
行链接

1920 到 1980 MHz 0 到 1199 fc = 1920 + 0.05*n 1.25 MHz

IMT2000-DL IMT-2000 下
行链接

2110 到 2170 MHz 0 到 1199 fc = 2110 + 0.05*n 1.25 MHz

CDMA700-UL CDMA 
700 MHz 上
行链接

776 到 794 MHz 0 到 359 fc = 776 + 0.05*n 1.25 MHz

CDMA700-DL CDMA 
700 MHz 下
行链接

746 到 764 MHz 0 到 359 fc = 746 + 0.05*n 1.25 MHz

CDMA1800-UL CDMA 
1800 MHz 上
行链接

1710 到 1785 MHz 0 到 1499 fc = 1710 + 0.05*n 1.25 MHz

CDMA1800-DL CDMA
1800 MHz 下
行链接

1805 到 1880 MHz 0 到 1499 fc = 1805 + 0.05*n 1.25 MHz

CDMA900-UL CDMA 
900 MHz 上
行链接

880 到 915 MHz 0 到 699 fc = 880 + 0.05*n 1.25 MHz

CDMA900-DL CDMA 
900 MHz 下
行链接

925 到 960 MHz 0 到 699 fc = 925 + 0.05*n 1.25 MHz

表 3 9100 数据交换软件信道功率系统  (Continued)

系统名称 含义 频率范围
信道编

(n) 中心频率 (fc) 信道宽度
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预定义的电缆类型

对于在故障点距离模式下进行的 DTF 测量，Willtek 为大部分常见的同轴
电缆提供了预定义电缆类型。这些电缆类型保存在 9100 数据交换软件之
中。您可以把您经常使用的电缆类型上载到 9102。如需了解关于在故障
点距离测量中使用电缆类型的详细信息，请参阅第150页的“设定电缆设
置”。如需了解关于在 9100 数据交换软件中管理电缆类型的信息，请参
阅第 220 页的“管理用于故障点距离测量的电缆类型”。

下表概括列出了 9100 数据交换软件中包含的所有预定义电缆类型。

表 4 9100 数据交换软件电缆类型

电缆类型 说明
速度 
(Vf %)

衰减率
(dB/100m) 介电常数

ANAVA5-50 AVA5-50 7/8" 91.00 5.530 1.21

ANAVA7-50 AVA7-50 1 5/8" 92.00 3.360 1.18

ANEFX2-50 EFX2-50 85.00 17.800 1.38

ANFSJ1-50A FSJ1-50A 84.00 28.500 1.42

ANFSJ2-50 FSJ2-50 83.00 19.600 1.45

ANFSJ4-50B FSJ4-50B 81.00 17.600 1.52

ANHJ12-50 HJ12-50 93.10 2.890 1.15

ANHJ45-50 HJ4.5-50 92.00 7.860 1.18

ANHJ4-50 HJ4-50 91.40 13.700 1.20

ANHJ5-50 HJ5-50 91.60 6.260 1.19

ANHJ7-50A HJ7-50A 92.10 3.420 1.18

ANHL4RP-50 HL4RP-50 88.00 12.200 1.29

ANLDF12-50 LDF12-50 88.00 3.260 1.29

ANLDF1-50 LDF1-50 86.00 20.000 1.35

ANLDF2-50 LDF2-50 88.00 17.000 1.29

ANLDF45-50A LDF4.5-50A 89.00 8.020 1.26

ANLDF4-50A LDF4-50A 88.00 10.700 1.29

ANLDF5-50A LDF5-50A 89.00 6.110 1.26

ANLDF5-50B LDF5-50B 91.00 6.100 1.21

ANLDF6-50 LDF6-50 89.00 4.430 1.26

ANLDF7-50A LDF7-50A 88.00 3.710 1.29

ANVXL5-50 VXL5-50 88.00 6.590 1.29

ANVXL5-5078 VXL5-50 7/8" 88.00 6.590 1.29

ANVXL6-50 VXL6-50 88.00 4.830 1.29

ANVXL6-50 VXL6-50 1 1/4" 88.00 4.830 1.29

ANVXL7-50 VXL7-50 88.00 3.710 1.29
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BERG10 RG10 65.90 26.201 2.30

BERG10A RG10A 65.90 26.201 2.30

BERG142 RG142 65.90 44.300 2.30

BERG17 RG17 65.90 18.000 2.30

BERG174 RG174 65.90 98.400 2.30

BERG178B RG178B 65.90 150.900 2.30

BERG17A RG17A 65.90 18.000 2.30

BERG188 RG188 65.90 101.700 2.30

BERG213 RG213 65.90 29.200 2.30

BERG214 RG214 65.90 29.200 2.30

BERG223 RG223 65.90 53.500 2.30

BERG55 RG55 65.90 54.100 2.30

BERG55A RG55A 65.90 54.100 2.30

BERG55B RG55B 65.90 54.100 2.30

BERG58 RG58 65.90 55.800 2.30

BERG58A RG58A 66.00 55.900 2.30

BERG58B RG58B 65.90 78.700 2.30

BERG58C RG58C 65.90 78.700 2.30

BERG8 RG8 65.90 26.201 2.30

BERG8A RG8A 65.90 26.201 2.30

BERG9 RG9 65.90 28.900 2.30

BERG9A RG9A 65.90 28.900 2.30

CSCR501070 CR50 1070PE 88.00 5.510 1.29

CSCR501873 CR50 1873PE 88.00 3.440 1.29

CSCR50540 CR50 540PE 88.00 10.300 1.29

EUEC12-50 EC12-50 2-1/4 88.00 3.370 1.29

EUEC1-50 EC1-50 1/4 82.00 20.980 1.49

EUEC1-50-HF EC1-50-HF 1/4 83.00 26.890 1.45

EUEC2-50 EC2-50 3/8 88.00 15.100 1.29

EUEC45-50 EC4.5-50 5/8 88.00 8.150 1.29

EUEC4-50 EC4-50 1/2 88.00 10.880 1.29

EUEC4-50-HF EC4-50-HF 1/2 82.00 16.080 1.49

EUEC5-50 EC5-50 7/8 88.00 6.100 1.29

EUEC6-50 EC6-50 1-1/4 88.00 4.510 1.29

表 4 9100 数据交换软件电缆类型

电缆类型 说明
速度 
(Vf %)

衰减率
(dB/100m) 介电常数
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EUEC7-50 EC7-50 1-5/8 88.00 3.810 1.29

NKRF114-50 RF 1 1/4"-50 88.00 4.290 1.29

NKRF158-50 RF 1 5/8"-50 88.00 3.630 1.29

NKRF12-50 RF 1/2"-50 88.00 10.700 1.29

NKRF214-50 RF 2 1/4"-50 88.00 3.220 1.29

NKRF38-50 RF 3/8"-50 86.00 16.200 1.35

NKRF58-50 RF 5/8"-50 88.00 7.460 1.29

NKRF78-50 RF 7/8"-50 88.00 5.850 1.29

NKRFE114-50 RFE 1 1/4"-50 88.00 4.440 1.29

NKRFE158-50 RFE 1 5/8"-50 88.00 3.680 1.29

NKRFE78-50 RFE 7/8"-50 84.00 6.290 1.42

NKRFF12-50 RFF 1/2"-50 82.00 15.700 1.49

NKRFF14-50 RFF 1/4"-50 83.00 27.200 1.45

NKRFF38-50 RFF 3/8"-50 81.00 20.900 1.52

RFHCA118-50 HCA118-50 92.00 4.550 1.18

RFHCA12-50 HCA12-50 93.00 11.100 1.16

RFHCA158-50 HCA158-50 95.00 2.890 1.11

RFHCA214-50 HCA214-50 95.00 2.880 1.11

RFHCA300-50 HCA300-50 96.00 1.483 1.09

RFHCA318-50 HCA318-50 96.00 1.260 1.09

RFHCA38-50 HCA38-50 89.00 13.200 1.26

RFHCA418-50 HCA418-50 97.00 0.957 1.06

RFHCA58-50 HCA58-50 92.00 8.180 1.18

RFHCA78-50 HCA78-50 93.00 5.750 1.16

RFHF4-18 HF 4-1/8" Cu2Y 97.00 1.000 1.06

RFHF5 HF 5" Cu2Y 96.00 0.700 1.09

RFHF6-18 HF 6-1/8" Cu2Y 97.00 0.600 1.06

RFLCF12-50 LCF12-50 88.00 10.500 1.29

RFLCF14-50 LCF14-50 83.00 20.200 1.45

RFLCF158-50 LCF158-50A 89.00 3.640 1.26

RFLCF214-50 LCF214-50A 88.00 3.260 1.29

RFLCF38-50 LCF38-50 88.00 16.500 1.29

RFLCF58-50 LCF58-50 88.00 8.260 1.29

RFLCF78-50A LCF78-50A 89.00 5.820 1.26

表 4 9100 数据交换软件电缆类型

电缆类型 说明
速度 
(Vf %)

衰减率
(dB/100m) 介电常数
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1

RFLCFS114 LCFS114-50A 89.00 4.420 1.26

RFSCF114-50 SCF114-50A 89.00 4.720 1.26

RFSCF12-50 SCF12-50 82.00 16.400 1.49

RFSCF14-50 SCF14-50 82.00 28.500 1.49

RFSCF38-50 SCF38-50 82.00 20.600 1.49

RFSCF78-50A SCF78-50A 88.00 6.160 1.29

TMLMR100A LMR100A 66.00 115.463 2.30

TMLMR1200 LMR1200 88.00 6.532 1.29

TMLMR1700 LMR1700 89.00 4.931 1.26

TMLMR195 LMR195 80.00 55.443 1.56

TMLMR200 LMR200 83.00 49.249 1.45

TMLMR240 LMR240 84.00 37.684 1.42

TMLMR300 LMR300 85.00 30.325 1.38

TMLMR400 LMR400 85.00 19.646 1.38

TMLMR500 LMR500 86.00 15.876 1.35

TMLMR600 LMR600 87.00 12.789 1.32

TMLMR900 LMR900 87.00 8.645 1.32

310801 310801 82.10 11.500 1.48

311201 311201 82.00 18.000 1.49

311501 311501 80.00 23,000 1.56

311601 311601 80,00 26.200 1.56

311901 311901 80.00 37.700 1.56

352001 352001 80.00 37.700 1.56

表 4 9100 数据交换软件电缆类型

电缆类型 说明
速度 
(Vf %)

衰减率
(dB/100m) 介电常数
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Chapter 20 菜单结构
C

本附录将概括介绍 9102 手持式频谱分析仪的菜单结构。
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模式功能键菜单
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应用菜单
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Chapter 21 质保和维修
D

本章将介绍 Willtek 所提供的客户服务。本章所要讨论的主题包括：

－ " 质保信息 " 第 332 页

－ " 设备退还说明 " 第 333 页
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Appendix D  质保和维修
质保信息
质保信息

Willtek 保证它的所有产品都符合它所公布的产品规格。而且在从将产品
提供给原始客户之日起的一年之内，担保产品在正常的工作条件和设计
的服务条件下，不会在材料和工艺方面出现故障。这种质保不能被转
移，也不适用于旧产品或者演示产品。

在处理质保申请时， Willtek 的责任将仅限于维修或者 -- 根据需要 -- 免
费更换任何 Willtek 认为存在缺陷，而且处于质保范围之内的组件或者器
件（除了电池以外）。如果 Willtek 无法在收到故障产品之后的合理时间
内，将部件或者器件改进、修复或者更换到质保协议所规定的条件，客
户将获得相当于产品原始定价的补偿。

在质保期内，客户需要以书面方式向 Willtek 通报存在缺陷或者不符合技
术规格的产品，并在发现这些情况之后的三十 (30) 天内将产品退还到
Willtek 的工厂、指定的服务供应商或者授权服务中心。客户应当预先支
付返还到 Willtek 或者指定服务供应商的、享受质保服务的产品的运输费
用和保险费用。Willtek 或者它的指定服务供应商将负责承担把产品发回
给客户的费用。

Willtek 的责任和客户按照硬件质保协议享受的维修服务仅限于对出现故
障的产品的修理或者更换（具体方式由 Willtek 决定）。Willtek 对因为下
列原因导致的故障不承担任何责任：(a) 在未经 Willtek 书面许可的情况
下，由除 Willtek 以外的第三方对产品进行了更换、维修或者改造； (b)
缺陷是因为客户没有正确地存储、操作、使用产品，或者滥用产品而导
致； (c) 缺陷是因为客户在与产品内部质量不符的电气或者机械环境下
使用设备而导致； (d) 缺陷是因为火灾、爆炸、电力故障或者任何自然灾
害所导致。

上述质保服务是客户独享的排他性维修服务。Willtek 不负责提供其他任
何书面或者口头的、由法律或者交易惯例明确或者间接规定的服务。特
别需要指出的是，Willtek 拒绝对设备的可商用性和对于某个特定用途的
适用性承认任何责任。Willtek 将不承担任何不属于上述质保服务的，由
Willtek 的某个代理商、经销商或者员工通过口头或者书面形式提供的任
何声明、规定、协议或者备忘录中提及的服务，除非由 Willtek 的某个授
权代表以书面方式规定某项服务。在任何情况下，Willtek 都不会对任何
直接的、间接的、偶然性的或者因为设备导致的损坏、费用或者损失承
担任何责任，其中因为合同、侵权行为或者其他法律而导致的利润损
失。
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Appendix D  质保和维修
设备退还说明
设备退还说明

如果请为您的设备申请退还或者相关授权，请通过电话或者网站联系您
当地的 Willtek 产品服务中心。对于每个返修设备，请添加一个包含下列
信息的标签：

－产品拥有者的姓名、地址和电话号码。

－序列号、产品类型和型号。

－质保状态（如果您不知道仪器的质保状态，请提供发票或者发货单的
复印件）。

－对故障和所需要的服务的详细说明。

－负责与维修有关问题的联系人的姓名和电话号码。

－退货授权 (RA) 编号或者参考编号。

如果可能的话，请用原始产品包装箱和材料返还设备。您也可以向
Willtek 索取其他 Willtek 产品包装箱。如果无法找到原始包装箱，您必须
小心打包设备，避免它在运输过程中受损。Willtek 对产品在发货过程中
可能遭受的损坏不承担任何责任。客户应当在包装箱外侧标明 Willtek 提
供的 RA 或者参考编号，并在将产品发送到 Willtek 之前支付相关运费和
保险费用。
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Appendix D  质保和维修
设备退还说明
334 9102 手持式频谱分析仪 4.00 版本



Chapter 22 软件使用许可
E

本章将介绍 9102 手持式频谱分析仪和 9100 数据交换软件的使用许可条
款。
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Appendix E  软件使用许可
最终用户使用许可协议
最终用户使用许可协议

该软件产品的所有版权都归 Willtek Communications 或者它的授权机构所
有。该软件受版权法和国际版权协议，以及其他知识产权法律和协议的
保护。

本最终用户协议允许您在下列限制条件下，使用本产品的包含的软件。
您不得：

(i) 同时在不同的计算机上使用和 / 或软件拷贝，除非该软件是一个从
互联网或者 www.willtek.cn 下载的升级版本；

(ii) 为除了您的标准存档规程以外的其他目的复制本软件；

(iii) 将软件独立于整个产品提供给第三方；

(iv) 对软件进行修改、反编译、反汇编、反向工程，或者进行其他任
何旨在获取软件源代码的尝试；

(v) 在违反购买客户所在国家的相关出口法律和法规的情况下，出口
该软件；

(vi) 在与产品用途无关的情况下使用该软件。

使用许可的供应者不得向最终用户或者第三方提供任何明示的、暗示的
或者写入协议的质保服务，或者代表这些供应者的权力，其中包括（但
不仅限于）对非侵权行为、名称、可商用性或者对于特定用途的适用性
的暗示保障。

Willtek Communications 对您或者其他任何第三方因为该软件的供应、使
用或者性能而导致的损害不承担任何责任（其中包括但不仅限于一般性
的、特殊的、因为产品导致的或者偶然性的损害，例如业务利润损失、
业务中断、业务信息丢失等）。
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Chapter 23 版本发布历史

Willtek及其标志均为Willtek Communications GmbH公司的商标。所有其他商标和注
册商标都是它们各自所属企业的资产。

本文中的产品规格和条款如有变更，恕不另行通知。

Willtek Communications GmbH 2005 年版权所有。

未经 Willtek Communications GmbH 的书面允许，不得以任何方式（包括打印、复印
和其他方式）复制或者分发本文的任何部分。

版本 说明

0411-300-A 第一个版本。

0412-300-A 纠正外部触发器接口设定和说明。

0503-301-A 添加新的曲线功能。频谱分析模式下的新 Measure 菜单。

0507-310-A 新的反射测量功能和多个改进。如需了解详细信息，请参阅第三
页的 “版本 3.10 的新功能”。 9100 数据交换软件的改进。

0512-400-A 新的 EMF(EMI) 功能已添加。新曲线找回器的描述已加入。9100 数
据交换软件描述已升级 , 添加了新的 EMF 功能和动态曲线功能。
信道功率模式描述更详尽。新附录包含预先定义的测量设置。



Chapter 24

Index
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3.01 版本的新功能 4

3.10 版本的新功能 3

36 保存和载入曲线 142

7 9130 VSWR/DTF 反射测量选件 123

9 故障点距离操作 147

9100 数据交换软件 201

9100 数据交换软件介绍 202

9102 手持式频谱分析仪简介 2

9130 VSWR/DTF 反射测量选件介绍 124

A

安全说明 xxi

安装软件 202

安装要求 202

安装一个新的选件 38

B
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保存和载入曲线 91, 118

保存和载入仪器设置 68, 120, 144

保存配置 205

保存一条曲线 91, 119, 142

本地模式 305

编程示例 297

标记 301

标记电平 303

标记栏 19

标记频率 304

标识 304

补偿增益和损耗 110

C

参考电平 300

测量 302

测量命令 241

测量模式 125

查看超出极限的测量值 34

查看发射模式参数 121

查看反射模式参数 145

查看完整的频段 52, 107, 134, 161

查看线损参数 164

查看信道功率模式参数 93

查看已装选件 37

处理系统错误 194

串行 (RS-232) 接口 14

串行接口连接 204

创建屏幕截图 211

次高峰值 303

从 9102 发送线缆类型 221

从 PC 载入模板 216
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从一台 PC 控制 9102 35

从远程控制恢复到本地模式 35

错误队列 304

D

DC in 接口 12

打印 35

打印测量结果 209

电池状态 LED 15

调节参考电平和刻度 213

调节 dB 的纵轴刻度 153

调节反射因数的刻度 138, 153

调节回波损耗的纵轴刻度 137

调节 RS-232 端口的波特率 41

调节扫描时间 82

调节输入阻抗 56

调节 VSWR 的刻度 137

调节显示窗口亮度 38

调节仪器的日期和时间 40

调节占用带宽比例 79

调节纵轴刻度 163

定义和载入极限模板 213

定义和载入外部耦合参数 217, 222

定义极限 214

定义频率跨度 82

定义上限和下限 32

定义外部耦合因数 218, 223

定义线缆类型 221, 225

定义用于计算均值的测量次数 64, 89, 116, 141

读取软件版本号 36

读取信道功率 79

读取序列号 35
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对信号执行特殊功能 57, 99, 111

多功能端口 13

E

Escape 键 22

耳机插孔 13

F

发射操作 101

发送模板到 9102 216

反射操作 129

反射模式介绍 130

反射校正 135

分辨带宽 299

服务命令 290

G

概述 1, 31, 230, 298

格式命令 289

更改频率 96

更改频率设置 105, 159

更改输入 25

更改信道 82

功能键 20

故障点距离模式介绍 148

故障点距离校正 152

故障诊断 193

关闭特殊测量功能 70

关闭外部设备补偿 110

管理 PC 和 9102 上的文件 226

管理用于故障点距离测量的线缆类型 220, 225

管理用于信号功率测量的通信系统 219, 224

关于本指南 xvii

光标键 21
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规范 xix

H

恢复缺省通信系统 81

回声 305

J

记录超出极限次数 34

计算命令 281

技术规格 124

技术支持 xviii

假定条件 xviii

检波器 301

检查校正 36

检查一般性设置 35

简介 298

键盘 20

将标记频率设为 FStep 30

将测量结果保存为图形文件 210

将测量结果保存为文本文件 210

将配置文件从 9102 复制到 PC 228

将所有模式恢复到出厂设置 48

将外部耦合损耗文件载入到 9102 218

将一条保存的曲线发送发送到 PC 208

将预定义的线缆类型上载到仪器 220

结果区域 16

进行 LAN 升级 198

进行有限次数的测量 99, 113, 139, 163

禁用一个标记 29

禁用一个动态标记 29

K

开始测量 15

刻度 300
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跨度 299

L

LAN 接口 14

LAN(TCP/IP）接口连接 205

利用 9100 数据交换软件配置通信系统 81

利用标记调节参考电平 30

利用标记调节中心频率 30

连接 9102 手持式频谱分析仪 12

连接 9160 VSWR/DTF 桥 126

连接 PC 和 9102 204

了解使用许可要求 202

M

命令示例 298

目的和范围 xviii

Q

启动软件 203

启动文件管理器 227

其他 304

启用和关闭第二条曲线 62, 88, 115, 140

启用和关闭跟踪发生器 103

启用和关闭简单极限 32

启用和关闭信号发生器 96

启用和禁用嘟嘟声 39

启用和禁用极限模板 33

启用和移动一个标记 28

启用外部设备补偿 110

启用一个动态标记 29

前期准备 298

切换显示 109

曲线 301, 302

曲线 A 减去曲线 115
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曲线 A 减去曲线 B 62, 88, 141

曲线 B 加到曲线 A 89, 116, 141

曲线偏移 63, 89, 116, 141

确定主机 IP 地址 199

确认键 22

R

RF in 接口 12

RF OUT 接口 13

软键 23

软件使用许可 335

软键说明 19

S

SCPI 错误 293

SCPI 命令参考 229

SCPI 命令参考 309

扫描 302

扫描时间 299

删除 9102 中的极限文件 33

删除所有曲线 67, 120

删除所有通信系统 81

删除文件 228

删除一个通信系统 81

删除一条曲线 67, 119, 143

删除用于外部设备补偿的文件 111

设备退还说明 333

设置 298

设置参考电平 54, 83, 109, 163

设置长度 150

设置 dB 的参考电平 153

设置电平 99

设置电平参数 53, 82, 108, 137, 153, 163
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设置反射功率的最大值 138

设置反射因数的最大值 138, 153

设置跟踪输出功率 104

设置回波损耗的参考电平 137

设置起始频率和截止频率 51, 98, 105, 132, 160

设置曲线 113, 154

设置 VSWR 的最大值 137

设置线缆参数 150

设置一个密码 196

设置一个新的通信系统 80

设置一台打印机 44

设置硬件衰减 83, 109

设置中心频率 97

设置中心频率和跨度 51, 106, 133, 151, 160

升级仪器软件 195

视频带宽 299

使用标记 28

使用测量结果 212

使用触发器 57, 111

使用过去保存的设置 46

使用极限 144, 154, 164

使用极限模板 33

使用极限线 31

使用简单极限 32

使用前面板 15

使用设置 225

使用事先定义的连接配置 204

使用通信系统和频率设置 79

使用网格 213

使用以前保存的设置 47

使用预定义的参数文件 150
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输入栏 19

输入命令 262

输入数字和文字 24

输入衰减 300

输入文字 213

数字键 22

T

特殊测量功能 68

特性和功能 5

添加标记 212

填写数字输入栏 24

填写文字输入栏 25

通过串行接口 298

通过 LAN 接口 298

退格键 23

W

外部触发器接口 13

维护您的仪器 10

为频率输入选择步进宽度 52, 98, 134, 161

为输入和输出选择电平单位 55, 84

为仪器设置一个设备名称 39

文件类型和目录结构 226

物理结构说明 10

X

系统命令 235

显示窗口 16

显示和隐藏标记 207

显示和隐藏参数 206

显示 Limits Editing 菜单中的一个曲线示例 215

显示命令 277

线损操作 157
9102 手持式频谱分析仪 4.00 版本 346



线损模式介绍 158

线损校正 162

相关信息 xviii

相邻信道功率比 (ACPR) 69, 76

校正 127

信道功率操作 73

信道功率模式操作方法 78

信号发生器操作 95

信号发生器模式介绍 96

信号监控 306

信号搜索 307

修改 9102 的 IP 地址 42

修改 9102 使用的 IP 端口 43

修改测量指标设置 136

修改极限线 215

修改 PC 的 IP 地址 43

修改频率设置 50

修改主菜单中显示的频率参数 106, 133, 161

修改纵轴刻度 54, 84, 110

选件 5

选择 9102 上的一个通信系统 79

选择测量类型 70

选择测量模式 26, 77, 96, 102, 131, 149, 158

选择测量指标 149

选择检波方式 64, 89

选择距离单位 150

选择频率模式 96

选择曲线模式 114, 139

选择 RBW、 VBW 和 SWT 53, 108

选择用户窗口颜色 45

Y
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一般性操作 11

一般性命令 230

仪器命令 275

仪器上电 14

硬件要求 126

影响服务寄存器的命令 233

影响事件状态寄存器的命令 232

应用例程 306

应用软件设置菜单 196

Z

在 9102 和 PC 之间交换设置文件 225

在 9102 上保存设置 46

在 9102 中复制曲线 65, 90, 117

在 9102 中选择极限线 33

在超出极限之后发出一次嘟嘟声 34

在某个相对于标记 1 的频率设置一个标记 30

在 PC 上保存结果 209

在 PC 上保存模板 216

在 PC 上保存、载入和打印结果 209

在 PC 上编辑通信系统参数 xiii, 219, 224

在 PC 上查看实际曲线 206

在 PC 上修改 9102 设置 225

在 PC 上载入一个曲线文件 209

载入 9102 的测量结果 205

载入一条曲线 67, 119, 143

在时域进行测量 52, 107, 134, 161

占用带宽 (OBW) 69, 76

质保和维修 331

质保信息 332

重复使用一个曲线名称 67, 92, 119, 143

中心频率 298
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重置 304

重置计数器 34

逐步设置参数 151

准备步骤 131, 149, 159

纵轴 153

最大峰值 303

最终用户使用许可协议 336
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